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J¸ ¤µa]øÚø¯z wºzx¨ ö£Ó¨£k® ÷£Ö öÁÎ±k (Output) GÚ¨£k®. 

AÆöÁÎ±møh¨ ö£ÖÁuØS ÁÇ[P¨£k® uµÄPÒ EÒÏk (Input) GÚ¨£k®. 

EÒÏmøh öÁÎ±hõP ©õØÖ® ö£õÔ•øÓ •øÓÁÈ¯õUP® (Processing)
GÚ¨£k®. •øÓÁÈ¯õUP® £i•øÓPÍõP |øhö£Ö® A÷u÷ÁøÍ AÁØøÓ 

JÊ[S•øÓ¯õPU PõmhÀ ªPÄ® •UQ¯©õÚx. J¸ ¤µa]øÚø¯¨ 

£S¨£õ´Ä ö\´²®÷£õx AvÀ EÒÏk, •øÓÁÈ¯õUP®, öÁÎ±k BQ¯Ú 

÷ÁÖ÷ÁÓõP CÚ[Põn¨£k®.

Euõµn[PÒ 

¤µa]øÚ 1 :
  

Ag\¼À CkÁuØS EP¢u J¸ Piuzøuz u¯õ›zuÀ

EÒÏk : Piuzøu GÊxÁuØS EP¢u J¸ uõÐ®  

÷£ÚõÄ®

J¸ PiuÄøÓ²® •zvøµ²® ¤]Ý®

•øÓÁÈ¯õUP® : 1. Piuzøu GÊxuÀ 

2. Piuzøu ©izxU PiuÄøÓ°À CkuÀ

3. PiuÄøÓø¯ JmkuÀ

4. PiuÄøÓ°À •PÁ›ø¯ GÊxuÀ

5. •zvøµø¯ JmkuÀ

     C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

•	 J¸ ¤µa]øÚø¯¨ £S¨£õ´Ä ö\´u¾® J¸ ¤µa]øÚUPõÚ 

ö|Ô•øÓø¯ E¸ÁõUP¾®

•	 {¸ÁõPU Pmhø©¨¦® Auß ÷uøÁ²®

•	 £õ´a\Ø ÷Põmk¨£h[PøÍ Áøµu¾® ÷£õ¼U SÔ•øÓø¯ GÊxu¾® 

AÁØÖUQøh÷¯ ©õØÓ¾®

•	 J¸ ¤µa]øÚUS ©õØÖz wºÄPøÍU PõnÀ

•	 ©õÔPÐ® ©õÔ¼PÐ®

•	 £ìPõÀ ö\´{µÀ ö©õÈ

•	 ö\´{µÀ ö©õÈPÎß £›nõ©®

     Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

1 ¤µa]øÚPøÍz wº¨£uØSa 

ö\´{µÀPøÍ GÊxuÀ

1'1    ¤µa]øÚø¯¨ £S¨£õ´Ä ö\´uÀ



  C»Á\¨ £õh¡À2

öÁÎ±k   Ag\¼À CkÁuØS EP¢u {ø»ø©°À C¸US® J¸ 

Piu®

SÔ¨¦    C®•øÓÁÈ°À £i•øÓ 4 I²® £i•øÓ 5 I²® 

©õØÓ»õ®. BÚõÀ HøÚ¯ £i•øÓPøÍ JÊ[S 

•øÓ¯õPa ö\´uÀ ÷Ásk®.

¤µa]øÚ 2  :    _øÁ¯õÚ ÷u}º u¯õ›zuÀ

      

EÒÏk        ÷u°ø», ^Û, öÁ¢}º

•øÓÁÈ¯õUP®  :  1. ÷u°ø»ø¯ ÷uÁi°À CkuÀ

2. ÷uÁi°ÞhõP öÁ¢}øµU Qsnz 

vÀ   FØÖuÀ

3. J¸ ÷uUPµsi¯ÍÄ ^Ûø¯U   

QsnzvÀ CkuÀ 

4. Pµsi°ÚõÀ ÷u}øµU P»USuÀ

5. ÷u}›À ]ÔuÍøÁ Gkzxa _øÁø¯a ÷\õvzuÀ

6. _øÁ ÷£õx©õÚuõP CµõÂmhõÀ £i•øÓPÒ 3, 4, 5   
BQ¯ÁØøÓ ©Ö£i²® ö\´uÀ

öÁÎ±k        _øÁ¯õÚ ÷u}º

¤µa]øÚ 3 :     ¦zuP¨ ö£õv JßÔÀ 40 £UP, 80 £UP¨ ¦zuP[PøÍ 

÷µÁv, Ruõ GßÓ C¸ \÷Põu›PÐUS •øÓ÷¯      

Â{÷¯õQzuÀ

EÒÏk   ¦zuP¨ ö£õv

•øÓÁÈ¯õUP®  :  1.  ¦zuP¨ ö£õvø¯z vÓzuÀ

2.  ö£õv°¼¸¢x   J¸    ¦zuPzøu 

GkzuÀ 

3.  ¦zuPzvß £UP GsoUøP 40 GÛß 

÷µÁvUSU  öPõkzuÀ

4.  ¦zuPzvß £UP GsoUøP 80 GÛß RuõÂØSU 

öPõkzuÀ

5.  ö£õv°À EÒÍ ¦zuP[PÒ •i²® ÁøµUS®      

£i•øÓPÒ 2, 3, 4, 5 Ia ö\´uÀ

öÁÎ±k       ÷µÁvUS 40 £UP¨ ¦zuP[PÒ QøhzuÀ, RuõÄUS 80

£UP¨ ¦zuP[PÒ QøhzuÀ

:

:

:

:

:

:
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¤µa]øÚ 4 :   C¸ GsPÎß TmkzöuõøPø¯U      

           PõnÀ

EÒÏk         C¸ GsPÒ 

•øÓÁÈ¯õUP®      C¸ GsPøÍU TmhÀ

öÁÎ±k       TmkzöuõøP

¤µa]øÚ 5 :   J¸ ö\ÆÁPzvß £µ¨£ÍøÁU               

           PõnÀ

EÒÏk     ö\ÆÁPzvß }Í•® AP»•®

•øÓÁÈ¯õUP®   £µ¨£ÍÄ= }Í® – AP»®

öÁÎ±k    £µ¨£ÍÄ

¤µa]øÚ 6 :  C¸ GsPÎÀ ö£›¯ GsønU PõnÀ

EÒÏk       C¸ GsPÒ

•øÓÁÈ¯õUP®   C¸ GsPøÍ²® J¨¤kÁuß ‰»® ö£›¯ GsønU 

PshÔ¢x  öÁÎ¨£kzuÀ

öÁÎ±k    ö£›¯ Gs

¤µa]øÚ 7 :   Kº Gs JØøÓ¯õ , Cµmøh¯õ GÚU PõnÀ

EÒÏk   Gs 

•øÓÁÈ¯õUP®   Gsøn CµsiÚõÀ ÁSzx  

«vø¯U PõnÀ

«v = 0 GÛß Cµmøh Gs GÚz wº©õÛzuÀ

«v = 1 GÛß JØøÓ Gs GÚz wº©õÛzuÀ

öÁÎ±k       Gsoß ÁøP (JØøÓ AÀ»x Cµmøh GÚU PõnÀ)

:

:

:

:

:

:

:

:

:

:

:

:
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ö\¯Ø£õk  

1' 100 CÛ¨¦PøÍ 20 ÷£›øh÷¯ \©©õP¨ ¤›zuÀ öuõhº£õÚ 

EÒÏk, •øÓÁÈ¯õUP®, öÁÎ±k BQ¯ÁØøÓU PõmkP.

2' J¸ £mhzøua ö\´ÁøuU PõmkÁuØS EÒÏk, •øÓÁÈ 

¯õUP®, öÁÎ±k BQ¯ÁØøÓU PõmkP.

©õØÖz wºÄPøÍ CÚ[PõnÀ

J¸ ¤µa]øÚUS JßÖUS ÷©Ø£mh wºÄPÒ C¸¢uõÀ AøÁ ©õØÖz wºÄPÒ 

GÚ¨£k®. Cx  ¤µa]øÚ°ß C¯À¤øÚ¨ ö£õÖzux.

Euõµn®                                       
E¸ 1.1

}[PÒ J¸ £õh\õø»¨ ÷£¸¢vÀ £õh\õø»US Á¸ÁuõPU öPõÒP.  £õh                          

\õø»US Á¸®÷£õx  ÷£¸¢vÀ EÒÍ J¸ SøÓ£õk Põµn©õP ÷£¸¢x 

Cøh°À {ßÓõÀ }[PÒ £õh\õø»US ÁµzuUP ÷ÁÖ ÁÈ•øÓPÒ £ØÔa 

]¢vzx¨ £õº¨¥ºPÒ AÀ»Áõ? CÆÁõÖ }[PÒ £õh\õø»USa ö\À»zuUP 

÷ÁÖ ©õØÖz wºÄPÒ £ØÔa ]¢v¨÷£õ®.

1. £õh\õø»US Á¸® ÷Á÷Óõ¸ £õh\õø»¨ ÷£¸¢vÀ £õh\õø»US 

Á¸uÀ

2. E[PÎh® £n® C¸¢uõÀ  Kº C. ÷£õ. \ AÀ»x uÛ¯õº ÷£¸¢vÀ   

£õh\õø»US Á¸uÀ

3. Ãv ÁÈ÷¯ |h¢x  ö\ßÖ £õh\õø»US Á¸uÀ

4. J¸ SÖQ¯ ÁÈ°À |h¢x ö\ßÖ £õh\õø»US Á¸uÀ

5.  ö£Ø÷Óõ¸US CuøÚ AÔÂUP•i²©õ°ß AÁºPÐøh¯ EuÂ²hß 

£õh\õø»US Á¸uÀ

6.  |®¤UøP¯õÚ    J¸Á›ß   EuÂ²hß  ÁõPÚzvÀ AÀ»x ÷©õmhõº           

ø\UQÎÀ £õh\õø»US Á¸uÀ

A¢|õÒ Pmhõ¯® £õh\õø»US Áµ÷Ási¯ J¸|õÒ GÛß C®©õØÖz 

wºÄPÎøh÷¯ |À» J¸ wºøÁU öu›¢öuk¨¥ºPÒ AÀ»Áõ?
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AuØ÷PØ£ J¸ ¤µa]øÚUS wºÄz öuõøh C¸USö©ÛÀ, AÁØøÓU P¸zvØ 

öPõsk  J¸ E]u©õÚ wºøÁz öu›¢öukzuÀ ªPÄ® EP¢ux.

CÆÁõÖ J¸ ¤µa]øÚUS C¸US® GÀ»õz wºÄPÐ® wºÄ öÁÎ (Solution 
Space) GÚ¨£k®. PoÛa ö\´{µ¼¾® £À÷ÁÖ wºÄPÒ CÚ[Põn¨£mk 

J¸ E]u©õÚ wºÄ öu›¢öukUP¨£kuÀ ÷Ásk®. A¨÷£õx Kº GÎ¯ SÖQ¯ 

ö\´{µø» E¸ÁõUP •i²®.

Euõµn® 1

J¸ ö\ÆÁPzvß _ØÓÍøÁU Põs£uØS EÒÍ wºÄ öÁÎø¯U Põs÷£õ®.

C¨¤µa]øÚUS›¯ EÒÏk, öÁÎ±k, •øÓÁÈ¯õUP® BQ¯ÁØøÓ¨ £S¨ 

£õ´Ä ö\´x Põmk÷Áõ®.

EÒÏk          ö\ÆÁPzvß }Í•® AP»•®

•øÓÁÈ¯õUP®  _ØÓÍøÁU PozuÀ

öÁÎ±k        _ØÓÍøÁU PõmhÀ

_ØÓÍøÁU Po¨£uØPõÚ wºÄ öÁÎø¯U Põs÷£õ®.

wºÄ 1 : _ØÓÍÄ = }Í® + AP»® + }Í® + AP»®

wºÄ 2 : _ØÓÍÄ = (2 × }Í®) + (2 ×	AP»®)

wºÄ 3 : _ØÓÍÄ = 2 × (}Í® + AP»®)

CzwºÄPÎøh÷¯ TmhÀ £ØÔ¯ ÂÍUP® ©õzvµ® EÒÍ J¸Áº |À» wºÁõPz 

wºÄ 1 Iz öu›¢öukUP»õ®. ö£¸UPÀ, TmhÀ Gß£Ú £ØÔ¯ ÂÍUP® 

EÒÍ J¸Áº |À» wºÁõPz wºÄ 3 Iz öu›¢öukUP»õ®. AuØSU Põµn® 

TmkÁuØS® ö£¸USÁuØS©õÚ ö\´øPPÒ CÈÁÍÁõP C¸zu»õS®.

Euõµn® 2

©õnÁß J¸Áß uPÁÀ ©ØÖ® öuõhº£õhÀ 

öuõÈÝm£Â¯Ø £õhzvØPõP¨ ö£ØÓ ¦ÒÎPÒ 35 C¾® 

SøÓ¢uöuÛß AÁß ]zv¯øh¯ÂÀø»ö¯ÚÄ® 

AÀ»x 35 AÀ»x Av¾® Ti¯öuÛß  AÁß ]zv 

¯øh¢v¸¨£uõPÄ® PõmhÀ.

EÒÏk : ö£ØÖÒÍ ¦ÒÎPÒ 

:

:

:
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•øÓÁÈ¯õUP® :  ö£ØÖÒÍ ¦ÒÎPøÍ 35 Ehß J¨¤kuÀ

wºÄ 1  : ¦ÒÎPÒ 35 C¾® SøÓöÁÛß 

     ÷£Ö = ]zv¯øh¯ÂÀø»

            AÆÁõÖ CÀ»õÂmhõÀ

            ÷£Ö = ]zv

wºÄ 2 :  ¦ÒÎPÒ 35 AÀ»x Av¾® Ti¯ÚöuÛß 

            ÷£Ö = ]zv 

            AÆÁõÖ CÀ»õÂmhõÀ 

            ÷£Ö = ]zv¯øh¯ÂÀø»

 öÁÎ±k : ]zv AÀ»x ]zv¯øh¯ÂÀø»

Euõµn® 3  

C¸ GsPÎÀ ö£›¯ GsønU PõnÀ (£UP® 3 C¾ÒÍ ¤µa\øÚ 6 I¨ 

£õºUP)

EÒÎh¨£k® C¸ GsPÐ® n1, n2 GÚU öPõÒÍ¨£k®.

wºÄ 1:   n1 BÚx n2  C¾® ö£›öuÛß ö£›¯ Gs n1 BS®.

n2 BÚx n1 C¾® ö£›öuÛß ö£›¯ Gs n2 BS®.

wºÄ 2 :  n1 C¼¸¢x n2 IU PÈUSP. 

A¨÷£õx QøhUS® ö£Ö©õÚ® §a]¯zv¾® ö£›öuÛß 

n1 ö£›¯  GsnõS®.

A¨÷£õx QøhUS® ö£Ö©õÚ® §a]¯zv¾® ]ÔöuÛß  n2
ö£›¯ GsnõS®.

CÆÁõÖ ¤µa]øÚUS C¸US® ©õØÖz wºÄPÎøh÷¯ E]u©õÚ wºøÁz 

öu›¢öukzuÀ ªPÄ® •UQ¯©õS®.

J¸ ¤µa]øÚø¯z wº¨£uØS¨ ¤ß£ØÓ¨£k® £iPøÍU PõmkuÀ ö|Ô•øÓ 

GÚ¨£k®. J¸ ¤µa]øÚUS •Êzvmhzxhß Ti¯ ÁÊUPÍØÓ wºøÁ 

AÎ¨£÷u ö|Ô•øÓ GÊu¨£kÁvß AÁ]¯©õS®.

1'2 ¤µa]øÚPøÍz wº¨£uØS ö|Ô•øÓPøÍ (Algorithms)
       E¸ÁõUPÀ        
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Euõµn® 1 

J¸ Piuzøu Ag\¼À CkÁuØPõÚ J¸  

ö|Ô•øÓø¯ E¸ÁõUS÷Áõ®.

(1)   Piuzøu GÊxuÀ

(2)   Piuzøu ©izuÀ

(3)   PiuÄøÓö¯õßÔÀ CkuÀ

(4)   •PÁ›ø¯ GÊxuÀ 

(5)   •zvøµø¯ JmkuÀ

(6)   Ag\¼À CkuÀ

÷©ØSÔzu £iPÒ J¸ Piuzøu Ag\¼À CkÁuØPõÚ ö|Ô•øÓ BS®.

C¢ö|Ô•øÓ°À  (1), (2), (3) BQ¯ £i•øÓPøÍ JÊ[S •øÓ¯õPa ö\´uÀ 

÷Ásk®. (4), (5) BQ¯ £iPøÍ ©õØÓ»õ®. AuØSU Põµn® •PÁ›ø¯ 

GÊv²® •zvøµø¯ Jmh»õ® AÀ»x •zvøµø¯ Jmi²® •PÁ›ø¯ 

GÊu»õ®. 

AuØ÷PØ£ J¸ ö|Ô•øÓ°À JÊ[S•øÓ¯õPa ö\¯Ø£kzu ÷Ási¯ 

£iPÒ C¸US® A÷u÷ÁøÍ, ]» \¢uº¨£[PÎÀ ]» £iPÎß JÊ[S •øÓ 

©õØÓ¨£mhõ¾® Auß ‰»® •ßøÁUS® •øÓÁÈ¯õUPzxUS £õv¨¦ 

HØ£h©õmhõx. Azxhß öÁÎ±k® \©©õÚuõP÷Á C¸US®.

Euõµn®  2 

500 g ^Ûø¯z uµõ]ß EuÂ²hß {Özx¨ ø£°À CkuÀ.

(1) ^Ûø¯¨ ø£°À CkuÀ.

(2) uµõ]ß «x øÁzx Áõ]¨ø£ Áõ]zuÀ. 

(3) Áõ]¨¦ 500 Qµõª¾® SøÓ¢uöuÛÀ Áõ]¨¦ 500 

QµõªØSa \©©õS® ÁøµUS® ^Ûø¯¨ ø£°À CkuÀ.

(4) Áõ]¨¦ 500 Qµõª¾® Ti¯öuÛß Áõ]¨¦ 500 QµõªØSa 

\©©õS® ÁøµUS® ^Ûø¯¨ ø£°¼¸¢x APØÓÀ.

(5)  Áõ]¨¦ 500 Qµõ©õP C¸US®÷£õx ^Û¨ ø£ø¯ 

uµõ]¼¸¢x APØÓÀ.

500 Qµõ® ^Ûø¯ AÍÂkÁuØPõÚ ö|Ô•øÓö¯õßÖ ÷©÷» uµ¨£mkÒÍx.
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ö\¯Ø£õk   

Kº Bµ®£¨ £õh\õø»°À 183 ©õnÁºPÒ EÒÍÚº. AÁºPøÍU 

P®£º, ÁÒÐÁº, CÍ[÷Põ GÚ ‰ßÖ CÀ»[PÍõP¨ ¤›zx 

CÀ»[PÎøh÷¯ ÂøÍ¯õmk ÂÇõ JßøÓ |hzxÁuØS Av£º 

wº©õÛzuõº. ©õnÁºPøÍ CÀ»[PÍõP¨ ¤›zuø»U Põmk® 

ö|Ô•øÓø¯ E¸ÁõUSP.

J¸ ö|Ô•øÓ°ß öuõÈØ£õk £ØÔU PØS®÷£õx ‰ßÖ Pmk¨£õmkU Pmh 

ø©¨¦PøÍ CÚ[Põn»õ®.

 ² öuõh› (Sequence)   

 ² öu›Ä (Selection)        

     

 ² «Òö\¯À (Iteration)       
     

                                                        E¸ 1.2

öuõh›

J¸ ö|Ô•øÓ°À C¸US® ]» £iPøÍ AÀ»x GÀ»õ¨ £iPøÍ²®, öuõhU 

P¨£i°¼¸¢x CÖv¨ £i ÁøµUS® JÊ[S •øÓ¯õP |øh•øÓ¨£kzuÀ 

öuõh› (Sequence) GÚ¨£k®.

Euõµn®

1.  J¸ £iÁ›ø\°À |h¢x ö\À»À

J¸ £iÁ›ø\°À ö\À¾®÷£õx £iUS¨ £i HÖuÀ  

AÀ»x  CÓ[SuÀ

2.    }[PÒ   £õh\õø»°À   uµ®  1 (Em£h)  C¼¸¢x uµ® 11 

ÁøµUS® öuõhºa]¯õPU PÀÂ PØÓÀ

ö\¯Ø£õk    

J¸ öuõh›UPõÚ ‰ßÖ {PÌa]PøÍU SÔ¨¤kP.

1'2'1  ªïPº¬ø¬ò M¼ˆF ªêŒõîŸ°‚ è†´Šð£†´‚ 
è†ì¬ñŠ¬ðŠ ðò¡ð´ˆî™
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öu›Ä

J¸ ö|Ô•øÓ°À Em£mh J¸ {£¢uøÚø¯z v¸¨v¯õUSÁuØS AÀ»x 

v¸¨v¯õUPõø©U÷PØ£a ö\¯Ø£kzu ÷Ási¯ £i£ØÔz wº©õÛUP¨£k® 

J¸ \¢uº¨£® öu›Ä  (Selection)  GÚ¨£k®. C[S C¸ öu›ÄPÒ 

C¸US® A÷u÷ÁøÍ, {£¢uøÚ v¸¨v¯õUP¨£k©õ°ß J¸ öu›Ä® 

v¸¨v¯õUP¨£hõÂmhõÀ ©ØøÓ¯ J¸ öu›Ä® öu›¢öukUP¨£k®.

Euõµn[PÒ

1.   uµ® 1 CØS J¸ ¤ÒøÍø¯ AÝ©vzuÀ

AÆÁõsiÀ \ÚÁ› 31 B¢ vPv  J¸ ¤ÒøÍ°ß 

Á¯x 5 C¾®  Ti¯öuÛß ¤ÒøÍø¯ £õh\õ 

ø»US AÝ©vUP»õ®.

AÆÁõÖ CÀ»õÂmhõÀ ¤ÒøÍø¯ £õh\õ 

ø»US AÝ©vUP •i¯õx

2.   J¸ £õhzvÀ ]zv¯øhuÀ 

¦ÒÎPÒ 35 AÀ»x Av¾® Ti¯öuÛß ]zv

AÆÁõÖ CÀ»õÂmhõÀ ]zv¯øh¯õø©.

3.   J¸ ¦zuPzøuU öPõÒÁÚÄ ö\´uÀ 

¦zuPzvß Âø»USa \©ÚõÚ AÀ»x Av¾® 

Ti¯ öuõøP E[PÎh® C¸¢uõÀ ¦zuPzøuU 

öPõÒÁÚÄ ö\´¯»õ®.    

AÀ»x ¦zuPzøuU öPõÒÁÚÄ ö\´¯ •i¯õx.

                                                                                                      E¸ 1.3

    

ö\¯Ø£õk 

1' öu›Ä EÒÍ ‰ßÖ \®£Á[PøÍU SÔ¨¤kP

2' Kº C»[øP¨ ¤µø\ 18 Á¯øu¨ §ºzv ö\´u ¤ßÚº AÁ 

¸USa \ºÁ\Ú ÁõUS›ø© QøhUSö©Ûß, ¤ßÁ¸® öÁØÔ 

h[PÐUS¨ ö£õ¸zu©õÚ ö\õÀø»z öu›¢öukUP.

 Á¯x 18 AÀ»x Av¾® ... (SøÓ¢ux, Ti¯x) GÛß, 

 ÁõUS›ø©ø¯¨ ¤µ÷¯õQUP ... (•i²®, •i¯õx) 

    AÀ»x

 ÁõUS›ø©ø¯¨ ¤µ÷¯õQUP ... (•i²®, •i¯õx)
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«Òö\¯À (©ÔuµÀ)

J¸ ö|Ô•øÓ°À Em£mh J¸ £i AÀ»x ]» £iPÒ J¸ {£¢uøÚø¯z 

v¸¨v¯õUS® ÁøµUS® AÀ»x v¸¨v ö\´¯¨£mi¸US® ÁøµUS® 

«sk® «sk® |øhö£ÖuÀ «Òö\¯À/©ÔuµÀ (Repetition) GÚ¨£k®.

Euõµn[PÒ

1.      ÁS¨¦US¨ ö£õÖ¨£õÚ B]›¯º AÀ»x B]›ø¯ ©õnÁº Chõ¨¤À   

       SÔ°k® •øÓÁÈ¯õUPzøuU P¸x÷Áõ®.

1.   Chõ¨¤À •u¼À EÒÍ ö£¯øµ Áõ]zuÀ

2.   A®©õnÁº Á¢v¸¢uõÀ 1 GÚU SÔ¨ 

¤kuÀ

3.   A®©õnÁº Á¢vµõÂmhõÀ 0 GÚU SÔ¨ 

¤kuÀ

4.   Akzu ©õnÁÛß ö£¯øµ Áõ]zuÀ

5.   Chõ¨¤À EÒÍ ö£¯ºPÒ •i²® ÁøµU 

S® £i (2) I AÀ»x £i (3) ©ØÖ® (4) Ia 

ö\´uÀ. 

2.   J¸  £¢vø¯   Áõ]zx   Av¾ÒÍ  ö\õØPÎß     

GsoUøPø¯U Põq® •øÓÁÈ¯õUPzøuU  

P¸x÷Áõ®.

1.   £¢v°À öuõhUPzvÀ EÒÍ ö\õÀø» Áõ]zuÀ

2.   ö\õØPÎß GsoUøP =1 

3.   Akzu ö\õÀø» Áõ]zuÀ

4.   ö\õØPÎß GsoUøP²hß 1 IU TmhÀ

5.   £¢v •iÁøh²® ÁøµUS® £iPÒ (3) I²® (4) I²® ö\´uÀ

6.   £¢vø¯ Áõ]zx •iUS®÷£õx  ö\õÀ GsoUøPø¯ GkzxøµzuÀ

E¸ 1.4
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ö\¯Ø£õk   

1' «Òö\¯¾hß C¸ \®£Á[PøÍ¨ £iPÍõPU SÔ¨¤kP.

2' 5 öuõhUP® 60 Áøµ²ÒÍ 5 Cß ©h[SPøÍ Gkzxøµ¨£uØPõÚ               

¤ßÁ¸® «Òö\¯¾US›¯ öÁØÔh[PøÍ {µ¨¦P. 

£i I.    n = 5 

£i II.  n Cß ö£Ö©õÚzøu GkzxøµUP.

£i III. n Cß ö£Ö©õÚzxhß 5 IU TmkP.

£i IV. n Cß ö£Ö©õÚ® } 60 BS® Áøµ²® ..., ... B® C»UP¨  

    £iPøÍa ö\´P.

1'3 ö|Ô•øÓø¯ Gkzxøµ¨£uØS¨ £À÷ÁÖ P¸ÂPøÍ¨     

       £¯ß£kzuÀ

ö|Ô•øÓø¯ E¸ÁõUS®÷£õx GÎuõP Gkzxøµ¨£uØS® ö|Ô•øÓø¯ 

ªP |ßÓõP ÂÍ[QUöPõÒÁuØS® £õ´a\Ø ÷Põmk¨ £h[PÒ (Flowcharts), 

÷£õ¼USÔ•øÓ GßÝ® P¸ÂPøÍ¨ £¯ß£kzxQß÷Óõ®.

1'3'1  ð£Œ„êŸ «è£†´Š ðìƒèœ

ö|Ô•øÓø¯, E¸ ÁiÁzvÀ, £iPÍõP E¸ÁõUS® AÀ»x E¸ÁõUP¨ 

£mkÒÍ Âuzøu Gkzxøµ¨£uØS¨ £õ´a\Ø ÷Põmk¨£h® £¯ß£kzu¨ 

£kQßÓx. C[S JÆöÁõ¸ öuõÈØ£õmøh²® PõmkÁuØS¨ ¤ßÁ¸® 

SÔ±kPÒ £¯ß£kzu¨£kQßÓÚ :

SÔ±k £¯ß£õk

öuõhUP® AÀ»x 

•iÄ

EÒÏk AÀ»x 

öÁÎ±k

•øÓÁÈ¯õUP®

wº©õÚ®
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£õ´a\À vø\ 

öuõhº¦

AmhÁøn 1'1 - £õ´a\Ø ÷Põmk¨£hU SÔ±kPÒ

öuõh› EÒÍ £õ´a\Ø ÷Põmk¨ £h[PÒ

öuõhUP¨ £i°¼¸¢x CÖv¨ £i ÁøµUS® EÒÍ £i•øÓPÒ GÀ»õ® 

JßÔ¼¸¢öuõßÖ JÊ[S•øÓ°À |øhö£ÖuÀ öuõh›°ß C¯À£õS®.

Euõµn® 

J¸ Ámhzvß £µ¨£ÍøÁU PozuÀ 

Ámhzvß Bøµø¯¨ 

ö£ÖuÀ

Ámhzvß £µ¨£ÍøÁU 

PozuÀ

Ámhzvß £µ¨£ÍøÁU 

PõmhÀ

öuõhUP®

 •iÄ

ªîK¾ àœ÷ ð£Œ„êŸ «è£†´Š ðìƒèœ

J¸ {£¢uøÚ v¸¨vö\´¯¨£kÁuØS AÀ»x  v¸¨v ö\´¯¨£hõø©US 

HØ£¨ £õ´a\À vø\ wº©õÛUP¨£kuÀ öu›ÂÀ EÒÍ ]Ó¨¤¯À£õS®. 

Euõµn®

J¸ uµ¨£mh Gs JØøÓ Gsnõ Cµmøh Gsnõ GÚU PõnÀ.
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Gsøn¨ ö£ÖuÀ

Gsøn CµsiÚõÀ ÁSzx 

«vø¯U PõquÀ

«v §a]¯©õ? 

CÀø» 

Kº JØøÓ Gs

B® 

 Kº Cµmøh Gs                                                                              

öuõhUP®

•iÄ

«Òö\¯À EÒÍ £õ´a\Ø ÷Põmk¨£h[PÒ

]» £iPÒ J¸ {£¢uøÚø¯z v¸¨vö\´²® ÁøµUS® AÀ»x v¸¨v 

ö\´v¸US® ÁøµUS® «sk® «sk® ö\¯Ø£kzu¨£kuÀ C[S EÒÍ                                 

]Ó¨¤¯À£õS®.

Euõµn®

Kº Gs Tmhzvß TmkzöuõøPø¯U PõnÀ
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Gs  (n) I¨ ö£ÖuÀ

ö©õzu® = 0

ö©õzu® = ö©õzu® + n 

÷Á Ö G s                

C¸UQßÓuõ?

ö©õzuzøu öÁÎ°hÀ

CÀø»

B®

öuõhUP®

•iÄ

ö\¯Ø£õk   

¤ßÁ¸® ¤µa]øÚPÐUS¨ £õ´a\Ø ÷Põmk¨ £h[PøÍ ÁøµP.

1' J¸ ö\ÆÁPzvß _ØÓÍøÁ²® £µ¨£ÍøÁ²® PõnÀ. 

2' J¸ {ÖÁPzvß öuõÈ»õÍºPÎß Ai¨£øha \®£Ízxhß 

¹. 5,000.00 I TmiU öPõk¨£uØSz wº©õÛUP¨£mkÒÍx. 

CuØ÷PØ£¨ ¦v¯ \®£ÍzøuU PoUP ÷Ási²ÒÍx.

3' J¸ Piuzøuz u£õ¼À Ck®÷£õx Auß {øÓU÷PØ£U 

Pmhn® AÓÂh¨£kQßÓx. {¯© {øÓUSU SøÓ¢u AÀ»x 

\©©õÚ {øÓ²ÒÍ Piu[PÐUPõP SÔzu Pmhnzøu ©õzvµ® 

ö\¾zu ÷Ásk®. {¯© {øÓ°¾® £õºUPU Ti¯ {øÓ²ÒÍ 

Piu[PÐUPõP ÷©»vPU Pmhnzøua ö\¾zu ÷Ásk®.

4' 7 Cß •uÀ 12 ©h[SPøÍU PõmhÀ

5' 9, 10 B®  £UP[PÎÀ   EÒÍ   Euõµn[PÐUPõP¨  £õ´a\Ø 

÷Põmk¨£h[PøÍ ÁøµP.
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1'3'2  «ð£L‚ °Pº¬øèœ (Pseudo codes)

J¸ ö|Ô•øÓø¯ GÎ¯ B[Q»a ö\õØPøÍ¨ £¯ß£kzv GÊzx¸ÁõPU 

PõmhÀ ÷£õ¼USÔ•øÓ (Pseudo code) GÚ¨£k®. CÆÁõÖ GÊu¨£k® 

÷£õ¼USÔ•øÓ PoÛ ö©õÈø¯a \õµõux. J¸ ÷£õ¼USÔ•øÓø¯ G¢uU 

PoÛö©õÈ AÔÄÖzuÀPÍõPÄ®  ©õØÓ»õ®. BP÷Á ÷£õ¼USÔ•øÓPøÍ 

GÊxÁuß ‰»® PoÛa ö\´{µÀPøÍ E¸ÁõUSÁøu GÎuõUP»õ®.

÷£õ¼U SÔ•øÓ°À JÆöÁõ¸ ÷PõøÁ²® GÎ¯ B[Q»a ö\õØPÎÚõÀ 

Põmh¨£k® Âu®£ØÔ Bµõ´¢x £õº¨÷£õ®. 

öuõhUP®  Begin

•iÄ   End

EÒÏk Input , Read , Get

öÁÎ±k  Output, Display, Show

•øÓÁÈ Process, Calculate

öu›Ä  IF … THEN .. .ELSE  … ENDIF

«Òö\´øP For – Do

    While – Endwhile 

    Repeat  –  Until

÷£õ¼USÔ•øÓPøÍ GÊxuÀ

Euõµn® 1 :- J¸ Ámhzvß £µ¨£ÍøÁU PozuÀ

BEGIN

  INPUT Radius 

  CALCULATE Area = 22/7 « Radius « Radius

  DISPLAY Area

END.

Euõµn® 2 :- Kº Gs JØøÓ¯õ, Cµmøh¯õ GÚU PõnÀ

BEGIN

  READ number as N

  CALCULATE  Remainder after N is divided by 2
  IF Remainder = 0 THEN
   DISPLAY “Even number”

     ELSE
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   DISPLAY “Odd number”
  ENDIF

END.

Euõµn® 3 :- Kº Gs Tmhzvß ö©õzuzøuU PõnÀ

BEGIN

  Total = 0

  REPEAT

   READ Number as N

   CALCULATE Total = Total + N

  UNTIL numbers are over

  DISPLAY Total

END.

Euõµn® 4 :- 10 GsPÎß ö©õzuzøu²® \µõ\›ø¯²®  PõnÀ

BEGIN

  Tot = 0

  Avg = 0

  n = 1

  WHILE n <= 10

   READ Num

   CALCULATE Tot = Tot + Num

   n = n + 1

  ENDWHILE

  CALCULATE Avg = Tot/(n-1)  

  DISPLAY Tot, Avg

END.

÷©ØSÔzu ÷£õ¼USÔ•øÓ £ØÔU Põmh¨£mkÒÍ ¤ßÁ¸® Âh¯[PÎÀ 

PÁÚg ö\¾zxP.

 ² Tot,  Avg, Num, n BQ¯Ú ©õÔPÒ BS®.

 ² Num GßÝ® ©õÔUS¨ ö£Ö©õÚ[PøÍ EÒÎk®÷£õx Ax öuõhº£õP

Tot, Avg,  n BQ¯ ©õÔPÎß ö£Ö©õÚ[PÐ® ©õÖQßÓÚ.
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 ² n ©õÔ°ß ‰»® «Òö\¯¾US Em£k® uhøÁPÎß GsoUøP 

ÁøPSÔUP¨£kQßÓx.

 ² Tot  = 0,  Avg = 0 BQ¯ÁØÔß ‰»® A®©õÔPÎß öuõhUP¨ ö£Ö©õÚ®

0 BP JxUP¨£mkÒÍx.

 ² Num ©õÔUS¨ ö£Ö©õÚ[PøÍ¨ ö£Ö•ß£õP Tot, Avg BQ¯ ©õÔPÎß 

Gs ö£Ö©õÚ[PÒ 0 GÚ GkUP¨£mkÒÍÚ Gß£÷u Cuß P¸zuõS®.

 ² n}1 Cß ‰»®  n Cß öuõhUP¨ ö£Ö©õÚ® 1 GÚ JxUP¨£mkÒÍx.

ο	 n ©õÔ°ß öuõhUP¨ ö£Ö©õÚ® 1 Gß£÷u Cuß P¸zuõS®.

 ² n <= 10 BÚx «Òö\¯ø»U Pmk¨£kzx® {£¢uøÚ BS®.

 ² WHILE n <= 10 Cß ‰»® n Cß ö£Ö©õÚ® 10 BS® ÁøµUS® 

«Òö\¯¾US Em£h ÷Ásk® GÚU Põmh¨£kQßÓx.

ο n Cß ö£Ö©õÚ® 10 AÀ»x 10 CØSU SøÓÁõP C¸US® \¢uº¨£[PÎÀ 

«Òö\¯À |øhö£ÖQßÓx. AuõÁx n <= 10 GßÝ® {£¢uøÚ Esø©¯õP 

C¸US® ÁøµUS® «Òö\¯À |øhö£ÖQßÓx. n Cß ö£Ö©õÚ® 11 BP 

C¸US®÷£õx «Òö\¯À {ßÖÂkQßÓx. A¨÷£õx {£¢uøÚ ö£õ´ 

¯õS®.

 ² READ Cß ‰»® Num ©õÔUPõÚ 

J¸ ö£Ö©õÚzøu¨ ö£ÖuÀ Põm 

h¨£kQßÓx.

 ² Tot = Tot + Num Cß ‰»® Num 

CØPõP¨ ö£ØÓ ö£Ö©õÚ® 

Tot ©õÔ²hß Tmh¨£mk A¨ 

ö£Ö©õÚ® ©Ö£i²®  Total 
©õÔU÷P JxUP¨£kuÀ Põmh¨ 

£kQßÓx.

 ² n=n+1 Cß ‰»® «Òö\¯¾US 

Em£k® uhøÁPÎß GsoUøP PoUP¨£kQßÓx. C[S Num ©õÔUS 

J¸ ö£Ö©õÚzøu¨ ö£ØÓ¤ßÚº n Cß ö£Ö©õÚzxhß 1 IU Tmi 

A¨ö£Ö©õÚ® ©Ö£i²® n ©õÔU÷P JxUP¨£kQßÓx. 

 ² ENDWHILE Cß ‰»® «Òö\¯À •iÁøh²® GÀø» Põmh¨£kQßÓx. 

CuØ÷PØ£ READ Num" Tot = Tot + Num"  n = n + 1 BQ¯ ÷PõøÁPÒ ©õzvµ® 

n <= 10 GßÝ® {£¢uøÚ v¸¨v¯õP C¸US® ÁøµUS® «Òö\¯¾US 

Em£kQßÓÚ.

 ² «Òö\¯À {ØS®÷£õx n Cß ö£Ö©õÚ® 11 BS®. Aa\¢uº¨£zvÀ 

{£¢uøÚ ö£õ´¯õS®.

E¸ 1.5
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 ² Avg = Tot/(n-1)  Cß ‰»® Tot Cß CÖv¨ ö£Ö©õÚzøu  n-1 CÚõÀ 

ÁSzx¨ ö£Ö® ö£Ö©õÚ® Avg ©õÔUS JxUP¨£kQßÓx. AuõÁx Avg
©õÔ°ß ‰»® \µõ\› PoUP¨£kQßÓx.

 ² DISPLAY Tot,  Avg Cß ‰»® EÒÎh¨£mh GsPÒ £zvß ö©õzuzøu²® 

\µõ\›ø¯²® öÁÎ°kQßÓÚ.

 

AÁuõÛ¨¦

1'3'3  ð£Œ„êŸ «è£†´Šðìƒè¬÷Š «ð£L‚ °Pº¬ø‚° ñ£Ÿø™

J÷µ ö|Ô•øÓø¯¨ £õ´a\Ø ÷Põmk¨£hzøu¨ ÷£õßÖ ÷£õ¼U SÔ•øÓ 

°Úõ¾® ÁøPSÔUP»õ®. BP÷Á £õ´a\Ø ÷Põmk¨ £hzøu¨ ÷£õ¼U 

SÔ•øÓ¯õP ©õØÖ® Âu®£ØÔ Bµõ´÷Áõ®.

öuõhUP®

P»USuÀ

^Ûø¯ CkuÀ

}º öPõvz 

xÒÍuõ?

^Û ÷uøÁ¯õ?

CÀø» 

CÀø» 

B® 

B® 

}øµU QsnzvÀ FØÖP

÷u°ø»¨ ø£ø¯U 

QsnzvÀ CkuÀ

•iÄ

}øµU öPõvUP 
øÁzuÀ

 

BEGIN

 Put tea bag in cup

 WHILE (not Water   
                 boiled)

  Boil water

 ENDWHILE

 Pour water in cup

 WHILE ( sugar needed )
  Add sugar
  Stir tea

 ENDWHILE

END

J¸ ©õÔUPõP¨ ö£Ö©õÚ[PøÍ JxUS®÷£õx •ßÚº 

C¸¢u ö£Ö©õÚ® AØÖ¨÷£õQßÓx.

Tot = Tot + Num GßÝ® ÷PõøÁ öuõÈØ£k®÷£õx 

Num  ©õÔUS EÒÍ ö£Ö©õÚ® Tot ©õÔ°À C¸US® 

ö£Ö©õÚzxhß Tmh¨£mh ¤ßÚº QøhUS® 

ö£Ö©õÚ®  Tot ©õÔUS JxUP¨£kQßÓx.

Tot = Tot + Num BÚx J¸ Poua \©ß£õhßÖ.
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Euõµn® 1 :-  C¸ \©©ØÓ GsPÎøh÷¯ ö£›¯ GsønU PõnÀ

öuõhUP®

C¸ GsPøÍ¨ (n1, n2) ö£ÖuÀ

ö£›¯ Gs n2 BS®
n1BÚx n2 

C¾® ö£›uõ CÀø»

B® 

 ö£›¯ GsønU PõmkP.                                                                              

ö£›¯ Gs n1BS®

•iÄ

BEGIN

  READ n1 , n2

  IF n1 > n2 THEN

   Large = n1

  ELSE

   Large = n2

  ENDIF

  DISPLAY Large

END
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Euõµn® 2 :-    £zx GsPÎÀ ]Ô¯ GsønU PõnÀ.

öuõhUP®

Gs  (n) I¨ ö£ÖuÀ 

min I öÁÎ°kPCount <10 ?

CÀø» 

CÀø»  

B® 

B® 

Gs  (n) I¨ ö£ÖuÀ

min =  n
Count =1

n  < min ?

 min =  n

Count = Count + 1

•iÄ

BEGIN

  INPUT Number as n

  min = n

  Count = 1

  WHILE Count<10

   INPUT Number as n

   IF n < min  Then

    min = n

   ENDIF

   Count=Count + 1

  ENDWHILE

  PRINT  min

END.
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   1'4 £ìPõÀ ö\´{µÀ ö©õÈ

Aøh¯õÍ[Põo Gß£x J¸ ©õÔø¯ AÀ»x ©õÔ¼ø¯ AÀ»x ö\´{µø» 

AÔ•Pgö\´¯¨ £¯ß£kzu¨£k® ö£¯º BS®. C¢u Aøh¯õÍ[Põoø¯¨ 

£¯ß£kzxøP°À ¤ßÁ¸®  ö£õxÁõÚ ÂvPøÍ¨ ¤ß£ØÓ ÷Ásk®:

 ² £ìPõÀ ö©õÈø¯  AÔ•Pg 

ö\´ÁuØS¨ £¯ß£kzu¨£k® 

JxUSö\´ ö\õØPøÍ (Reserved 
words) £¯ß£kzu»õPõx. G¢u 

öÁõ¸ ö©õÈ°Úx® JxUSö\´ 

ö\õØPøÍ AÔ•Pgö\´Á 

uØS¨ £¯ß£kzu •i¯õx.

 ² Euõµn®  - BEGIN, END BQ¯Ú ö\À¾£i¯õÁvÀø». 

 ² B[Q» ö|k[PnUQÀ EÒÍ Kº GÊzxhß öuõh[P ÷Ásk®.

 ² Aøh¯õÍ[Põo°ß •uÀ GÊzvØS¨ ¤ßÚº GÊzxPøÍ (a-z, A-Z) 
AÀ»x GsSÔ C»UP[PøÍ²® (0-9) RÌU÷Põmøh²® ^ _ &   

£¯ß£kzu»õ®.

Euõµn®  - Student_name

 ² £ìPõÀ ö©õÈ°À Aøh¯õÍ[PõoUS GÊzx¨ ÷£u® ö\ÀÁõUSa 

ö\¾zxÁvÀø» 

 ^Euõµn® - Art, art, ART BQ¯Ú J÷µ Aøh¯õÍ[Põo¯õS®&

 ² ö\õØPÐUQøh÷¯ CøhöÁÎ  (Space) C¸zu»õPõx.

Euõµn® - Student Name - ö\À¾£i¯õÁvÀø»

 ² Aøh¯õÍ[Põo°À ¤ßÁ¸® Á›²¸UPÒ Ch®ö£ÓU Thõx:

      ~    !   @   #   $  %   ^    &   *   (  )    -   +  =  {  }  [  ]  :  ;  ‘  “  <  > ?  ,  .  /  |  \ 

BÚõÀ underscore ( _ ) SÔ ©õzvµ® ö\À¾£i¯õS®.

 ² AÔ•Pgö\´ÁuØS Aºzu•ÒÍ ö£¯ºPøÍ¨ ¤µ÷¯õQ¨£uß ‰»® 

ö\´{µø» GÎuõP ÂÍ[QU öPõÒÍ»õ®.

 ² ö\À¾£i¯õÚ Aøh¯õÍ[PõoPÐUS Euõµn[PÒ :

Sum, SUM, Total_Nos, Num1, FirstName, Last_Name 

1'4'1  Ü¬ìò£÷ƒè£E (ldentifier)

Var year : integer; 

data type

integer

reserved word data identifier
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ö\À¾£i¯ØÓ  Aøh¯õÍ[PõoPÐUS Euõµn[PÒ :

$75, Average  Marks, 9A, Last-name

£ìPõÀ  ö©õÈ°À  £¯ß£kzu¨£k®  ö\õØPÒ (Reserved Words) JxUSö\´ 

ö\õØPÍõP £ìPõÀ ö©õÈ°À Áøµ¯øÓ ö\´¯¨£mkÒÍÚ. BP÷Á 

JxUSö\´ ö\õØPÒ Aøh¯õÍ[Põo¯õP¨ £¯ß£kzu¨£kÁvÀø».

JxUSö\´  ö\õØPÒ ö\´{µÀ ö©õÈUS ö©õÈ ÷ÁÖ£kQßÓÚ. £ìPõ¼À  

£¯ß£kzu¨£k® JxUSö\´ ö\õØPÒ R÷Ç Põn¨£kQßÓÚ :

exports
file
for
function
goto
if
implementation
in
inherited
inline
interface
label
library

mod
nil
not
object
of
or
packed
procedure
program
record
repeat
set
shl

shr
string
then
to
type
unit
until
uses
var
while
with
xor

and
  
asm
array
begin
case
const
constructor
destructor
div
do
downto
else
end

ö\´{µÀ öuõÈØ£k®÷£õx EÒÏkPøÍ²® •øÓÁÈ°ÞhõPU Pozu ÷£Ö 

PøÍ²® PoÛ {øÚÁPzvÀ øÁzxUöPõÒÍ ÷Ásk®. AuØSz ÷uøÁ¯õÚ 

Chzvß AÍÄ uµÄÁøPø¯U öPõsk wº©õÛUP¨£k®. BP÷Á uµÄ ÁøP 

(Data type) £ØÔa ö\´{µ»º AÔ¢v¸zuÀ ªPÄ® •UQ¯©õÚx.

uµÄ ÁøPPÐ® AÁØÔß Ãa_PÐ® R÷Ç Põn¨£kQßÓÚ.

Integer - ÷|º AÀ»x ©øÓ {øÓö¯sPÒ / •ÊöÁsPÒ

Euõµn® - 0" 46" -12

1'4'2  å¶‚°ªêŒ ªê£Ÿèœ (Reserved Words)

1'4'3  ðvè£™ ªñ£NJ™ ðò¡ð´ˆîŠð´‹ Gòñˆ 
 îó¾ õ¬è (Standard Data Type)
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Real - ÷|º AÀ»x ©øÓ ö©´ö¯sPÒ  / u\© GsPÒ

Euõµn® - 0'0" 25'68

Boolean
 
§¼¯ß

 True AÀ»x False

Char - \õÂ¨ £»øP°À EÒÍ 

¯õuõ°Ý® J¸ Á›²¸

Euõµn® -‘k’, ‘#’, ‘7‘ 

String - ¯õuõ°Ý® J¸ Á›²¸z öuõh›

 Euõµn® -‘ICT’, ‘programming’, 'Sri Lanka'

SÔ¨¦ : Char, String GßÝ® uµÄ ÁøPPÎß ö£Ö©vPÒ JØøÓ ÷©Ø÷PõÒ 

PÎß (Single quotation) EÒ SÔUP¨£k®.

1'4'4  ªêŒGóL™ ðò¡ð´ˆîŠð´‹ ñ£PèÀ‹ (Variable)   
  ñ£PLèÀ‹  (Constant)

©õÔPÒ (Variable) 

©õÔ J¸ÁøP Aøh¯õÍ[Põo BS®. 

ö\´{µø» |øh•øÓ¨£kzx®÷£õx ©õÔ JxUP¨£mh ö£Ö©õÚ[PÒ ©õØÓ 

©øh²®.

£ìPõÀ ö©õÈ°À ©õÔø¯U AÔÂ¨£uØS ''Var'' GßÝ® JxUSö\´ ö\õÀ 

£¯ß£kzu¨£kQßÓx.

Euõµn®

Var  count : integer;
Var  a,b : real;
Var  n1, n2 : integer;

  Avg : real ;
  Pass : boolean;
  Character : char;
  Name,school : String;

                                                                                                  
E¸ 1.6

Retrieve Store
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•UQ¯®
J¸ ©õÔUPõP J¸ ö£¯º C¸US® A÷u ÷ÁøÍ AvÀ AÔÂUP¨ 

£mh uµÄ ÁøPUS›¯ uµÄPÒ ÷uUQ øÁUP¨£kQßÓÚ.

A variable has a nane, stores a value of the declared type.

ö\´{µø» |øh•øÓ¨£kzx®÷£õx Aøh¯õÍ[PõoUS JxUP¨£mh 

ö£Ö©õÚ[PÒ ©õØÓ©øh¯õ©¼¸¨¤ß AzuøP¯ Aøh¯õÍ[Põo ©õÔ¼ 

GÚ¨£k®.

£ìPõÀ  ö©õÈ°À  ©õÔ¼ø¯  AÔÂ¨£uØS (Declare) ''const'' GßÝ® 

JxUSö\´ ö\õÀ £¯ß£kzu¨£kQßÓx.

Euõµn® Const    max = 100;
  Const    pi = 22/7;

ÂøÚUSÔPÒ CÀ»õ©À PozuÀ, J¨¤kuÀ, u¸UPU ÷PõøÁPøÍ E¸ 

ÁõUPÀ BQ¯ÁØøÓa ö\´¯•i¯õx. BP÷Á ö\´{µÀPøÍ GÊxÁuØS 

ÂøÚUSÔPÒ Azv¯õÁ]¯©õS®.

Ai¨£øh ÂøÚUSÔ ÁøPPÒ

1' GsPou ÂøÚUSÔPÒ

        ÂøÚUSÔ  £¯ß£õk            ÷PõøÁ        ÷£Ö 

            +      TmhÀ   6 + 3  9
_  PÈzuÀ   7 - 5          2

*   ö£¸UPÀ   2 * 5  10

/  ÁSzuÀ   10/4    2'50

DIV  ÁSzu¼ß ¤ß DÄ  20 DIV 6 3

MOD   ÁSzu¼ß ¤ß «v  20 MOD 6 2

©õÔ¼PÒ (Const) 

AÁuõÛ¨¦

 ² ö\´{µø»a ö\¯Ø£kzx®÷£õx J¸ ©õÔUPõP¨ £À÷ÁÖ 

ö£Ö©õÚ[PÒ C¸US® A÷u÷ÁøÍ ©õÔ¼°ß ö£Ö©õÚ® 

©õÓõ©À C¸US®

1'5 ÂøÚUSÔPÒ/ö\¯¼ (Operators)
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3
6 20

18
2

DIV

MOD

2' J¨¥mk ÂøÚUSÔ

ö£Ö©õÚ[PøÍ AÀ»x ÷PõøÁPøÍ J¨¤kÁuØS J¨¥mk ÂøÚUSÔPÒ 

£¯ß£kzu¨£kQßÓÚ. J¨¥mk ÂøÚUSÔPÒ  Ch®ö£Ö® ÷PõøÁ°ß 

CÖv¨ ÷£Ö G¨÷£õx® §¼¯ß (Boolean) ö£Ö©õÚzøu GkUQßÓx. AuõÁx 

÷PõøÁ Esø© AÀ»x ö£õ´¯õS®.

     ÂøÚUSÔ £¯ß£õk           ÷PõøÁ    ÷£Ö

>   ö£›¯x      7 > 3   Esø©

>=   ö£›¯x AÀ»x \©ß  8 >= 8    Esø©

<   ]Ô¯x       3 < 2   ö£õ´ 
<=   ]Ô¯x AÀ»x \©ß    4 <= 6    Esø© 

=   \©ß       3 = 1   ö£õ´

< >   \©ÚØÓx      2 < > 5    Esø©

3' u¸UP ÂøÚUSÔ

C¸ AÀ»x £» ÷PõøÁPøÍ J¸[Qøn¨£uØSz u¸UP ÂøÚUSÔ  (Logical 

Operator) £¯ß£kzu¨£kQßÓx. CuøÚ¨ £ØÔ ÷©¾® PØ£uØSz uµ® 10 CÀ 

}[PÒ PØÓ Ai¨£øh u¸UP Áõ°ÀPøÍ¨ £õºUP.

     

i)  AND ÂøÚUSÔ

CÆÂøÚUSÔ ""(•uØ ÷PõøÁ) AND (Cµshõ® ÷PõøÁ)'' GßÓ  Ai¨£ 

øh°À  £¯ß£kzu¨£kQßÓx. AvÀ •uØ ÷PõøÁ²® Cµshõ® ÷PõøÁ²® 

Esø©¯õP  AÀ»x ö£õ´¯õP C¸¨£uØ÷PØ£ AND ÂøÚUSÔ°ÚõÀ ö£Ó¨ 

£k® ÷£Ö® Esø© AÀ»x ö£õ´ BS®. ¤ßÁ¸® AmhÁøn°À  AND

ÂøÚUSÔ°ß öuõÈØ£õk Põn¨£kQßÓx. 

•uØ ÷PõøÁ Cµshõ® ÷PõøÁ (•uØ ÷PõøÁ) AND (Cµshõ®÷PõøÁ)

ö£õ´ ö£õ´ ö£õ´

ö£õ´ Esø© ö£õ´ 

Esø©  ö£õ´ ö£õ´ 

Esø© Esø© Esø© 
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Euõµn® -  1' ^©øÇÃÌa] > 56& AND ^öÁ¨£{ø» < 30&"
2' ^E¯µ® > 60& AND  ^Á¯x < 15& 
3' (3 >= 2) AND (3 < > 3) GßÝ® ÷PõøÁø¯U P¸x÷Áõ®.

3 >= 2 GßÝ® ÷PõøÁ Esø©¯õS®. 3 < > 3GßÝ® ÷PõøÁ 

ö£õ´¯õS®. BP÷Á Jmkö©õzu©õÚ ÷PõøÁ²® ö£õ´ 

¯õS®.

•UQ¯®
 � C¸  ÷PõøÁPÎÀ SøÓ¢u£m\® J¸ ÷PõøÁ¯õÁx ö£õ´¯õP 

C¸US®÷£õx AND ÂøÚUSÔ EÒÍ Jmkö©õzu©õÚ 

÷PõøÁ²® ö£õ´¯õS®.

 � GÀ»õU ÷PõøÁPÐ® Esø©¯õP C¸US®÷£õx ©õzvµ÷©

AND ÂøÚUSÔ EÒÍ ÷PõøÁ Esø©¯õS®.

ii)  OR ÂøÚUSÔ

CÆÂøÚUSÔ ""(•uØ ÷PõøÁ) OR (Cµshõ® ÷PõøÁ)'' GßÓ Ai¨£øh°À 

£¯ß£kzu¨£kQßÓx. AvÀ •uØ ÷PõøÁ²® Cµshõ® ÷PõøÁ²® 

Esø©¯õP AÀ»x ö£õ´¯õP C¸¨£uØ÷PØ£ OR ÂøÚUSÔ ‰»® 

ö£Ó¨£k® ÷£Ö® Esø© AÀ»x ö£õ´ BS®. ¤ßÁ¸® AmhÁøn°À 

OR ÂøÚUSÔ°ß öuõÈØ£õk Põn¨£kQßÓx.

•uØ ÷PõøÁ Cµshõ® 

÷PõøÁ

(•uØ ÷PõøÁ) OR (Cµshõ® ÷PõøÁ)

ö£õ´ ö£õ´ ö£õ´

ö£õ´ Esø© Esø©

Esø© ö£õ´ Esø©

Esø© Esø© Esø©

Euõµn® -   1' ^öÁ¨£{ø» > 30& OR ^©øÇÃÌa] < 55&

2' (3 >= 2)  OR (3 < > 3)  GßÝ® ÷PõøÁø¯U P¸x÷Áõ®. 

3 >= 2  GßÝ® ÷PõøÁ Esø©¯õS®. 3 < > 3  GßÝ® ÷PõøÁ 

ö£õ´¯õS®. BP÷Á Jmkö©õzu©õÚ ÷PõøÁ Esø©¯õS®. 

•UQ¯®
 � C¸ ÷PõøÁPÎÀ SøÓ¢u£m\® J¸ ÷PõøÁ¯õÁx Esø© 

¯õP C¸US®÷£õx OR ÂøÚUSÔ EÒÍ ÷PõøÁ²® Es 

ø©¯õS®.

 � GÀ»õU ÷PõøÁPÐ® ö£õ´¯õP C¸US®÷£õx ©õzvµ÷© 

OR ÂøÚUSÔ  EÒÍ ÷PõøÁ  ö£õ´¯õS®.
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iii)  NOT ÂøÚUSÔ

G¨÷£õx®, Esø©¯õÚ J¸ ÷PõøÁ¯õÚx NOT ÂøÚUSÔ ‰»® ö£õ´¯õPU 

Põmh¨£k® A÷u÷ÁøÍ ö£õ´¯õÚ J¸  ÷PõøÁ NOT ÂøÚUSÔ ‰»® 

G¨÷£õx® Esø©¯õÚuõPU Põmh¨£k®.

÷PõøÁ NOT ^÷PõøÁ&

ö£õ´ Esø©

Esø© ö£õ´

Euõµn®

1' NOT ^öÁ¨£{ø» > 30& 

2' NOT (5 = 5) J¸ ö£õ´U ÷PõøÁ¯õS®.

   5 = 5 GßÝ® ÷PõøÁ Esø©¯õS®.

  BP÷Á NOT(5 = 5) GßÝ® ÷PõøÁ ö£õ´ö¯ÚU Põmh¨£kQßÓx.

ö\´øP •ß{PÌÄ/•ßÝ›ø©

£ìPõÀ ÷PõøÁø¯ |øh•øÓ¨£kzx®÷£õx ¤ßÁ¸® ÂøÚUSÔ 

•ß{PÌÄ/•ßÝ›ø©°ß (Operator Precedence) JÊ[S•øÓ ¤ß£ØÓ¨ 

£kQßÓx.

•ß{PÌÄ ©mh®       ÂøÚUSÔ

1   NOT
2   * / DIV MOD AND
3   + - OR
4   = < > < <= > >= SøÓ¢ux

Ti¯x

£ìPõÀ ÷PõøÁPøÍ ©v¨¤k® Âu®

Euõµn® -- ^1)   Euõµn® -- ^2&   Euõµn® -- ^3&
5 + 14 MOD 4     3 + 7 DIV 2    16 / 4 * 2
5 + 2    3 + 3    4 * 2
7    6    8

Euõµn® - ^4&   Euõµn® -- ^5&
         NOT (8 MOD 2 > 5)  4 >= 4 AND NOT(7 > 9) 

NOT (0 > 5)   True AND NOT(False)
NOT(False)   True AND True
True    True
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J¸ \õuõµn £ìPõÀ ö\´{µ¼À Ch®ö£Ö® Ai¨£øh¨ £SvPøÍ 

CÚ[Põs÷£õ®.

EÒÏk

Write(‘Welcome Pascal Programming’);
{calculate the total and  average of two numbers}  
Writeln(‘Enter First Number’);
Read(num1);
Writeln(‘Enter Second Number’);
Read(num2);
total := num1 + num2;
avg := total/2;
writeln(‘Total is ' , total);
writeln(‘Average is' , avg);

öÁÎ±k

}•øÓÁÈø¯U Põmk® ÷PõøÁPÒ

Begin    ¤µuõÚ ö\´{µ¼ß öuõhUP®

program addNum  (input,output); ö\´{µ¼ß ö£¯º

var              num1,num2,total : integer; }  
            avg: real;

ö\´{µ¼ß ö£¯ºaddNum

          avg: real;

End.     ¤µuõÚ ö\´{µ¼ß •iÄ

SÔ¨¦øµPøÍU 

(commets) PõmhÀ(commets) 

{calculate the total and  average of two numbers}

©õÔPøÍ AÔÂ¨¦a ö\´uÀ

SÔ¨¦ - SÔ¨¦øµø¯U PõmkÁuØS  (*..........*) I²® £¯ß£kzu»õ®.

C[S —program˜" —input˜"  —output˜ BQ¯Ú JxUSö\´ ö\õØPÍõS®. 

 ² —addNum˜ Gß£x Kº Aøh¯õÍ[Põo¯õS®. Cx ö\´{µ¼ß ö£¯µõS®. 

ö\´{µ¼ß ö£¯¸hß Aøh¨¦USÔPÎÝÒ÷Í input" output GÚU PõmhÀ 

Azv¯õÁ]¯©ßÖ.

 ² EÒÏmkUPõP read^ &" readln^ & GßÝ® JxUSö\´ ö\õØPÒ £¯ß£kzu¨ 

£kQßÓÚ.

 ¾ Read^num1&¦ ÷PõøÁ ‰»® num1 BÚ ©õÔUPõPz uµÄPÒ EÒÎ 

h¨£kQßÓÚ.

 ¾ readln^& ‰»® uµÄPÒ vøµ°ß J¸ ¦v¯ {øµ°¼¸¢x EÒÎh¨   

£kQßÓÚ.

 ² öÁÎ±mkUPõP write^ &" writeln^ & GßÝ® JxUSö\´ ö\õØPÒ £¯ß 

£kzu¨£kQßÓÚ. 

 ¾ Write ^‘Welcome to Pascal Programming’&; ÷PõøÁ ‰»® Welcome to 
Pascal Programming  GßÝ® ö\´vø¯z vøµ°À öÁÎ°h»õ®.
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 ¾ writeln ^‘Average is Z, avg&¦ ÷PõøÁ ‰»® vøµ°ß  J¸  ¦v¯ {øµ°À 

Average is GßÝ® £õh¨ £Sv²hß  avg ©õÔ°ß ö£Ö©õÚzøu 

Põm]¨£kzu»õ®.

£ìPõÀ TØÖPøÍ (Statements) GÊx®÷£õx 

 ² J¸ ÷PõøÁ°ß A¢uzvÀ semi-colon (;) Ch¨£kQßÓx. semi-colon ‰»® 

÷PõøÁ •iÁøhÁuõPU TÓ¨£kQßÓx. 

 ² total:= num1 + num2 ¦ GßÝ®  ÷PõøÁ°ß  ‰»® num1, num2 GßÝ® C¸ 

©õÔPÎß ö£Ö©õÚ[PÒ Tmh¨£mk, Á¸ÂøÍÄ total GßÝ® ©õÔUS 

J¨£øhUP¨£kQßÓx.

 ² C[S £¯ß£kzu¨£k®  —:}— BÚx J¨£øh ÂøÚUSÔ (Assignment 
Operator) GÚ¨£k®.

1'6   öu›ÄU Pmk¨£õmkU Pmhø©¨¦z  öuõhº¦£k® 

ö\´{µø» Aø©zuÀ

GÎ¯  IF ÷PõøÁ

öu›ÄU  Pmk¨£õmkU P mhø©¨¦  ªP GÎ¯  ÂuzvÀ ¤ßÁ¸©õÖ Põmh¨

£mkÒÍx. CvÀ C¸ Âu[PÒ Esk.

TØÖ

{£¢uøÚ 

Esø©¯õ?

CÀø»

B®

÷£õ¼U SÔ•øÓ

IF  Condition  THEN
 Statement

ENDIF

i) IF... THEN.... ENDIF

C[S {£¢uøÚ v¸¨v¨£kzu¨£iß ©õzvµ® TØÖ |øh•øÓ¨£kz 

u¨£k®.
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Euõµn® 1 : EÒÎh¨£k® Gs ÷|öµÛß ©õzvµ® A¢u Gsøn Aa]kuÀ

Program positiveNo(input,output);
Var  N : integer;
Begin
 Writeln(‘Enter Number’);
 Read(N);
 If N > 0 then
 Writeln(N);
End.

Gs N I¨ ö£ÖuÀ

N > 0
CÀø»  

B® 

Gsøn Aa]kuÀ

•iÄ

öuõhUP®

÷£õ¼USÔ•øÓ

Begin
   Input N
   IF  N > 0  
THEN
 Print N
   ENDIF
End.

£õ´a\Ø ÷Põmk¨£h®

£ìPõÀ ö\´{µÀ

ii) IF... THEN... ELSE ... ENDIF      

C[S {£¢uøÚ v¸¨v¯õUP¨£kö©Ûß TØÖ 1 E® v¸¨v¯õUP¨£hõÂiß 

TØÖ 2 E® {øÓ÷ÁØÓ¨£k®.
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NESTED IF

J¸ {£¢uøÚ°ß ¤ß CßÝö©õ¸ {£¢uøÚ¯õP J¸ {£¢uøÚU Tmh® 

Á¸® \¢uº¨£zvÀ NESTED IF £¯ß£kzu¨£k®. 

i)    J¸ uÛ ©õÔUS¨ £» {£¢uøÚPÒ C¸US®÷£õx NESTED IF  I¨   

       £¯ß£kzuÀ 

Euõµn® 3: J¸  £õhzvØS  J¸  ©õnÁß  ö£ØÓ  ¦ÒÎPøÍ EÒÎk®÷£õx 

AuØS›¯ ]zvø¯U PõnÀ. 

Euõµn® 2 : \©©ØÓ C¸ GsPÎøh÷¯ ö£›¯ GsønU PõnÀ

{£¢uøÚ 

Esø©¯õÚuõ?

CÀø» 

B® 

TØÖ 1

  TØÖ 2

IF  Condition  THEN

 Statement1

ELSE
 Statement2

ENDIF

÷£õ¼USÔ•øÓ

program LargeNo(input,output);

Var  n1, n2, Large: integer;

Begin

 Writeln (‘Enter Two Numbers’);

 Read(n1,n2);

 If n1 > n2 then

  Large := n1

 Else

  Large := n2;

 Writeln(‘Large Number is ’ , Large);

End.

£õ´a\Ø ÷Põmk¨£h®

£ìPõÀ ö\´{µÀ
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¦ÒÎ (M) I¨ ö£ÖuÀ

M >= 75
CÀø» CÀø» CÀø» CÀø» 

B®  B®  B®  B®  

M >= 65 M >= 50 M >= 35

]zv = ''A'' ]zv = '' B'' ]zv = '' C'' ]zv = '' S'' 

]zv = '' F'' 

]zvø¯ öÁÎ°kuÀ

•iÄ

öuõhUP®

÷£õ¼USÔ•øÓ           £ìPõÀ ö\´{µÀ
                                                                                                                          

     

Begin
Input Marks as M
IF M >= 75 Then 
      Grade = ‘‘A’’
ELSE
      IF M >= 65 then
            Grade = ‘‘B’’
      ELSE
            IF M >= 50 then

         Grade = ‘‘C’’
  ELSE
         IF M >= 35 then
   Grade = ‘‘S’’
         ELSE 
   Grade = ‘‘F’’
          ENDIF
  ENDIF

        ENDIF
ENDIF
Display Grade

End.

program GradeForMarks (input,output);
Var   M: integer;
 Grade: char;
Begin
 Writeln(‘Enter marks’);
 Read(M);
 If M >= 75 then
     Grade := ‘A’
 Else 
     If M >= 65 then
     Grade := ‘B’
                Else
  If M >= 50 then
  Grade := ‘C’ 
         Else
      If M >= 35 then
      Grade := ‘S’
      Else
      Grade := ‘F’;
 Writeln(‘‘Grade = ’’, Grade);
End.



C»Á\¨ £õh¡À 33

J¸ ©õÔUS¨ £» {£¢uøÚPÒ C¸US®÷£õx Case Statement 
I¨ £¯ß£kzuÀ

 
IF …THEN…  ELSE…  ENDIF öu›ÄU Pmk¨£õmkU Pmhø©¨ø£ «sk® 

«sk® £¯ß£kzxÁv¾® £õºUP GÎuõP Case  I¨ £¯ß£kzu»õ®.

program FindGrade(input,output);
var Marks : integer;
 Grade: char;
Begin
 Writeln(‘Enter Marks’);
 Read(Marks);
 Case Marks of
  0..34 : Grade :=  ‘W’;
  35..49 : Grade :=  ‘S’;
  50..64 : Grade :=  ‘C’;
  65..74 : Grade := ‘B’;
  75..100 : Grade :=  ‘A’;
 Else
  Writeln(‘Invalid Marks’);
 End;
 if (Marks >= 0) AND (Marks <= 100) then
  Writeln(‘Grade is ’ , Grade);
End.

£ìPõÀ ö\´{µÀ

÷ÁÖ

£õ´a\Ø ÷Põmk¨£h®

0-34

¦ÒÎPÒ (Marks)I¨ ö£ÖuÀ

Marks

50-64  65-74 75-100

]zv = '' S'' ]zv = '' C'' ]zv = '' B'' ]zv = '' A'' 

]zvø¯ öÁÎ°kuÀ

]zv = '' W'' 

35-49

ö\À¾£i¯ØÓ ¦ÒÎö¯ÚU PõmhÀ

öuõhUP®

•iÄ
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1'7    «Òö\¯ÀPøÍ¨ £¯ß£kzva ö\´{µÀPøÍ GÊxuÀ
 

«Òö\¯ÀPÎß  uhøÁPÒ •ßTmi÷¯ AÔ¯¨£mi¸US®÷£õx «Òö\¯À 

Pmhø©¨¦PÒ £¯ß£kzu¨£k® Âuzøu Bµõ´÷Áõ®.

i) (Pmhø©¨¦ •øÓ 1) FOR - DO 

FOR  Variable := Value_1 TO Value_2 DO

 ² C[S Variable , Value_1,  Value_2 BQ¯ÁØÔß uµÄ ÁøP •Ê GsPÍõP

^integer& C¸zuÀ ÷Ásk®.

 ² «Òö\¯ø»z öuõh[SÁuØS Value_2 Cß ö£Ö©õÚ® Value_1 Cß     

ö£Ö©õÚzv¾® £õºUPU Tku»õP C¸zuÀ ÷Ásk®.

 ² «Òö\¯À  Value_1 CÀ öuõh[S® A÷u÷ÁøÍ  Value_2 CÀ  •iÁ 

øhQßÓx.

 ² BP÷Á «Òö\¯À |øhö£Ö® uhøÁPÎß GsoUøPø¯ {a\¯©õP   

AÔ¢v¸¢uõÀ ©õzvµ÷© FOR - DO Pmhø©¨ø£¨ £¯ß£kzu»õ®.
  

«Òö\¯Ø Pmhø©¨¦ öuõhUP¨ 

ö£Ö©õÚ®

CÖv¨ 

ö£Ö©õÚ®

«Òö\¯À |øh 

ö£Ö® uhøÁPÎß 

GsoUøP

FOR X:= 1 TO 5 DO 1 5 5
FOR X:= 0 TO 4 DO 0 4 5

  FOR X:= 5 TO 10 DO 5 10 6

Euõµn® : 1öuõhUP® 10 Áøµ²ÒÍ ö£Ö©õÚ[PøÍ öÁÎ°hÀ

Program print10Nos (input,output);
Var  count : integer;
Begin

For  count := 1 to 10 do
Writeln(count);

End.

C[S count GßÝ® ©õÔ°ß ö£Ö©v 1 öuõhUP® 10 ÁøµUS® ©õØÓ¨£mk 

öÁÎ°h¨£k®. A÷u÷ÁøÍ «Òö\¯À £zxz uhøÁPÒ {øÓ÷ÁØÓ¨£k®.
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ii) (Pmhø©¨¦  •øÓ 2) FOR - DO 

FOR  Variable : = Value_1 DOWNTO Value_2 DO

 ² «Òö\¯ø»z öuõh[SÁuØS Value_1 Cß ö£Ö©õÚ® Value_2 Cß 

ö£Ö©õÚzv¾® £õºUPU Tku»õP C¸zuÀ ÷Ásk®.

 ² «Òö\¯À Value_1 CÀ öuõh[S® A÷u÷ÁøÍ Value_2 CÀ•iÁøh 

QßÓx. 

«Òö\¯Ø Pmhø©¨¦ öuõhUP¨ 

ö£Ö©õÚ®

CÖv¨ 

ö£Ö©õÚ®

«Òö\¯À |øh 

ö£Ö® uhøÁPÎß 

GsoUøP

FOR X:= 10 DOWNTO 5 DO 10 5 6
FOR X:= 4 DOWNTO 0 DO 4 0 5

Euõµn® : 10 öuõhUP® 1 ÁøµUS® ö£Ö©õÚ[PøÍ öÁÎ°hÀ

Program printReverse (input,output);

Var  count : integer;
Begin

For  count := 10  downto 1 do
Writeln(count);

End.

C[S count GßÝ® ©õÔ°ß ö£Ö©õÚ® 10 öuõhUP® 1 ÁøµUS® ©õÔU 

öPõsk öÁÎ°h¨£k®  A÷u÷ÁøÍ  «Òö\¯À £zxz  uhøÁPÒ |øh 

•øÓ¨£kzu¨£kQßÓx.
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£zx GsPÎß Tmkz öuõøPø¯²® \µõ\›ø¯²® PõnÀ

«Òö\¯¼À J¸ TmkU 

÷PõøÁ

program total_avg (input,output);
var  I,num,total : integer;
 avg: real;
Begin
 total := 0;
 for I := 1 to  10 do
 begin
   writeln(‘Enter Number’);
   read(num);
   total := total + num;
 end;
 avg := total/I;
 writeln(‘Total is ’, total);
 writeln(‘Average is ’,avg);
end.

}
SÔ¨¦ : J¸ TmkU  ÷PõøÁ begin CØS®  end ; CØSªøh÷¯ GÊu¨£k 

QßÓx. «Òö\¯ÀPÎß uhøÁPÒ {a\¯©õPz öu›¯õuÂhzx "While do" 
Pmhø©¨¦ AÀ»x  "Repeat until" Pmhø©¨¦ £¯ß£kzu¨£k®.

i) While do Pmhø©¨¦

♦  «Òö\¯¼ß öuõhUPzv÷»÷¯ {£¢uøÚ ÷\õvUP¨£kQßÓx.

♦   {£¢uøÚ Esø©¯õÚöuÛß ©õzvµ® «Òö\¯À öuõh[SQßÓx

♦  {£¢uøÚ ö£õ´ö¯Ûß J¸÷£õx® «Òö\¯À öuõh[P©õmhõx.

♦  «Òö\¯À •iÁøhÁuØS {£¢uøÚ ö£õ´¯õP C¸zuÀ ÷Ásk®.

♦  «Òö\¯À |øhö£Ö® A÷u÷ÁøÍ {£¢uøÚ ö£õ´¯õS® \¢uº¨£® Áµõx 

GÛß,  «Òö\¯À (infinite loop) BÚx •iÂÀ GsoUøP°À •iÄÓõx 

öuõh¸®.

Euõµn® 1 -- while number > 0 do
 number ©õÔ°ß ö£Ö©õÚ® ÷|öµÛß ©õzvµ® «Òö\¯À |øhö£Ö®

Euõµn® 2 -- number (} 1¦
while number <=10 do
number (} number ¬ 1¦

◦ number ©õÔ°ß öuõhUP¨ ö£Ö©õÚ® 1 BøP¯õÀ {£¢uøÚ Es 

ø©¯õS®.
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◦ BP÷Á «Òö\¯À {øÓ÷ÁØÓ¨£kQÓx.

 ◦ «Òö\¯À |øhö£Ö® JÆöÁõ¸ uhøÁ°ß÷£õx®  number Cß ö£Ö 

©õÚzxhß 1 Tmh¨£kQßÓx.

 ◦ BP÷Á number Cß ö£Ö©õÚ® 10 AÀ»x 10 C¾® £õºUPU SøÓÁõP 

C¸US®Áøµ «Òö\¯À |øhö£ÖQßÓx.

 ◦ number ©õÔ°ß ö£Ö©õÚ® 11 BP C¸US®÷£õx «Òö\¯À {Özu¨ 

£kQßÓx.

ii) Repeat Until Pmhø©¨¦ 

♦  «Òö\¯¼ß öuõhUPzvÀ {£¢uøÚ ÷\õvUP¨£kÁvÀø»

♦    «Òö\¯»õÁuØS  EÒÍ  TØÖPøÍ  J¸  uhøÁ {øÓ÷ÁØÓ¨£mh ¤ß 

Ú÷µ {£¢uøÚ ÷\õvUP¨£kQßÓx

♦ {£¢uøÚ ö£õ´ö¯Ûß ©õzvµ® «Òö\¯À «ÍÄ® öuõh[SQßÓx

♦ {£¢uøÚ Esø©¯õQ¯x® «Òö\¯À •iÁøhQßÓx

♦  «Òö\¯À  {øÓ÷ÁØÓ¨£k®   A÷u÷ÁøÍ {£¢uøÚ Esø©¯õS® 

\¢uº¨£® Áµõx GÛß, •iÂÀ GsoUøP°À «Òö\¯À {øÓ 

÷ÁØÓ¨£k® (infinite loop)

Euõµn® 1 -- £ìPõÀ GßÝ® ö\õÀ «Òö\¯¾US Em£kuÀ

count := 0¦
Repeat

writeln  ^‘Pascal’&¦
  count (} count¬1

Until count > 5¦

 ◦ count ©õÔ°ß öuõhUP¨ ö£Ö©õÚ® 0 BS®.

 ◦ Pascal GßÝ® ö\õÀ vøµ «x Põm]¨£kzu¨£kQßÓx.

 ◦ count ©õÔ°ß ö£Ö©õÚzxhß 1 Tmh¨£kQßÓx.

 ◦ count  ©õÔ°ß ö£Ö©õÚ® 5 C¾® ö£›uõöÁÚa ÷\õvUP¨£kQßÓx.

 ◦ CÆÁõÖ count  ©õÔ°ß ö£Ö©õÚ® 5 BS® Áøµ «Òö\¯À {øÓ 

÷ÁØÓ¨£kQßÓx.

 ◦ count Cß ö£Ö©õÚ® 6 BP Á¸®÷£õx «Òö\¯À {Özu¨£k®.

 ◦ «Òö\¯À {Özu¨£k®÷£õx Pascal  GßÝ® ö\õÀ vøµ«x 6 uhøÁ 

Põm]¨£kzu¨£mi¸US®.
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Euõµn® 2 

sum := 0;
repeat

  sum := sum + 5;
  writeln(sum);

until sum < 50;

♦ sum ©õÔ°ß öuõhUP¨ ö£Ö©õÚ® 0 BS®.

♦ sum Cß ö£Ö©õÚzxhß 5 Tmh¨£kQßÓx.

♦ sum Cß ö£Ö©õÚ® 5 vøµ «x Põm]¨£kzu¨£kQßÓx.

♦ sum ©õÔ°ß ö£Ö©õÚ® 50 C¾® SøÓÁõÚuõöÁÚa ÷\õvUP¨ 

£kQßÓx.

♦ sum <50 {£¢uøÚ v¸¨v¯õUP¨£kQßÓx (Esø©¯õS®).
♦ BP÷Á «Òö\¯À {Özu¨£kQßÓx.

Euõµn® 3 

sum (} 0¦
repeat

  sum (} sum ¬ 5¦

  writeln^sum&¦

until sum >= 50¦

♦ sum ©õÔ°ß öuõhUP¨ ö£Ö©õÚ® 0 BS®.

♦ sum Cß ö£Ö©õÚzxhß 5 Tmh¨£kQßÓx.

♦ sum Cß ö£Ö©õÚ® vøµ «x Põm]¨£kzu¨£kQßÓx.

♦ sum ©õÔ°ß ö£Ö©õÚ® 50 C¾® Ti¯uõ, \©©õÚuõ GÚa ÷\õvUP¨ 

£kQßÓx.

♦ sum > =50 GÝ® {£¢uøÚ  v¸¨v¯õUP¨£k® (Esø©¯õP C¸US®)
ÁøµUS® «Òö\¯À {øÓ÷ÁØÓ¨£kQßÓx.

♦ «Òö\¯À {ØS®÷£õx sum  Cß ö£Ö©õÚ® 50 BS®.

♦ 10 uhøÁ «Òö\¯À {øÓ÷ÁØÓ¨£kQßÓx. 

♦ öÁÎ±hõP 5 öuõhUP® 50 Áøµ²ÒÍ  5 Cß ©h[SPÒ  Põm]¨£kzu¨£k®.

öu›Ä® «Òö\¯¾® JßÔ¼¸¢öuõßÖ ÷ÁÖ£mh C¸ Pmk£õmkU Pmh 

ø©¨¦PÍõP C¸¢u÷£õv¾® ¤µa]øÚ°ß C¯À¦U÷PØ£ J¸ öu›ÄUS¨ 

¤ßÚº J¸ «Òö\¯À |øhö£Ó»õ® AÀ»x |øhö£Óõ©À C¸UP»õ®. 

AÆÁõ÷Ó «Òö\¯À |øhö£Ö® A÷u÷ÁøÍ J¸ öu›Ä öuõhº£õP 

1'8 EÒÍø© Pmk¨£õmkU Pmhø©¨¦PÎß ÷uøÁ¨£õk
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JßÔ¼¸¢öuõßÖ ÷ÁÖ£mh •øÓÁÈ¯õUP[PÒ |øhö£Ó»õ®. CzuøP¯ 

{ø»ø©PÎß RÌ ö\´{µ¼ØPõP EÒÍø© Pmk£õmkU Pmhø©¨¦PøÍ¨ 

£¯ß£kzu ÷Ásk®.

1'8'1  ªîKM™ eœªêò™è¬÷Š ðò¡ð´ˆî™

J¸ öu›Âß J¸ {£¢uøÚ v¸¨v ö\´¯¨£kÁuØS AÀ»x v¸¨v ö\´¯¨ 

£hõø©US HØ£ J¸ «Òö\¯À |øhö£Ó»õ®. 

Euõµn® -- £¯|›ß öu›ÄU÷PØ£ öÁÎ±miÀ Kº HÖÁ›ø\ AÀ»x CÓ[S 

Á›ø\ Gs öuõhº QøhzuÀ.

program orderNos(input,output);
var  num:integer;

cho:char;
begin

     writeln('Select Assending(A) or Desending(D)');
     read(cho);
     if cho =  'A' then
        begin
             writeln('Asending Order');
             for num := 1 to 6 do
                 writeln(num);
        end;
     if cho = 'D' then
         begin
              writeln('Desending Order');
              for num := 6 downto 1 do
                  writeln(num);
         end;
end.

1'8'2  eœªêòL™ ªîK¬õŠ ðò¡ð´ˆî™

«Òö\¯À |øhö£Ö® A÷u÷ÁøÍ J¸ öu›Ä |øhö£Ö® ÂuzøuU 

P¸x÷Áõ®.

Euõµn® -:  £¯|µõÀ   EÒÎh¨£k®  GsPÒ  JØøÓ GsPÍõ,  Cµmøh      

       GsPÍõ, Gß£øu CÚ[Põn¾® JØøÓ, Cµmøh Gs GsoU

       øPø¯  ÷ÁÖ÷ÁÓõPU Pozu¾®. 
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program rep_sel(input,output);
var num, rem, count, e_count,o_count:integer;
begin
 e_count := 0, o_count := 0;
     for count := 1 to 10 do
         begin
              writeln('Enter Number' );
              read(num);
              rem := num mod 2;
              if rem = 0 then
                 begin
                      writeln('Even number');
                e_count := e_count + 1;
                 end
              else
                  begin
                       writeln('Odd number');
                       o_count := o_count + 1;
                  end;
         end;
     writeln(e_count,'Even Number/s');
     writeln((o_count ,'Odd Number/s');
end.

ö\´{µ¼À uµÄPøÍ {øÚÁPzvÀ ÷uUQøÁ¨£uØS ©õÔPøÍU Pmhõ¯® 

£¯ß£kzu ÷Ásk®. AÆÁõ÷Ó A®©õÔUPõP EP¢u J¸ uµÄ ÁøP C¸zuÀ 

÷Ásk®. J÷µ uµÄ ÁøPUS›¯ £» uµÄPøÍz ÷uUQ øÁ¨£uØS, ö£¯›À 

JßÔ¼¸¢öuõßÖ ÷ÁÖ£mh £» ©õÔPÒ ÷uøÁ.

Euõµn® -: 5 

•Ê GsPøÍ {øÚÁPzvÀ ÷uUQ øÁ¨£uØS 5 ©õÔPÒ ÷uøÁ. AzuøP¯ 

©õÔPøÍ¨ £¯ß£kzx •ß£õP¨ ¤ßÁ¸©õÖ AÔÂ¨¦a ö\´uÀ  ÷Ásk®.

Var p, q, r, s, t : integer; AÀ»x 

n1, n2, n3, n4, n5 ( real¦

1'9 AoPøÍ (Array) £¯ß£kzuÀ
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1'9'1  ÜEèO¡ ðò¡ð£´

J÷µ ÁøPUS›¯ uµÄPøÍ J÷µ ö£¯øµ¨ £¯ß 

£kzv {øÚÁPzvÀ ÷uUQ øÁ¨£uØS Ao 

£¯ß£kzu¨£kQßÓx. BP÷Á JÆöÁõ¸ uµÄUS® 

÷ÁÖ÷ÁÓõP  ©õÔ¨ ö£¯ºPÐUS¨ £v»õP J¸ 

uÛ ©õÔ¨ ö£¯›ß RÌ ÷uøÁ¯õÚ AÍÂØSz 

uµÄPøÍz ÷uUQ øÁ¨£uØS Aoø¯¨ £¯ß 

£kzu»õ®.

Here comes the data 
train

Each car holds a 
single piece of data

E¸ 1.8

1'9'2  å¼ðKñ£í ÜE¬ò õ¬óòÁˆî™

J÷µ ÁøPUS›¯ uµÄPøÍz J¸ öuõh›¯õPz ÷uUQ øÁ¨£uØS¨ £¯ß 

£kzu¨£k® uµÄU Pmhø©¨¦ J¸ £›©õn Ao BS®. J¸ £›©õn Ao°ß 

_mi ‰»® AkzukzxÒÍ {øÚÁP öÁÎPÒ ÷ÁÖ£kzu¨£kQßÓÚ.

J¸£›©õn Ao ¤ßÁ¸©õÖ AÔÂ¨¦a ö\´¯¨£k®.

Var  Name_of_Array ( array [first value '' last value] of data type

Euõµn® -:  var marks ( array [0''9] of integer¦

 ² Cuß ‰»® 10 •Ê Gs ö£Ö©õÚ[PøÍ EÒÍhUPzuUP marks GßÝ® 

J¸, J¸ £›©õn Ao E¸ÁõUP¨£kQßÓx.

E¸ 1.7
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E¸ 1.9

1'9'3  ÜEJ¡ ð‡¹èœ

 ² Kº Ao°ß £SvPÒ (‰»P[PÒ) Akzukzx C¸US®.

 ² Kº Ao°ß _mi (JÊ[S•øÓ Gs) Ao°ß ö£¯¸hß Aøh¨¤ÝÒ÷Í 

Põmh¨£k®.

M[0]

X[0]

M[1]

X[1]

M[2]

X[2]

M[3]

X[3]

M[4]

X[4]

öuõhUP ‰»P®

SøÓ¢u£m\a _mi

CÖv ‰»P®

E¯º¢u£m\a _mi

Ao°ß ö£¯º 
_mi

‰»P® 1 ‰»P® 5

Euõµn®

Var M ( Array[0..4] of integer; GßÝ® Ao°ß AÍÄ 5 BS®. 

Ax M[0] öuõhUP® M[4]  ÁøµUS® EÒÍ  5 ‰»P[PøÍU öPõskÒÍx.

_mi \xµ Aøh¨£õßPÎÝÒ Põmh¨£k®. 

Ao Áøµ¯øÓ ö\´¯¨£k® •øÓU÷PØ£ Auß _mi uõÚ[PÒ ÷ÁÖ£k®.

•uØ_mi

 Ao°ß  }Í® 10

‰»P® (_mi 8 CÀ

EÒÍ ‰»P®)

(First index) Element (at index 8)
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Euõµn® -:  Var X ( Array[1..5] of integer; 

J÷µ ÁøP¯õÚ uµÄPøÍ ©õzvµ÷© J¸ Ao°À ÷uUQøÁUP»õ®.

Ao°À G¢uöÁõ¸ ‰»Pzøu²® GÊ©õØÓõP AqP»õ®. BP÷Á «Ò ö\¯Ø 

Pmhø©¨¤ß ‰»® Kº Aoø¯ GÎuõPU Pmk¨£kzu»õ®.

Euõµn® -:  40 ©õnÁºPÎß Pou¨ ¦ÒÎPøÍ Kº Ao°Ø ÷\ºzuÀ.

var  maths : array[0..39] of integer;
i,marks : integer; 

for i := 0 to 39 do
begin

  writeln(‘Enter marks’);
  read(marks);
  maths[i] := marks;

end;

1'9'4  æ˜ ÜE‚°Š ªðÁñ£ùƒè¬÷ åŠð¬ìˆî™

E¸ 1.10

•ÊöÁsPÒ Ch®ö£ÓzuUP 5 ‰»P[PøÍU öPõsh num Aoø¯U 

P¸x÷Áõ®.

num[0] num[1] num[2] num[3] num[4]

45

36 60

45 75 36 81 60

var   num : array[0..4] of integer;

num[0] := 45; 

num[2] := 36; num[4] := 60;

num[1] := num[4] + 15;
num[3] := num[0] + num[2];
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1'9'5  æ˜ ÜEJ¡ ªðÁñ£ùƒè¬÷‚ è£†CŠð´ˆî™

Kº Ao°ß ö£Ö©õÚ[PøÍU Põm]¨£kzuÀ Auß ‰»P[PÎß ‰»® 

|øhö£ÖQßÓx.

writeln ^num[3]&; - 4 B® ‰»PzøuU Põm]¨£kzuÀ ^81&

writeln ^num[1]" num[4]&; - 2, 5 B® ‰»P[PøÍU Põm]¨£kzuÀ ^36" 60&

for  x (} 0 to 3 do - Ao°ß ‰»P® 1 •uÀ 4 ‰»P[PøÍ Põm]¨£kzuÀ 

writeln ^num[x]&;  ^45" 75" 36" 81& 

for  x (} 2 to 4 do - Ao°ß 3 öuõhUP® 5 Áøµ²ÒÍ 3 ‰»[PøÍU Põm]¨£kzuÀ 

writeln ^num[x]&;   ^36" 81" 60&  

for  x (} 0 to 4 do - Ao°ß GÀ»õ ‰»P[PøÍ²® Põm]¨£kzuÀ      

writeln ^num[x]&;  ^45" 75" 36" 81" 60&  

Euõµn® -- J¸ ÁS¨¤ß 35 ©õnÁºPÒ uPÁÀ ©ØÖ® öuõÈÝm£Â¯À 

£õhzvØS¨ ö£ØÓ ¦ÒÎPøÍ J¸ Ao°À ÷\P›zx Tku»õÚ 

¦ÒÎø¯²® A¨¦ÒÎPÎß \µõ\›¨ ö£Ö©õÚzøu²® PozuÀ.

program ictMarks(input,output);
var marks:array[0..34] of integer;
    i,tot,max:integer;
    avg:real;
begin
     for i := 0 to 34 do
         begin
              writeln('Enter Marks');
              read(marks[i]);   (* Read Marks to array *)
              tot := tot + marks[i]; (* Add marks *)
         end;
     avg := tot/35;
     max := marks[0];
     for i := 1 to 34 do
         if marks[i] > max then max := marks[i];
     writeln('Maximum marks = ', max);
     writeln('Average marks = ',avg);
end.
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1'10 E£  ö\´{µÀPøÍ¨ £¯ß£kzuÀ

J¸  ö\´{µ¼ß  •øÓÁÈ¯õUP[PÎß AÍÄ AvP›¨£uÝhß Ax   ]UP»õÚ 

uõQßÓø©¯õÀ, AuøÚ Áõ]zx ÂÍ[QU öPõÒÍÀ, ö\´{µø»¨ ÷£nÀ 

÷£õßÓ £oPÒ PiÚ©õÚøÁ¯õS®. BP÷Á ö\´{µÀPøÍ GÊx®÷£õx 

C¯ßÓ Áøµ E£ö\´{µÀPÍõP GÊxuÀ J¸ öÁØÔPµ©õÚ •øÓ¯õS®.

E£             

¤µa]øÚ 1

E£             

¤µa]øÚ 2

E£

¤µa]øÚ n

¤µuõÚ 

¤µa]øÚ

E£ ö\´{µÀ 1

-----------------       

-----------------

E£ ö\´{µÀ 2

-----------------       

-----------------

E£ ö\´{µÀ n
-----------------       

-----------------

1'10'1  àð ªêŒGó™ õ¬èèœ

¤µuõÚ ö\´{µ¾hß öuõhº¦£mh E£ ö\´{µÀPÎß ‰»® ¤µuõÚ ö\´ 

{µ¾US öÁÎ±møhz v¸®£ ÁÇ[PzuUP, ÁÇ[P •i¯õu C¸ ÁøP E£  

ö\´{µÀPÒ EÒÍÚ. öÁÎ±møhz v¸®£ ÁÇ[PzuUP E£ ö\´{µÀPÒ             

\õº¦PÒ (Function) GÚÄ® öÁÎ±møhz v¸®£ ÁÇ[P •i¯õu E£ 

ö\´{µÀPÎß  |øh•øÓ (Procedure)  GÚÄ® AøÇUP¨£k®.
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1'10'2  àð ªêŒGó™è¬÷ ÜPºè…ªêŒî™

PROGRAM 
CONST 

VAR
function 

and 
procedure 
declaration

main 
program

BEGIN

END

E¸  1.11 

¤µuõÚ ö\´{µø»z öuõhUS•ßÚº \õº¦PøÍ²® |øh•øÓPøÍ²® 

AÔ•Pg ö\´uÀ ÷Ásk®. ¤µuõÚ ö\´{µ¼À E£ {µÀPøÍ AøÇUP 

(Calling the function or Procedure) ÷Ásk®.

J¸ |øh•øÓø¯ AÔ•Pgö\´ÁuØS›¯ \›¯õÚ öuõh›¯À (Syntax) R÷Ç 

Põn¨£kQßÓx.

Procedure  Name_of_Procedure ^name_of_variable: data type&¦

Euõµn® --  J¸ Ámhzvß £µ¨£ÍøÁU Põs£uØS›¯ |øh•øÓ

         Procedure calculateArea ^var radius ( real&¦ 

J¸ \õºø£ AÔ•Pg ö\´ÁuØS›¯ \›¯õÚ öuõh› (Syntax) R÷Ç Põn¨ 

£kQßÓx.

Function  Name_of_Function^name_of_variable ( data type& ( data type ¦

Euõµn® --  J¸ Ámhzvß £µ¨£ÍøÁU Põs£uØS›¯ \õº¦

                Function calculateArea ^var radius ( real&( real¦
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Euõµn® -- J¸  Ámhzvß £µ¨£ÍøÁ²® £›vø¯²® Po¨£uØPõÚ  ö\´  

      {µø»U P¸x÷Áõ®.

1' |øh•øÓPøÍ¨ £¯ß£kzv E¸ÁõUP¨£mh ö\´{µÀ

program procedure_circle(input,output);
const pie = 22/7;
var radius:real;
procedure getData(var radius: real);
          begin
               writeln('Enter Radius');
               read(radius);
          end;
procedure ComputeArea(var radius:real);

Return Output

Calling the procedure

Calling the function

Procedure sub1(var x:real);
begin
 statement
 ………………
end; 

Function sub2(var x:real): real ;
begin
  statement
  ………….
end;

begin
 statement
 ………………
 sub1(value);
 ………………
 V = sub2(value);
 ………………
 statement
end.

 

Procedure declaration
|øh•øÓø¯

AÔÂ¨¦ ö\´uÀ

\õºø£ AÔÂ¨¦ 

ö\´uÀ

|øh•øÓø¯ 

AøÇzuÀ

\õºø£ AøÇzuÀ

¤µuõÚ ö\´{µÀ

Function declaration

Main Program

{ {
{{

{
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          var area:real;
          begin
               area := pie * radius * radius;
               writeln('Area = ',area);
          end;
procedure ComputeCircumference(var radius:real);
          var circum:real;
          begin
              circum := 2 * pie * radius;
              writeln('Circumference = ',circum);
          end;
begin
     getData(radius);
     ComputeCircumference(radius);
     ComputeArea(radius);
end.

2' \õº¦PøÍ¨ £¯ß£kzv E¸ÁõUP¨£mh ö\´{µÀ

program function_circle(input,output);
const pi = 22/7;
var radius:real;
function ComputeArea(var radius:real):real;
          var area:real;
          begin
               area := pi * radius * radius;
               ComputeArea := area;
          end;
function ComputeCircumference(var radius:real):real;
          var circum:real;
          begin
              circum := 2 * pi * radius;
              ComputeCircumference := circum;
          end;
begin
     writeln('Enter Radius');
               read(radius);
     writeln('Circumference = ',ComputeCircumference(radius));
     writeln('Area = ', ComputeArea(radius));
end.
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ö\´{µÀ  Gß£x  PoÛ°ÚõÀ  {øÓ÷ÁØ 

Ó¨£h  ÷Ási¯  SÔ¨¤mh  J¸  £oø¯

{øÓ÷ÁØÖ® ÂuzøuU Põmk® J¸ AÔÄ 

ÖzuÀ öuõh›¯õS®. CÆÁÔÄÖzuÀPøÍ 

ÁÇ[SÁuØS  J¸ PoÛ ö\´{µÀ ö©õÈ 

AÁ]¯©õS®.

PoÛ°ß ö\´{µÀ öuõÈØ£k® Âu®

1'11'2  W› ñ†ì èEQ ªêŒGóô£‚è™ ªñ£Nèœ

C¯¢vµ ö©õÈ 

Cx PoÛ°À ÷|µi¯õPa ö\¯Ø£kzuzuUP  ö©õÈ¯õS®. AÔÄÖzuÀPøÍ 

ÁÇ[SÁuØPõP 0, 1 GßÝ® xÂu GsPÒ (¤ØÖPÒ) £¯ß£kzu¨£mhÚ. 

BP÷Á C¯¢vµ ö©õÈ°À GÊu¨£mh J¸ ö\´{µø» ÷|µi¯õP •øÓ 

ÁÈ¯õUPzvØSa ö\¾zu»õ®.

C¯¢vµ ö©õÈ°À GÊu¨£mh J¸ ö\´{µ¼ß £s¦PÍõÁÚ:

· PoÛ°À ÷|µi¯õP {øÓ÷ÁØÓ¨£k® 

· {øÓ÷ÁØÖuÀ ªPÄ® ÂøµÁõS®

1'11'1  å¼ ªêŒGó™ ªñ£NJ¡ «î¬õ

Hello Mr. 
Computer?Computer?

'1010101010101010'

E¸  1.12

1'11 ö\´{µÀ ö©õÈPÎß £›nõ©®
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· ö©õÈö£¯º¨¦ ö\´{µÀ ÷uøÁ¨£hõv¸US®

· C¯¢vµzøua \õº¢v¸zuÀ (J¸ PoÛUS GÊu¨£mh ö\´{µø» 

÷ÁöÓõ¸ PoÛ°À C¯UP •i¯õv¸US®)

· 0,1 BQ¯ÁØøÓ ©õzvµ® £¯ß£kzv GÊu¨£mi¸¨£uÚõÀ ©Ûuº 

PÍõÀ ÂÍ[QU öPõÒÍÀ ]UP»õP C¸US®.

J¸[S÷\º¨¦ ö©õÈ

C¯¢vµ  ö©õÈ°À 0, 1 BQ¯ÁØøÓ Ai¨£øh¯õ´U öPõsk GÊu¨£mh 

PmhøÍUS¨  £v»õP  GÎ¯  SÔ±kPÎÀ ö£¯ºPøÍ¨ £¯ß£kzv J¸[S 

÷\º¨¦ ö©õÈ Aø©UP¨£mkÒÍx.

J¸[S÷\º¨¦ ö©õÈ°À GÊu¨£mh ö\´{µ¼ß £s¦PÍõÁÚ:

 ² {øÓ÷ÁØÓ¨£kuÀ C¯¢vµ ö©õÈa ö\´{µ¾hß J¨¤k®÷£õx ÂøµÄ 

SøÓ¢ux.

 ² J¸[S÷\º¨¤ GßÝ® ö©õÈö£¯º¨¦ ö\´{µ¼ß ‰»® C¯¢vµö©õÈ 

AÔÄÖzu»õP ö©õÈö£¯ºUP¨£kuÀ ÷Ásk®.

 ² C¯¢vµzøua \õº¢v¸US® (J¸ PoÛUS GÊu¨£mh J¸ ö\´{µø»  

÷ÁÖ  PoÛ°À C¯UP •i¯õv¸US®)
 ² SÔ±kPÒ £¯ß£kzu¨£kQßÓø©¯õÀ GÎuõP ÂÍ[QUöPõÒÍz 

uUPuõP C¸US®.

B[Q» ö©õÈ°À Aø©¢u GÎ¯ ö\õØPøÍ¨ £¯ß£kzva ö\´{µÀPøÍ 

ªPÄ® GÎuõP ÂÍ[QU öPõÒÍzuUPÁõÖ Aø©UP¨£mh PoÛ ö\´{µÀ 

ö©õÈ E¯º ©mhU PoÛ ö©õÈ GÚ¨£k®.

E¯º ©mhU PoÛ ö©õÈUS Euõµn[PÒ

FORTRAN" BASIC" COBOL" PASCAL" C
E¯º ©mhU PoÛ ö©õÈ°À GÊu¨£mh ö\´{µÀPÎß £s¦PÒ:

1'11'3  àò˜ ñ†ì‚ èEQ ªêŒGóô£‚è™ ªñ£Nèœ
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 ² ÂÍ[QU öPõÒÍÀ GÎuõS®.

 ² {øÓ÷ÁØÖÁuØS •ß£õP C¯¢vµ ö©õÈ AÔÄÖzuÀPÍõP ©õØÓ 

÷Ásk®.

 ² C¯¢vµzøua \õº¢u ö©õÈ¯ßÖ.

FORTRAN Pascal C 

High - Level Language

Assembly Language 

Machine Language 

Hardware

1'11'4  ªêŒGó™ ªñ£N õ¬èèœ

ö\´{µ»õUP® Gß£x J¸ SÔzu £oø¯a ö\´²® Âu® £ØÔU PoÛUS 

AÔÄÖzuÀPøÍ AÎ¨£uØSU PoÛa ö\´{µ»›ÚõÀ ö\´¯¨£k® 

BUP§ºÁ©õÚ •øÓÁÈ¯õS®. J¸ SÔzu ¤µa]øÚUS J¸ wºøÁz u¸ÁuØS 

G¢u £oø¯a ö\´uÀ ÷Ásk® Gß£x £ØÔU PoÛUS AÔÄÖzuø» 

AÎ¨£uØSz u¯õ›zu AÔÄÖzuÀ öuõSv ö\´{µÀ GÚ¨£k®.

ö\´{µÀ •øÓÁÈUS¨ ¤µ÷Á]¨£uØS¨ £» ©õØÖ¨ ö£ÖÁÈPÒ EÒÍÚ. 

AøÁ ö\´{µÀ PmhøÍ¨ £iÁ[PÒ (Paradigms) GÚ¨£k®. ö\´{µÀPøÍ¨ 

£¯ß£kzv Â÷\h ¤µa]øÚPÐUSz wºÄPøÍ E¸ÁõUSÁuØS Ai¨ 

£øh°À ÷ÁÖ£mh ö£ÖÁÈPÒ £À÷ÁÖ PmhøÍ¨ £iÁ[PÎß ‰»® 

SÔUP¨£kQßÓÚ. ö£¸®£õ»õÚ ö\´{µÀ ö©õÈPÒ J¸ PmhøÍ¨£iÁ 

ÁøP°ß RÌ PoUP¨£kQßÓ ÷£õv¾® ]» ö©õÈPÎÀ £À÷ÁÖ PmhøÍ¨ 

£iÁ[PÐUS›¯ ‰»zxÁ[PÒ C¸¨£øuU Põn»õ®.
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PmhøÍ¨ 

£iÁ[PÒ

 (Paradigms)

öÁÎ°k®

(Declarative)
PmhøÍ

°k®

(Imperative)

u¸UP 

(Logic)

\õº¦z uµÄ¨ 

£õ´a\À

(Functional 
Dataflow)

uµÄzuÍ®

(Database)
|øh•øÓ 
(Procedural)

ö£õ¸Ò 

\õº¢u 

(Object 
Oriented)

\©õ¢uµ 

•øÓÁÈ

¯õUP®

(Parallel 
Processing)

•   C •   Java •   Java •   Prolog •   Lisp •   SQL

E¸ 1.13    

ö\´{µÀ PmhøÍ¨ £iÁ®

PmhøÍ°k® öÁÎ°k® ö£õ¸Ò \õº

\õº¦a ö\´{µÀ u¸UPa ö\´{µÀ

Algol
Cobol 
PL/1 
Ada 
C

Modula - 3

Lisp
Haskell

ML
Miranda

APL

Prolog Smalltalk
Simula 

C++ 
Java

CØøÓÁøµUS® £» ö\´{µÀ ö©õÈPÒ E¸ÁõQ²ÒÍÚ. AøÁ Põ»zxhß 

©v¨¥mkUS Em£kzu¨£k®÷£õx ¤ßÁ¸©õÖ ©õØÓ[PÒ C¸¨£øuU 

Põn»õ®.

|øh•øÓa ö\´{µ¼ØS® öÁÎ±mka ö\´{µ¼ØSªøh÷¯ 

EÒÍ Âzv¯õ\®

|øh•øÓ ö©õÈ Gß£x ªPa ]Ó¢u Pmhø©¨¦¨ £i•øÓz öuõSvø¯²® 

|øh•øÓPøÍ²® öPõsh PoÛa ö\´{µÀ ö©õÈ ÁøP BS®. AvÀ 

JÊ[PõÚ £i•øÓPøÍU öPõsh TØÖPÒ Ch®ö£ÖQßÓÚ.
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|øh•øÓP 

ÐUQøh÷¯ 

uµÄPÒ £›©õÓ¨

£kQßÓÚ

öÁÎ±mkz öuõh›

|øh•øÓa ö\´{µÀ

|øh•øÓ 1

|øh•øÓ 2

|øh•øÓ 3

öÁÎ±mkz öuõh›

SÔ•øÓ

uµÄ

}[PÒ PØÓ £ìPõÀ ö\´{µ¼À |øh•øÓa ö\´{µ¼ß C¯À¦PÒ 

EÒÍÚ.

öÁÎ±mka ö\´{µÀ Gß£x Pmk¨£õmk¨ £õ´a\À ÂÁµn® CÀ»õ©À 

Po¨£uß u¸UPU öPõÒøPø¯U Põmk® PoÛa ö\´{µÀPÎß Pmhø©¨¦® 

‰»P[PÐ® E¸ÁõUP¨£mkÒÍ Âu©õS®. C¢u BUP§ºÁ©õÚ Âu® 

£¯ß£kzu¨£k® £» {º©õo¨¦PÎß ‰»® £UP ÂøÍÄPøÍ CÈÁÍ 

ÁõUSÁuØS AÀ»x }USÁuØS •¯»¨£kQßÓx. •uÀ ö\´{µÀ ö©õÈPÒ 

÷£õ» ¤µa]øÚø¯z wº¨£uØS G[VÚ® ö\¯Ø£kuÀ ÷Ásk® Gß£øu 

ÂÁ›¨£v¾® £õºUP¨ ¤µa]øÚø¯z wº¨£uØS Gaö\´{µø»z u¯õ›UP 

÷Áskö©Ú ÂÁ›¨£uß ‰»® Cx ö\´¯¨£kQßÓx. GÆÁõÓõ°Ý® 

Auß ‰»®  GÆÁõÖ  |øhö£ÖQßÓx Gß£x ÂÁ›UP¨£kÁvÀø» 

AuõÁx ¤µa]øÚ Gx Gß£x  £ØÔ ©õzvµ® PoÛ AÔÂUS® A÷u÷ÁøÍ 

Ax wºUP¨£k® Âu® £ØÔ AÔÂ¨£vÀø». EÒÎh¨£k® ¤µa]øÚUSz 

÷uøÁ¯õÚ wºÄPÒ PoÛ ‰»® Psk¤iUP¨£kQßÓÚ. Cx ÂÁµ©õÚ 

£i•øÓ¯õP ö|Ô•øÓa ö\¯¾US Á¸®, |øh•øÓa ö\´{µ¾US GvµõÚx. 

öÁÎ±mka ö\´{µÀ ö\¯ØøP ~snÔøÁ Ai¨£øh¯õ´U öPõshx.
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•UQ¯®

|øh•øÓU PmhøÍ¨ £iÁ® 

(Procedural Paradigm)

wºøÁU Põq® ÂuzøuU TÖuÀ 

Saying how you achieve it

A
B
C

1'  \xµ•Q A ø¯ øÁUP

2'  \xµ•Q A «x \xµ•Q  

    B ø¯ øÁUP.

3'  \xµ•Q C ø¯a \xµ     

   •Q B «x øÁUP.

  
öÁÎ±mkU PmhøÍ¨ 

£iÁ®

(Declarative Paradigm)

÷uøÁ¯õÚÁØøÓU TÖuÀ

Saying what you want

A
B
C 3 \xµ[PøÍU 

öPõsh ys

Pmhø©¨¦a ö\´{µø»²® ö£õ¸Ò \õº¢u ö\´{µø»²® J¨¤kuÀ

Pmhø©¨¦a ö\´{µÀ (Structured Program) Gß£x u¸UPa ö\´{µÀ 

PmhøÍ¨£iÁ©õP C¸US® A÷u÷ÁøÍ Ax ö£õ¸Ò \õº¢u ö\´{µ¼ß 

•Ø£mh \¢uº¨£©õS®. Pmhø©¨¦a ö\´{µØ PmhøÍ¨ £iÁzvß 

‰»® ö\´{µø» ÂÍ[QU öPõÒÁuØS® |ÃÚ©¯©õu¾US® Á\vPÒ 

ö\´¯¨£kQßÓÚ. öuõSv TÖ E£öuõSvPÍõP¨ ¤›UP¨£mi¸US® 

A÷u÷ÁøÍ ÷©¼¸¢x RÊUS¨ ö£ÖÁÈPÒ EÒÍÚ.

ö\´{µ¼ß SÔ•øÓPÐUSz u¸UPU PmhøÍø¯U øP¯ÎUS® öuõÈÝm£® 

C[S Esk. BP÷Á, AvÀ •øÓÁÈ GÎuõUP¨£kQßÓx. ö£›¯ ö\´{µÀ 

JßÖ ]Ô¯ A»SPÍõP¨ ¤›zx ÷ÁÓõUP¨£mi¸US® A÷u÷ÁøÍ A¨£SvPÒ 

JÊ[PõP Jß÷ÓõöhõßÖ ¤ønUP¨£mi¸US®.
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£¯|¸USz uµÄPøÍa 

ö\¸S©õÖ AÔÂUQßÓx

£¯|º ö\¸Q¯ uµÄPøÍ¨ 

ö£ÖQßÓõº

£¯|¸US¨ ÷£øÓ 

ÁÇ[SQßÓx

uµÄPÒ •øÓÁÈ¯õUPzvØS 

Em£kzu¨£kQßÓÚ

Pmhø©¨¦a ö\´{µÀ

}[PÒ PØÓ £ìPõÀ ö\´{µ¼À Pmhø©¨¦a ö\´{µÀ C¯À¦PÐ® EÒÍÚ

ö£õ¸Ò  \õº¢u  PoÛa  ö\´{µÀ Gß£x

ö£õ¸ÒPÒ (Objects) GßÝ® GsnU 

P¸øÁ Ai¨£øh¯õ´U öPõsh ö\´{µØ 

PmhøÍ¨£iÁ® BS®. ö£õ¸ÒPÒ 

uµÄPÒ (Data) ©ØÖ® •øÓ°¯ÀPÒ 

(Methods) BÀ Aø©¯¨ ö£ØÓøÁ. 

•øÓ°¯ÀPÒ Gß£øÁ uµÄPøÍU 

øP¯õÐ® Âu©õP EÒÍ SÔ•øÓPÍõS®. ö£õ¸Ò\õº ö\´{µ»õUP¼ß 

Ai¨£øhU Pmhø©¨¦ ÁS¨¦ BS®.

 Object 

Property Method Attribute
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ö£õ¸Ò \õº¢u ö\´{µ¼À ÁS¨¦ Gß£x J¸ Ai¨£øhU Pmhø©¨£õS®. 

J¸ ÁS¨¤Úx uµÄPøÍ²®, |hzøuø¯²® ÂÁ›US®. J¸ ÁS¨£õÚx J÷µ 

ÁøP¯õÚ ö£õ¸ÒPøÍ E¸ÁõUS®.

ö£õ¸Ò \õº¢u ö\´{µÀPÒ uPÁÀPøÍ £›©õÖÁuß ‰»® 

Jß÷ÓõöhõßÖ Fhõk® £» ö£õ¸ÒPøÍU öPõskÒÍÚ.

E¸ 1.14

  

•øÓø© (System)

AÔUøP 

u¯õ›zuÀ

(Record Loans)

ÁÍ[PøÍa 

    ÷\ºzuÀ  

(Add 
Resources)

÷Põ¨¦ 

AÔUøP°hÀ 

(Report Fines)

Pmhø©¨¦ AqSøP

 (Structured Approach)
\õº¦PøÍ²® |øh•øÓPøÍ²®

öPõskÒÍx. (Composed of functions
 or procedures) 

¡»Pz uPÁÀ •øÓø©

(Library Information Systems)

£mi¯À  

(Catalog)

¡À 

(Book)

¡»Pº

 (Librarian)

¡»P® 

(Library)

ö£õ¸Ò \õµ¢u AqSøP

 (Object Oriented Approach)
ö£õ¸ÒPøÍ²® •øÓ°¯ÀPøÍ²®   

öPõskÒÍx.(Composed of objects and
 methods) 
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£s¦

(Attributes) (Data)

÷uõÀ {Ó® 

PsPÎß {Ó®

E¯µ® 

}Í®

{øÓ

•øÓ°¯ÀPÒ

(Methods) (Code)

C¸zuÀ

£kzuÀ

Áõø» BmkuÀ

E»õÄuÀ

£s¦PÎß 

ö£Ö©õÚ[PÒ

(Attributes Values)

÷uõÀ  {Ó®  - 

\õ®£À, öÁÒøÍ, 

PÖ¨¦

PsPÎß {Ó® - 

}»•® P¤»•®

E¯µ®  - 18''
}Í® - 38''
{øÓ - 30 CÓõzuÀ

•øÓ°¯ÀPÒ 

(Methods)

C¸zuÀ

£kzuÀ

Áõø» BmkuÀ

E»õÄuÀ

öµõª|õ´

ÁS¨¦ (Class) ö£õ¸Ò (Object)

Procedural Languages Computation involves 
code operating on Data

Code (Methods)

Data (Property)

E¸ 1.15
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Object-Oriented Languages
An object encapsulates 
both code and data

Code (Methods)

Data (Property)

Computation involves 
objects intracting with 
each other

E¸ 1.16

ö\¯Ø£õk 

Car GßÝ® ÁS¨ø£U (Class) P¸x®÷£õx Auß ö£õ¸ÒPÒ 

(Objects), £s¦PÒ (Properties) •øÓ°¯ÀPÒ (Methods) BQ¯ 

ÁØøÓ CÚ[PõsP.

ö\´{µ»õUP•® (Programming) ¤µv BÁn•® (Scripting)

ö\´{µÀ ö©õÈPÎß \õuõµn £uz öuõh›¯À öuõhº£õPU Pk® öuõh›¯À 

(Syntax) ÂvPÒ EÒÍÚ. AøÁ AiUPi öuõSUP¨£h ÷Ási¯øÁ. ö\´{µÀ 

ö©õÈø¯z öuõSzuÀ (Compile) ÷Ásk®. ¤µv BÁn ö©õÈPÒ ö£õxÁõP 

÷ÁÖ ¤µ÷¯õPzxhß (E&®. Áø» ÷©÷»õi AÀ»x Áø»a ÷\øÁ¯P®)

ö£¸®£õ¾® |øh•øÓ¨£kzu¨£k® J¸ SÔ•øÓ E¸ÁõUP¨£kQßÓx. 

AÆÁõ÷Ó ¤µv BÁn ö©õÈø¯ ÂÍUP (Interpret) ÷Ásk®. ¦v¯ÁºPÐUS 

¤µvaö\õÀ ö©õÈø¯¨ £¯ß£kzuÀ ªP GÎuõÚx.

Javascript, PHP BQ¯ Cµsk® ¤µv BÁn ö©õÈPÍõS®.

ö\¯Ø£õk

¤ßÁ¸® ö\´{µØ PmhøÍ¨£iÁ[PÎß ÷ÁÖ£õkPøÍ J¨¤kP.

 • |øh•øÓ²® öÁÎ±k® (Procedural vs Declarative)
 • Pmhø©¨¦® ö£õ¸Ò \õº¢ux® (Structured vs Object 

oriented)
 • ö\´{µ»õUP•® ¤µv BÁn•® (Programming vs Scripting)
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1'11'5  ªñ£Nªðò˜Š¹ ªêŒGó™èœ

C¯¢vµ ö©õÈ uÂº¢u ÷ÁöÓ¢u ö©õÈ°¾® GÊu¨£mh ö\´{µÀPøÍ 

(C»US¨ ö£õ¸Ò SÔ•øÓPÒ) C¯US •ßÚº  C¯¢vµ ö©õÈ AÔÄÖz 

uÀPÍõP (C¯¢vµU SÔ•øÓ) ©õØÓ ÷Ásk®.

J¸[S÷\º¨¦ ö©õÈ°À  GÊu¨£mh  J¸   ö\´{µø»   J¸[S ÷\º¨¤ 

GÚ¨£k® ö©õÈö£¯º¨¦ ö\´{µ¼ß ‰»® C¯¢vµ ö©õÈ AÔÄÖzu»õP 

©õØÓ ÷Ásk®.

E¯º©mhU PoÛ ö©õÈø¯¨ £¯ß£kzv GÊu¨£mh J¸ ö\´{µø» C¯¢vµ 

ö©õÈ AÔÄÖzuÀPÍõP ©õØÖÁuØS C¸ ö\´{µÀPÒ (ö©ßö£õ¸ÒPÒ) 
£¯ß£kzu¨£kQßÓÚ.

1' Á›ö©õÈ©õØÔ (Interpreter)
2' öuõS¨¤ (Compiler)

Á›ö©õÈ©õØÔ

E¯º ©mhU PoÛ ö©õÈ°À GÊu¨£mh ö\´{µø»a  ö\´•øÓ¨£kzx 

•ßÚº AvÀ EÒÍ TØÖPÒ JÆöÁõßøÓ²® C¯¢vµ ö©õÈU PmhøÍ¯õP 

ö©õÈö£¯ºzx  AUPnzvÀ AuøÚ Jzu PmhøÍø¯ C¯UQ ö©õÈö£¯º¨¦ 

•øÓÁÈ¯õUP® |øhö£Ö® ö©õÈö£¯º¨¦ ö\´{µÀ Á›ö©õÈ©õØÔ 

GÚ¨£k®.

Á›ö©õÈ©õØÔ   £¯ß£kzu¨£k®   PoÛ   ö©õÈPÎÀ   ö\´{µø»  

©õØÖ®÷£õx 

1' ö\´{µÀ Âv ÁÊUPÒ CÀ»õÂiß C¯UQ¯ ¤ßÚº \›¯õÚ    

öÁÎ±møhz  u¸QßÓx.

2' ö\´{µ¼À ÁÊUPÒ C¸¨¤ß AuøÚ CÖvÁøµUS® ö\´•øÓ¨£kzu  

•i¯õx (ÁÊ EÒÍ Ch® ÁøµUS® ö\´•øÓ¨£kzxÁuØPõÚ BØÓÀ   

EÒÍx).

SÔ¨¦ & ö\´{µÀ C¯UP¨£k® JÆöÁõ¸ uhøÁ²® ö©õÈö£¯º¨¦ 

|øhö£Ö®.
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öuõS¨¤ 

E¯º ©mhU PoÛ ö©õÈ°À GÊu¨£mh ö\´{µø»a ö\´•øÓ¨£kzx 

•ßÚº AuøÚ •ØÓõP J¸uhøÁ C¯¢vµ ö©õÈ AÔÄÖzuÀPÍõP ©õØÔ¯ 

¤ßÚº C¯USuÀ öuõS¨¤°ß ‰»® |øhö£Ö®.

öuõS¨¤ £¯ß£kzu¨£k® PoÛ ö©õÈ°ß Buõµ‰»U SÔ•øÓø¯ 

(Source code)  C¯¢vµU SÔ•øÓ¯õP ©õØÖ®÷£õx

1' ö\´{µ¼À Âv ÁÊUPÒ CÀ»õÂiß C¯UQ¯ ¤ßÚº öÁÎ±k    

ÁÇ[P¨£k®.

2' ö\´{µ¼À Âv ÁÊUPÒ C¸¨¤ß AuøÚ C¯¢vµU SÔ•øÓ¯õP   

ö©õÈö£¯ºUP •i¯õx. AÆÁÊ EÒÍ Ch[PÒ Põmh¨£k®.

SÔ¨¦ & ö\´{µø» J¸ uhøÁ C¯¢vµU SÔ•øÓ¯õP ©õØÔ¯ ¤ßÚº 

÷uøÁ¯õÚ GzuøÚ uhøÁ²® ö\´{µø» C¯UP»õ®. Buõµ‰»U SÔ•øÓ 

©õØÓ¨£mhõÀ ©õzvµ® «sk® ö©õÈö£¯º¨¦ ÷uøÁ¨£k®.
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E¸ 1.17
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 ² J¸ ¤µa]øÚø¯¨ £S¨£õ´Áuß ‰»® EÒÏk, •øÓÁÈ¯õUP®, 

öÁÎ±k BQ¯ÁØøÓ CÚ[Põn»õ®.

 ² ö|Ô•øÓø¯ E¸ÁõUSÁuØS¨ £õ´a\Ø ÷Põmk¨ £h[PøÍ²® 

÷£õ¼USÔ •øÓø¯²® £¯ß£kzu»õ®.

 ² öuõh›, öu›Ä, «Òö\¯À ÷£õßÓ Pmk¨£õmkU Pmhø©¨¦PÒ 

C¸UQßÓÚ.

 ² J¸ ö|Ô•øÓ°À C¸US® ]» £iPøÍ AÀ»x GÀ»õ¨ £i 

PøÍ²® Kº Bµ®£¨ £i°¼¸¢x CÖv¨ £i ÁøµUS® •øÓ÷¯ 

|øh•øÓ¨£kzuÀ  öuõh› (Sequence) GÚ¨£k®.

 ² J¸ {£¢uøÚø¯z v¸¨v£kzu¾US AÀ»x v¸¨v¨£kzuõø©US 

HØ£ |øh•øÓ¨£kzu ÷Ási¯ £i ¯õöuÚz wº©õÛUS® \¢uº¨£® 

öu›Ä (Selection) GÚ¨£k®. 

 ² J¸  ö|Ô•øÓ°À  Ch®ö£Ö®  J¸  £i  AÀ»x ]» £i•øÓPÒ 

AÀ»x  J¸ {£¢uøÚ v¸¨v¯õUP¨£k® ÁøµUS® AÀ»x v¸¨v 

¯õP  C¸US®  ÁøµUS®   AÀ»x   v¸®£z  v¸®£   |øhö£ÖuÀ 

«Òö\¯À (Repetition)  GÚ¨£k®. 

 ² J¸ ©õÔø¯ AÀ»x ©õÔ¼ø¯ AÀ»x  ö\´{µø» AÔ•Pg ö\´¯¨ 

£¯ß£kzu¨£k® ö£¯º Aøh¯õÍ[Põo BS®. 

 ² ö\´{µø» |øh•øÓ¨£kzx®÷£õx AÔ•Pgö\´ÁuØPõP JxUP¨ 

£mh ö£Ö©õÚ[PÒ ©õÖuø» AÔ•Pg ö\´ÁuØS ©õÔ GßÝ® 

ö£¯º £¯ß£kzu¨£k®.

 ² £ìPõÀ Gß£x Kº E¯º©mha ö\´{µÀ ö©õÈ¯õS®'

 ² J¸ ÷PõøÁö¯õßÔß _¸USu»õÚx ÂøÚUSÔPÎß  •ßÝ›ø© 

JÊ[S•øÓU÷PØ£ |øhö£ÖQßÓx.

 ² C¯¢vµ ö©õÈ²® J¸[S÷\º¨¦ ö©õÈ²® RÌ ©mha ö\´{µÀ ö©õÈ 

PÍõPU P¸u¨£kQßÓÚ.

 ² £ìPõÀ, ÷£]U, ^, áõÁõ GßÝ® ö©õÈPÒ E¯º ©mha ö\´{µÀ 

ö©õÈPÐUS Euõµn[PÍõS®.

 ² C¯¢vµö©õÈ°À GÊu¨£mh ö\´{µø» ÷|µi¯õP •øÓÁÈ¯õUPz 

vØSa ö\¾zu»õ®. 

 ² C¯¢vµö©õÈ uÂº¢u ÷ÁöÓ¢uU PoÛ ö©õÈ°¾® GÊu¨£mh 

ö\´{µø»a ö\¾zx •ß£õP C¯¢vµö©õÈ AÔÄÖzuÀPÍõP 

©õØÖuÀ ÷Ásk®.

 ² Á›ö©õÈ©õØÔ  (Interpreter), öuõS¨¤ (Compiler) BQ¯Ú C¸ ö©õÈ 

ö£¯º¨¦a ö\´{µÀPÍõS®.

ö£õÈ¨¦
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•øÓø© £ØÔ¯ AÔ•P® 

¯õ÷uÝö©õ¸  ö£õx ÷|õUPzøu AøhÁuØöPÚ  Cøhz öuõhº¦PøÍU 

öPõsh TÖPÎß öuõS¨÷£ •øÓø© GÚ¨£k®.

R÷Ç E¸ 2.1 CÀ Põmh¨£mkÒÍ Ãv ö\¨£Ûk® ö£õÔ°ß £SvPÒ JßÖ 

höÚõßÖ Cøhzöuõhº¦PøÍU öPõsi¸UPÂÀø». BP÷Á, CuøÚ¨ 

£¯ß£kzv Ãv ö\¨£Ûk® £oø¯a ̂ µõP ÷©ØöPõÒÍ •i¯õx. E¸ 2.2 CÀ 

Põmh¨£mkÒÍ ö£õÔ JßÖhöÚõßÖ Cøhzöuõhº¦PøÍU öPõsi¸¨ 

£uÚõÀ Cuß‰»® Ãv ö\¨£Ûk® £oø¯ ^µõP ÷©ØöPõÒÍU Ti¯uõP 

EÒÍx. CÁØÖUPø©¯ E¸ 2.2 CÀ Põmh¨£mkÒÍ  ö£õÔ, •øÓø©ö¯õß 

ÓõPz (öuõSv) öuõÈØ£kQÓx GÚ»õ®.

     

E¸ 2.1                                           E¸ 2.2   

C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

•	 •øÓø© GßÓõÀ GßÚöÁÚ AÔ•Pg ö\´¯Ä®

•	 •øÓø©°¾ÒÍ TÖPÐUS Cøh°»õÚ öuõhºø£ ÂÍUPÄ® 

•	 øP•øÓz uPÁÀ •øÓø©, PoÛz uPÁÀ •øÓø© BQ¯ÁØøÓ 

ÂÍUPÄ®

•	 •øÓø© Â¸zv B²Ò Ámhzøu ÂÍ[QU öPõÒÍÄ®

•	 •øÓø© Â¸zv B²Ò Ámhzvß £i•øÓPÒ ©ØÖ® AÁØÖU 

Qøh°»õÚ öuõhº¦PøÍ ÂÍUPÄ® 

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

2'1 uPÁÀ •øÓø© £ØÔ¯ GsnUP¸

Ãv ö\¨£Ûk® ö£õÔ

2 uPÁÀ •øÓø© Â¸zva ö\¯ß•øÓ



  C»Á\¨ £õh¡À64

•øÓø©ö¯õßÔß Ai¨£øhU TÖPÒ

J¸ •øÓø© ‰ßÖ Ai¨£øhU TÖPøÍU öPõsi¸US®. AøÁ¯õÁÚ :
1' EÒÏk

2' •øÓÁÈ¯õUP®

3' öÁÎ±k

•øÓø©ö¯õßÖUS EÒÏmøh ÁÇ[S®÷£õx £À÷ÁÖ •øÓÁÈPÒ  ‰» 

©õP öÁÎ±møh ÁÇ[S®.

Output
öÁÎ±k

Input
EÒÏk

         Processing 
   •øÓ ÁÈ¯õUP®

E¸ 2.3 •øÓø©ö¯õßÔß Ai¨£øhU TÖPÒ (Basic components of a system)

Euõµn® - 1 - £õh\õø»ø¯ J¸ •øÓø©¯õPU öPõÒ÷Áõ®

•øÓø©   - £õh\õø»

÷|õUP®    -  |õmkU÷PØÓ |Ø¤µø\PøÍ E¸ÁõUSuÀ 

EÒÏk       - ¤ÒøÍPÒ

•øÓÁÈ¯õUP®     - £õh\õø»°À B]›¯ºPÒ, ©ØÖ® HøÚ¯  

                     ÁÍ[PÎß CøhÂøÚ öPõsh |hÁiUøPPÒ  

                             Põµn©õP ¤ÒøÍPÒ PØÓÀ ö\¯ß•øÓ°À  

    Dk£hÀ.

öÁÎ±k              |Ø¤µø\PÒ |õmkUSU QøhzuÀ

Euõµn® - 2 -  ÁÎ©sh» A•UP®, öÁ¨£{ø», PõØÔß vø\, Dµ¨ 

£uß BQ¯ uµÄPøÍ EÒÎmhx® Põ»{ø» GvºÄTÓÀ 

uPÁÀ •øÓø© J¸ |õøÍ¯ ÁõÛø» GvºÄTÓ¼øÚ 

Á¸ÂøÍÁõPz u¸uÀ. Cz uPÁÀPÒ ‰»® |õ® wº©õÚ[ 

PøÍ ÷©ØöPõÒÍU Ti¯uõP C¸US®.

uPÁÀ •øÓø©
uµÄPøÍ, uPÁÀPÍõP ©õØÖ® •øÓø©÷¯ uPÁÀ •øÓø© (Information 

System) GÚ¨£k®.

uPÁÀ

(Information)

uµÄ

(Data)
•øÓ 

ÁÈ¯õUP®

(Processing) 

E¸ 2.4 
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uPÁÀ •øÓø©PÒ ¤µuõÚ©õP  øP•øÓz uPÁÀ  •øÓø© (Manual System) 
PoÛø¯ Ai¨£øh¯õPU öPõsh uPÁÀ •øÓø© (Computer Based 
Information System) GÚ ÁøP¨£kzu¨£k®.

øP•øÓz uPÁÀ •øÓø©

C®•øÓø©°À GÀ»õ •øÓÁÈ¨£kzuÀPÐ® |£ºPÎß øPPÍõÀ ÷©Ø 

öPõÒÍ¨£k®.

Euõµn® - £õh\õø»°À ©õnÁº AÝ©v ö£Ö® øP•øÓz uPÁÀ 

•øÓø©ø¯ ÷|õUS÷Áõ®. 

¤ÒøÍø¯¨ £õh\õø»US AÝ©vzux® A¢u¨ ¤ÒøÍUS›¯  ÷\ºÂ»UP® 

ÁÇ[P¨£k®. AÁµx uÛ¨£mh uPÁÀPÒ Ah[Q¯  ÷PõøÁö¯õßÖ®       

u¯õ›UP¨£k®. £õh\õø»U Põ»zvÀ AÁº ö£ØÓ AøhÄPÒ, öÁØÔPÒ 

÷£õßÓÚ  C¢u _¯ÂÁµU  ÷PõøÁ°À £v¯¨£k®.  H÷uÝö©õ¸ \¢uº¨£zvÀ 

©õnÁöµõ¸Á›ß Ph¢uPõ» AøhÄPÒ £ØÔ¯ uPÁÀPÒ Av£¸USz  

÷uøÁ¨£kQÓx GÚU öPõÒ÷Áõ®. Auß EÒÏk, •øÓÁÈ¯õUP®, 

Á¸ÂøÍÄ BQ¯Ú ¤ßÁ¸©õÖ Aø©¢v¸US®.   

EÒÏk

¤ÒøÍ°ß ö£¯º, E›¯ Á¸h®

•øÓÁÈ¯õUP®

1. ¤ÒøÍUS›¯ ÷\ºÂ»UPzøu ÁÇ[SuÀ

2. A¢u ÷\ºÂ»UPzxUS›¯ ÷PõøÁPøÍ CÚ[PõnÀ

3. A¢uU ÷PõøÁPÎÀ E›¯ Á¸h[PÎß ö£Ö÷£ÖPÒ £ØÔ¯ ÂÁµ[PøÍ¨ 

ö£ÓÀ

4. A¢u uPÁÀPÎß xøn²hß AÔUøP u¯õ›zuÀ

Á¸ÂøÍÄ

E›¯ Á¸hzxUPõÚ ¤ÒøÍ°ß AÔUøP

  

ö\¯Ø£õk    

÷©Ø£i uPÁÀ •øÓø© øP•øÓz uPÁÀ •øÓø©ö¯õßÔØS¨ 

£v»õP  PoÛz  uPÁÀ  •øÓ¯õP  EÒÍöuÚU  öPõÒP. ÷©Ø£i

©õnÁµx uPÁÀPøÍ øP•øÓz uPÁÀ •øÓø© ‰»•®, PoÛ 

•øÓz uPÁÀ •øÓø© ‰»•® uÛzuÛ¯õP ÷©ØöPõÒÁuß 

AÝT» ¤µvT»[PøÍ J¨¤kP.
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PoÛø¯ Ai¨£øh¯õPU öPõsh uPÁÀ •øÓø©
PoÛ ‰»® uµÄPÒ uPÁÀPÍõP ©õØÓ¨£k® •øÓø©÷¯ PoÛz uPÁÀ 

•øÓø© GÚ¨£k®.

PoÛ©¯¨£kzu¨£mh £õh\õø» ¡»P •øÓø©ö¯õßøÓU P¸xP. Cuß 

‰»©õP ¡»P¸USU QøhUS® £¯ßPÒ Á¸©õÖ

•	 SÖQ¯ ÷|µzvÀ SÔ¨¤mh  ¡À EÒÍuõ GÚÄ®, EÒÍöuÛß Ax 

C¸US® Ch® BQ¯ÁØøÓ²® AÔ¯ •iuÀ.

•	 £møhU SÔ•øÓ (Barcode System) ‰»©õP ¦zuP[PÎøÚ CµÁÀ ÁÇ[PÀ 

öuõhº£õÚ uPÁÀPøÍ¨ ÷£n•iuÀ.

•	 ¦zuP[PÐUPõÚ uõ©uU Pmhnzøu C»SÁõPU Po¨¤h •iuÀ. 

•	 ©õnÁ¸US ÂøÚzvÓÚõP ¦zuP[PøÍ ÷ui¯Ô¯ C»SÁõuÀ.

•	 ¡ÀPøÍ CµÁÀ ö£ØÓÁºPÎß ÂÁµ[PøÍ •øÓ¯õP¨ ÷£n •iuÀ.

•	 E›¯ vPv°À ¦zuP[PøÍ «ÍU øP¯ÎUPõ÷uõµx £mi¯ø»z u¯õ›UP 

•iuÀ.

•	 ¡À{ø»¯z öuõhµÓõ •øÓø© (Online System) ‰»©õP, ¡»P® öuõhº£õÚ 

uPÁÀPøÍ ÁÇ[P •iuÀ.

•	 A[PzuÁºPÐUS  C»zvµÛ¯À ¡ÀPøÍ (e books) ÁÇ[P •iuÀ.

•	 ¤µuõÚ Põ›¯õ»¯zxhß Áø»¯ø©¨¦USÒÍõUP¨£mi¸¨£uõÀ Âk 

øP¨ £zvµ® ÁÇ[S® \¢uº¨£[PÎÀ  ¡ÀPøÍ J¨£øhzu / J¨£øhU 

Põu ÂÁµ[PøÍ  AÔ¯ •iuÀ.

ö\¯Ø£õk    

♦	 ÷©ØTÓ¨£mh AÝT»[PøÍz uÂµ ©õnÁºPÐUSU QøhU 

S® ÷ÁÖ AÝT»[PøÍ¨  £mi¯Ø£kzxP.

øP•øÓ  ©ØÖ®  PoÛz  uPÁÀ  •øÓPÐUS  Cøh°»õÚ  ¤µuõÚ 

÷ÁÖ£õkPÒ

øP•øÓz uPÁÀ •øÓø© PoÛz uPÁÀ •øÓø©

•øÓÁÈ¯õUPzvß ‰»® uPÁÀPøÍ¨ 

ö£Ö®÷£õx uÁÖPÒ HØ£h»õ®

u¯õ›UP¨£mh ö\´{µÀ ‰»® 

uPÁÀPÒ ö£Ó¨£kÁuõÀ uÁÖ 

PÒ HØ£kÁuØPõÚ Áõ´¨¦ ªPU 

SøÓÄ
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uPÁÀPøÍ •øÓÁÈ¨£kzu AvP Põ»® 

÷uøÁ¨£k®

SÖQ¯  Põ»zvÀ  •øÓÁÈ¨ 

£kzu»õ®

uµÄPøÍ ÷\ªUP AvP ChÁ\v ÷uøÁ¨ 

£kÁxhß BÁn[PøÍ¨ ÷£qÁuØS 

A¾©õ› AÁ]¯©õS®.

ªPa ]Ô¯ Ch¨£µ¨¤À AvP 

AÍÁõÚ uµÄPøÍ¨ ÷£n •i 

Áxhß CuØöPÚ uµÄz uÍ 

ö©ßö£õ¸Ò £¯ß£kzu¨£k®.

£À÷ÁÖ PõµoPÎÚõÀ uµÄPÒ AÈÁøh 

¯»õ®. PoÛz uPÁÀ •øÓø©÷¯õk 

J¨¤k®÷£õx £õxPõ¨¦U SøÓÁõÚ 

uõS®.

Põ¨¦ (Backup) •øÓø©°Ý 

hõPÄ®  PhÄaö\õÀø» Ck 

Áuß ‰»‰® uµÄPøÍ¨ £õx 

Põ¨£õP¨ ÷£n»õ®

2'2  •øÓø©  Â¸zva ö\¯ö»õÊ[S

uPÁÀ •øÓø© Â¸zv°À £À÷ÁÖ •øÓPÒ £¯ß£kzu¨£k®. 

CÁØÖÒ •øÓø© Â¸zv B²Ò Ámh® (System development life cycle) 
¤µuõÚ©õÚuõS®.

 
Cx £» £iPøÍU öPõshx.

1'  ÷uøÁPøÍ CÚ[PõnÀ (Identification of requirements)
2' wºÂøÚ ÁiÁø©zuÀ (Designing the solution)
3' wºÂøÚU SÔ•øÓ¨£kzuÀ (Coding of the solution)
4' wºÂøÚa ÷\õvzx¨ £õºzu¾® uÁÖ }USu¾® (Testing and debugging)
5' wºÂøÚ |øh•øÓ¨£kzuÀ (Deployment of  the solution)
6' •øÓø©ø¯¨ £µõ©›zuÀ (Maintenance of the system)

•øÓø©ö¯õßøÓ {ÖÂ¨ £¯ß£kzx®÷£õx ¦v¯ ÷uøÁPÒ HØ£h»õ®. 

AÆÁõÓõÚ \¢uº¨£[PÎÀ •u»õ® £i•øÓUS «sk® ö\ßÖ ÷uøÁø¯ 

{øÓÄ ö\´ÁuØS C¢u ö\¯ß•øÓø¯ «Ía ö\´¯ ÷Ásk®.

•øÓø© Â¸zv B²Ò Ámhzvß £iPÒ

1' ÷uøÁPøÍ CÚ[PõnÀ (Identification of requirements)
 

Cuß÷£õx HØPÚ÷Á EÒÍ øP•øÓz uPÁÀ •øÓø©°øÚ÷¯õ AÀ»x 

u¯õ›UP¨£h ÷Ási¯ uPÁÀ •øÓø© £ØÔ÷¯õ |ßS Bµõ´Áx AÁ]¯ 

©õS®. ¦v¯ •øÓø©°ß ÷|õUP®, AÝT»[PÒ, ÂøÚzvÓß BQ¯Ú 

£ØÔ¯ GÊzx‰»U SÔ¨¦PÒ ÷£n¨£k®.  {ÖÁÚ¨ £o¯õmPÒ, •øÓø© 

Â¸zv ~m£Â¯»õÍºPÒ C¸\õµõ¸® Cøn¢x CuøÚ ÷©ØöPõÒÁº. 

2'2'1  º¬ø¬ñ M¼ˆF õ£›‚¬è õ†ì‹
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C¢u¨ £i°À, •øÓø©¨ £S¨£õ´ÁõÍ›ÚõÀ (System analyst) HØPÚ÷Á 

EÒÍ •øÓø© £ØÔ ÂÁµ©õP Bµõ¯¨£mk ¦vuõP EÒÍ ÷uøÁPÒ CÚ[ 

Põn¨£k®. £¯|º ÷uøÁø¯ {øÓ÷ÁØÖÁuØöPÚ uPÁÀPøÍ ÷\P›UP 

÷Ási HØ£k®. uPÁÀPÒ £» ÁÈPÎÀ ÷\P›UP¨£h»õ®. AÁØÖm ]» 

Á¸©õÖ.

      1& AÁuõÛ¨¦ (Observation) 

2& ÷|ºPõnÀ (Interview)

3& ÂÚõUöPõzx (Questionnaire)

4& £vÄPÒ, ©ØÖ® BÁn[PøÍ Bµõ´uÀ (Document sample collection)

5& ‰»ÁøP©õv› E¸ÁõUP® (Prototyping)

1&  AÁuõÛ¨¦ 

•øÓø© Â¸zv Bµ®£ {ø»°À |øh•øÓ°¾ÒÍ EÒÍ •øÓø©ø¯ 

AÁuõÛ¨£uß ‰»® uPÁÀ ÷\P›UP¨£k®. Cx ¦v¯ •øÓø© SÔzx 

Gk÷PõÒPøÍ ÷©ØöPõÒÁuØPõP •UQ¯©õÚx.

Euõµn® : ¡»PzxUSa ö\ßÖ, ¡»Pº ¡ÀPøÍ Â{÷¯õQUS® Âuzøu   

      AÁuõÛzuÀ.

2&  ÷|ºPõnÀ

Ez÷u\ •øÓø©°øÚ¨ £¯ß£kzu EÒÍÁºPÎøÚ ÷|¸US÷|º \¢vzx 

ÂÚõUPøÍU ÷Pm£uß  ‰»® QøhUS® ÂøhPÒ £S¨£õ´Ä ö\´¯¨£k®. 

£¯ÚºPÎß ©Ú¨£õ[S öuõhº£õP öÁÎ¨£øh¯õP AÔuÀ C[S ÷©Ø 

öPõÒÍ¨£k®.

Euõµn® : ¡»Pøµa \¢vzx AÁ›h® ÷|ºPõnÀ ÷©ØöPõÒÍÀ.

3& ÂÚõUöPõzx

Pmhø©¨¦ ÂÚõUPÒ  ‰»®, GÊzx ‰» ÂøhPÒ  ö£Ó¨£mk AøÁ 

£S¨£õ´Ä ö\´¯¨£mk uPÁÀPÒ ö£Ó¨£k®. 

Euõµn® : u¯õ›UP¨£mh ÂÚõUöPõzøu ¡»P›h® öPõkzx AÁØøÓ¨   

       §ºzv ö\´¯a ö\´uÀ. 

4& AÔUøP, ÷PõøÁPøÍ¨ £Ÿm]zuÀ 

{ÖÁÚzv¾ÒÍ AÔUøPPÒ, ÷PõøÁPÒ BQ¯ÁØøÓ AÁuõÛzx uPÁÀ 

ö£Ó¨£k®.

Euõµn® : ¡»P AÔUøPPÒ, ¡»P AmøhPÒ BQ¯Ú öuõhº£õÚ                                   

      uPÁÀPøÍ¨  ö£ÖuÀ.
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5& ‰»ÁøP ©õv›ø¯U Põm]¨£kzuÀ

{ÖÁ EÒÍ •øÓø©°ß ©õv›ø¯ £oUSÊÂÚ¸USU Põm]¨£kzv AÁº 

PÍx P¸zxUPÒ ö£Ó¨£k®.

Euõµn®& ¦v¯ ¡»P •øÓ°¾ÒÍ Âh¯[PøÍU Põm]¨£kzu, AÔUøPPÒ, 

©õv›PÒ BQ¯ÁØøÓU PõmkuÀ.

2' wºÂøÚ ÁiÁø©zuÀ (Designing the solution)

 Cx •øÓø© A¤Â¸zv B²Ò Ámhzv¾ÒÍ HøÚ¯ 

•øÓPøÍ Âh ÷ÁÖ£mhuõS®. •øÓø©°ß £À÷ÁÖ 

£mh Âh¯[PÒ C[S vmhªh¨£k®. Cuß÷£õuõÚ 

ö\¯Ø£õkPÒ ]» Á¸©õÖ.

1.  ö©ßö£õ¸øÍ AÔ•Pgö\´uÀ, ö©ßö£õ¸Ò Pmhø©¨ø£ (Software  

architecture) CÚ[PõnÀ

2.  £¯|º Cøh•P® (User interface) Põm]¯ÎUS® Âu•® uµÄPøÍa                       

÷\ªzu¾®

3.    ¤µuõÚ ÁßTÖPÒ ©ØÖ® AÁØÔ¾ÒÍ TÖPøÍ CÚ[PõnÀ

4.   JÆöÁõ¸ E£öuõSvUS® Cøh°»õÚ ö£õ¸zu¨£õmøh CÚ[PõnÀ

5.  •øÓø©ø¯a ö\¯Ø£kzu¨ ö£õ¸zu©õÚ ö©ßTÖPÒ, ÁßTÖPÒ BQ¯ 

ÁØøÓz wº©õÛzuÀ

6.  ö©ßö£õ¸Ò, uµÄz ÷uUPP®, Cøh•P® BQ¯ EmPmhø©¨¦PøÍz    

wº©õÛzuÀ

7.  ÷\õuøÚz vmhzvøÚ (Test plans) ÷©ØöPõÒÍÀ

3' wºÂøÚ SÔ•øÓ¨£kzuÀ (Coding  the solution)

ö\´{µ¾US HØÓ PoÛ ö©õÈø¯¨ £¯ß£kzv vmhªh¨£mh •øÓ 

ø©ø¯U SÔ•øÓ¨£kzuÀ C¢u¨ £i°ß ¤µuõÚ ÷|õUP©õS®. SÔ•øÓPÒ 

GÎø©¯õPÄ® ÂøÚzvÓÚõPÄ® Aø©ÁuÚõ¾® AÁØøÓ ÂÍ[QU 

öPõÒÁx® SÔ•øÓ¨£kzu¾® C»SÁõS®. •øÓø©ø¯ ö\ÆøÁ¯õPU 

SÔ•øÓ¨£kzxÁuß ‰»® •øÓø©ø¯¨ £Ÿm]zuÀ, £µõ©›zuÀ 

BQ¯ÁØÖUPõÚ ö\»Ä® ÷|µ•® «u©õS®. 
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C¨£i°ß ¤µuõÚ ÷|õUP® •øÓø©°À EÒÍ uÁÖPøÍ  

}USu»õS®. SÔ•øÓz uÁÖPÒ, vmhz uÁÖPÒ AÀ»x 

\¢uº¨£z uÁÖPÒ  C[S }UP¨£k®. Cuß‰»® uµ® 

EÖv¨£kzu¨£k®.

•øÓø© £Ÿm]UP¨£k®  £iPÒ £» EÒÍÚ. AÁØÔÀ 

]» Á¸©õÖ:

A»Sa ÷\õuøÚ

•Êø©a ÷\õuøÚ 

    •øÓø©a ÷\õuøÚ

HØ¦øhø©a ÷\õuøÚ
  

E¸ 2.5 •øÓø©ø¯ ÷\õvUS® Âu[PÒ

1&  A»Sa ÷\õuøÚ (Unit Testing)

•øÓø©°ß JÆöÁõ¸ TÖ®  ÷ÁÖ÷ÁÓõPa ÷\õvU 

P¨£k®. Cuß÷£õx, SÔzu A»QÀ ÷©ØöPõÒÍ¨£k® 

EÒÏkPÐUS HØÓ Á¸ÂøÍÄPÒ ö£Ó¨£kQßÓuõ GÚa 

÷\õvUP¨£k®.

Euõµn®& A¾Á»Pzvß {vUQøÍ, {ÖÁÚUQøÍ, BQ¯ÁØøÓ öÁÆ 

÷ÁÓõPa ÷\õvzuÀ

2&  J¸[Qøn¨¦a ÷\õuøÚ (Integration Testing)

÷©Ø£i ÷\õuøÚ°À JÆöÁõ¸ A»S®  E›¯ •øÓ°À 

JßÔønUP¨£mk £Ÿm]UP¨£k®. EÒÎh¨£mh uµÄ 

PÐUS HØ£ Cøh•P©õÚx £Ÿm]UP¨£k®.

4' wºÂøÚa ÷\õvzu¾® uÁÖ }UP¾® (Testing and debugging)
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3&  •øÓø©a ÷\õuøÚ  (System Testing)

Cuß÷£õx •Êø©¯õÚ •øÓø©US® E›¯ EÒÏk 

PÎØS  Gvº£õºzu Á¸ÂøÍÄPÒ QøhUP¨ ö£ØÓÚÁõ 

GÚ¨ £Ÿm]UP¨£k®. PÁÚ® ö\¾zu ÷Ási¯ \¢uº¨ 

£[PÒ,  Â¸zv •øÓø©°ß Emö\¯Ø£õkPÒ BQ¯Ú 

C[S P¸zvØ öPõÒÍ¨£k®.

4&  HØ¦øhø©a ÷\õuøÚ (Acceptance Testing)

•øÓø©a ÷\õuøÚPÒ AøÚzx® §ºzv¯õQ uÁÖPÒ 

v¸zu¨£mh ¤ßÚº CÖv°À ÷©ØöPõÒÍ¨£k® ÷\õu 

øÚ÷¯ HØ¦øhø©a ÷\õuøÚ GÚ¨£k®. C¢ua ÷\õuøÚ 

°ß÷£õx •øÓø©°øÚ¨ £¯ß£kzu EÒ÷Íõ›ØS 

•øÓø© ö\¯Ø£kzvU  Põmh¨£k®.  Cuß÷£õx  £¯Úº  

Ez÷u\ •øÓø©ø¯ HØÖUöPõÒÍ÷Áõ AÀ»x  ÷©¾® 

]» ^ºv¸zu[PÒ ÷©ØöPõÒÍ¨£h ÷Áskö©Ú÷Áõ 

öu›ÂUP Ch•sk.    

  

uÁÖ }UP¨£mh ¦v¯ •øÓø©ø¯ {ÖÄuÀ C¢u¨ £i°À 

÷©ØöPõÒÍ¨£k®. 

•øÓø©ø¯ {ÖÄ® •øÓPÒ Á¸©õÖ :

1& ÷|µi¯õPa ö\¯Ø£kzuÀ  (Direct Implementation)

2& \©õ¢uµ©õPa ö\¯Ø£kzuÀ (Parallel Implementation)

                    3& öÁÒ÷Íõmh •øÓa ö\¯Ø£kzuÀ (Pilot Implementation)

                    4& Pmh[PÍõPa ö\¯Ø£kzuÀ (Phase Implementation)

÷|µi¯õPa  ö\¯Ø£kzuÀ (Direct Implementation)

£øÇ¯ •øÓø©°ß ö\¯Ø£õmøh •Êø©¯õP {Özv 

¦v¯ •øÓø© ö\¯Ø£kzu¨£k®. ¦v¯ •øÓø©  öÁØÔ 

¯Î¨¤ß Ax öuõhµ¨£k®.

5.  •øÓø©ø¯ {ÖÄuÀ  (Deployment of the system)
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Euõµn® : ¡»P øP•øÓ uPÁÀ •øÓø©ø¯ •Êø©¯õP  {Özv  ¡»P 

•Põø© ö©ßö£õ¸øÍ (Library management software)  {ÖzuÀ.

\©õ¢uµ©õPa ö\¯Ø£kzuÀ (Parallel Implementation)

Cuß÷£õx uØ÷£õx £õÁøÚ°À EÒÍ •øÓø© 

©ØÖ® ¦v¯ •øÓø© BQ¯Ú J÷µ ÷|µzvÀ 

\©õ¢uµ©õPa ö\¯Ø£kzu¨£k®. ¦v¯ •øÓø© 

öÁØÔPµ©õP Aø©²©õ°ß £øÇ¯ •øÓø© 

{Özu¨£mk ¦v¯ •øÓø© ö\¯Ø£kzu¨£k®.

Euõµn® : £øÇ¯  ¡»P   •øÓø©  ö\¯Ø£kzu¨£k® A÷u÷ÁøÍ ¦v¯ 

•øÓø©²® {ÖÂa ö\¯Ø£kzuÀ

öÁÒ÷Íõmh •øÓa ö\¯Ø£kzuÀ (Pilot Implementation)

C¢u •øÓø© ]Ô¯ ¤µ÷u\ö©õßÔÀ •u¼À 

{ÖÁ¨£k®. Cuß÷£õx •Êø©¯õÚ •øÓø© 

öu›Äö\´¯¨£mh ©õÁmhzvÀ •u¼À {ÖÁ¨ 

£mk ö\¯Ø£kzuÀ ÷©ØöPõÒÍÀ.

Euõµn® :  ÁõPÚ Á¸©õÚÁ› AÝ©v¨£zvµ® öuõhº£õPz u¯õ›UP¨£mh 

•øÓø© •u¼À  J¸ ©õPõnzvØS ©mk® {ÖÁ¨£mk 

¤ßÚº  •Ê ©õPõn[PÐUS® {ÖÁ¨£hÀ.

Pmh[PÍõPa ö\¯Ø£kzuÀ (Phase Implementation)

C[S öu›Äö\´¯¨£mh £SvPÒ Pm-

h[PÍõP uÛzuÛ÷¯ ¤µ÷u\zvÀ AÀ»x 

QøÍ°À £i¨£i¯õP {ÖÁ¨£k®.

£øÇ¯ 

•øÓø©

¦v¯ 

•øÓø©

¦v¯ 

•øÓø©

£øÇ¯ 

•øÓø©
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Euõµn® :  ¦v¯ ¡»P •øÓø©ø¯ {ÖÂ Auß ¤ßÚº Ax £õh\õø» 

•Põø©zxÁ •øÓø©²hß öuõhº¦£kzu¨£hÀ.

6' •øÓø©ø¯¨ £µõ©›zuÀ (Maintenance of the system)
  

¦v¯ •øÓø©ø¯ {ÖÂ¯ ¤ßÚº •øÓø©ø¯U 

SÔ¨¤mh Põ»® Áøµ £µõ©›zuÀ ÷Ásk®.  

•øÓø©¨ £µõ©›¨¤ß÷£õx PoÛ, PoÛ 

Áø»¯ø©¨¦, PoÛ ö©ßö£õ¸ÒPÒ BQ¯ 

ÚÄ® £µõ©›UP¨£k®. 

•øÓø©ø¯¨  £µõ©›US®÷£õx  Â¸zv  ö\´¯¨£mh  •øÓø©°À 

÷©ØöPõÒÍ¨£h  ÷Ási¯  ©õØÓ[PÒ  Á¸©õÖ :

•	 ¦vuõP CÚ[Psh £¯|º ÷uøÁPøÍ •øÓø©°À Em£kzuÀ

•	 •øÓø©ø¯¨ £Ÿm]US®÷£õx CÚ[Põn¨£hõux® •øÓø©ø¯a 

ö\¯Ø£kzx®÷£õx CÚ[Põn¨£mhx©õÚ ]Ö ¤µa]øÚPÐUSz wº 

ÂøÚ ÁÇ[SuÀ

•	 |ÃÚ öuõÈÝm£ ÷©®£õmøh •øÓø©°À ¦SzxuÀ ‰»® •øÓ 

ø©°ß ÂøÚzvÓøÚ ÷©®£kzuÀ

2'2'1 º¬ø¬ñ M¼ˆF ñ£FKòƒèœ

•øÓø© Â¸zv B²Ò ÁmhzvÀ £À÷ÁÖ ©õv›¯[PÒ EÒÍÚ. Cv¾ÒÍ 

JÆöÁõ¸ ©õv›¯zvß ‰»©õPÄ® •øÓø© Â¸zv AqS•øÓ £À÷ÁÖ 

ÁÈPÎÀ |øh•øÓ¨£kzu¨£k®.

1. }ºÃÌa] ©õv›¯® (Waterfall Model)

2. Fhõmh Â¸zv ©õv›¯® (Iterative Incremental Model)

3. ‰»ÁøP ©õv›¯® (Prototype Model)

4. _¸Î²¸ ©õv›¯® (Spiral Model)

}ºÃÌa] ©õv›¯® (Waterfall Model)
}ºÃÌa] ©õv›¯zxUS Á»¯ •øÓø©  Â¸zv uPÁÀ •øÓø© Euõµn 

©õS®. B²ÒÁmh¨ £i•øÓPÒ ÷|º÷PõmiÀ |øh•øÓ¨£kzu¨£hÀ }º 

ÃÌa] ©õv›¯® ‰»® Põmh¨£k®. C¢u ©õv›¯zxUPø©¯ •øÓø©ø¯ 

E¸ÁõUS®÷£õx PÁÛUP ÷Ási¯øÁ Á¸©õÖ.
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♦ •u¼À ÷uøÁPÒ |ßS CÚ[Põn¨£h ÷Ásk®.

♦ J¸ £i•øÓ §µn©õÚ ¤ßÚ÷µ Akzu £i•øÓ Bµ®¤UP¨£h ÷Ásk®.

♦ Â¸zvö\´²® •øÓø©°ß CÖv¨ ö£Ö÷£ØøÓ CÖvU Pmhzv÷»÷¯   

   Põn•i²®. Cuß Põµn©õP Gvº£õµõu ö£Ö÷£ÖPÒ QøhUP»õ®.

       

      

E¸ 2'6

÷uøÁPøÍ     

CÚ[PõnÀ

    wºÂøÚz                          

   vmhªhÀ

wºÂøÚ |øh 

•øÓ¨£kzuÀ

wºÂøÚ ÷\ªz

u¾® ö\ÆøÁ¯õU 

P¾®

•øÓø©ø¯        

{ÖzuÀ

•øÓø©ø¯¨  

  £µõ©›zuÀ
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Fhõmh Â¸zv ©õv›¯® 

               

÷uøÁPøÍ CÚ[PõnÀ 

(Identification of Require-
ments)

vmhªhÀ 

(Planning)

Bµ®£z 

vmhªhÀ (Initial 
Planning)

©v¨¥k (Evalution)
÷\õvzuÀ 

(Testing)

{ÖÄuÀ

(Deployment)

|øh•øÓ¨£kzuÀ

(Implementation)

£S¨£õ´Ä® •ß vmhªh¾®

(Analysis and Designing)

E¸ 2'7  Fhõmh Â¸zv B²Ò Ámh® & }ºÃÌa] ©õv›²¸

C¢u ©õv›¯zvß C¯À¦PÒ Á¸©õÖ

♦  C¢u Â¸zv ©õv›¯zvß ¤µuõÚ ÷|õUP® J¸ uhøÁ°À ]Ö £SvPÍõP 

«sk® «sk® FhõmhzxUSÒÍõÁx® AÆÁõÓõÚ GÀ»õ Fhõm 

h[PÎß ÷£õx® ÷©®£kzu¨£k® (Incremental) ÁøP°»õÚ •øÓø©ø¯ 

Â¸zv ö\´u»õS®.

♦  •øÓø©  Â¸zv¯õÍºPÒ  (System developers)  •ßøÚ¯   £i•øÓPÎÀ 

ö£ØÖU öPõsh AÔøÁ¨ £¯ß£kzu •iÁx AÝT»©õS®.

♦ •øÓø©PÎß ÷uøÁø¯ GÎø©¯õP |øh•øÓ¨£kzxÁuß ‰»©õP 

Cuß ¤µuõÚ £i•øÓ Bµ®£©õS®.

♦  •øÓø© •Êø©¯õP Â¸zv ö\´¯¨£k® Áøµ Fhõmh® ‰»® Â¸zv 

ö\´¯¨£k®.

♦ AøÚzx Fhõmh[PÎß÷£õx® •øÓø©°ß vmhzvÀ ©õØÓ[PÒ 

÷©ØöPõÒÍ¨£kÁxhß ¦v¯ ö\¯ß•øÓ²® ÷\ºUP¨£k®.
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ö\¯Ø£õk   

1' •øÓø© Â¸zv B²Ò Ámhzøu |øh•øÓ¨£kzuÀ 

•øÓö¯õßøÓ E¸ÁõUS®÷£õx Fhõmh Â¸zv ©õv›¯®, 

Á»¯ ©õv›¯® BQ¯ÁØøÓ¨ £¯ß£kzx®÷£õx AÁuõÛU 

PzuUP ¤µuõÚ ÷ÁÖ£õkPøÍz u¸P.

 ² ¯õ÷uÝ® ö£õx÷|õUQøÚ AøhÁuØöPÚ Cøh¯Óõ Fhõmh® 

öPõsh  TÖPÎß öuõS¨÷£ •øÓø© GÚ¨£k®.

 ² G¢uöÁõ¸ •øÓø©²® ‰ßÖ Ai¨£øhU TÖPøÍU öPõshÚ. 

EÒÏk, •øÓÁÈ¨£kzuÀ, Á¸ÂøÍÄ BQ¯Ú÷Á AøÁ¯õS®.

 ² uµÄPøÍz uPÁ»õP ©õØÖ® •øÓø©÷¯ uPÁÀ •øÓø© GÚ¨£k®.

 ² uPÁÀ •øÓø©¯õÚx, øP•øÓz uPÁÀ •øÓø© (Manual System), PoÛ 

©¯¨£kzu¨£mh uPÁÀ •øÓø© (Computer Based  Information System) GÚ 

Cµsk ÁøP¨£k®.

 ² ©Ûuß uÚx øPPÎÚõÀ •øÓÁÈ¯õUPzøu ÷©ØöPõsk                                         

Á¸ÂøÍøÁ¨ ö£ÖuÀ øP•øÓ uPÁÀ •øÓø© GÚ¨£k®.

 ² PoÛ ©¯¨£kzu¨£mh uPÁÀ •øÓø© (Computer Based Information System) 

GÚ¨£kÁx PoÛ ‰»® uµÄPøÍ uPÁÀPÍõP ©õØÖu»õS®.

 ² •øÓø© Â¸zv B²Ò Ámhzøu¨ £¯ß£kzv ¦v¯ •øÓø©ø¯ E¸ 

ÁõUP÷Áõ, HØPÚ÷Á EÒÍ •øÓø©ø¯ Â¸zv ö\´¯÷Áõ •i²®.

 ² •øÓø©  Â¸zv  B²Ò Ámh®  BÖ Pmh[PøÍU öPõsi¸US®. 

AøÁ¯õÁÚ

1. ÷uøÁPøÍ CÚ[PõnÀ                    (Identification of requirements)
2. wºÂøÚ ÁiÁø©zuÀ                      (Designing of the solution)

3. wºÂøÚ |øh•øÓ¨£kzuÀ             (Implementation of the solution)

4. wºÂøÚ £›÷\õvzu¾® uÁÖ }UP¾® (Testing of the solution)

5. •øÓø©ø¯ {ÖÄuÀ                       (Deployment of the solution)

6. •øÓø©ø¯ £µõ©›zuÀ                         (Maintenance of the system)

 ² •øÓø© Â¸zv ©õv›¯©õP Fhõmh •øÓø© Â¸zv B²ÒÁmh® 

£¯ß£kzu¨£k®.

ö£õÈ¨¦
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Cøn¯®  GÚ¨£kÁx  E»öP[S 

•ÒÍ  PoÛ  Áø»¯ø©¨¦PÎß 

÷\ºUøP¯õS®. E»P \‰PzuÁ 

¸hß ªP ÂøµÁõPz uPÁØ öuõhº 

£õhø» ÷©ØöPõÒÍzuUP ÁÈ 

•øÓ¯õP (Information super highway) 
Cøn¯® Aø©¯¨ö£ØÖÒÍx. 

Cøn¯¨ £¯ß£õmiß Põµn©õP 

CßÖ •Ê E»P•® §÷PõÍU 

Qµõ©©õP (Global village) ©õÔ 

²ÒÍx. ªP EßÚu©õÚ ÷\øÁø¯ BØÖ® Cøn¯zxUS uÛ²›ø©¯õÍº 

Qøh¯õx. uØ÷£õx, Cøn¯a \[P® (The Internet Society) GÝ® C»õ£ ÷|õUP® 

P¸uõ Aø©¨ö£õßÔß ‰»©õP Cøn¯¨ £¯ß£õk öuõhº£õÚ |øh 

•øÓPÒ, öPõÒøPPÒ ©ØÖ® Cøn¯z öuõÈØ£õmiØPõÚ ö\®ø©|h¨¦ 

ÁÇUS (Protocol) BQ¯Ú öuõhº£õÚ |hÁiUøPPÒ ÷©ØöPõÒÍ¨£mk 

  
C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

●	 Cøn¯a ö\´£o

●	 Cøn¯a ÷\øÁPÒ

●	 uPÁÀ ÷uhÀ

●	 ^ºø© ÁÍ Ch[Põo (URL) 

●	 Cøn¯a ö\®ø© |h¨ö£õÊ[S •PÁ› (IP •PÁ›)
●	 BÒPÍ¨ ö£¯º

●	 BÒPÍ¨ ö£¯º ÷\øÁ¯P®

●	 ö\®ø© |h¨¦ ÁÇUS

●	 ªßÚg\À

●	 PõönõÎU P¸zuµ[S

●	 \‰P Áø»zuÍ[PÒ

Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

3'1'1  Þ¬íò‹ 

3 Cøn¯® ©ØÖ® ªßÚg\À
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Á¸QßÓÚ.  E[PÒ  PoÛ°ÞhõP }[PÒ Cøn¯zxhß öuõhº¦ öPõÒÐ® 

÷£õx E[PÍx PoÛ²® Cøn¯zvÀ ÷\º¢xÒÍ PoÛ¯õP ©õÖ®. 

Cuß‰»©õP E[PÐUSz ÷uøÁ¯õÚ G¢uöÁõ¸ Âh¯® \õº¢u uPÁÀPøÍ²®  

Cøn¯zv¼¸¢x ö£ØÖUöPõÒÍ •i²®.

3'1'2 Y˜¬ñ õ÷ ÞìŠð´ˆF (URL) ðŸPò ÜPºè‹

G©x AÔøÁ ÷©®£kzu uPÁÀPÒ ªP  CßÔ¯ø©¯õuÚÁõP Aø©QßÓÚ. 

uPÁÀPøÍz ÷ukÁuØS E»QÀ Põn¨£k® ªPa ]Ó¢u  ÁÈ Cøn¯©õS®. 

uPÁÀPøÍ Cøn¯ Áø»¯ø©¨¤¾ÒÍ PoÛPÐUQøh÷¯ FkPhzx 

ÁuØS «£õh ©õØÖ ö\®ø© |h¨¦ ÁÇUS (HTTP - Hyper Text Transfer 
Protocol) £¯ß£kzu¨£k®. ÷©¾®,  HµõÍ©õÚ uPÁÀPÒ  Cøn¯zvÀ 

Ah[Q²ÒÍÚ. A¢uz uPÁÀPøÍ ÁÇ[S® ¤µuõÚ ÷\øÁ¯õP E»PÍõÂ¯ 

Áø» (Word Wide Web - WWW) Aø©¢xÒÍx. BP÷Á, E»PÍõÂ¯ Áø»°¾ÒÍ 

Áø»U Ph¨¤h[PÎÀ (Websites) uPÁÀPÒ Ah[Q²ÒÍÚ. CÆÁõÖ Áø»U 

Ph¨¤h[PÎÀ EÒÍ Cß÷ÚõµßÚ ÁÍ[PøÍz uÛzxÁ©õP CÚ[Põn 

^ºø© ÁÍ Ch¨£kzv (Uniform Resource Locater - URL) EuÄ®.

^ºø© ÁÍ Ch¨£kzv°¾ÒÍ (URL) £SvPøÍ CÚ[Põs÷£õ®

Euõµn©õP ¤ßÁ¸® ^ºø© ÁÍ Ch¨£kzvø¯ ÷|õUS÷Áõ®. 

http ://www.edupub.gov.lk/e-books/english/ict.pdf

Cv»h[Q²ÒÍ £SvPøÍ E¸ 3.1 CÀ Põmi¯ÁõÖ ÁSzx ÷|õUP •i²®. 

http://www.edupub.gov.lk/e-books/english/ict.pdf

ö\®ø© |h¨¦ ÁÇUS

(HyperText Transfer
Protocol) 

÷\øÁ

(World Wide Web)
ÁÍ® Aø©¢xÒÍ Ch®

(Path where the  
resource is located)

BÒPÍ¨ ö£¯º

(Domain name)
ÁÍU÷Põ¨¦

(Resource)

↓

↓ ↓ ↓

E¸ 3.1

PÁÛUP : ̂ ºø© ÁÍ Ch¨£kzv°À, «  £õh ö\®ø© |h¨ö£õÊ[S öuõhUP® 

BÒPÍ¨ ö£¯º Áøµ¯õÚ TÖPÒ Ah[Q°¸¨£x Pmhõ¯©õÚuõS®.
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PÀÂzxøÓ \õº¢u ^ºø© ÁÍ Ch¨£kzvPÒ  ]» Á¸©õÖ:
http://www.edupub.gov.lk  - PÀÂ öÁÎ±mkz vønUPÍ®

htt://www.moe.gov.lk   - PÀÂ¯ø©a_

http://www.nie.lk   - ÷u]¯ PÀÂ {ÖÁP®

http;www.doenets.lk   - C»[øP¨ £Ÿmø\z vønUPÍ®

3'1'3   Þ¬íò„ ªê‹¬ñ ïìŠªð£¿ƒ° (Internet Protocol address)
       ºèõK

Cøn¯zvÀ Cøn¢xÒÍ JÆöÁõ¸ PoÛø¯²® uÛzxÁ©õP 

CÚ[Põs£uØS Cøn¯ ö\®ø© |h¨ö£õÊ[S (IP) •PÁ› £¯ß£kz 

u¨£k®. C¢u Cøn¯ ö\®ø© |h¨ö£õÊ[Qß •PÁ› u\© ¦ÒÎ°ÚõÀ 

÷ÁÓõUP¨£mh 0 •uÀ 225 Áøµ¯õÚ |õßS ö£Ö©õÚ[PÎÚõÀ ÁøP 

SÔUP¨£k®. (E¸ 3.2) C¢u C»UPªhÀ •øÓ u\©U SÔ¨¦¨ ¦ÒÎ°hÀ 

(Dotted decimal notation) GÚ¨£k®.

Euõµn®   172.64.85.42
  193.213.78.154

E¸ 3.2 Cøn¯zv¾ÒÍ PoÛPøÍ CÚ[Põn IP •PÁ›¨ £¯ß£õk 

C¢u Cøn¯ ö\®ø© |h¨ö£õÊ[S •PÁ›, Cøn¯a ÷\øÁ ÁÇ[S|µõÀ 

ÁÇ[P¨£k®. (Internet Service Provider - ISP)  Cøn¯a ÷\øÁ  ÁÇ[S|º  J¸  

P®£Û¯õP  Aø©Áxhß, Cuß‰»® Cøn¯a ÷\øÁPÒ, ªßÚg\À ÷\øÁ 

÷£õßÓÚ ÁÇ[P¨£k®. C¢ua ÷\øÁPøÍ ÁÇ[SÁuØöPÚ  AUP®£Û E›¯ 

Pmhnzøu AÓÂk®.

3'1'4  Ýœè÷Š ªðò˜ (Domain name)

÷©÷» SÔ¨¤mh ̂ ºø© ÁÍ Ch¨£kzv°À Põn¨£mh  edupub.gov.lk GÝ® 

BÒPÍ¨   ö£¯øµU  P¸x÷Áõ®.  CvÀ  gov Aµ_  (Government)  Gß£øu²® 
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lk C»[øP  Gß£øu²® ÁøPSÔUQßÓÚ. 

CuØPø©¯, gov BÒPÍzxUS¨ ¤ßÚõÀ 

Ch¨£k® lk ÷©À©mh BÒPÍ¨ ö£¯µõS®. 

CÆÁõÓõP÷Á Cøn¯zv¾ÒÍ GÀ»õ Áø»U 

Ph¨¤h[PÐ® uÛzxÁ©õÚ BÒPÍ¨ 

ö£¯ºPÎÚõÀ ÁøPSÔUP¨£k®.

BÒPÍz xøÓPøÍ ÁøPSÔ¨£uØS ¤ßÁ¸® ö£¯ºPÒ £¯ß£kzu¨£k®.

   
BÒPÍ® (Domain)    AuØS›¯ ÂÍUP®

       com    Áõo£®

       org    C»õ£ ÷|õUPØÓ Aø©¨¦

       gov    Aµ_

       edu    PÀÂ

       net          Áø»¯ø©¨¦

BÒPÍzxUS›¯ |õmøh¨ (Country domain) ¤µv{vzxÁ¨£kzu ¤ßÁ¸® 

ö£¯ºPÒ £¯ß£kzu¨£k®. 

BÒPÍ® (Domain)    AuØS›¯ |õk

       lk             C»[øP 
       in         C¢v¯õ

       au         AÄì÷µ¼¯õ

       jp         á¨£õß 

       uk         IUQ¯ Cµõa]¯®

       us         IUQ¯ Aö©›UPõ

BÒPÍ¨ ö£¯¸US Á»x£UP A¢uzv¾ÒÍ BÒPÍ® ÷©À©mh BÒPÍ®

(Top level domain) GÚ¨£k®. 

Euõµn®

^ºø© ÁÍ Ch¨£kzv URL BÒPÍ¨ ö£¯º ÷©À©mh  BÒPÍ®

http://www.google.com google.com             com
http://www.edupub.gov.lk edupub.gov.lk              lk
http://www.nie.lk/pages/syllabus.asp nie.lk              lk
http://www.unicode.org/consortium/
consort.html

unicode.org             org
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3'1'5  Þ¬íò„ ªêŒðE Gè¿‹ Mî‹

PoÛø¯¨ ÷£õ»ßÔ ©ÛuµõÀ J÷µ ©õv›¯õÚ ö£¸¢öuõøP¯õÚ GsPøÍ 

{øÚÂÀ øÁzv¸¨£x PiÚ©õS®. GÛÝ®, AÁºPÍõÀ |£ºPÎß 

ö£¯ºPøÍ bõ£P® øÁzv¸¨£x GsPøÍ {øÚÂÀ øÁzv¸¨£øu 

Âh C»SÁõS®. BP÷Á, Cx öuõhº¤À ¤øÇPÒ |øhö£ÖÁuØPõÚ 

\¢uº¨£[PÐ® SøÓÁõS®. Cuß Põµn©õP÷Á Cøn¯zvÀ GsPÒ ©mk® 

Põn¨£kÁvÀø». Áø»U Ph¨¤h[PøÍ¨ £õºøÁ°kÁuØöPÚ E[PÍx 

Áø»÷©÷»õiø¯ ^ºø© ÁÍ Ch¨£kzv°ß£õÀ (URL) ÁÈ¨£kzx® 

÷£õx E[PÍx GzuÛ¨¦ •u¼À Áõ]UPU£hUTi¯ •PÁ›, IP •PÁ›¯õP 

£›©õØÓ¨£h ÷Ásk®. C¢u ©õØÕk BÒPÍ¨ ö£¯º ÷\øÁ ÁÇ[S|µõÀ 

(Domain Name System - DNS) CÚõÀ ÷©ØöPõÒÍ¨£k®.

}[PÒ SÔzuöÁõ¸ Áø»U Ph¨¤hzxhß CønÁuØS AuØS›¯ •PÁ›ø¯ 

Áø»÷©÷»õiUS (Browser) EÒÎmhx® (Euõµn©õP www.yahoo.com) Cx 

A¢u •PÁ› IP •PÁ›¯õÚ 209.191.122.70 Gß£uõP DNS  ÷\øÁ¯PzxUSU 

÷Põ›UøP Âh¨£k®. C¢u IP •PÁ› ‰»©õP E[PÐUS›¯ Áø»U Ph¨¤h¨ 

£UP® öuõhº¦Ö®. (E¸ 3.3) Cx ¤ßÚo°À Pn¨ö£õÊvÀ |øhö£Ö® 

ö\¯ß•øÓ¯õS®. 
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Áø»

÷©÷»õi

DNS                 
÷\øÁ¯P®

OS

DNS                 DNS                 DNS                 

1 £¯Úº Áø»÷©÷»õiø¯z 

vÓ¢x ^ºø© Ch¨£Sv°À 

(URL) ~øÇuÀ

Áø»÷©÷»õi 

URL CøÚ DNS 

÷\øÁ¯PzxUS 

ÁÈ¨£kzuÀ

6 Áø»÷©÷»õi ‰»©õP 

HTML Cøn¯¨ 

£UPzøu vøµ°À 

Põm]¨£kzuÀ

5 Cøn¯÷\øÁ 

ÁÇ[S|µõÀ HTML 

uµÄPÒ «Í ÁÇ[P¨£hÀ

4       IP  
•PÁ›ø¯U 

öPõsh 

Cøn¯                

÷\øÁ 

¯PzxUS 

÷Põ›UøPø¯ 

ÁÈ¨£kzuÀ

3 DNS ÷\øÁ¯P® 

FhõP URL CÀ 

Ch¨£mh £¯Ú›ß  
ö£¯º IP •PÁ›¯õP 

©õØÕk ö\´¯¨£hÀ

÷©÷»õi

2

E¸ 3.3

uÛ²›ø© öPõsiµõu Cøn¯® ö\®ø© |h¨¦ ÁÇUS (Protocol)
‰»©õP÷Á ÁÈ|hõzu¨£k®. ö\®ø© |h¨¦ ÁÇUS GÚ¨£kÁx PoÛ 

Áø»¯ø©¨¤¾ÒÍ SÔ¨¤mh ÁøPz uPÁÀ £›©õØÓzxUPõÚ Âv•øÓ 

PÍõS®. Cøn¯zvÀ |øh•øÓ¨£kzu¨£k® ö\®ø© |h¨¦ ÁÇUSPÒ ]» 

Á¸©õÖ

HTTP         HyperText Transfer Protocol

TCP/IP        Transmission Control Protocol / Internet Protocol 

FTP            File Transfer Protocol

SMTP         Simple Mail Transfer Protocol

ICMP          Internet Control Message Protocol

-

-

-

-

-
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ö\®ø© |h¨¦ 

ÁÇUS                        
£¯ß£õk

HTTP HTML BÁn¨ £›©õØÓ®

TCP/IP IP •PÁ›¨ £›©õØÓÀ Pmk¨£õk

FTP ÷Põ¨¦¨ £›©õØÓ®

SMTP ªßÚg\À £›©õØÓ®

ICMP ÁÊ HØ£k®÷£õx öu›Âzu¾® ö\´vU Pmk¨£õk®

Cøn¯®, J¸ ö£¸®£µ¨¦ Áø»¯ø©¨£õS® (WAN - Wide area network).
Cx ÷\øÁ¨ £¯|º - - u¸|º ©õv›¯zvØPø©¯ (Client Server model) {¸©õoU 

P¨£mkÒÍx. CuØPø©¯ Cøn¯zv¾ÒÍ AøÚzxU PoÛPÐ® ÷\øÁ¨ 

£¯|º PoÛPÍõP÷Áõ AÀ»x ÷\øÁ u¸|º PoÛPÍõP÷Áõ Huõ°Ý® J¸ 

ÁøPUSÒ Ah[S®.

E¸ 3.4 Cøn¯zvß ÷\øÁ u¸|º ÷\øÁ¨ £¯|º ©õv›¯ø©¨¦

÷\øÁø¯ ÁÇ[S® PoÛ, ÷\øÁ¯PU (Server) PoÛ GÚ AøÇUP¨£k®. 

Cuß‰»©õP, ÷\øÁ¨ £¯|›ß (Client) PoÛUSz ÷uøÁ¯õÚ ÁÍ[PÒ 

£Qµ¨£k®.

÷\øÁ u¸|›ß PoÛ°¾ÒÍ uPÁÀPøÍ ÷\øÁ¨ £¯|¸US ÁÇ[SuÀ                   

uµÂÓUP® (Download) GÚ AøÇUP¨£k®.

÷\øÁ¨ £¯|›ß PoÛ°¾ÒÍ uPÁÀPøÍ ÷\øÁu¸|›ß PoÛUS ÁÇ[ 

SuÀ uµ÷ÁØÓ® (Upload) ö\´uÀ GÚ AøÇUP¨£k®.

CuØPø©¯ ÷\øÁ¨£¯Úº, ÷\øÁu¸|º BQ÷¯õµx PoÛPÐUS Cøh 

°»õÚ, uPÁÀ £›©õØÓ® C¸ÁÈ¨ £›©õØÓ©õS®.

 ² ÷\øÁ u¸|º PoÛ, ÷\øÁ ö£Ö|º PoÛ¯õP AÔ•P¨£kzu¨£k® 

\¢uº¨£[PÐ® EÒÍÚ. 
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Cøn¯a ÷\øÁ¯PU PoÛPÒ Á¸©õÖ

Áø»a ÷\øÁ¯P® (Web Server) -  Áø»U Ph¨¤h[PøÍa ÷\ªzx   

øÁzu¾®  ÷\øÁ¨ £¯|›ß PoÛPÐUS 

ÁÇ[Su¾®.

Ag\À ÷\øÁ¯P® (Mail Server)- ªßÚg\ÀPøÍ¨  £›©õÖu¾®  ÷\ªzx               

øÁ¨£x® ÷\øÁ¨ £¯|›ß PoÛUS 

ÁÇ[Su¾®.

DNS ÷\øÁ¯P® (DNS Server)  -      URL CøÚ IP •PÁ›¯õP ©õØÖuÀ

3'1'6  Þ¬íòˆF¡  «ê¬õèœ

Cøn¯zv¼¸¢x £»ÁøP¨£mh ÷\øÁPÒ QøhUQßÓÚ. AÁØÖm ]» 

Á¸©õÖ.

1. E»PÍõÂ¯ Áø» (World Wide Web - WWW)
2. ªßÚg\À (Electronic Mail - E-Mail)
3. ÷Põ¨¦¨ £›©õØÓ® (File Transfer) 
4. öuõø» AqSøP (Remote Access)
5. ÷Põ¨¦¨ £QºÄ (File Sharing)
6. £À¿hP Kmh® (Streaming of multimedia)
7. ÷uhØ ö£õÔPÒ (Search Engines)

3'1'7  àôè÷£Mò õ¬ô (World Wide Web-WWW)

Cøn¯zvÞhõP ÁÇ[P¨£k® ÷\øÁö¯õß÷Ó 

E»PÍõÂ¯ Áø»¯õS®. Azxhß Cx Cøn 

¯zxhß öuõhº¦£mh E»PÍõÂ¯ PoÛPÎÀ 

÷uUP¨£mkÒÍ C»zvµÛ¯À BÁn[PÎß 

£õ›¯  öuõS¨£õS®.  ÷\º. ›® ÷£ºÚì ½  Gß£

Á÷µ (Sir Tim  Berners Lee) E»PÍõÂ¯ Áø» 

(WWW) Cß u¢øu GÚ P¸u¨£kQßÓõº. WWW 
CøÚ¨ £¯ß£kzx÷Áõº Áø» ÷©÷»õi (Web browser) 
FhõP Áø»U Ph¨¤h[PøÍ  AqP •i²®.  Áø» 

÷©÷»õi GÚ¨£kÁx  J¸ ¤µ÷¯õP  ö©ßö£õ¸ÍõS®. 

Áø» ÷©÷»õiPÐUPõÚ Euõµn[PÒ ]» E¸ 3.5 CÀ 

Põmh¨£mkÒÍÚ.

J¸ Áø»U Ph¨¤h® £» Áø»¨ £UP[PøÍU öPõsh 

uõS®. Áø»¨£UP[PÎÀ GÊzx¸Â»õÚ SÔ¨¦UPÒ, E¸ 3.5 Áø»÷©÷»õiPÒ
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£h[PÒ,  PõönõÎPÒ, £À¿hPU Põm]PÒ, «°ønPÒ (Hyperlink)
BQ¯Ú Ah[Q°¸US®. «°ønø¯¨ £¯ß£kzxÁuß ‰»©õP Cøn¯¨ 

£UP[PÐÒ C»SÂÀ \g\›UP •iQÓx. Áø»U Ph¨¤hö©õßÔÝÒ 

~øÇÁuØS, Áø» ÷©÷»õi°À Põn¨£k® •PÁ›¨ £møh°À ^ºø© ÁÍ  

Ch¨£kzvø¯z  (Áø»U Ph¨¤h  •PÁ›) umha_a ö\´x Enter  \õÂø¯a 

ö\¯Ø£kzu ÷Ásk®. Áø»U Ph¨¤h[PÒ £ØÔ¯ Ai¨£øhz uPÁÀPÒ 

Ah[Q¯ £UP® öuõhUP¨ £UP® AÀ»x •P¨£UP® (Homepage) GÚ¨£k®. 

Av¾ÒÍ «°ønPÎÞhõP Áø»U Ph¨¤hzv¾ÒÍ HøÚ¯ £UP[PÐUSÒ 

~øÇ¯»õ®. Euõµn©õP C»[øP¨ £Ÿmø\z vønUPÍzvß Ezv÷¯õP§ºÁ 

Áø»U Ph¨¤hzøu ÷|õUS÷Áõ®.

•PÁ›¨ 

£møh

« CønPÒ

 

•P¨¦¨ 

£UP®

E¸ 3.6 C»[øP¨ £Ÿmø\z vønUPÍzvß Ezv÷¯õP§ºÁ Áø»U Ph¨¤h®

3'1'8  «è£Š¹Š ðKñ£Ÿø‹ ªê‹¬ñ ïìŠ¹ õö‚°    

   (File Transfer Protocol - FTP) 

ªßÚg\À ö\´vPÒ ]Ô¯ ÷Põ¨¦PÍõP Cøn¨¦a ö\´¯¨£mk AÝ¨ 

£¨£k®. GÛÝ®, £õ›¯ AÍÁõÚ ÷Põ¨¦PøÍ 

ªßÚg\À ‰»® AÝ¨£•i¯õx. CÆÁõÓõÚ 

£õ›¯ ÷Põ¨¦UPøÍ ©ØöÓõ¸ PoÛUS¨ 

£›©õØÖÁuØS ÷Põ¨¦¨ £QºÄ ö\®ø© |h¨¦ 

ÁÇUS (File Transfer Protocol) £¯ß£kzu¨£k®. 

Â÷\h©õP ÷\øÁ¨ £¯|ºPÎß PoÛ°¾ÒÍ 

÷Põ¨¦PøÍ ÷\øÁ¯PU PoÛUS £v÷ÁØÓ® (Upload	 files)	 ö\´ÁuØS® 

Cøn¯zv¾ÒÍ ÷\øÁ¯PU PoÛ°¼¸¢x ÷Põ¨¦PøÍ¨ uµÂÓUP® 

ö\´ÁuØS® (Download	files)	Cx £¯ß£kzu¨£k®. (E¸ 3.7)
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PmhøÍPÒ

x»[PÀPÒ

uµÄ

öuõhº¦øhø©

÷\øÁ¨ £¯|º÷\øÁ¯PU      

   PoÛ

E¸ 3.7 ÷Põ¨¦¨ £›©õØÓÀ •øÓø©

3'1'9 ªî£¬ô Üµè™ (Remote Access)

PõönõÎU P¸zuµ[S

¤µuõÚ A¾Á»P[PÒ

   

Cøn¯®

Cøn¯®

Ãk

uÍzv¾ÒÍ 

£o¯õÒ

E¸ 3.8 öuõø» AqPÀ

öuõø» AqPÀ ‰»® Cøn¯zv¾ÒÍ PoÛø¯ öuõø»Â¼¸¢uÁõ÷Ó 

Pmk¨£kzu•iÁxhß, ö\´£oPøÍ²® ÷©ØöPõÒÍ»õ®. öuõø» AqPÀ 

‰»® ÷©ØöPõÒÍzuUP £oPÐUPõÚ  Euõµn[PÒ ]» Á¸©õÖ :

1. ÷\øÁ¯PU PoÛ°¾ÒÍ ö©ßö£õ¸ÒPøÍ ÷\øÁ¨ £¯|›ß 

PoÛUS {ÖÄuÀ

2. ÷\øÁ¨ £¯|›ß PoÛ°¾ÒÍ ÁÊUPøÍ {Áºzv ö\´uÀ.

SÔzu £¯|›ß AÝ©v°ßÔ AÁ›ß PoÛ°À EÒÍ •UQ¯©õÚ uµÄ 

PøÍ²® uPÁÀPøÍ²® ÷ÁöÓõ¸ £¯|º PÍÁõkuÀ "" Hacking '' GÚ¨£k®.

   ö£¸®£µ¨¦ Áø»¯ø©¨¦
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3'1'10  «è£Š¹Š  ðA˜¾ (File Sharing)

PoÛ  Áø»¯ø©¨ø£  ÷©ØöPõÒÁuß  ¤µuõÚ  

÷|õUP® ÁÍ[PøÍ¨  £Qº¢x öPõÒÁuõS®. ÷\øÁ 

¯PU  PoÛ°¾ÒÍ ÁÍ[PøÍ ÷\øÁ¨ £¯|›ß 

PoÛPÐUQøh°À TmhõP¨ £¯ß£kzxuÀ 

÷Põ¨¦¨ £QºÄ GÚ AøÇUP¨£k®. CuØPø©¯ 

Cøn¯zv¾ÒÍ £À÷ÁÖ ÷Põ¨¦PÒ £Qº¢x £¯ß 

£kzu¨£kÁuøÚU PõnUTi¯uõPÄÒÍx. CuØPõÚ Euõµn[PÒ ]» 

Á¸©õÖ

1.     Cøn¯zvÞhõP¨ £Ÿmø\¨ ö£Ö÷£ÖPøÍ¨ £õºøÁ°k®÷£õx  A¢uU 

÷Põ¨¦ HµõÍ©õÚ ÷\øÁ¨ £¯|µõÀ J÷µ uhøÁ°À £¯ß£kzu¨£hÀ.

2.  Áø»U Ph¨¤h® JßÖUS B°µUPnUPõÚ £¯Úº J÷µ uhøÁ°À 

¤µ÷Á]zuÀ

¤µuõÚ £À¿hP ÁÇ[PÒ ö\¯ö»õÊ[S

£¯|º, Cøn¯¨ £U 

PzvÀ uõß Â¸®¤¯ 

PõönõÎ AÀ»x 

£õhø»z öu›Ä 

ö\´uÀ

 

÷\øÁ¯PU PoÛ, £¯ÚµõÀ 

÷Põµ¨£mh Â÷\h ÷Põ¨¦ 

£ØÔ¯ ö\´vø¯ £À¿hP 

÷\øÁ  ÁÇ[S|¸US 

ÁÈ¨£kzuÀ

£¯|µõÀ ÷Põµ¨£mh 

÷PõøÁø¯ Cøn¯ 

÷\øÁ¯õP PoÛUS 

AÝ¨£õx ÷|µi¯õP                   

÷\øÁ¯õÍº PoÛUS 

AÝ¨¦uÀ'

4 ÷\øÁ¨ £¯|›ß PoÛ°¾ÒÍ 

ö©ßö£õ¸Îß ‰»©õP A¢uU 

÷Põ¨¤øÚ ÷PmP AÀ»x £õºøÁ°h 

ÁøPö\´uÀ

£À¿hP ÷\øÁ¯PU PoÛ

¤µuõÚ £À¿hP ÷\øÁ¯PU PoÛ

3'1'11  ð™Öìè æ†ì‹  (Streaming of media)

E¸ 3.9 £À¿hP ÁÇ[PØ ö\¯ß•øÓ
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£õh (Text), J¼, JÎ ÁiÂ»ø©¢u AøÚzx¨ £À¿hP ÁøPz                       

uPÁÀPøÍ²® PoÛPÐUQøh÷¯ £›©õÔUöPõÒÍ Cøn¯® ö£›x® EuÄ 

QÓx. CuØS Euõµn©õP Cøn¯zv¼¸¢x  £h[PÒ, £õhÀPÒ, Põönõ 

ÎPÒ ÷£õßÓÁØøÓz uµÂÓUP® ö\´uø»U SÔ¨¤h»õ®.

3'1'12 «îìŸ ªð£Pèœ (Search Engines)

Cøn¯zv¾ÒÍ Áø»U Ph¨¤h[PÎÀ HµõÍ©õÚ uPÁÀPÒ Ah[Q²ÒÍÚ. 

C¢uz uPÁÀPøÍ¨ ö£ÖÁuØS E›¯ Áø»U 

Ph¨¤h[PÐÒ  ¤µ÷Á]zuÀ ÷Ásk®. CuØS 

AÁØÔß Áø»U Ph¨¤h •PÁ›ø¯ ^ºø© 

ÁÍ Ch¨£kzv (URL) AÔ¢v¸zuÀ ÷Ásk®. 

GÛÝ®, Cøn¯zvÀ ö£¸©ÍÂ»õÚ Áø»U 

Ph¨¤h[PÒ Põn¨£kÁuõÀ Cx ªPÄ® PiÚ©õÚ 

ö\¯Ø£õhõS®. £¯|º  Cøn¯zv¾ÒÍ G¢uz 

uPÁø»²® C»SÁõPz ÷ui¯ÔÁuØS ÷uhØ ö£õÔPÒ ÁiÁø©UP¨£m 

kÒÍÚ. ÷uhØ ö£õÔ°ß ÷uhØ PmhzvÝÒ ÷uh÷Ási¯ uPÁ¼ß 

Ai¨£øha ö\õÀø»z umha_aö\´x ÷ukuÀ ö£õzuõøÚ AÊzv¯x® 

ö£¸©ÍÂ»õÚ «°øn¨¦UPÒ QøhUP¨ö£Ö®. A¢u «°øn¨¦PÎÀ 

JßøÓ÷¯õ £»ÁØøÓ÷¯õ ö\¯Ø£kzv AÁ]¯©õÚ uPÁÀPøÍ¨ ö£ØÖU 

öPõÒÍ»õ®. ö£¸©ÍÂÀ £¯ß£õmi¾ÒÍ ÷uhØ ö£õÔPÒ ]» Á¸©õÖ:

          http://www.google.com AÀ»x  http://www.google.lk 
http://www.yahoo.com
http://www.ask.com
http://www.msn.com

3'1'13  Ýœè÷Š ªðò˜ «ê¬õòè‹ (Domain Name Server)

E¸ 3.10 BÒPÍ¨ ö£¯º ÷\øÁ u¸|µõÀ IP •PÁ›¯õP ©õØÕk ö\´¯¨£hÀ

Cøn¯U Ph¨¤h[PÎøÚz uÛzxÁ©õP  CÚ[Põs£uØS ^ºø© ÁÍ 

Ch¨£kzv £¯ß£kzu¨£k®. CuÞhõP¨ £¯|º, Cøn¯U Ph¨¤h[PøÍ 

C»SÁõP bõ£PzvÀ øÁzv¸UP •i²®. B°Ý®, Cøn¯zvÀ EÒÍ 

PoÛö¯õßøÓ CÚ[Põs£uØS BÒPÍ¨ ö£¯ºPÎß IP •PÁ›÷¯ 

Ai¨£øh¯õP  £¯ß£kzu¨£kQßÓx. J¸ Áø»U Ph¨¤hzvß ^ºø© 
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ÁÍ Ch¨£kzv AÆ Áø»U Ph¨¤h £UP[PÒ ÷\ªUP¨£mkÒÍ Áø»a                            

÷\øÁ¯PU PnÛ°ß Cøn¯ ö\®ø© |h¨ö£õÊ[S •PÁ› (IP Address)
²hß BÒPÍ¨ ö£¯º ÷\øÁ ‰»©õP CønUP¨£mi¸US®. GÚ÷Á, IP
•PÁ›¯õP ©õØÕk ö\´²® ö\¯Ø£õk BÒPøÍ¨ ö£¯º ÷\øÁ¯PzvÚõÀ 

÷©ØöPõÒÍ¨£kQßÓx. (E¸ 3.10)

3'2  öuõhº£õh¾US Cøn¯zvß £¯ß£õk

3'2'1 I¡ù…ê™

C¸Áº AÀ»x J¸ öuõSv°Ú¸UQøh°À C»zvµÛ¯À •øÓ°À Piu[PÒ 

©ØÖ® ÷Põ¨¦PøÍ¨ £›ÁºzuøÚ  ö\´u÷» ªßÚg\À GÚ¨£k®. C¢ua                   

÷\øÁø¯ C»Á\©õP Cøn¯zvÞhõP ÁÇ[S® £» {ÖÁÚ[PÒ EÒÍÚ. 

Cøn¯ Cøn¨¦US ©mk÷© C[S ö\»Ä HØ£k®. Cx uØ÷£õøu¯ E»Qß 

ªP ÂøµÁõÚx® ö\»Ä SøÓ¢ux©õÚ  öuõhº£õhÀ •øÓ¯õS®.  (E¸ 3.11)

ªßÚg\À

(ö\´vPøÍ

AÝ¨¦uÀ)

Cøn¯® 
C»zvµÛ¯À 

•øÓ°À 

ö\´vø¯¨ ö£ÓÀ

Ag\À 

÷\øÁ¯P®

Ag\À 

÷\øÁ¯P®

uÛ¯õÒ 

PoÛPÒ

E¸ 3.11 ªßÚg\À ÷\øÁ ‰»® Piu[PÒ ÷Põ¨¦PÒ £›©õØÓ¨£k® Âu®

E»Q¾ÒÍ G¢u |£¸® CønzvÞhõP ªßÚg\À PnUS JßÔøÚ 

E¸ÁõUQU öPõÒÍ•i²®.  CuøÚ Cøn¯zvÀ Aøh¯õÍ¨£kzxÁuØS 

£¯ß£kzu¨£k® ªßÚg\À •PÁ› ¤ßÁ¸©õÖ Aø©¢v¸UP ÷Ásk®:

ªßÚg\¼¾ÒÍ C¯À¦PøÍ AÔ¢xöPõÒÁuØS C»[øP¨ £Ÿmø\z 

vønUPÍzvß ªßÚg\À •PÁ›ø¯ ÷|õUS÷Áõ®. exams@doenets.lk 
GÚ¨£kÁx  £¯|ºPÎß BÒPÍ¨ ö£¯º BS®. C[S exams GÚ¨£kÁx 

£¯|º ö£¯µõP Aø©Áxhß doenets.lk BÒPÍ¨ ö£¯µõS®. @  GÝ®  SÔ±k  

‰»©õP £¯|º ö£¯º, BÒPÍ¨ ö£¯º BQ¯Ú ÷ÁÖ£kzu¨£k®. 
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exams@doenets.lk

£¯|º ö£¯º

(User name) 
BÒPÍ¨ ö£¯º

(Domain name)

↓ ↓

ªßÚg\ø» AÝ¨¦£Áº, ö£Ö|º  BQ¯  C¸ uµ¨¤Ú¸US® ªßÚg\À  

•PÁ› C¸zuÀ Pmhõ¯©õS®. ªßÚg\ø»¨ 

£¯ß£kzu •ß£uõP ªßÚg\À PnUøP Bµ® 

¤zuÀ ÷Ásk®. Cøn¯zvÀ  ªßÚg\À Á\

vø¯ C»Á\©õP  ÁÇ[SQßÓ £» {ÖÁÚ[PÒ 

EÒÍÚ. ªßÚg\À PnUQØS ªßÚg\À •PÁ 

›²® (email address) PhÄaö\õÀ¾® (Password) C¸z 

uÀ AÁ]¯©õS®. ªßÚg\ø» AÝ¨¦ÁuØS 

AÀ»x ö£Ó¨£mh ªßÚg\ÀPøÍ¨ £õºøÁ°h 

ªßÚg\À PnUQÝÒ ~øÇzuÀ ÷Ásk®. CuØöPÚ £¯|º ªßÚg\À 

Ph¨¤h Cøh•PzvÀ ö£¯º, PhÄaö\õÀ BQ¯ÁØøÓ Em£kzv  Sign  in
«x ö\õkUP ÷Ásk®.

ªßÚg\¼ÞhõPU Piuzøu AÝ¨¦uÀ

ªßÚg\À  FhõPU  Piuzøu  AÝ¨¦Áøu ¤ßÁ¸©õÖ ÷©ØöPõÒÍ»õ®.

(E¸ 3.12)

Dear All,

Please see the attachment for my results.

Shani

Subject OL results released

To sasikala7@gmail.com
Cc bpdasun@yahoo.com
Bcc monali@sltnet.lk

Cøn¨¦ (Attachment)

E¸ 3.12 ªßÚg\À ‰»® Piuzøu AÝ¨¦uÀ
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●		 To  GÝ®  ChzvÀ  ö£Ö|›ß  ªßÚg\À  •PÁ›ø¯U SÔ¨¤h      

÷Ásk®. (sasikala7@gmail.com)
●			 Cc (Carban copy) GßÝ® 

ChzvÀ C¢u Piuzvß ¤µ 

vPÒ AÝ¨£¨£h ÷Ási¯ |£º 

PÍx ªßÚg\À •PÁ›PøÍ 

EÒÎkuÀ ÷Ásk®. (bpdasun@
yahoo.com)

●		 Bcc  (Blind Carbon copy) :- To, 
Cc BQ¯ÁØÔß  RÌ SÔ¨¤h¨£mhÁºPÒ AÔ¢x öPõÒÍõx 

ªßÚg\¼øÚ ÷ÁÖ ]»›ØS AÝ¨£ ÷Áskö©Ûß AÝ¨£¨£h 

÷Ási¯ ªßÚg\À •PÁ›PøÍ  BCC   GÝ® ChzvÀ EÒÎkuÀ 

÷Ásk®. (monali@sltnet.lk)
●			 Bcc  ¤µv Qøh¨÷£õ¸US (monali@sltnet.lk) C¢uU Piu® AÝ¨£¨£mh 

HøÚ¯ÁºPÍx ªßÚg\À •PÁ›PÒ AøÚzx® öuß£k®. (sasikala7@
gmail.com, bpdasun@yahoo.com) To, CC FhõP AÝ¨¤¯ ¤µvPÎÀ BCC  
FhõP¨ ¤µvPÒ AÝ¨£¨£mh ªßÚg\À •PÁ›PÒ (monali@sltnet.lk) 
Põm]¯ÎUPõx.

●		 Subject GÝ® ChzvÀ ªßÚg\À  PiuzxUS›¯ uø»¨¦ AÀ»x E›¯ 

Âh¯®  _¸UP©õPU SÔ¨¤h¨£hÀ ÷Ásk®. (O / L Results released)
●		 Attachment :-  ªßÚg\¾hß ÷ÁÖ C»zvµÛ¯À ÷Põ¨¦ AÀ»x 

÷Põ¨¦PøÍ  Cønzx  AÝ¨£ ÷Ásk©õ°ß ¤øn¯À F]  öuß 

£k® Chzvß «x ö\õkUQ CønUP ÷Ási¯ ÷Põ¨¤øÚz öu›Ä 

ö\´uÀ ÷Ásk®. (Results. jpg)
●	 Send GÝ® ChzvÀ ö\õkUSÁuß ‰»® ªßÚg\ø» AÝ¨£»õ®.

ªßÚg\À PnUQÀ £¯ß£õmkUS Á\v¯õP ¤ßÁ¸©õÖ Piu[PÒ 

ÁøP¨£kzu¨£mi¸US®.

●	 Inbox - ö£Ó¨£mh Ag\ÀPÒ ÷\ªUP¨£mi¸US®

●				Drafts	-	AÝ¨¦ÁuØöPÚ u¯õºö\´x •Êø©¨£kzu¨£hõu Piu[PÒ  

÷\ªUP¨£mi¸US® 

●		 Sent				-	AÝ¨£¨£mh Piu[PÒ ÷\ªUP¨£mi¸US® 

●		 Trash	/	Deleted		-	AÈUP¨£mh P iu[P Ò S Ô̈ ¤mh P õ» zxUS                                    

     ÷\ªUP¨£mi¸US®

●	 Spam / Junk - ÷uøÁ¯ØÓ Piu[PÒ ÷\ªUP¨£mi¸US®. G©US   

          AÝ¨£¨£k® Piu[PÒ ÷ÁÓõP ÷\ªUP¨£mi¸US®.
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Inbox Spam

E¸ 3.13 ÷\ª¨£Pzv¾ÒÍ Piu[PÒ

3'2'2   àìù® ªêŒFè¬÷ ÜÂŠ¹î™ (Instant Messaging - IM) 

  

E¸ 3.14 EhÚi ö\´vPøÍ AÝ¨¦uÀ

Cøn¯zvÞhõP C¸Á¸UQøh°À uÛ¨£mh •øÓ°À SÖgö\´v 

PÎøÚ¨  £›©õÔ AÍÁÍõÄuÀ  (Chatting)  EhÚia ö\´v AÝ¨¦uÀ 

GÚ¨£k®.

Sµö»õ¼

A[PzuÁ›ß ö\À¼hz öuõø»÷£]

A[PzxÁU PoÛ

A[PzuÁ›ß ö\´v

Member Message

ö£õxU PoÛ

A[PzxÁz öuõø»|PÀ

     öuõø»|PÀ



C»Á\¨ £õh¡À 93

E¸ 3.15 |ÃÚ EhÚi ö\´v AÝ¨¦uÀ 

ö£õÔ•øÓPÒ

3'2'3  è£ªí£O‚ è¼ˆîóƒ° (Video Conference)

öÁÆ÷ÁÖ Ch[PÎ¾ÒÍ C¸Áº AÀ»x 

£»¸US Cøh°À J¼, JÎ uµÄPøÍ FkPhzv 

PoÛ Áø»¯ø©¨¤ÞhõPU P»¢xøµ¯õhø» 

÷©ØöPõÒÍÀ PõönõÎU P¸zuµ[S (Video 
Conference) GÚ¨£k®.

PõönõÎU P¸zuµ[øP ÷©ØöPõÒÍ AÁ]¯  

©õÚøÁ

∙   PoÛPÒ                                                                
E¸ 3.16

∙   Áø»UP©µõ

∙   Cøn¯z öuõhº¦

∙   öuõhº£õhÀ ö©ßö£õ¸Ò (J¼, JÎ Á\vPÐhß) 

3'2'4 êÍè õ¬ôˆî÷ƒèœ (Social Networks / Social Media)

|£ºPÒ, Cøn¯zvÞhõP \‰Pz öuõhº¦PøÍ 

÷©ØöPõÒÐ® •øÓ÷¯ \‰P Áø»z uÍ[PÒ 

GÚ¨£k®. C¢u \‰P Áø»z uÍ[PÎß FhõP 

uÛ¨£mh uPÁÀPÒ, £h[PÒ, PõönõÎPÒ, 

AßÓõh |hÁiUøPPÒ ÷£õßÓÚ £ØÔ¯ 

uPÁÀPÒ £›©õÔU öPõÒÍ¨£k®. Cuß÷£ÓõP, 

\‰Pz öuõhº¦PÒ Â›ÁøhÁxhß  J¸Áº 

uõß C¸US® Chzv¼¸¢÷u \‰Pz 

öuõhº¦PÎøÚ¨ ÷£n •i²®. £» \‰Pa  

^º÷PkPÒ  E¸ÁõSÁuØS,  Pmk¨£õhØÓ   Ca    

÷\øÁ°ß £¯ß£õk Põµn©õP Aø©¢xÒÍx.

E¸ 3.17
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\‰P Áø»zuÍ[PÐUPõÚ ]» Euõµn[PÒ Á¸©õÖ

http://www.facebook.com
http://www.twitter.com
http://www.youtube.com
http://www.flickr.com
http://www.pinterest.com
http://www.secondlife.com

3'2'5 ºA™ èEQ â‡í‚è¼ (Cloud Computing)  

uÛ¯õÒ PoÛ Ah[P»õP \P» PoÛ Áø»¯ 

ø©¨¦PÒ ©ØÖ® ö\À¼hU P¸ÂPÒ (Mobile devices) 
AøÚzx® Cøn¯zvÞhõP JßÔønUP¨£mk 

÷uøÁ¯õÚ G¢uU Pnzv¾® G¢uöÁõ¸ Chzv 

¼¸¢x® uPÁÀPøÍ¨ ö£ÓÄ® uPÁÀPøÍa ÷\ªU 

PÄ® Á\v ö\´¯¨£mkÒÍ •øÓ÷¯ •QÀ PoÛ 

GsnUP¸ÁõS®.

•QÀ PoÛ°ß ¤µuõÚ ÷\øÁPÒ

 ² EmPmhø©¨¦ J¸ ÷\øÁ¯õP      (Infrastructure as a Service) -IaaS
 ² A¤Â¸zva `ÇÀ J¸ ÷\øÁ¯õP   (Platform as a Service) -PaaS
 ² ö©ßö£õ¸Ò J¸ ÷\øÁ¯õP            (Software as a Service)-SaaS

EmPmhø©¨¦ J¸ ÷\øÁ¯õP  (Infrastructure as a Service (IaaS)) 

Cuß‰»® PoÛPÐUöPÚ uÛzxÁ©õÚ `Çö»õßÖ Pmiö¯Ê¨£¨ 

£kÁxhß ÷\øÁ¯PU PoÛ°ß EuÂ²hß uµÄPøÍa ÷\ª¨£uØöPÚ 

öÁÎ°øÚ  ÁÇ[SÁxhß £À÷ÁÖ ÁÍ[PÐ® QøhUP¨ö£Ö®.  

Euõµn® :  uÚUöPßÖ ÷\øÁ¯P PoÛ, wUPõ¨¦_Áº CÀ»õu÷£õx® 

•QÀ PoÛa ÷\øÁ ‰»©õP ÷\øÁ¯PU PoÛ ChÁ\v 

(Sever space) wUPõ¨¦a _Áº BQ¯ Á\vPøÍ £¯ß£kzu»õ®.
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A¤Â¸zva `ÇÀ J¸ ÷\øÁ¯õP  (Development Platform as a Service 
(Paas))

C¢ua ÷\øÁ ö©ßö£õ¸Ò A¤Â¸zv ©ØÖ® ö©ßö£õ¸Ò C¯UP® (Run)
BQ¯ÁØÖUPõÚ `Çø» ÁÇ[S®. £oö\¯À •øÓø©,  PoÛ ö©õÈa 

`ÇÀ,  uµÄz uÍ®  (Database), Áø»a ÷\øÁ¯P® BQ¯ Á\vPÒ AøÚzx® 

Cuß‰»® £¯|¸US ÁÇ[P¨£k®.

Euõµn® :  £oö\¯À •øÓø© (Operating system), öuõS¨¤ (Compilers)  
÷£õßÓÚ,  E[PÒ PoÛ°À {ÖÁ¨£miµõx ÂiÝ® Th 

•QÀ PoÛ ÷\øÁ ‰»©õP ö©ßö£õ¸ÒPøÍ EØ£zv 

ö\´¯»õ®.

ö©ßö£õ¸Ò J¸ ÷\øÁ¯õP (Software as a Service (SaaS))

÷\øÁ¨ £¯|¸USz ÷uøÁ¯õÚ C¯US ö©ßö£õ¸øÍ {ÖÁõx, •Q¼À 

(Cloud) AÀ»x Cøn¯zvÀ {ÖÁ¨£mkÒÍ ö©ßö£õ¸ÒPøÍ¨ £¯ß£kz 

xÁuØPõÚ Á\vPøÍ  Cx ÁÇ[SQßÓx.

Cuß÷£õx Â÷\h©õP ö©ßö£õ¸Ò A¤Â¸zv ö©ßö£õ¸Ò u¯õ›¨¦ 

BQ¯ÁØÖUSz ÷uøÁ¯õÚ Áßö£õ¸ÒPÒ, A¤Â¸zv ö©ßö£õ¸ÒPÒ 

BQ¯ÁØøÓU öPõÒÁÚÄ ö\´²®÷£õx®, •Põø© ö\´²®÷£õx® HØ£h 

÷|›k® ö\»ÄPÒ, ]UPØÓßø© BQ¯ÁØøÓU SøÓzxUöPõÒÍ»õ®. 

Euõµn® :  uµ® 10 CÀ }[PÒ PØÓ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸Ò, 

C»zvµÛ¯À Â›uõÒ ö©ßö£õ¸ÒPÒ BQ¯Ú Android
•øÓø©°À {ÖÁ¨£hõx Áø»÷©÷»õi ‰»©õP÷Á £¯ß 

£kzu¨£k®.

      

 ² ö©ßö£õ¸ÐUPõÚ ö\»Ä SøÓÁøhuÀ

 ² ö\¯»õØÖÁøu ÷©®£kzuÀ

 ² £µõ©›¨¦ |hÁiUøPPÒ SøÓÁøhuÀ

 ² ö©ßö£õ¸ÒPøÍ EhÚi¯õP CØøÓ¨ 

£kzu •iuÀ

 ² Cøn¯Óõ Cøn¯ Á\v ÷uøÁ¨£hÀ

 ² SøÓ ÂøµÄ Cøn¨¤ß÷£õx öuõÈØ 

£õk SøÓÁøhuÀ

AÝT»[PÒ

¤µvT»[PÒ 

•QÀ PoÛø¯¨ £¯ß£kzxÁuß AÝT», ¤µvT»[PÒ
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ö\¯Ø£õk

1' {µÀ A°¾ÒÍÁØÖUS¨  ö£õ¸zu©õÚÁØøÓ {µÀ B °¼¸¢x   

   öu›Äö\´x A®¦USÔ ‰»® CønzxU PõmkP. 

           {µÀ A                  {µÀ B 

ªßÚg\À •PÁ› doenets.lk
BÒPÍ¨ ö£¯º 172.92.83.106
^›ø© ÁÍ Ch¨£kzv somasiri@gmail.com

IP •PÁ› http://www.nie.lk/syallabus/ol/ict.pdf

{µÀ A               {µÀ B 
Áø»÷©÷»õi BÒPÍ¨ ö£¯øµ IP •PÁ›¯õP 

©õØÖuÀ

Cøn¯a ÷\øÁ Google
BÒPÍ¨ ö£¯º ÷\øÁ¯P® (DNS) Mozilla Firefox
÷uhØö£õÔ E»PÍõÂ¯ Áø» (WWW)

 ² ^ºø© ÁÍ Ch¨£kzv ̂ URL& ‰»©õP  Áø»U Ph¨¤h[PÎ¾ÒÍ Áø»¨ 

£UP[PøÍ CÚ[Psk öPõÒÍ•i²®.

 ² Cøn¯zv¾ÒÍ GÀ»õ PoÛPÐUS® uÛzxÁ©õÚ IP •PÁ› 

£¯ß£kzu¨£k®.

 ² Áø»U Ph¨¤h[PøÍz uÛzxÁ©õP CÚ[Põs£uØS BÒPÍ¨ ö£¯º 

^Domain name& £¯ß£kzu¨£k®.

 ² BÒPÍ¨ ö£¯º ÷\øÁ¯Pzvß ‰»©õP BÒPÍ¨ ö£¯º, IP •PÁ›¯õP 

©õØÓ¨£k®.

 ² Cøn¯zvß |hÁiUøPPÒ AøÚzx® ö\®ø© |h¨ö£õÊ[S ̂Protocol& 
‰»® ÷©ØöPõÒÍ¨£k®.

 ² E»PÍõÂ¯ Áø» ^WWW&, ªßÚg\À ^e -mail& BQ¯Ú Cøn¯zvÚõÀ 

ÁÇ[P¨£k® ¤µuõÚ ÷\øÁPÍõS®.

 ² Cøn¯zøuU  Pmk¨£kzu  Áø»÷©÷»õi ^Web browser& £¯ß£kz 

u¨£k®.

ö£õÈ¨¦
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 ² Cøn¯zvÀ uPÁÀPøÍz ÷ukÁuØS, ÷uhØö£õÔPÒ ^Search engines& 
£¯ß£kzu¨£k®.

 ² ªßÚg\À ÂøµÁõÚx® ©¼ÁõÚx©õÚ öuõhº£õhÀ •øÓ¯õS®.

 ² ªßÚg\À ÷\øÁø¯¨ ö£ÖÁuØS ªßÚg\À •PÁ› AÁ]¯©õS®.

 ² Ehß  ö\´v¯Ý¨¦uÀ,  PõönõÎU  P¸zuµ[S, \‰P Áø»zuÍ[PÒ 

BQ¯ÚÄ® öuõhº£õh¾UöPÚ¨ £¯ß£kzu¨£k®. 
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4 £À¿hP¨ £¯ß£õk

  C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

● C»UP•øÓ ÁøµÂ¯¼ß ¤µuõÚ A®\[PÒ

● ÁøµÂ¯À öPõÒvÓß ©ØÖ® ö|¸UP®

● ÁøµÂ¯À ÁøPPÒ

● ÁøµÂ¯À ö©ßö£õ¸Ò £¯ß£õmiß Ai¨£øh A®\[PÒ

● JÎ°¯À Aø\Åmhzvß Ai¨£øh  A®\[PÒ

● ÷PzvµPou C¯À¦PÒ ©ØÖ® ÁiÁ[PÒ

● \mhP ÁøPPÒ

● JÎ°¯À Aø\Åmh®

● £Qº¢uÎzuÀ

● J¼¨£vÄ ö\´uÀ

● öuõSzuÀ

● JÎ°¯À Aø\ÅmhzvØPõP  J¼ -& JÎ ÷\º©õÚ®

   Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

 
BvPõ»zv¼¸¢÷u ©Ûuß uÚx EÒÍzuõÀ GsqQßÓ Põm]PÒ ©ØÖ® 

PsPÍõÀ PõqQßÓ ]Ó¨¦U Põm]PøÍ PØPÒ, £»øPPÒ, uõÒPÎÀ 

Áøµ¯Ä®, AÁØøÓ {Ó¢wmi ÁiÁø©UPÄ® BºÁ® PõmiÚõß. ©Ûuß 

uÚx P¸zxUPøÍ •ßøÁUP ¤µuõÚ FhP©õP KÂ¯[PøÍ £¯ß£kzvÚõß 

Gß£uøÚ £søh¯Põ» Põm]PÎß Ga\[PÒ GkzxUPõmkQÓÚ. Azxhß 

C[S HØ£kQßÓ £À÷ÁÖÁøP SøÓ£õkPÒ, uÁÖPøÍ {Áºzv ö\´¯Ä® 

÷uøÁ¯õÚ Áºn[PøÍ ¤µ÷¯õQUPÄ® AÁß AvP •¯Ø] ö\´v¸¢uõß 

Gß£øu CÆ KÂ¯[PøÍ AÁuõÛ¨£uß ‰»® öu›¯Á¸QÓx.

BÚõÀ öuõÈÝm£ ÁÍºa]¯õÀ PoÛ ÁøµÂ¯À ö©ßö£õ¸øÍ¨ £¯ß 

£kzv ªP C»SÁõP £À÷ÁÖ¨£mh Áøµ¦PøÍ E¸ÁõUPÄ®, E¸ÁõUP¨ 

£mh Áøµ¦PøÍ ÷uøÁU÷PØ£ J¸[Pø©UPÄ® •i²ö©ß£x CÆÁøP 

ö©ßö£õ¸Ò £¯|ºPÎß P¸zuõS®. PoÛ ÁøµÂ¯À ö©ßö£õ¸øÍ¨ 

£¯ß£kzv E¸ÁõUP¨£kQßÓ £h® AÀ»x E¸Á©õÚx, C»UP•øÓ 

Áøµ¦PÒ ^Digital graphics& GÚ AøÇUP¨£kQÓx.

4'1   C»UP•øÓ ÁøµÂ¯À (Digital Graphics)
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C»UP•øÓ Áøµ¤¯¼ß ¤µuõÚ TÖPøÍ CÚ[Põs÷£õ®. (E¸ 4.1)

£h‰»®

Pixel

¤›vÓß

Resolution £¸©ß

Size

Áºn®

Colour
C»UP•øÓ 

Áøµ¤¯¼ß 

¤µuõÚ 

TÖPÒ

E¸ 4.1 C»UP•øÓ Áøµ¦PÎß ¤µuõÚ TÖPÒ

 ² £h‰»® (Pixel)
£h‰»® Gß£x öÁØÖU  PsPÍõÀ £õº¨£uØS PiÚ©õÚ ªPa ]Ô¯ 

¦ÒÎ¯õS®. AuØS Áºn® Esk. GÚ÷Á £h‰»©õÚx ¯õ÷uÝ® Áºnz 

øu²øh¯ ªPa ]Ô¯ ¦ÒÎ¯õS®. G®©õÀ AÁuõÛUP¨£kQßÓ C»UP•øÓ 

Áøµ¦PÍõÚx ̂ Digital graphics& £À»õ°µUPnUPõÚ  £h‰»[PøÍU öPõsk 

E¸ÁõUP¨£mhuõS®.

C¨ £h‰»®  BÚx  {øµ,  {µ¼ß  Ai¨£øh°À  JßÖUöPõßÖ   ªP 

ö|¸UP©õP JÊ[S£kzxÁuß ‰»® Áøµ£õÚx E¸ÁõUP¨£kQÓx. (E¸ 

4.2) C»UP•øÓ Áøµ¦ £h‰»[PÎß Ao/Tmh©õP ^Array& Põn¨£k 

Áxhß, Cx ¤m£h® (Bitmap) GÚÄ®  AøÇUP¨£kQÓx.

E¸ 4'2  £h‰»®

Áøµ¤ß £¸©øÚ PoÛzvøµ°ß AÍÄ AÀ»x Aa]h¨£kQßÓ uõÎß  

AÍÂØ÷PØ£  ö£›uõUP  AÀ»x ]ÔuõUP •i²®. C¢{ø»°÷»  J¸ A[ 

S»zv÷» EÒÍhUP¨£k® £h‰»[PÎß ö£Ö©õÚ® ©õØÓ©øhQÓx. 

£h‰»®

£h‰»U Tmh®

£h‰»  {øµ

£h‰» {µÀ
ö£›uõUP¨£mh E¸Á®
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SøÓ¢u £h‰»[PøÍU öPõsh £i©©õÚx ö£›uõUP¨£k® {ø»°À Cuß 

uµ©õÚx SøÓÁøhÁøu AÁuõÛUP»õ®. (E¸ 4.3)

E¸ 4.3  £i©©õÚx ö£›uõUP¨£k® {ø»°À uµ©õÚx SøÓÁøhuÀ

Áøµ¤À  ¤µ÷¯õQUP¨£mkÒÍ Áºn®, £h‰»® JßÔ¾ÒÍ ¤m AÍÁõÀ 

Áøµ¯ÖUP¨£kQÓx. Cx £h‰»® JßÔ¾ÒÍ ¤m AÍÄ ^bits per pixel - 
(bpp&&  GÚ P¸u¨£kQÓx. AvPÍÄ ¤mPøÍU öPõsh Áøµ£õÚx uµzuõÀ 

Ti¯uõP Põn¨£kQÓx.

£h‰»ö©õßÔß Áºn® ©ØÖ® ¤m AÍÄ

 ² £h‰»ö©õßÔß ""¤m'' AÍÁõÚx SÔzu Áøµ¤À EÒÍ Áºn[PøÍ 

Ai¨£øh¯õPU  öPõs÷h  wº©õÛUP¨£kQÓx.

 ² BÚõÀ Áøµö£õßøÓ AÁuõÛ¨£uõÀ £h‰»ö©õßÔ¾ÒÍ Áºn[PÎß 

GsoUøPø¯ wº©õÛUP C¯»õx. C¢{ø»°À £h‰»ö©õßÔ¾ÒÍ 

""¤m'' AÍÂøÚ Ai¨£øh¯õPU öPõsk £hö©õßÔ¾ÒÍ Áºn[PÎß 

GsoUøPø¯ PoUP •i²®. CuØPõP ¤ßÁ¸® ̀ zvµzøu¨ £¯ß£kzu 

•i²®.

£h‰»ö©õßÔ¾ÒÍ Áºn[PÎß GsoUøP } (2) bpp ^£h‰»® JßÔ¾ÒÍ "¤m'  AÍÄ&

Euõµn®: £h‰»ö©õßÔÀ |õßS ""¤m'' EÒÍöuÛÀ, £h‰»ö©õßÔ¾ÒÍ 

Áºn[PÎß 

J¸ ""¤m'' CÚõÀ ÁøPUSÔUP¨£k® 

Áºnzvß AÍÄ Á¸©õÖ:

Cµsk ""¤m'' CÚõÀ ÁøPU 

SÔUP¨£k® Áºnzvß AÍÄ Á¸©õÖ

0
1 }Cµsk Áºn®

00
01
10
11

}|õßS Áºn®
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GsoUøP    } ^2& 4

     } 2 « 2 « 2 « 2

     } 16 Áºn®

Azxhß Áºn[PÎß GsoUøP uµ¨£kªhzx ""¤m'' AÍÂøÚ  Po¨ 

£uØPõP ¤ßÁ¸® `zvµ® £¯ß£kzu¨£kQÓx.

£h‰»ö©õßÔß ""¤m'' GsoUøP  } 

             } 

£h‰»ö©õßÔß ""¤m'' GsoUøP  } 4

  

    ¤m 1    ¤m 4    ¤m 8   ¤m 24 

£h‰»ö©õßÔ¾ÒÍ 

¤mPÎß AÍÄ ^Bits per pixel&
Áºn[PÎß 

GsoUøP

`zvµ®

1 bpp  2 Áºn[PÒ (2)1

2 bpp  4 Áºn[PÒ (2)2

3 bpp  8 Áºn[PÒ (2)3

10 bpp 1024 Áºn[PÒ (2)10

16 bpp 65536 Áºn[PÒ (2)16

24 bpp 16777216 Áºn[PÒ

^16'7 ªÀ¼¯ß&

(2)24

32 bpp 4294967296 Áºn[PÒ

^4294 ªÀ¼¯ß&

(2)32

 ² ¤›vÓß (Resolution)
C»UP•øÓ Áøµ¤ß ö£ÍvP £›©õnzvøÚ ^Physical dimension& AÍÂk® 

A»PõP £h‰»® £¯ß£kzu¨£kQßÓx. A÷u÷ÁøÍ Auß ö£ÍvP 

£›©õn©õÚx £i© ¤›vÓß ̂ Image resolution&  BP Põm]¨£kzu¨£kQßÓx.

(E¸ 4.4)

C¢u C»UP•øÓ £h©õÚx 250 £h ‰»[PÒ AP»zøu²®, 175 £h‰»[PÒ 

E¯µzøu²® öPõshx. Cuß £i© ¤›vÓß ^Image resolution& 250«175

£h‰»[PÒ AÀ»x 45"500 £h ‰»[PÒ BS®.

√Áºn®

√ 16
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17
5 

 £
h

‰
»

[
P
Ò

 

250 £h‰»[PÒ

^45"500 £h‰»[PÒ&

E¸ 4'4  £i© ¤›vÓß

AvPÍÄ £h‰»[PøÍ²®, E¯º ¤›vÓ 

øÚ²® ^High resolution& öPõsh C»UP•øÓ 

£h©õÚx E¯ºuµzøuU öPõshuõP Põn¨£k®. 

C»UP•øÓ¨ £hzvß uµ©õÚx Kº A[S» 

AÍÂ¾ÒÍ (Qøh AÀ»x {ø»USzx) £h 

‰»[PÎß GsoUøP ^Pixels per inch ^ppi&&
AÀ»x  Kº A[S» AÍÂ¾ÒÍ (Qøh AÀ»x 

{ø»USzx) ¦ÒÎPÎß GsoUøP  ^Dots per 
inch ^dpi&& BÀ wº©õÛUP¨£kQÓx. (E¸ 4.5) 

E¸ 4.5  A[S»ö©õßÔ¾ÒÍ ¦ÒÎPÎß GsoUøP

Áºn[PÒ

C»UP•øÓ  Áøµ¤¯¼À  £À»õ°µUPnUPõÚ £h‰»[PÒ  EÒÍÚ Gß£øu 

}[PÒ AÔÃºPÒ. JÆöÁõ¸ £h‰»•® Áºnö©õßøÓ ÁøPUSÔUQßÓx. 

GÚ÷Á £h‰»ö©ß£x ̄ õxö©õ¸ ÁºnzøuU öPõsh J¸ ]Ô¯ ¦ÒÎ¯õS®.  

Áºn[PÒ JßÖhöÚõßÖ ÷\ºÁuõÀ E¸ÁõUP¨£kQßÓ, \õuõµn ©ÛuÛß 

öÁØÖU PsPÐUS ¦»¨£kQßÓ Áºn[PÒ HÓzuõÍ 16 ªÀ¼¯ßPÍõP  

Põn¨£iÝ®,  AÁØøÓ   uÛzuÛ÷¯   ÷ÁÖ¤›zx  AÔÁx ]µ©©õÚ 

Põ›¯©õS® (E¸ 4.6).

ö\ÆFuõ (Ultra Violet)    (Infrared) ö\[RÌöÁØÖU PsPÐUS 

Pm¦»ÚõQßÓ Áºn[PÒ

E¸ 4.6 PsqUS Pm¦»ÚõQßÓ, Pm¦»ÚõPõu Áºn[PÒ

C»UP•øÓ Áøµö£õßøÓ E¸ÁõUS®÷£õx AvP Áºn[PÒ £¯ß£kz 

u¨£h •i²® GÛÝ® A¢u Áºnzøu öÁÎ¨£kzxÁuØPõÚ £õ[S Áºn 

©õv›¯[PÎÚõÀ wº©õÛUP¨£kQßÓx (E¸ 4.7).
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C¸ ÁøP Áºn ©õv›¯[PÒ  ^Colour Models&  ¤µuõÚ©õP £¯ß£kzu¨£k 

QßÓÚ (E¸ 4.7). 

CMYK ©õv›¯® 

(CMYK Model)

Áºn ©õv›¯[PÒ

(Color Models)

RGB ©õv›¯® 

(RGB Model)

E¸  4.7 Áºn ©õv›¯®

 ² RGB ©õv›¯® &  Cx öuõø»UPõm] ©ØÖ® PoÛ vøµPÎÀ £µÁ»õP 

£¯ß£kzu¨£kQßÓx. CuØS Áºn JÎP÷Í ªPÄ® EuÂ¯õP C¸U 

QßÓÚ. Ai¨£øh°À C[S ‰» Áºn[PÍõP ]Á¨¦, £aø\ ©ØÖ® }»® 

^Red, Green and Blue&  Gß£Ú £¯ß£kzu¨£kQßÓÚ.

 ² CMYK  ©õv›¯® & Áºn ø©°øÚ Ai¨£øh¯õPU öPõsk uõÎß 

«x £h[PøÍ Aa]kÁuØPõP  C®©õv›¯® £¯ß£kzu¨£kQÓx. C[S 

•ußø© Áºn[PÍõP CÍ}»®, Fuõ, ©g\Ò ©ØÖ® PÖ¨¦ ^Cyan, 
Magenta, Yellow, Black& Gß£Ú £¯ß£kzu¨£kQßÓÚ.

‰»Áºn[PÎß ^RGB& ÷\º 

©õÚzuõÀ Cµshõ® {ø» 

Áºn[PÒ E¸ÁõUP¨£k®.

Cµshõ® {ø» Áºn  ̂ CMYK& 

ø©°ß ÷\º©õÚzuõÀ ‰» 

Áºn[PÒ E¸ÁõUP¨£k®

E¸ 4.8 Áºn ÷\º©õÚ®

C»UP•øÓ Áøµ¤¯¼À ¤µ÷¯õQUP¨£mkÒÍ Áºn[PÎß Ai¨£øh°À  
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AuÚõÀ SÔzxUPõmkQßÓ uPÁ¼øÚ AÔ¢xöPõÒÍ •i²®. GÚ÷Á £h® 

AÀ»x E¸Âß  uµzvøÚ ÷£qÁuØS Áºn©õÚx AvPÍÂÀ EuÄQÓx.

‰» Áºn[P÷Í uÛÁºn[PÒ BS®.  C¸ uÛ Áºn[PÎß ÷\º©õÚzuõÀ 

E¸ÁõUP¨£kQßÓ Áºn[PÒ  Cµshõ®{ø» Áºn[PÒ ^Secondary colours&
GÚÄ®, ‰ßÖ Áºn[PÎß ÷\º©õÚzuõÀ E¸ÁõUP¨£kQßÓ Áºn[PÒ 

‰ßÓõ® {ø» Áºn[PÒ ̂ Triplet colours& GÚÄ®  AøÇUP¨£k®. C»UP•øÓ 

uµÁõUP¼À ‰» Áºnö©õßÔÀ 256 ö£Ö©vPÒ (0-255) Esk.

‰ßÓõ®{ø» Áºn® (Triplet colours)
‰ßÓõ® {ø» Áºnö©õßÖ E¸ÁõUP¨£k® Âu® (E¸ 4.9) CÀ Põmh¨ 

£mkÒÍx. C[S Ãa\õÚx  ^000" 000" 000 - 225" 225" 225& BS®. Cx RGB 
‰ßÓõ® {ø» (Triplet& GÚ AøÇUP¨£kQÓx. RÊÒÍ E¸ÁõÚx RGB ^245, 

102, 36& ö£Ö©vø¯ AÀ»x RGB ^F5, 66, 24& GÝ® £vÚÖ© ö£Ö©vø¯ 

PõmkQÓx.

‰» 

Áºn[PÎß 

ö£Ö©v

E¸ 4.9 ‰ßÓõ®{ø» ÁºnU P»øÁ

Áøµö£õßÔß ö|¸UP®  (Compression of a graphic)
Áøµö£õßÔß £¸©ÚõÚx Aøu E¸ÁõUP £¯ß£kzu¨£kQßÓ £h‰»zvß   

AÍÄ,  Áºn[PÎß  ÷\º©õÚ®  ÷£õßÓÁØÓõÀ   wº©õÛUP¨£kQÓx.  AvP

£h‰»[PøÍ²® Áºn[PøÍ²®  E¯º ¤›vÓøÚ²® ^High resolution&
öPõsh £i©©õÚx E¯º öPõÒvÓøÚU öPõshuõS®. CÆÁõÓõÚ £i© 

ö©õßøÓ ÷\ªUS®÷£õx HØ£kQßÓ PiÚzußø©ø¯ uÂº¨£uØPõP Áøµ¦ 

ö|¸UP®  ^Graphic compression& £¯ß£kzu¨£kQßÓx.   £i©ö©õßøÓ 

÷\ªUS®÷£õx® ^Save& AÀ»x Auß ¤ßÚ¸® ö|¸UPzøu ^Compression&  
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÷©ØöPõÒÍ •i²®.

Áøµö£õßøÓ ÷\ªUS®÷£õx ö|¸UPzvØPõP £¯ß£kzu¨£kQßÓ  ÷Põ¨¦ 

ÁøPPÒ  ^File Formats& Áøµ¦US £õv¨¦PøÍ HØ£kzxÁuØS, Põµn©õP 

Aø©¯»õ®. C¢u ÷Põ¨¦ ÁøP¯õÚx  ÁiÁø©¨¦PÐUS ö£õ¸¢uU Ti¯uõP 

£À÷ÁÖ EzvPÐUPø©¯ E¸ÁõUP¨£mh  ö|Ô•øÓ ^Algorithms& CøÚ 

£¯ß£kzv ÁiÁø©UP¨£mkÒÍx.

Áøµ¦  ö|¸UP©õÚx ^Graphic compression&  C¸ ÁøPPÎÀ Põn¨£h»õ®. 

AøÁ CÇ¨¦ AÀ»x £õv¨¦ ö|¸UP® ̂ Lossy compression& ©ØÖ® CÇ¨£À»õ 

AÀ»x £õv¨£øh¯õu ö|¸UP® ^Lossless compression& BS®.

£õv¨£øh²® ö|¸UP® (Lossy 
compression)

£õv¨¤À»õu ö|¸UP® (Lossless 
compression)

   ‰» Áøµ¦

ö|¸UP¨

£mh Áøµ¦

«Íz vÓUP¨ 

£mh Áøµ¦

‰» Áøµ¤ß uµzvÀ 

Põn¨£hõø©

£õv¨£øh²® 

ö|¸UP¨ 

£¯ß£õk

Áøµ¤øÚ

vÓzuÀ

‰» Áøµ¦ £õv¨¤À»õu

ö|¸UP¨ 

£¯ß£õk

ö|¸UP¨

£mh Áøµ¦

«Íz vÓUP¨ 

£mh Áøµ¦

‰» Áøµ¤ß uµzvÀ 

Põn¨£kQßÓø©

Áøµ¤øÚ 

vÓzuÀ

E¸ 4.10 Áøµ¤ß ö|¸UP ÁøPPÎß J¨¥k

£õv¨£øh²® ö|¸UPzøu²øh¯  ÷Põ¨¦  ÁøPPøÍ¨  £¯ß£kzv  Áøµ¤ß  

öPõÒÍÍøÁ  CÈÁõUP  •i²®.  CuÚõÀ  Auß  uµ®  SøÓÁøhQÓx. Áøµ 

¤øÚ «ÍzvÓUS®÷£õx Auß Esø©¯õÚ ÷uõØÓ® Põmh¨£h©õmhõx. 

GÛÝ® £õv¨£øh²® ö|¸UP® BÚx Áøµö£õßøÓ ÁiÁø©zuÀ 

AÀ»x ÷\ªzuÀ ö\¯Ø£õmøh C»SÁõUSÁxhß Cøn¯zv¼¸¢x 

Áøµ¦PøÍ ÂøµÁõP uµÂÓUP® ö\´¯Ä® EuÄQÓx. C[S JPEG" TIFF 

÷£õßÓÚ £õv¨£øh²® ö|¸UPzvøÚ Ai¨£øh¯õPU öPõsh ]» ÷Põ¨¦ 

ÁøPPÍõS®.
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Azxhß E¸ÁõUP¨£mh Áøµ¤ß uµzøu ÷£o²® ö|¸UP® ö\´¯ •i²®. 

C¢{ø»°À CuøÚ «Íz vÓUS®÷£õx Auß Esø©¯õÚ ÷uõØÓzøu 

AÁuõÛUP •i²®. Cx £õv¨¤À»õu ö|¸UP©õP P¸u¨£kQÓx. C[S GIF" 

PNG" RAW ÷£õßÓÚ £õv¨¤À»õu ö|¸UPzvøÚ  Ai¨£øh¯õPU öPõsh 

]» ÷Põ¨¦ ÁøPPÍõS®.

Áøµ¤ß ÁøPPÒ (Graphic types)
C»UP•øÓ Áøµ£õÚx ¤µuõÚ©õP C¸ÁøP¨£k®. AøÁ ""£µÁÀ Áøµ¦''

^Raster graphic& ©ØÖ® ""ö|Ô¯ Áøµ¦'' ^Vector graphic& BS®. £¯ß 

£kzx® Áøµ¦ ö©ßö£õ¸ÒPÐUS Aø©¯÷Á Áøµ£õÚx CÆÁõÖ ÁøP¨ 

£kzu¨£kQÓx.

£µÁÀ Áøµ¦ (Raster graphic) ©ØÖ® ö|Ô¯ Áøµ¤ØS (Vector graphic)
Cøh÷¯¯õÚ ÷ÁÖ£õkPÒ

 ² £µÁÀ Áøµ¦ (Raster graphic) BÚx £À÷ÁÖ Áºn[PøÍU öPõsh 

£h‰» TmhzuõÀ E¸ÁõUP¨£kQÓx. BÚõÀ ö|Ô¯ Áøµ¦ (Vector 
graphic) BÚx ÷Pzvµ Pou E¸UPÎÚõÀ E¸ÁõUP¨£kQÓx.

 ² £µÁÀ Áøµ¦ E¸ÁõUPzvÀ ÷Põ¨¦ Â£µ® ÷£n¨£kÁvÀø», BÚõÀ 

ö|Ô¯ Áøµ¦ E¸ÁõUPzvÀ ÷|º÷PõkPÎß GsoUøP, ÁøÍ÷PõkPÎß 

GsoUøP, ¤µ÷¯õQUP¨£kQßÓ Áºn[PÒ, Bµ®£®, •iÄ ÷£õßÓ 

Â£µ[PÒ ÷£n¨£kQßÓÚ.

 ² £µÁÀ Áøµ¤ß uµ® AuøÚ ö|¸UP©õUS®÷£õx SøÓUP¨£k®. BÚõÀ 

ö|Ô¯ Áøµ¤ß  uµ® ©õØÓ©øh¯õx.

 ² GÚ÷Á ö£¸¨¤UPU Ti¯  Áøµ¤ØS £µÁÀ Áøµ¦ ö£õ¸zu©ßÖ, BÚõÀ 

CuØS ö|Ô¯ Áøµ¦ ö£õ¸zu©õÚx.

©ØÖ®

 ² £µÁÀ Áøµ¤ß E¸ÁõUP®, ÷\ª¨¦UPõP PoÛ {øÚÁPzvÀ SøÓÁõÚ 

Ch÷© £¯ß£kzu¨£kQßÓx. BÚõÀ ö|Ô¯ Áøµ¤ØS PoÛ {øÚ 

ÁPzvÀ AvP Ch® ÷uøÁ¨£kQÓx.

 ² £µÁÀ Áøµ¤øÚ E¸ÁõUPU Ti¯ ö©ßö£õ¸ÒPÒ ]» ¤ßÁ¸©õÖ - 
Adobe Image Ready, Adobe Photoshop, ProArtRage, Artweaver, Corel PHOTO-
PAINT, GIMP, Deluxe Paint, GIMP shop, Microsoft Photo Editor

 ² ö|Ô¯ Áøµ¦ÁøP ö©ßö£õ¸ÒPÒ ]» ¤ßÁ¸©õÖ - Adobe Illustrator, 
Adobe Live Motion, Corel Paint Shop Pro, Adobe Fireworks, Microsoft Expression 
Design, DrawPlus, X ara Photo & Graphic Designer, CorelDRAW, Litha-Paint
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£µÁÀ Áøµ¤ÚõÀ E¸ÁõUP¨£mk 

ö£›uõUP¨£mhx 

ö|Ô¯ Áøµ¤ÚõÀ E¸ÁõUP¨ 

£mk ö£›uõUP¨£mhx

E¸ÁõUP¨£h 

÷Ási¯ 

Áøµ¦PÒ

E¸ 4.11

Áøµ¦  ö©ßö£õ¸øÍ¨  £¯ß£kzv  {ø»zu  Áøµö£õßøÓ 

E¸ÁõUSuÀ

{ø»zu  Áøµö£õßøÓ  E¸ÁõUSÁuØS ö£õ¸zu©õÚ  ö©ßö£õ¸ÒPÒ £» 

Põn¨£kQßÓÚ. AÁØÔÀ ]» ÷©÷» SÔ¨¤h¨£mkÒÍÚ. BÚõÀ A÷ÚP 

ö©ßö£õ¸ÒPÒ £n® ö\¾zv öPõÒÁÚÄ ö\´¯¨£h ÷Ási¯øÁ¯õS®. 

Azxhß CøÁ  AøÚzx  £oaö\¯À  •øÓø©PÎ¾®  C¯[Põx.   GÚ÷Á   

C»Á\©õP   Cøn¯zv¼¸¢x   C»SÁõP   uµÂÓUP® ö\´¯UTi¯, A÷ÚP 

£oö\¯À •øÓø©PÎ¾® {ÖÁ¨£mk C¯[PU Ti¯ ö©ßö£õ¸öÍõßøÓ¨ 

£ØÔ Bµõ´÷Áõ®.

GIMP
Cx GNU ÁøP, vÓ¢u £oö\¯À •øÓø©UPõP E¸ÁõUP¨£mh Kº Áøµ¦  

ö©ßö£õ¸Ò {PÌa]¯õS®  ^Image Manipulation Program&. ö©ßö£õ¸ÍõÚ 

Cx £i©ö©õßøÓ E¸ÁõUP, ©õØÔ¯ø©UP, JÎ¨£h[PøÍ J¸[Pø©UP 

©ØÖ® ö©¸Tmh £¯ß£kzu¨£kQÓx. AvP £s¦U TÖPøÍU öPõsh 

C¢u ö©ßö£õ¸øÍ \õuõµn £i©ö©õßøÓ E¸ÁõUSÁuØS® AÀ»x E¯º 

uµzøuU öPõsh JÎ¨£h[PøÍ J¸[Pø©¨£uØS® £¯ß£kzu •i²®. 

Cx J¸ ""£µÁÀ Áøµ¦'' ^Raster graphic& ö©ßö£õ¸ÍõS®.
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GIMP  ö©ßö£õ¸ÍõÚx, UNIX £oö\¯À •øÓø©ø¯ Ai¨£øh¯õPU 

öPõshx. Azxhß C¢u ö©ßö£õ¸ÍõÚx Microsoft Windows ©ØÖ® MAC 
OSX £oö\¯À •øÓø©PÎ¾® C¯[PUTi¯uõP Põn¨£kQÓx. GIMP 
ö©ßö£õ¸øÍ  PoÛ°÷»  {ÖÁuØPõP ¤ßÁ¸® •PÁ›US ö\ÀP:  

http://www.gimp.org/downloads / 

GIMP ö©ßö£õ¸Îß Áøµ¦¨ £¯|º Cøh•P® (Graphical User 
Interface)

1 3 4

2

5

E¸ 4.12

1'   ¤µuõÚ P¸Â¨ ö£mi (The Main Toolbox)

Áøµö£õßøÓ J¸[Pø©UP (Editing) ¤µ÷¯õQUP¨£kQßÓ C¢u P¸Â¨ 

ö£miø¯ ÷uøÁU÷PØ£ ö£ÓÄ® AÀ»x ‰iÂhÄ® •i²®. CuØPõP, 

Edit → Preferences →Toolbox →
P¸Â¨ ö£miø¯¨ ö£Ó Enable I²® ‰iÂh Disable I²® öu›P.
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£hÄ¸ 

(Icon)
P¸Â°ß 

ö£¯º

SÖg\õÂ 

(Shortcut 
Key)

Â£µ®

öu›ÄU P¸ÂPÒ  (Selection tools)

Rectangle R ÷uøÁ¯õÚ £Svø¯ ö\ÆÁP 

AÀ»x \xµ ÁiÂ÷» öu›uÀ

Ellipse E ÷uøÁ¯õÚ £Svø¯ Ámh®, 

AÀ»x }ÒÁmh ÁiÂ÷» 

öu›uÀ

Free (Lasso) F _mi°ß EuÂ²hß £i©zvß 

÷uøÁ¯õÚ £Svø¯ ÷uøÁ¯õÚ 

ÁiÂ÷» öu›uÀ

Fuzzy (Magic 
Wand)

U J÷µ Áºnzøu²øh¯, JßÖh 

öÚõßÖ CønUP¨£mh £Sv 

PøÍz öu›uÀ

By Colour Shift + O  öu›Ä ö\´u Áºn® £i©zvÀ 

G[S Põn¨£iÝ® A¢u Áºnz 

øu²øh¯ £SvPøÍz öu›uÀ

Scissors I öu›Ä ö\´¯ ÷Ási¯ £Svø¯a 

_ØÔ öu›uÀ

Foreground - £i©zvß •ßÚoø¯z öu›uÀ

Áºn® wmk® P¸ÂPÒ (Brush Tools)
Bucket Fill Shift + B öu›Äö\´u £SvUS Áºn® 

AÀ»x ÁiÁö©õßøÓ ChÀ

Blend 
(Gradient)

L öu›Äö\´u £SvUS ÁºnU 

P»øÁø¯ ChÀ

Pencil N öu›Äö\´u £SvUS Áºn® 

ChÀ, öu›Ä ö\´u ö£ß]À 

AÍÂØ÷PØ£ ÷Põk ÁøµuÀ
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Paintbrush P öu›Äö\´u ö£ß]À AÍÂØ 

÷PØ£ ÷Põk ÁøµuÀ, Áºn® 

wmhÀ

Eraser Shift + E Áøµ¤¾ÒÍ  ÷PõkPøÍ 

AÈzuÀ

Airbrush A Áºnz yÂø¯ £¯ß£kzxuÀ 

÷£õ» Áøµ¤ß Áºn[PøÍ yÄ 

ÁuõÀ ÁºnªhÀ

Ink K Áºnz y›øP÷£õÀ Áøµ¤ß 

«x Áºn[PøÍz wmk®. _m 

iø¯  ÷ÁP©õP  Aø\¨£uõÀ  

y›øP°ÚõÀ ©øÓUP¨£mh  ¤µ

÷u\®  SøÓÁøhÁxhß   ö©x

ÁõP  Aø\¨£uõÀ £µ¨¦  AvP›U 

P¨£kQÓx.

Clone C Áøµ¤À öu›Äö\´u £Svø¯ 

÷ÁöÓõ¸ ChzvÀ ¤µv ö\´²®

Heal H Áøµ¤÷» ö£õ¸zu©õÚ Áº 

nzuõÀ Áºn® wmkuÀ

Perspective 
Clone

- ÷Põnzøu ©õØÔ¯Ähß Clone 
Tool ÷£õÀ öuõÈØ£k®. 

Convolve 
(Blur/Sharpen)

Shift + U Áøµ¤øÚ öuÎÁØÓuõP AÀ»x 

v¸zu©õÚuõP ©õØÖ®

Smudge S Áøµ¤øÚ ©[P»õUS®.

Dodge/Burn Shift + D Dodge ‰»® Áøµø£ öÁÎa 

\©õÚuõPÄ® Burn ‰»® P¸ø© 

¯õÚuõPÄ® ©õØÓ¨£k®.

Ch©õØÖ® P¸ÂPÒ (Transform Tools)
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Move M öu›Äö\´u £Svø¯ A[S® 

C[S® |PºzuÀ

Align Q Áøµ¤øÚ ÷|º Á›ø\¨£kzu 

EuÄ®

Crop Shift + C Áøµ¤ß ÷uøÁU÷PØ£ £›©õn 

zøu SøÓzuÀ

Rotate Shift + R öu›Äö\´u £Svø¯ AÀ»x J¸ 

{øµø¯  ÷uøÁU÷PØ£ _ÇØÖuÀ

Scale Shift + T öu›Äö\´u £Sv°ß AÀ»x J¸ 

{øµ°ß  £›©õnzøu ÷uøÁU 

÷PØ£ ©õØÔ¯ø©zuÀ

Shear Shift + S öu›Äö\´u £Svø¯ J¸ vø\ 

°À uÒÐuÀ

Perspective Shift + P öu›Äö\´u £Sv°ß AÀ»x 

AkUQß £õºøÁU ÷Põnzøu 

÷uøÁU÷PØ£ ©õØÖuÀ

÷ÁÖ P¸ÂPÒ (Other tools)
Path B ÁiÁzxhß Ti¯ ÷Põk ÁøµuÀ, 

÷uøÁU÷PØ£ öu›Ä ö\´u¾®,  

©ØÖ® ©õØÔ¯ø©zu¾®

Colour Picker O Áøµ¤¾ÒÍ ¯õ÷uÝ® Áºn 

ö©õßøÓz öu›Ä ö\´uÀ

Magnify 
(Zoom)

Z Áøµ¤ß  Põm]ø¯ ö£›uõU 

SuÀ AÀ»x ]ÔuõUPÀ

Measure Shift + M }Í AÍÄ ©ØÖ® ÷PõnzøuU 

Põm]¨£kzuÀ

A
Text M GÊzxUPøÍ Em¦SzuÀ
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2' P¸Â ÷uºÄPÒ  (Tool options) (  Áøµö£õßøÓ E¸ÁõUS® ÷£õx G®©õÀ 

£¯ß£kzu¨£kQßÓ  P¸ÂPÐUPø©¯ ©õØÓ©øh²® C¢u vøµ¯õÚx 

£¯ß£kzxQßÓ SÔzu  P¸Âø¯ øP¯õÐÁuØS¨ £¯ß£kzu¨£k®.

3' £i© \õÍµ® (Image window)(  Cx E¸ÁõUP¨£kQßÓ Áøµ¤øÚ Põm]¨ 

£kzu EuÄQßÓx. ÷uøÁ¯õÚ GsoUøPU÷PØ£ £» £i© \õÍµ[PøÍ 

vÓ¢xöPõÒÍ •i²®. C¢{ø»°À £» öu›ÄPøÍ ÷©ØöPõÒÍ •i²®.  

AÆÁõÔßÔ J¸ \õÍµzøu ©õzvµ® vÓUP ÷Áskö©ÛÀ, CuøÚ 

÷uøÁU÷PØ£ ©õØÔUöPõÒÍ •i²®. CuØPõP, 

  Windows → Single  Window Mode I öu›Ä ö\´P.

4' AkUSPÒ (Layers)"  ö\ÆÁÈPÒ (Channels)  ©ØÖ® ÁÈPÒ (Paths)(  Gß£Ú 

uzuÀPÒ   ^Tabs&  ‰»® Põmh¨£mkÒÍÚ. ÷uøÁU÷PØ£ CÁØÔß «x 

ö\õkUSÁuõÀ CÁØøÓ vÓ¢xöPõÒÍ •i²®.

5' Brushes$Patterns$Gradients( Áøµö£õßøÓ E¸ÁõUPÄ® ÷uøÁU÷PØ£ 

Áºn® wmhÄ® C¢u Á\v EuÂ¦›QÓx.

 ² Áøµ¦ ö©ßö£õ¸Ò £¯ß£õmiß ¤µuõÚ A®\[PÒ:

Áøµö£õßøÓ 

E¸ÁõUP ¦v¯ 

vøµø¯¨ ö£ÓÀ 

^New&

 ² File → New Cß ‰»® New Image 
ö\õÀ»õhØö£mi vÓUP¨£k® ^dia-
logue box&  

 ² Áøµ¤ß £›©õnzvØS ÷uøÁ¯õÚ 

AÍÃmk A»øP öu›P

 ² E¯µ, AP»[PøÍ ÁÇ[SP AÀ»x 

•ßÚº E¸ÁõUP¨£mh £›©õn 

ö©õßøÓ¨ ö£ÖP ^Template&.  
 ² OK ö£õzuõøÚ ö\õkUSP.
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Áøµ¤øÚ HØÓÀ 

^Export&

 ² File → Export öu›Äö\´P,

 ² Cuß÷£õx   ö£Ó¨£k®    Image   
ö\õÀ»õhØ ö£mi°À Áøµ¤ß 

ö£¯øµ ÁÇ[SP

 ² Places  CÀ ö£õ¸zu©õÚ  Chzøu 

^Saving Location& öu›P.

 ² Select File Type ̂ By Extension& GßÝª 

hzvÀ ö£õ¸zu©õÚ  ÷Põ¨¦ ÁøPø¯  

^File Format& öu›P.

 ² Export ö£õzuõøÚ ö\õkUSP.

 ² ^C[S ÷Põ¨¦ ÁøPUPø©¯ Áøµ¦ 

ö|¸UP® |øhö£Ö®&

E¸ÁõUP¨£mh 

Áøµ¤øÚ          

÷\ªzuÀ ^Save&

 ² File → Save ö\õkUSP.

 ² Save   Image   ö\õÀ»õhØ  ö£mi 

vÓUP¨£k®.  CvÀ  ö£õ¸zu©õÚ 

Chzøu öu›Äö\´x, Áøµ¤ØS 

ö£¯öµõßøÓ ÁÇ[SP.

 ² Save ö£õzuõøÚ ö\õkUSP. 

 
PÁÛUP - GIMP ö©ßö£õ¸ÍõÀ E¸ 

ÁõUP¨£mh Áøµ£õÚx XCF ÷PõøÁ   

}m]ø¯U    öPõsi¸US®.

^File extension&  ^E+® - image1.xcf&

E¸ÁõUP¨£mk, 

÷\ªUP¨£mh 

Áøµ¤øÚz vÓzuÀ 

^Open& 

 ² File → Open ö£õzuõøÚ ö\õhUSP.

 ² Cuß÷£õx  ö£Ó¨£k®  Open  
ö\õÀ»õhØ  ö£mi°À  Áøµ¦ 

÷\ªUP¨£mh Chzøuz öu›P.

 ² Names GÝªhzvÀ Áøµ¤øÚz 

öu›P.

 ² Open ö£õzuõøÚ ö\õkUSP.

GIMP ö©ßö£õ¸Îß £¯ß£õk

1'  £i©[PÎß ÷\º©õÚzuõÀ Áøµö£õßøÓ E¸ÁõUPÀ.

    Áøµ¤ß E¸ÁõUPzxUPõÚ £i©[PøÍ GÆÁõÖ ö£Ó •i²®?

 ² PoÛ°À ÷\ªUP¨£mkÒÍ  £i©[PÒ

 ² Á¸i ‰»® Scan ö\´¯¨£mk PoÛ°À ÷\ªUP¨£mh  £i©[PÒ
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 ² C»UP•øÓ P©µõ ‰»® £hö©kUP¨£mk PoÛ°À ÷\ªUP¨£mh  

£i©[PÒ

 ² C»UP•øÓ P©µõ Á\vø¯UöPõsh øP¯hUPz öuõø»÷£] ^smartphone& 
‰»® £hö©kUP¨£mk PoÛ°À ÷\ªUP¨£mh  £i©[PÒ

E¸ 4.13

÷©¾ÒÍ  £h©õÚx  öÁÆ÷ÁÓõP  GkUP¨£mh   ‰ßÖ £i©[PøÍa ÷\ºzx 

E¸ÁõUP¨£mh Áøµ¤øÚU PõmkQÓx. Cx ¤ßÁ¸©õÖ E¸ÁõUP¨£mhx. 

CuØPõP E©x PoÛ°À ÷\ªUP¨£mh AÀ»x C»SÁõP ö£ÓU Ti¯ 

£i©[PøÍ¨ £¯ß£kzxP.

£i 1'  GIMP ö©ßö£õ¸øÍ vÓ¢xUöPõÒP'

£i 2'  Menu bar CÀ Windows → Single  Window Mode Iz öu›P.

PÁÛUP - GIMP ö©ßö£õ¸Îß Áøµ¦¨ £¯|º Cøh•P® C¸ÁøPPÎÀ 

Põmh¨£k®. AøÁ Single -Window Mode AÀ»x Multi Windows Mode 
BS®. Áøµ¤ß E¸ÁõUPzvß •ßÚº ÷uøÁU÷PØ£ Cøh•Pzøu 

©õØÔUöPõÒÍ ÷Ásk®.

£i   3'  ÷uøÁ¯õÚ £i©[PøÍ¨  ö£ÖÁuØPõP, File → Open Iz öu›P,

 Open ö\õÀ»õhØö£mi ‰»® £i©[PøÍ vÓ¢xUöPõÒP.

C[S  £i©[PÒ   JÆöÁõßÓõP   vÓUP¨£h   ÷Ási²ÒÍuõÀ 

Open as Layers Gß£øu vÓUP ÷Áshõ®. 

£i   4'  C[S  •ßÚÛ   P¸Â  Â¸¨¦z   ÷uºÂ¼¸¢x  Foreground and
background I   öu›Ä  ö\´P.  ¤ßÚo  Áºn[PÍõP  •øÓ÷¯

PÖ¨¦ ©ØÖ® öÁÒøÍ°øÚz öu›P. CuØPõP  E¸ÂÀ  Põmh¨

£mkÒÍÁõÖ Áºn[PøÍU  öPõsh ö£mi°ß  «x ö\õhU 

SÁuõÀ ÷uøÁ¯õÚ  {Ózøu¨ ö£ÖP, AÀ»x  HTML  notation
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GÝ® PmhzvÀ PÖ¨¦ ÁºnzxUPõP 000000 ©ØÖ® öÁÒøÍ  

ÁºnzxUS ffffff GÚ umha]mk, OK ö\´P.

E¸ 4.14

£i  5'  ¦v¯ Áøµ¤ØPõÚ vøµø¯¨   ö£Ó,  File → New öu›P. C[S

  ö£Ó¨£k®   Create  a  New  Image   ö\õÀ»õhØ   ö£mi°÷»

  AP»® -  1200px"   E¯µ®  800px   ^£h‰»®&   GÚ   Cmk OK   
  ö£õzuõøÚ  ö\õkUSP.  ^÷ÁÖ £›©õn[PÐUPõP  Templates    
  £¯ß£kzu •i²®&.  

÷uøÁU÷PØ£ £›

©õnzøu  CkP.

(AP»®, (Width) 
E¯µ® (Height))  

E¸ÁõUP¨£mkÒÍ 

£›©õn[PøÍ 

ö£Ó (Template) 

£›©õnzvØ 

PõP AÍÃmk 

A»øP öu›P.

E¸ 4.15

•ßÚo

¤ßÚo
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C¢{ø»°À vøµ¯õÚx ¤ßÁ¸©õÖ Põm]¯ÎUS®

vÓUP¨£mkÒÍ 

£i©[PÒ ¦v¯  Áøµ¤Ø 

S›¯ vøµ 

E¸ 4.16

£i   6' •u»õÁx  £i©zøuz  öu›P.  AuØöPõzu  AkUQß  «x 

  (Layer)  Á»x  _mi  ö£õzuõøÚ  ö\õkUQ,  Add an Alpha   
  Channel Iz öu›P.

Alpha Channel, £i©zvøÚ FkPõmhÀ (Transparent) ö\´¯ EuÄQßÓx. 

CµshõÁx £i©zøu ÷\ºUS®÷£õx, C¢u FkPõmhÀ uõÚõP÷Á 

÷uõßÖ®. BÚõÀ AkUQ÷» J¸ £i©® ©õzvµ® Põn¨£k® {ø»°À Add 
an Alpha Channel öu›Ä ö\´¯¨£hÀ ÷Ásk®. 

     

E¸ 4.17

£i   7'  P¸Â¨  ö£mi°¾ÒÍ  ^Ellipse& öu›Ä P¸Âø¯ öu›P.  Tool 
options  → Feathers    öu›Äö\´x, ÷uøÁ¯õÚ  £i©zvß«x 

Ellipse ÁiÂÀ Aøh¯õÍªkP.
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£i    8' Select → Feathers, Feather Cß Euõµn¨ ö£Ö©õÚ©õP 10 
£h‰»zøuz öu›P.   OK ö£õzuõøÚ  ö\õkUSP. Edit → Copy 
Visible Iz öu›P.

E¸ 4.18

£i   9'  ¦v¯  vøµ°ß  ÷©À ö\õkUSP. Edit → Paste as → New Layer   
  öu›P. ö£Ó¨£mh  £i©¨  £Sv¯õÚx ¦v¯ Áøµ£õÚx vøµ  

  «x ÷uõßÖ®. |Pºzx® P¸Âø¯ ^Move tool& £¯ß£kzv £i©  

  zøu vøµ°ß «x  {ø»¨£kzxP.

£i 10'     C¢u Áøµ¦PÎß  E¸ÁõUPzvÀ  AøÚzx £i©[PÐ® J÷µ 

£¸©øÚU öPõsi¸¨£x ]Ó¢ux. CuØPõP P¸Â Â¸¨¦z 

÷uºÄ P¸Â¨ö£mi°¾ÒÍ  Scale Tool   Iz  öu›P. £i©zvß 

«x ö\õkUSP. Scale ö\õÀ»õhØ ö£mi°÷» £i©zvß AP»®  

450 £h‰»®  GÚÄ®,  E¯µ®  600  £h‰»®   GÚÄ®  CkP.    

Scale ö£õzuøÚ ö\õkUSP.

E¸ 4.19

£i   11'  ÷©¾ÒÍ £i•øÓ 5" 6" 7" 8" 9 ©ØÖ® 10 BÀ SÔ¨¤mhÁõÖ 

  £i•øÓPøÍ¨  ¤ß£ØÔ ©ØøÓ¯ C¸ £i©[PøÍ²®  Áøµ  

  ¦z vøµ°À {ø»¨£kzxP. £¸©øÚ²® ©õØÖP.
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C¢u AkUSPÒ (Layers) AøÚzx® ¤ßÁ¸©õÖ 

Põm]¯ÎUS®

                                                                                      

£i   12' J¸ø©¯õUSuÀ  ©ØÖ® ÷\ªzuÀ ÷£õßÓ  ö\¯Ø£õkPÒ •i¢ 

u¤ß AøÚzx AkUSPøÍ²® JßÔønzx J¸ AkUPõP 

©õØÓÀ AÁ]¯©õS®.  CuØPõP,  AkUSPøÍU  öPõsh 

vøµ°÷» Á»x _mi¨  ö£õzuõøÚ  ö\õkUSP. ¤ßÚº, Merge  
Visible Layers → Expand as necessary → Merge I ö\õhUSP.

  

£i   13'  E¸ÁõUP¨£mh  Áøµ¤¾ÒÍ  ÷uøÁ¯ØÓ  £SvPøÍ   }USÁu 

  ØPõP Crop I £¯ß£kzv ÷uøÁ¯õÚ ¤µ÷u\zøu ©õzvµ® 

  öu›P.

£i  14'      Áøµ¤ØS Border JßøÓ Ck 

ÁuØPõP, Filter → Decor 
→Add Border Iz öu›P. 

Border X=10" Border  Y = 10" 
GÚÄ® Border Áºn® }»® 

GÚÄ® Cmk, Ok ö£õz 

uõøÚ ö\õhUSP.

Border    X = 15"    Border   Y=15"  GÚÄ® 

Border Áºn® ©g\Ò GÚÄ® Cmk, Ok 
ö£õzuõøÚ ö\õkUSP.

÷©¾ÒÍx÷£õÀ C¸ uhøÁPÎÀ Border I CkP.

 

E¸ 4.20

E¸ 4.21
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£i    15'  Áøµ¤øÚ ÷\ªzu ^Save& ¤ßÚº AuøÚ HØÖ©v ^Export&   

  ö\´P.

AkUSPÒ ^Layers&
GÎ¯ ©ØÖ® ]UP»õÚ Áøµ¦PøÍ E¸ÁõUSÁuØPõP AkUSPÎß   

£¯ß£õk   ªP   AÁ]¯©õS®.  Áøµ¦US   C¯À¦PøÍ ÷\º¨£uØS   

AkUSPÒ £¯ß£kzu¨£kQßÓx.  C¯À¦PøÍ øP¯õÐÁuØS 

AkUSPÒ EuÄQßÓÚ. AkUSPÒ Gß£x FkPõmhzuUP umkPÒ/

AmøhPÍõS®.  BÚõÀ  C¯À¦PÒ  JßÔß  «x  JßÖ ÷\ºÁuõÀ 

AuØS RÊÒÍ AkUS Pm¦»ÚõÁvÀø».

 ² AkUSPÒ vøµ°À JÆ÷Áõº £i©zxUPõPÄ® öÁÆ÷ÁÓõÚ 

AkUSPÒ £¯ß£kzu¨£hÀ ÷Ásk®.

 ² CuÚõÀ SÔzu AkUQ¾ÒÍ C¯À¦PøÍ ©õØÖÁuõÀ Ax  

©ØøÓ¯ AkUSPÐUS £õv¨¦ HØ£kzuõx. (GÊzx, Áºn® 

ChÀ, ÁiÁø©zuÀ, öuõSzuÀ ÷£õßÓÚ)

 ² AkUPõÚx Pm¦»ÚõP AÀ»x Pm¦»ÚõPõ©À C¸¨£uØPõP 

Ps Aøh¯õÍzøu¨ £¯ß£kzxP.

 ² ©õØÓ[PÒ ö\´ÁuØPõP ¤ßÁ¸® AkUSPøÍ £¯ß£kzxP. 

1' ¦v¯ AkUS ^New&

2' AkUS Ao ^Group&
3' AkUøP |PºzuÀ ^Move&
4' AkUS «Ò¤µv ^Duplicate 

layers&
5' AkUS |[Tµ® ChÀ 

^Anchor&
6' AkUøP }UPÀ ^Delete&

 ² ^Opacity& JÎ¦Põ C¯À¦ -
Cx AkUSPÒ vøµ°À  ÷©À

£Sv°À Põn¨£kQÓx. öu›Ä

ö\´¯¨£mh AkUöPõßÔß 

JÎ¦Põ ^Opacity& C¯Àø£ 

AvP›¨£uß AÀ»x SøÓ¨ 

£uß ‰»® AuØS RÊÒÍ 

AkUPõÚx Pm¦»ÚõuÀ AvP 

›US® AÀ»x SøÓÁøh²®. 

E¸ 4.22

1 3 5

2 4 6

JÎ¦Põ 

C¯À¦
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Opacity 100%

Opacity 75%

Opacity 50%

E¸ 4.23

2.  GÊzx¸øÁU öPõsh Áøµ¦PøÍ E¸ÁõUPÀ

E¸ 4.24

£i   1'  GIMP ö©ßö£õ¸øÍ vÓ¢xUöPõÒP

£i   2'  ¦v¯ Áøµ¦UPõÚ vøµø¯¨ö£Ó File → New I öu›P.

  C¢{ø»°À  ö£Ó¨£k®   Create a New Image    ö\õÀ»õhØ
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  ö£mi°À  AP»® & 640px GÚÄ® E¯µ® 400px GÚÄ® Cmk, 

  OK ö£õzuõøÚ ö\õkUSP.

£i   3'  •ßÚo ©ØÖ® ¤ßÚo  Áºn[ 

PÐUPõP  •øÓ÷¯   HTML   notation 
ö£Ö©vø¯   29c89c"  e3216a   GÚ 

©õØÔ  Áºnzøu¨  ö£ÖP.  ¤ßÚº 

Gradient P¸Âø¯z öu›P.

                                     E¸ 4.25

£i   4'  _miø¯ ö\õkUQ ¤ßÚoz vøµ°÷» ^Background window& 

Chª¸¢x Á»©õP ÷PõöhõßøÓ  ÁøµP.   C¢{ø»°À   öu›Ä       

ö\´u  Áºn[PÐUPø©¯ ¤ßÚo Áºn® ¤µ÷¯õQUP¨£k®.  

          

E¸ 4.26

£i   5'  GÊzöuõßøÓ   ÷\º¨£uØPõP,  P¸Â¨   ö£mi°À  GÊzx¸   

P¸Âø¯ öu›P. C¢{ø»°À AuØPø©¯ P¸Âz ÷uºÄ ^Tool 
options& ÷ÁÖ£k® .  GÊzxUS    ö£õ¸zu©õÚÁõÖ ¤ßÁ¸® 

Â£µ[PøÍ ©õØÖP. GÊzx¸ ÁøP  Gill Sans, Ultra Bold AÀ»x 

ui¨¦hß   Ti¯   GÊzx¸ÁøP,  GÊzx¸ £¸©ß 72 ^Font 
Size&, Áºn®  PÖ¨¦ ^Color&.

Cuß ¤ßÚº vøµ°ß «x ö\õkUQ NATURE GÚ umha_ ö\´P. Move P¸Âø¯ 

E£÷¯õQzx umha_ ö\´u ö\õÀø» vøµ°ß ©zv°÷» {ø»¨£kzxP.

£i   6'  GÊzx¸øÁa _ØÔ GÀø»ö¯õßøÓ Ch, AkUSPÒ vøµ°÷» 

GÊzx¸øÁU  öPõsh  AkUøP  öu›P. RÊÒÍ Add new Layer
I ö\õkUQ ¦v¯ AkUöPõßøÓ ^Layer& ö£ÖP. AuØS Text 
border GÚ¨ö£¯›kP. A®¦USÔø¯ £¯ß£kzv Text border 
AkUøP GÊzx¸ AkUQß RÌ |PºzxP.



 C»Á\¨ £õh¡À122 C»Á\¨ £õh¡À 123

E¸ 4.27

£i   7'  GÊzx¸  AkUøP  öu›P,  Á»x  _mi  ö£õzuõøÚ  ö\õkUQ  

  Alpha to selection Iz öu›P.

  
£i   8'  £¸©øÚ     ö£›uõUP,  

Select → Grow Iz öu›P.

Grow Selection ö£Ö© 

vø¯ 2 (£h ‰»®) Áøµ 

AvP›UP.  OK ö£õz 

uõøÚ ö\õkUSP. 

£i   9'  Text border AkUøPz öu›P. •ßÚo Áºn®  (Foreground 
colour)  öÁÒøÍø¯z öu›¢x, AuøÚ¨ ¤µ÷¯õQUP.     Bucket 
fill  P¸Âø¯    öu›¢x  GÊzx¸Âß   «x ö\õkUSP.

  Cuß ¤ßÚº Select → None öu›P.

£i   10'  GÊzx¸ÂØS     {Çø»a   

^Shadow& ÷\º¨£uØS Text 
border  AkUøPz   öu›P. 

menu bar  CÀ   Filters → 
Light and  Shadow → Drop
Shadow I öu›P. E¸ÂÀ 

Põmh¨£mkÒÍÁõÖ ©õØ 

Ô¯ø©zx, CÖv°÷» OK  
ö£õzuõøÚ ö\õkUSP.

 

E¸ 4.28

 E¸ 4.29
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£i    11'      {ø»¨£kzv¯  ¤ßÚº  AkUSPÒ   AøÚzøu²®   JßÖ 

  ÷\ºzuÀ  AÁ]¯©õS®.  CuØPõP AkUS  vøµ°À Á»x 

  _mi  ö£õzuõøÚ   ö\õkUQ,  Merge   Visible  Layers    →
  Expand as necessary → Merge I ö\õkUSP.

£i    12'  •ßÚº  PØÓ  AÔøÁU  öPõsk  Áøµ¦US  GÀø»ö¯õßøÓ

  CkP. ö£õ¸zu©õÚ ChzvÀ ÷\ªUSP. ¤ßÚº Export ö\´P. 

PÁÛUP - C¢u Áøµ¤ß ¤ßÚoUPõP £À÷ÁÖ Áºn[PÒ, A»[Põµ[PÒ, 

¤µ÷¯õQUP¨£h  •i²®.  öu›Ä  ö\´u   A»[Põµzvß   «x   _mi¯õÀ 

ö\õkUQ AuøÚ AÊzva ö\ßÖ ¤ßÚo°ß «x ÂkÂUP ̂ Drag and drop&' 
÷ÁÖ£mh £i©[PøÍ ÷\ºzx ¤ßÚoö¯õßøÓ E¸ÁõUPÄ® •¯Ø] ö\´P

Euõµn®

E¸ 4.30

 ö\¯Ø£õkPÒ

1' Â÷\h {PÌÄPÎÀ E[PÍõÀ GkUP¨£mh ¦øP¨£h[PøÍ 

JßÔønzx Áøµö£õßøÓ E¸ÁõUSP.

2' Áøµ¤ß  E¸ÁõUPzvÀ  £¯ß£kzu¨£kQßÓ Filter •øÓ 

PøÍ ¤µ÷¯õQzx E©x Áøµ¤ß uµzøu AvP›UP.

3' C»[øP°¾ÒÍ  ¤µ]zvö£ØÓ Ch[PøÍ Cøn¯zuÍzv¼ 

¸¢x  uµÂÓUP®  ö\´x,  Áøµö£õßøÓ  E¸ÁõUSP. AuØS 

ö£õ¸zu©õÚ uø»¨¦ AÀ»x AÔ•Pö©õßøÓ EÒÎkP.

4' uØPõ»zvÀ £µÁ»õP £¯ß£kzu¨£kQßÓ C»UP•øÓ Aa_¨ 

£i©[PøÍ ÷©ØöPõÒÍUTi¯ÁõÖ AøÇ¨¤uÌ JßøÓ 

E¸ÁõUSP.

5' £õh\õø»°À  |øhö£ÖQßÓ  Â÷\h    {PÌöÁõßÖUPõP 

""÷£Úº''  JßøÓ  E¸ÁõUSP.
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4'2   C¸£›©õn JÎ°¯À Aø\Åmh®
    

C»UP•øÓ Áøµö£õßøÓ E¸ÁõUSÁx £ØÔ²® Auß Ai¨£øh A®\[ 

PøÍ £ØÔ²® •ßøÚ¯ £õh[PÎÀ PØÕºPÒ. 

JÎ°À Aø\Åmhzvß  ¤µuõÚ  ÷|õUP®  {ø»zu Áøµ¤øÚ ÷©¾® AÊzu 

©õUSÁxhß  AuøÚ ö©´{ø» AÀ»x Esø© {ø»¯õUSÁuõS®. 

EØ£zvø¯ ÷©®£kzx® FhP©õP ÁoP öÁÎ±kPÒ, PoÛ ÂøÍ 

¯õmkUPÒ ©ØÖ® Põmlß (Cartoon) £h[PøÍ E¸ÁõUPÄ® JÎ°¯À Aø\

Åmh[PÒ £¯ß£kzu¨£kQßÓÚ.

JÎ°¯À Aø\Åmh® GßÓõÀ GßÚ?

JÎ°¯À Aø\Åmh® Gß£x ¯õuõ°Ý® C»US ö£õ¸Ò ^Target Οbject&
AÀ»x ö£õ¸ÒPÒ ^Οbjects& £» Aø\Áøu PõmkÁuØS E¸ÁõUP¨£kQßÓ 

Pm¦» Aø\ÅmhU Põm]¯õS®. CuØPõP Á›ø\¯õÚ ̂ Sequentially& \mhP[PÒ 

£»ÁØÔÀ C»US¨ö£õ¸Ò AÀ»x ö£õ¸ÒPÒ  JÊ[Pø©UP¨£k®. C¢uU 

\mhP[PÎß Aø\Ä ÷ÁPzøuU TmiU SøÓ¨£uõÀ SÔzu C»US¨ 

ö£õ¸ÒPÎß Aø\Ä ÷ÁPzøu TmiUSøÓUP •i²®.

JÎ°¯À Aø\Åmhzvß Ai¨£øh  A®\[PÒ

\mhP ÁøPPÒ

JÎ°¯À Aø\Åmh ÁiÁø©¨¤ØPõP \mhP[PÒ £» ¤µ÷¯õ QUP¨£kQßÓÚ. 

AøÁ  •ußø©   \mhP®  ^Key frame&" ""mÃß'' \mhP®  ^Tween frame&" 
\mhP[PÒ ^Frames& ©ØÖ® öÁÖø© ¤µuõÚ \mhP®  ^Blank Keyframes&
÷£õßÓÚÁõS®.

 ² •ußø© \mhP® ^Key frame& - •ußø© \mhPö©ß£x JÎ°¯À  Aø\

ÅmhzvØS ¤µ÷¯õQUP¨£kQßÓ \mhP[PÎÀ Â÷\h©õÚ Kº \mh 

P©õS®. •ußø© \mhP©õÚx £¯|º ‰»÷© öu›Ä ö\´¯¨£kQÓx. 

•Êø©¯õÚ   Aø\Åmhö©õßÔß   •UQ¯©õÚ   Ch[PÎÀ   •ußø© 

\mhP[PÒ £» Põn¨£h •i²®. Euõµn©õP Aø\Åmhzvß Bµ®£zvÀ 

©ØÖ® CÖv°À Põn¨£kQßÓ \mh[PÒ •ußø© \mhP[PÍõP 

P¸u¨£kQßÓÚ.

 ² mÃß \mhP[PÒ ^Tween frames&- Aø\Åmh¼À Pm¦» v›¦UPõm]

PÒ ÁiÁø©UP¨£kÁx  mÃß \mhPzv»õS®. •ußø© \mhP[PÒ 

CµsiØQøh÷¯ Aø\Åmhzøu ÁiÁø©¨£÷u mÃß \mhPzvß 

SÔU÷PõÍõS®. •ußø© \mhP©õÚx  £¯|µõÀ wº©õÛUP¨£k® 
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A÷u÷ÁøÍ, mÃß \mhP©õÚx PoÛ {PÌa]°ÚõÀ ^Computer program&

wº©õÛUP¨£k®.

 ² J¸ ö\UPÛÀ 24 \mhP[PøÍ Cønzx Aø\Åmhö©õßøÓ ÁiÁø©UP 

•i²®. Euõµn©õP Bµ®£, ©ØÖ® CÖv \mh[PÍõP C¸ •ußø© 

\mhP[PÒ EÒÍÚ. 24 \mhP[PÎß Aø\Åmhzvß÷£õx PoÛ 

{PÌa] ^Computer program& Gg]¯ 22 \mhP[PøÍ mÃß \mhP©õP 

ÁiÁø©UQßÓx. CÆÁõÖ £¯|›ß SøÓ¢u£m\ •¯Ø]²hß ]Ó¢u÷Áõº 

Aø\Åmhzøu ÁiÁø©UP •iQÓx.

 ² \mhP[PÒ ^Frames& - ÷|µa \mhP[PÐUS ¦v¯ \mhP[PøÍ ^Frames& 
÷\º¨£uõÀ ÁiÁø©zu JÎ°¯À Aø\Åmhzøu «sk® «sk® 

ö\¯Ø£kzxÁuØS  ^Repeat& ÷uøÁ¯õÚ \mhP[PÎß AÍøÁ AvP›UP 

•i²®. A¢{ø»°À JÎ°¯À Aø\Åmhzvß  ÷|µ® AvP›UP¨£k®.

 ² öÁÖø© •ußø© \mhP® ̂ Blank Keyframe&  - ÷|µa\mhPzxUS öÁÖø© 

•ußø© \mhö©õßøÓ ^Blank Keyframe& EÒÎkÁuõÀ J¸ JÎ°¯À 

Aø\Åmhzvß CÖv°÷» CßÝö©õ¸ Aø\Åmhzøu SÔzu JÎ°¯À 

Aø\Åmhzxhß  CønUP •i²®.

ö©ßö£õ¸öÍõßøÓ    E£÷¯õQzx    JÎ°¯À   Aø\Åmhö©õßøÓ  

E¸ÁõUSuÀ

Vectorian Giotto
Vectorian Giotto Gß£x JÎ°¯À Aø\Åmh[PøÍ ÁiÁø©UP £¯ß 

£kzu¨£kQßÓ Cøn¯zv¼¸¢x uµÂÓUP® ö\´x PoÛ°À {ÖÁ¨ 

£hUTi¯ Kº C»Á\ ö©ßö£õ¸ÍõS®. ÷ÁÖ JÎ°¯À Aø\Åmh ö©ß 

ö£õ¸øÍ¨÷£õÀ SÔ•øÓPøÍ ^Coding& ChÀ AÁ]¯©ØÓ PõµnzvÚõÀ 

C® ö©ßö£õ¸øÍ¨ £¯ß£kzxÁx C»SÁõÚuõS®.

E¸ÁõUP¨£kQßÓ £i©[PøÍ |PºzxÁ÷u C¢u ö©ßö£õ¸Îß ¤µuõÚ 

SÔU÷PõÍõS®. Azxhß C®ö©ßö£õ¸ÎÀ 50 CØS® AvP©õÚ Flash  

JÎ°¯À Aø\ÅmhU  P¸ÂPÒ   Põn¨£kQßÓÚ.  Giotto  ö©ßö£õ¸Îß 

]Ó¨£®\®  GßÚöÁÛß  ]UP»õÚ   {PÌÄPÒ  £»ÁØøÓ  ^Complex scripts& 
\mhP[PÐUQøh÷¯ £õv¨£øh¯õuÁõÖ ªP C»SÁõP CønUP •iÁ 

xhß  AuØS ö£õ¸zu©õÚ J¼°øÚ Em¦SzuÄ® •i²®. Vectorian Giotto 
ö©ßö£õ¸øÍ RÊÒÍ URL CøÚ¨£¯ß£kzv uµÂÓUP® ö\´x PoÛ°÷» 

{ÖÁ •i²®.  

http://vectorian.com/giotto/



 C»Á\¨ £õh¡À126 C»Á\¨ £õh¡À 127

Vectorian Giotto ö©ßö£õ¸Îß Áøµ¦¨ £¯|º Cøh•P® 

(Graphical User Interface)

E¸ 4.31

1. ÁøµuÀ P¸Â¨£møh

2. Built in player

3. AkUSPÒ

4. ÷|µa \mhP®

5. £o¨¤µ÷u\®

6. ÷Pzvµ Pou C»US¨ ö£õ¸ÒPÐ® ÁiÁ[PÐ®

7. Áºn®

8. C¯À¦PÒ \õÍµ®

1' ÁøµuÀ P¸Â¨£møh (Drawing Toolbar) - JÎ°¯À Aø\Åmhzvß 

Ai¨£øh öuõÈØ£õhõÚx £o¨¤µ÷u\zv¾ÒÍ ö£õ¸Ò AÀ»x GÊz 

xUPøÍ Aø\zu¾® AÁØÔÀ ÷ÁÖ£õkPøÍ HØ£kzu¾©õS®.  C[SÒÍ 

P¸ÂPÒ C¢÷|õUPzxUPõP £¯ß£kzu¨£kQßÓÚ. 

1

7 8

6
3

52 4
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Line tool (N)
÷Põk ÁøµuÀ 

P¸Â

£o¨¤µ÷u\zvß «x ÷PõkPøÍ Áøµ¯ ¤µ÷¯õQUP¨£kQÓx.

1' P¸Â°ß «x ö\õkUSP. 

2. Shape GÝ® \õÍµzvÀ,  Pen PmhzvÀ Áµ÷Ási¯ ÷Põmk 

ÁøPø¯²® Auß Áºnzøu²® öu›P. ui¨ø£ wº©õÛUP 

C»UPö©õßøÓ CkP.

3' _miø¯ ö\õkUQ £o¨¤µ÷u\zvß «x ÁøµP'

PÁÛUP &   ÷Põmøh 

Áøµ¢u       ¤ßÚ¸® 

AuøÚz   öu›Äö\´x 

÷uøÁ¯õÚÁõÖ Auß 

ÁøP, Áºn® ©ØÖ® 

ui¨ø£ ©õØÔUöPõÒÍ 

•i²®.
 

Insert bitmap
(M) 

£i©[PøÍ 

EÒÎk® 

P¸Â

£o¨¤µ÷u\zvß «x £i©® JßøÓ EÒÎkÁuØS 

¤µ÷¯õQUP¨£k® ' Giotto £o¨¤µ÷u\zxUS EÒÎh¨£hU 

Ti¯ £i© ÷Põ¨¦ ÁøPPÍõÁÚ   bitmap ^bmp&" JPEG ^jpg&" 
TIFF ^tif&" PNG ^png&" GIF ^gif& and ICO ^ico&'

1' P¸Â°ß «x ö\õhUSP.

2' Cuß÷£õx ö£Ó¨£k® Open ö\õÀ»õhØ ö£mi ‰»® 

÷uøÁ¯õÚ £i©zøu öu›Ä ö\´x vÓ¢xUöPõÒP.

ui¨¦

Áºn®

ÁøP
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T
Text tool

(T)
GÊzx¸ 

P¸Â

£o¨¤µ÷u\zvß «x GÊzxUPøÍ EÒÎh ¤µ÷¯õQU 

P¨£k®.

1' P¸Â°ß «x ö\õhUSP.

2 C¢{ø»°ß vÓUP¨£k® C¯À¦PÒ \õÍµzvß GÊz 

x¸ÁøP, £¸©ß, ui¨£õUPÀ, ÷|º¨£kzuÀ ©ØÖ® 

y›øP \õÍµzv¼¸¢x Áºn® ÷£õßÓÁØøÓ öu›¢x 

£o¨¤µ÷u\zvß «x _mi¯õÀ ö\õkUQ umha]kP.

PÁÛUP - C¯À¦PÒ \õÍµ®  Põm]¨£hÂÀø»ö¯ÛÀ,

Window → Object Properties I ö\õkUSP. Azxhß umha 

]mh  ¤ßÚ¸® ÷uøÁ¯õÚÁõÖ GÊzx¸øÁ ©õØÔ¯ø©UP  

•i²®.

Oval tool
(O)

"}ÒÁmh' 

ÁiÁ P¸Â

£o¨¤µ÷u\zvß «x }ÒÁmh ÁiÁ £i©[PøÍ Áøµ¯ 

¤µ÷¯õQUP¨£k®.

1' P¸Âø¯z öu›P.

2. Shape  \õÍµzvÀ £hzvß GÀø» ÁøP, Áºn® ©ØÖ® 

ÁiÁ® ÷£õßÓÁØøÓ²®  y›øP \õÍµzvÀ £hzxUPõÚ 

Áºnzøu²® öu›P. 

3' _miø¯ ö\õkUQ £o¨¤µ÷u\zvß «x ÁøµP.

uÛ Áºn®

Áºna 

÷\º©õÚ®

£h®

Áºn® Ck®÷£õx

●    uÛ Áºn®

●   Áºna ÷\º©õÚ® AÀ»x £hö©õßøÓ EÒÎh •i²®.
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Rectangle tool (R)
ö\ÆÁP ÁiÁ P¸Â

£o¨¤µ÷u\zvß «x ö\ÆÁP ÁiÁ¨ £h[PøÍ 

Áøµ¯ ¤µ÷¯õQUP¨£k®. ÷©¾ÒÍÁõÖ }ÒÁmh 

ÁiÁ £h[PøÍ Áøµ¯ ¤ß£ØÔ¯ £iPøÍ 

¤ß£ØÖP.

Pencil tool (P) 
ö£ß]À P¸Â

£o¨¤µ÷u\zvÀ «x ÷uøÁ¯õÚÁõÖ ÷PõkPøÍ 

Áøµ¯ ¤µ÷¯õQUP¨£k®.

1'   P¸Âø¯z öu›P.

2' ÷©÷» line tool CÀ ÷PõkPÒ Áøµ¯ ¤ß£ØÔ¯ 

£iPøÍ ¤ß£ØÖP.

Brush tool (B) 
y›øPU P¸Â

£o¨¤µ÷u\zvÀ «x Â¸®¤¯ÁõÖ ui¨¦hß Ti¯ 

ÁiÁ[PøÍ Áøµ¯ ¤µ÷¯õQUP¨£k®. 

1' P¸Âø¯z öu›P.

2' ÷©÷» line tool ©ØÖ® Pencil tool CÀ ¤ß£ØÔ¯ 

£iPøÍ ¤ß£ØÖP.

Selection tool (V)
öu›Ä ö\´²® P¸Â

£o¨¤µ÷u\zvÀ ÁiÁø©zu  ÁiÁ[PÒ GÊz 

xUPÒ ©ØÖ® £h[PøÍ öu›Ä ö\´x |PºzxÁuØS 

¤µ÷¯õQUP¨£k®.

1'  P¸Âø¯ öu›P.

2' A®¦USÔø¯ ÁiÁø©UP¨ 

    £mh   C»US¨  ö£õ¸Îß 

    «x  _mi¯õÀ   ö\õkUSP.

3' SÔzu   C»US¨ ö£õ¸Îß «x öÁÒøÍ {Ó 

]Ö ¦ÒÎPÒ £hº¢x Põn¨£iß, Ax öu›Ä 

ö\´¯¨£mhuõPU P¸u¨£k®.
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Sub selection tool (A)
E£ £SvPøÍ öu›Ä 

ö\´²® P¸Â

ÁiÁø©UP¨£mh ÁiÁzvß ÷uõØÓzøu ©õØÖ 

ÁuØPõP ¤µ÷¯õQUP¨£k®.

1'  P¸Âø¯z öu›P. 

2' ©õØÓ® ö\´¯ ÷Ási¯ Ái 

Ázvß «x ö\õkUSP.

3'  C[S A¢u[PÎÀ EÒÍ Aøh

  ¯õÍzvß «x ö\õkUQ Em 

£UP® AÀ»x öÁÎ£UP©õP  

_miø¯ AÊzv¯ÁõÖ Aø\¨

   £uõÀ ÷uøÁ¯õÚ ©õØÓzøua 

ö\´P.

Lasso tool (L)
""÷»÷\õ'' P¸Â

£o¨¤µ÷u\zvß «xÒÍ £h® ÁiÁ® ÷£õßÓÁØøÓ 

öÁmi ÷ÁÓõUP ¤µ÷¯õQUP¨£k® 

1' P¸Âø¯z  öu›P.

2' £hzvß «x ö\õkUQ ÷uøÁ¯õÚ £Svø¯z 

öu›P. 

Free transform tool 
(Q)

_¯õwÚ Ch©õØÖ® 

P¸Â

{¸©õoUP¨£mh ÁiÁ® AÀ»x £i©[PÎß 

£›©õnzøu ©õØÓÀ, _ÇØÖuÀ ©ØÖ® ÁiÁzøu 

©õØÓÀ ÷£õßÓÁØÖUS ¤µ÷¯õQUP¨£k®. 

1' P¸Âø¯z öu›P

2' C»US¨ ö£õ¸Îß «x   

   ^Οbject& ö\õkUSP.

3' C»US¨   ö£õ¸Îß           

   «xÒÍ   ¦ÒÎPøÍ 

   ö\õkUQ ÷uøÁ¯õÚ 

   ©õØÓzøu ö\´P.

Ink bottle tool (S)
ø© SÁøÍ P¸Â

£o¨¤µ÷u\zvß «x {¸©õoUP¨£mh ÁiÁ[ 

PÎß GÀø»ø¯ ©õØÖÁuØPõP ¤µ÷¯õQUP¨£k® 

1' P¸Âø¯z öu›P.

2' Shape → Pen, C[S ÷uøÁ¯õÚ Áºn®, £¸©ß, 

©ØÖ® ÁøPø¯z öu›P. 

3' ÁiÁzvß «x ö\õkUSP.
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Paint Bucket tool (K)
Áºn "£UöPm' P¸Â

{¸©õoUP¨£mh ÁiÁ[PÎß Áºnzøu ©õØÖ 

ÁuØPõP ¤µ÷¯õQUP¨£k®.

1' P¸Âø¯z öu›P.

2' Shape → Brush, C[S ÷uøÁ¯õÚ uÛ Áºn®, 

ÁºnUP»øÁ AÀ»x £i©ö©õßøÓ öu›P.

Eyedropper tool (I)
xÎzuÀ P¸Â

J¸ ÁiÁzxUS E£÷¯õQUP¨£mh ÁºnU P»øÁø¯ 

CßÝ÷©õº ÁiÁzxUS EÒÎh ¤µ÷¯õQUP¨£k®.

1' P¸Âø¯z öu›P.

2' ÁºnzøuU öPõsh ÁiÁzvß «x ö\õhUSP.

3' ¤ßÚº  Áºnªh  ÷Ási¯   ÁiÁzvß    «x 

ö\õkUSP.

Eraser tool (E) 
AÈ P¸Â

{¸©õoUP¨£mh ÁiÁzvß Kº £Svø¯ ©mk® 

AÈ¨£uØS ¤µ÷¯õQUP¨£k®. C¢ {ø»°À ÁiÁ® 

•ÊÁx® }UP¨£h©õmhõx. 

2. Build-in-player -   ÁiÁø©UP¨£mh JÎ°¯À Aø\Åmhzøu 

C¯USÁuØS  ^Play&"  {ÖzxÁuØS  ^Stop&"  Bµ®£  \mhPzxUSa ö\À»

^Rewind&" CÖv \mhPzxUSa ö\À» ^Go to End& ÷£õßÓÁØÖUPõP 

£¯ß£kzu¨£kQßÓx.

{ÖzxuÀ

C¯USuÀ

Bµ®£ \mhPzvØS

CÖv \mhPzvØS

E¸ 4.32
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3'    AkUSPÒ (Layers) -  GÎ¯  ©ØÖ® 

]UP»õÚ JÎ°¯À  Aø\Åmh  

ÁiÁø©¨¤ß÷£õx  AkUSPÎß    

£¯ß£õk ªP •UQ¯©õS®. JÎ 

°¯À Aø\Åmhvß÷£õx  C»US¨  

ö£õ¸ÒPøÍ  ÷ÁÖ ÷ÁÓõÚ  AkUS 

PÎÀ  EÒÎkÁuõÀ  AÁØøÓ  

C»SÁõP  øP¯õÍ  •i²®.  AkU

SPÒ Gß£x  FkPõmhzuUP Phuõ]°ß öuõSv ÷£õßÓuõS®. BÚõÀ  

]»  \¢uº¨£[PÎÀ C»US¨  ö£õ¸ÒPÒ  JßÓß «x JßÖ ÷\ºÁuõÀ 

AuØS RÊÒÍ AkUS Pm¦»ÚõÁvÀø». ö£õxÁõP Giotto ö©ßö£õ¸øÍ 

vÓUS®÷£õx •u»õÁx  AkUS Põm]¨£k®.  Ax Layer 1 GÚ ö£¯›h¨   

£mi¸US®. AkUSPÒ \mhPzvß«x  Á»x  _mi ö£õzuõøÚ ö\õkUS

ÁuõÀ ¦v¯ AkUöPõßøÓ vÓzuÀ, AkUøP }UPÀ, AkUøP |PºzuÀ, 

AkUøP Põm]¨£kzuÀ/©øÓzuÀ ÷£õßÓ P¸©[PøÍ ÷©ØöPõÒÍ 

•i²®.

4'  ÷|µa\mhP® (Timeline) - JÎ°¯À Aø\Åmh ÁiÁø©¨¤ß÷£õx 

¤µuõÚ A®\©õP Cx P¸u¨£kQÓx. Aø\Åmhzøu JÊ[Pø©¨£uØS 

GkUS® Põ»zøu u¯õº£kzxÁuØS Cx £¯ß£kzu¨£kQßÓx.

5'  £o¨¤µ÷u\® (Work area)  - JÎ°¯À Aø\Åmhzøu ÁiÁø©¨£uØPõÚ 

¤µ÷u\® £o¨ ¤µ÷u\©õS®.

6'  ÷PzvµPou ÁiÁ[PÐ® C¯À¦PÐ® - 
ÁiÁø©¨¤ØPõP   E£÷¯õQUP¨£kQßÓ  C»US¨   

ö£õ¸ÒPÒ ©ØÖ® ÁiÁ[PÐUS ÁºnªkÁuØPõP 

C¢u \õÍµ® £¯ß£kzu¨£kQÓx. Azxhß GÀø»°ß 

ÁøP, Áºn®, ÁºnU P»øÁ ÷£õßÓÁØøÓ öu›¯Ä®, 

£i©[PøÍ EÒÎhÄ® C¢ua   \õÍµ® EuÄQÓx.

                                                                                                         E¸ 4.34

E¸ 4.33
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7' Áºn[PÒ (Colours) - - ÁiÁø©¨¤ß÷£õx P¸Â¨ 

£møh°¾ÒÍ ö£ß]À,  y›øP, ø©SÁøÍ, GÊz 

x¸ ÷£õßÓ P¸ÂPÎß ¤µ÷¯õPzvØS ÷uøÁ¯õÚ 

Áºn[PÒ ¤µuõÚ©õP öu›Ä ö\´Áx C¢u \õÍµz 

uõ»õS®. GÀø»°ß Áºnzøu "Pen' GÝ® Chzv¾® 

{µ¨¦ÁuØPõÚ Áºnzøu "Brush' GÝ® Chzv¾® 

ö£Ó •i²®.

8'  C¯À¦ \õÍµ® (Properties Window) - - GÊzx¸ P¸Âø¯ öu›Ä ö\´x 

Gkzx¸UPÎß £¸©ß, ÁiÁ®, ÁøP ÷£õßÓÁØøÓ ©õØÔ¯ø©¨£uØPõP  

C¯À¦ \õÍµ® EuÂ¦›QßÓx.

E¸ 4.36

JÎ°¯À  Aø\Åmh¨  £¯ß£õmiß ¤µuõÚ A®\[PÒ

¦v¯ \õÍµzøu¨ 

ö£Ó

(New) 
File → New Movie

{¸©õnzøua

 ÷\ªUP (Save) 

• File → Save ö£õzuõøÚ ö\õkUSP. 
• Save Image ö\õÀ»õhØ ö£mi°À 

Name GÝªhzvÀ ö£¯øµ  ÁÇ[SP.

• Places ChzvÀ ö£õ¸zu©õÚ Chzøu

      (Saving Location) öu›P. 

• Save ö£õzuõøÚ ö\õkUSP. 

PÁÛUP & Giotto ö©ßö£õ¸Ò ‰»® ÁiÁø©UP¨£mk ÷\ªUP¨£mh 

÷Põ¨£õÚx .vgd ̂Vectorian giotto document& ÷Põ¨¦ }m]ø¯U öPõsi¸US® 

Azxhß C¢u JÎ°¯À Aø\Åmh® Áø»U Ph¨¤h[PÒ ÁiÁø©¨¤ß 

÷£õx E£÷¯õQUP Ti¯ ÷Põ¨£õPÄ® ÷\ªUP¨£h •i²®.  Cx Export 
Flash Movie GÚ AøÇUP¨£k®.

C¢{ø»°À  JÎ°¯À Aø\Åmhzøu   .swf  ^small  web   format& GÝ® 

÷Põ¨¦  }m]²hß ÷\ªzuÀ ÷Ásk®.

E¸ 4.35
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{¸©õnzøu 

÷ÁÖ ÷Põ¨¦ 

ÁøP°À      

÷\ªzuÀ 

 Export 
ö\´uÀ

 ²  .swf    ^small  web  format&  ÷Põ¨£õP 

÷\ªUP. 

 ² File → Export Flash Movie Iz  öu›P.

     ÷Põ¨¦ ÷\ªUP¨£h ÷Ási¯ Chz  

     øu öu›¢x, AuØS ö£õ¸zu©õÚ 

     ö£¯øµ Cmk ÷\ªUSP (Save). 
 ² Cuß÷£õx vÓUP¨£k® Export Settings 

ö\õÀ»õhØ ö£mi°À Compress movie I 

ö\õhUQ OK ö£õzuõøÚ ö\õkUSP. 

÷\ªUP¨£mh 

{¸©õnzøu 

vÓzuÀ

 ² File → Open I öu›Ä ö\´x ÷Põ¨¦  ÷\ªUP¨ 

£mh   Chzv¼¸¢x  vÓ¢x öPõÒÍ  •i²®.

    BÚõÀ   C¢uU   ÷Põ¨ø£ JÎ°¯À  Aø\  

    Åmh©õP  vÓ¨£uØS.

 ² ÷Põ¨¦ ÷\ªUP¨£mh Chzøu öu›P.

 ² ÷Põ¨¤ß «x Á»x _mi ö£õzuõøÚ ö\õkU 

SP.

 ² ö£õ¸zu©õÚ Áø»÷©÷»õi ^Web Browser& 
CøÚz öu›P.

 ² C¢{ø»°À  JÎ°¯À  Aø\Åmh©õÚx  Áø» 

÷©÷»õi°À C¯[SÁøu Põn»õ®.

Vectorian Giotto ö©ßö£õ¸øÍ £¯ß£kzv GÎ¯ JÎ°¯À Aø\Åmhzøu 

ÁiÁø©zuÀ

£i    1' Giotto ö©ßö£õ¸øÍ vÓUP.

£i  2'  E¸ÂÀ Põmh¨£mkÒÍx   

  ÷£õÀ £o¨¤µ÷u\zvß «x 

  ö\ÆÁP,  }ÒÁmh  ÁiÁ  E¸U

  PøÍ ÁøµP. 

                                                                             

£i      3'  C¢u E¸UPøÍ öu›ÄU P¸Âø¯ E£÷¯õQzx öÁÆ÷ÁÓõP 

öu›Ä ö\´x Pen ©ØÖ® Brush ÷£õßÓP¸ÂPÎß EuÂ²hß 

GÀø» Áºn® ©ØÖ® {µ¨¦ Áºn® CkP. 

  

£i  4'  C¢ua ö\¯Ø£õhõÚx ÷|µa \mhPzvÀ ^Timeline& •u»õÁx 

  \mhPzvÝÒ  EÒÍøu   AÁuõÛUP.  Cx  •u»õÁx ¤µuõÚ 

  \mhP©õS®.

 E¸ 4.37
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E¸ 4.38

£i  5'  ÷|µ \mhPzvÀ ^Timeline& 24 BÁx \mhPzvß «x Á»x _mi   

  ö£õzuõøÚ ö\õhUQ, Insert Keyframe Iz öu›P. C¢{ø»°À   

  ÷|µ \mhP©õÚx  1  öuõhUP®  24  Áøµ ¤ßÁ¸©õÖ Põm]¨  

  £k®.

E¸ 4.39

öu›ÄU P¸Â°ß ^Selection tool& EuÂ²hß  

£o¨¤µ÷u\zvß «x   Áøµ¯¨£mh    ö\ÆÁP, 

}ÒÁmh ÁiÁ E¸Á[PøÍ uÛzuÛ÷¯ RÌ 

÷|õUQ |Pºzv ¤ßÁ¸©õÖ {ø»¨£kzxP.

                                                                                                                                        

                                                                                                  
 E¸ 4.40

£i  6'  ÷|µa \mhPzvÀ 1  öuõhUP® 24  Áøµ²ÒÍ  ¯õöuÝö©õ¸ 

  \mhPzvß  «x  Á»x _mi¨ ö£õzuõøÚ  ö\õkUQ Create 
  Motion Tween Iz öu›P. C¢{ø»°À ÷|µa \mhP® ¤ßÁ¸ 
  ©õÖ Põm]¨£k®.   

E¸ 4.41

£i  7'  Build-in-player I¨ £¯ß£kzv {¸©õnzøu C¯USP.
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E¸ 4.42

PÁÛUP & JÎ°¯À Aø\Åmhzvß ÷ÁPzøuU Tmh AÀ»x  

SøÓUP ©ØÖ® {¸©õnzvß ¤ßÚo Áºnzøu AÀ»x £›©õ 

nzøu ©õØÓ ÷Áskö©ÛÀ,

Modify → Document Iz öu›P. C¢{ø»°À ö£Ó¨£k® Document 
Properties  ö\õÀ»õhØ ö£mi°À ÷uøÁ¯õÚ ©õØÓ[PøÍ ö\´x 
OK ö£õzuõøÚ ö\õhUSP. 

¤ßÚo

Áºnzøu

 ©õØÓ

ö\UPß Jß 

ÖUPõÚ \mhP 

Ãuzøu  Tmi 

SøÓ¨£uõÀ 

C¯UPzvß 

÷ÁPzøu Tmi 

SøÓzuÀ

£›©õn®

GÊzx¸øÁU  öPõsh  JÎ°¯À  Aø\Åmhzøu  {¸©õozuÀ

£i  1'  Giotto ö©ßö£õ¸øÍ vÓUSP.

£i  2'  E¸ÂÀ  Põmh¨£mkÒÍÁõÖ  

  £o¨¤µ÷u\zvß «x ö\ÆÁP

  ö©õßøÓ ÁøµP.

£i  3'  Brush → Linear Iz öu›¢x   

  Áºn[PøÍ E¸ÁõUQ Áºn  

  "£UöPm' P¸Â°ß EuÂ²hß 

  ÁºnªkP.

£i  4'  AkUSPÒ  ^Layer&  vøµ°÷»  Layer 1 Cß  «x  C¸•øÓ   

ö\õhUQ  ^Double  click& AkUøP ‘Background’ GÚ¨ ö£¯›kP.

£i  5'  ¦v¯ AkUöPõßøÓ¨  ö£ÖÁuØS  Layer vøµ°ß «x Á»x 

_mi ö£õzuõøÚ ö\õhUQ  ¬ Layer CøÚz öu›P.

£i  6'       C¢u  AkUøP  ‘Text’  GÚ¨ ö£¯›kP.

                C¢{ø»°À AkUSPÎß vøµ ¤ßÁ  

                ¸©õÖ Põm]¨£k®.

E¸ 4.43

E¸ 4.44



 C»Á\¨ £õh¡À136 C»Á\¨ £õh¡À 137

£i   7'  Text  GÝ®  AkUøPz  öu›P. GÊz

x¸ P¸Â°ß EuÂ²hß  £ o ¨ 

¤µ÷u\zvß  «x  Beautiful    Sri 
Lanka GÚ umha]kP.

£i   8'  C¢u GÊzxUPøÍ öu›Ä  ö\´x  

C¯À¦  \õÍµzvß   EuÂ²hß  

GÊzxUPøÍ  ÁiÁø©UP.  

(GÊzx¸ ÁøP Curlz MT" GÊzx¸ £¸©ß 35) GÊzxUPøÍ E¸ÂÀ Põmh¨ 

£mkÒÍx ÷£õÀ £o¨¤µ÷u\zvß ©zv°÷» {ø»¨£kzxP.

£i   9'  GÊzxUPÎß  «x   Á»x _mi  

  ö£õzuõøÚa ö\õhUQ Effect  →  
  Add…  Iz öu›P. 
  
£i   10'  Effect  \õÍµzv÷»   GÊzxUPÐU 

PõP  £¯ß£kzu  Ti¯ £À÷ÁÖ 

£mh   ÂøÍÄPÒ  ^effects&  EÒ 

Íøu   AÁuõÛUP»õ®.   CvÀ  

Falling Leaf  Iz  öu›P.  ¤ßÚº  

OK  ö£õzuõøÚ    ö\õhUSP.

C¢u  ÂøÍøÁ  ¤µ÷¯õQzu  ¤ßÚº Text ÷|µ 

\mhP©õÚx RÊÒÍÁõÖ ©õØÓ©øh¢xÒÍøu 

AÁuõÛUP. 

            E¸ 4.436

 

E¸ 4.47

Text ÷|µ \mhP©õÚx CÆÁõÖ ©õØÓ¨£mhx öu›Ä ö\´u ÂøÍÂß 

^Effects&  Ai¨£øh°»õS®. CuØ÷PØÓõØ÷£õÀ ¤ßÚo  ^Background& ÷|µ  

\mhPzøu²® ÁiÁø©zuÀ ÷Ásk®. CuØPõP, 

E¸ 4.45
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£i   11'  Background ÷|µa  \mhPzøuz  öu›P.  AvÀ 83  BÁx \mh  

  Pzvß «x ^Text \mhP®  •iÁøh²®  Ch®&  Á»x  _mi

  ö£õzuõøÚa ö\õkUQ Insert Keyframe Iz öu›P. 
  
£i   12'  {¸©õoUP¨£mh  JÎ°¯À  Aø\Åmhzøu  ÷\ªzx  Export  
  ö\´x  ¤ßÚº vÓ¢x £õºUP.

   ö\¯Ø£õk 

1' E[PÍõÀ   {¸©õoUP¨£mh   {ø»zu  Áøµö£õßøÓ ¤ßÚ 

o¯õP £¯ß£kzv. Aø\¯UTi¯ÁõÖ ö£õ¸zu©õÚ GÊzx 

¸øÁ¨ ¤µ÷¯õQ¨£uõÀ JÎ°¯À Aø\Åmhö©õßøÓ ÁiÁ 

ø©UP  £À÷ÁÖ£mh ÂøÍÄPøÍ ^Effects& EÒÏkö\´x ©õØ 

Ó[PøÍ AÁuõÛUP.

P¸zx¨ £›©õØÓzxUPõP Áøµ¤¯ÀPøÍ ÁiÁø©zuÀ, JÎ°¯À Aø\

Åmh® ÷£õßÓ Âh¯[PøÍ •ßÚº PØÕºPÒ. CÆÁõÖ E¸ÁõUP¨£mh 

{¸©õn[PÐUS J¼ ÂøÍÄPÒ AÀ»x J¼°øÚ Em¦SzxÁuõÀ AÁØøÓ 

÷©¾® ÂøÚzvÓÝøh¯uõP ©õØÓ •i²®.

J¼z uµÄPøÍ £vÄö\´ÁuõÀ E¸ÁõUP¨£kQßÓ ÷Põ¨£õÚx J¼ ÂøÍ 

ÁõP  P¸u¨£k®. C¢u J¼ ÂøÍÄPøÍ PoÛ°÷» ÁiÁø©UPÄ® AÁØ 

øÓ öuõSUPÄ® £» ö©ßö£õ¸ÒPÒ E£÷¯õQUP¨£kQßÓÚ. AÁØÔÀ ]» 

¤ßÁ¸©õÖ:

² Audacity 
 ² Power Sound Editor 
 ² Mp3 DirectCut 
 ² Music Editor Free 
 ² Wavosaur 

² Ardour 
 ² WavePad Sound Editor 
 ² Sound Engine

4'3   J¼ ÂøÍÄPÒ
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J¼ ÂøÍÄPøÍ ÁiÁø©UP J¼z öuõS¨¦ ö©ßö£õ¸øÍ E£÷¯õQzuÀ

J÷h]mi ^Audacity& 
Audacity Gß£x Âß÷hõì, Mac ©ØÖ® Linux £oö\¯À •øÓø©PÎ÷» 

{ÖÁ¨£hUTi¯ Kº vÓ¢u ‰» Buõµ J¼zöuõS¨¦ ö©ßö£õ¸ÍõS® (Audio 
editing Software). C¢u J¼z  öuõS¨¦ ©ØÖ® J¼¨£vÄ |hÁiUøPPÐUPõP 

E£÷¯õQUP¨£kQßÓ  ö©ßö£õ¸øÍ PoÛ°÷» {ÖÄÁuõÀ ö£Ó¨£kQßÓ 

Áøµ¦ £¯|º Cøh•Pzv÷» ^GUI& £¯|›ß ÷uøÁU÷PØ£ ö©õÈ°øÚ 

öu›Äö\´¯ •i²®.

^Audacity& ö©ßö£õ¸øÍ E£÷¯õQzx;

 ² ÷|µi J¼¨£vÄ

 ² PoÛ°÷» ö\¯Ø£mkU öPõsi¸US® J¼U ÷Põ¨¦PÎß £vÄ

 ² |õhõ AÀ»x £vÄ (Recorder) J¼z uµÄPøÍ C»UP•øÓ¯õP ©õØÖuÀ 

AÀ»x CÖÁmkPÎÀ £vÁõP ÷\ªzuÀ

 ² WAV" AIFF" FLAC" MP2" MP3 ©ØÖ®  Ogg Vorbis ÷£õßÓ ÷Põ¨¦PøÍ 

u¯õº ö\´uÀ AÀ»x £v¨¦UPõP öuõSzuÀ

 ² J¼°øÚ Á¸ÂøÍÁõUPÀ, P»zuÀ, öÁmi }USuÀ AÀ»x JßÔønzuÀ

 ² J¼°øÚ £vÄö\´²®÷£õx Auß Pv°øÚ ©ØÖ® J¼°ß ìuõ°øÚ  

©õØÖuÀ

÷£õßÓ £» J¼zöuõS¨¦ |hÁiUøPPøÍ ÷©ØöPõÒÍ •i²®. 

Audacity ö©ßö£õ¸øÍ ¤ßÁ¸® URL I¨ £¯ß£kzv uµÂÓUP® ö\´x 

PoÛ°÷» {ÖÂUöPõÒÍ •i²®.

http($$audacity.sourceforge'net
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Audacity ö©ßö£õ¸Îß Áøµ¦¨ £¯|º Cøh•P®

1
2 3 4

7
5

8

6

10

11

12

13

14

9

E¸ 4.48

1'  £mi¯À £møh - Menu Bar
2'  |Pºzx® P¸Â¨£møh  - Transport Toolbar
3'  P¸ÂPøÍU öPõsh P¸Â¨£møh - Tools Toolbar
4'  £vÄö\´²® «mhº P¸Â¨£møh - Recording Meter Toolbar
5'  ¤ßÚo «mhº P¸Â¨£møh - Playback Meter Toolbar
6'  P»¨¦ P¸Â¨£møh - Mixer Toolbar 
7'  öuõS¨¦ P¸Â¨£møh - Edit Toolbar
8'  ¤µvö\´²® P¸Â¨£møh - Transcription Toolbar
9'  xøn²Ö¨¦ P¸Â¨£møh - Device Toolbar
10' ÷|µ¨£møh - Timeline 
11'  _Ák Pmk¨£õmkU P¸Â  - Track Control Panel 
12'  ö\Â¨¦» _Ák   - Audio Track
13'  öu›Ä P¸Â¨£møh - Selection Toolbar 
14'  {ø»¨£møh - Status Bar
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J¼U ÷Põ¨¦ ÁiÁø©¨¦ ö©ßö£õ¸Ò £¯ß£õmiß ¤µuõÚ A®\[PÒ

J¼

÷Põ¨¦PøÍ 

ÁiÁø©UP 

¦v¯ \õÍµzøu 

E¸ÁõUPÀ ^New&

File → New

{¸©õoUP¨

£mh  J¼U

÷Põ¨¤øÚ 

÷\ªzuÀ

^Save&

 ² File → Save 
 ² ÷Põ¨ø£ ÷\ªUP ö£õ¸zu©õÚ Ch 

zøu öu›Ä ö\´x, ö£õ¸zu©õÚ 

ö£¯øµ ÁÇ[Q, ^Save&ö£õzuõøÚ 

     ö\õkUSP.

PÁÛUP & Audacity  ö©ß£õ¸øÍ E£÷¯õQzx ÁiÁø©UP¨£kQßÓ 

÷Põ¨£õÚx  .aup (Audacity Project) ÷Põ¨¦ }m]ø¯U öPõsi¸US®. A¢u 

÷Põ¨¦ }m]UPø©¯ ÷\ªUP¨£mh ÷Põ¨£õÚx öuõS¨¦ |hÁiUøPUPõP 

¤µ÷¯õQUP¨£h •i²®. Azxhß C¢u ÷Põ¨ø£ Cøn¯zuÍ[PÒ ÁiÁ 

ø©¨¤ß÷£õx E£÷¯õQUPU Ti¯ÁõÖ ÷Põ¨¦ ÁøP¯õPÄ® ÷\ªUP 

•i²®. Cx  J¼  HØÓÀ ^Export Audio& GÚ P¸u¨£k®. C[S JÎ°¯À 

Aø\Åmh©õP  ÷\ªUPTi¯ÁõÖ £» ÷Põ¨¦ ÁøPPÒ Esk. AÁØÔÀ ]» 

WAV" AIFF" FLAC" MP2" MP3 BS®.

J¼U ÷Põ¨ø£ 

Export ö\´uÀ 

^Export Audio&

 ² File → Export Audio IU öu›P.

 ² ÷\ªUPz ÷uøÁ¯õÚ Chzøu öu›¢x, 

ö£õ¸zu©õÚ ö£¯øµ ÁÇ[SP. 

 ² ÷uøÁ¯õÚ ÷Põ¨¦ ÁøPø¯ Save as 
type ‰»® öu›P.

 ² Save ö£õzuõøÚ ö\õkUSP.

 ² Cuß÷£õx  vÓUP¨£k®    Edit Metadata 
ö\õÀ»õhØ  ö£miø¯ E£÷¯õQzx 

J¼U P»øÁUPõÚ uµÄ ÂÁµ[PøÍ 

ÁÇ[SP. ^ö£¯º, Á¸h®&
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Audacity CøÚ E£÷¯õQzx J¼¨£vøÁ ö©ØöPõÒÍÀ

£i  1'  File → New Iz öu›P.

£i  2'  |Pºzx®  P¸Â¨£møh°¾ÒÍ £vÄ ^Record& P¸Â°ß «x   

  ö\õhUSP.

£i  3'  PoÛ²hß CønUP¨£mkÒÍ ~qUS£ßÛ°ß EuÂ²hß   

  ÷uøÁ¯õÚ J¼°øÚ £vÄ ö\´P. 

£i  4'  CÖv°÷» |Pºzx®  P¸Â¨£møh C¾ÒÍ {Özx ^Stop&   

  P¸Â°ß «x ö\õkUSP.

£i  5'  C¢u P¸Â¨£møh°¾ÒÍ C¯US ^Play& P¸Â°ß«x ö\õkUQ 

  £vÄ ö\´¯¨£mh J¼ø¯ ö\Â©kUP.

C¯USP

(Play)

{ÖzxP 

(Stop)

£vÄö\´P 

(Record)

{¸©õoUP¨£mh J¼U ÷Põ¨¤¾ÒÍ ÷uøÁ¯ØÓ £SvPøÍ }USu¾® 

öuõSzu¾®

£i  1'  {¸©õoUP¨£mk .aup (Audacity Project) ÷Põ¨¦ }m]¯õP        

  ÷\ªUP¨£mh ÷Põ¨ø£ vÓUSP.

£i  2'  |Pºzx®  P¸Â¨£møh°¾ÒÍ öu›ÄU P¸Âø¯ (Selection   
  Tool)  E£÷¯õQzx J¼U ÷Põ¨¤¾ÒÍ ÷uøÁ¯õÚ £Svø¯z   

  öu›P.

E¸ 4.49

öu›ÄU P¸Â

(Selection Tool)

E¸ 4.50
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£i  3'  öuõS¨¦   P¸Â¨£møh  ^Edit Toolbar&   C¾ÒÍ  J¼  öÁmk 

  ^Trim  Audio& P¸Â°ß «x ö\õkUSP. Cx ÷uøÁ¯ØÓ £SvPøÍ 

  }USÁuØS EuÂ¦›²®.  

ö\Â¨¦» 

öÁmk 

(Trim Audio)

                                            E¸ 4.51

£i•øÓ 4'  öuõS¨¦a ö\¯Ø£õmiß ¤ßÚº J¼U ÷Põ¨ø£ ÷\ªUSP.

£i©[PøÍU öPõsh \õÍµ[PÎß ÷\º©õÚzuõÀ ÁiÁø©UP¨£kQßÓ 

Pm¦»U Põm]¯õÚx PõönõÎ BP P¸u¨£k®. CuØPõP £vÄ ö\´¯¨£mh 

Pm¦» Põm]PÒ AÀ»x {ø»zu Áøµ¦PÒ AÀ»x J¼U ÷Põ¨¦PÒ 

E£÷¯õQUP¨£kQßÓÚ.

PõönõÎ ÷Põ¨¦PøÍ E¸ÁõUPÄ® AÁØøÓ öuõSUPÄ® £» PoÛ ö©ß 

ö£õ¸ÒPÒ  E£÷¯õQUP¨£kQßÓÚ. AÁØÔÀ ]» ¤ßÁ¸©õÖ:
 ² PhotoBucket
 ² YouTube Remixer
 ² Movie Masher
 ² One True Media
 ² Motion Box
 ² Stash Space
 ² Windows Movie Maker
 ² AVI Edit
 ² Super DVD Video Editor

PõönõÎ ÷Põ¨¦PøÍ E¸ÁõUP  Pm¦»z öuõS¨¦ ö©ßö£õ¸øÍ 

E£÷¯õQzuÀ

Âß÷hõì ‰Â ÷©UPº (Windows Movie Maker)
Microsoft {ÖÁÚzuõÀ E¸ÁõUP¨£mh vÓ¢u ‰» Buõµ PõönõÎ 

öuõS¨¦ ö©ßö£õ¸ÍõP Windows Movie Maker P¸u¨£kQÓx. Cuß ‰»® 

PõönõÎPøÍ E¸ÁõUPÄ® AÁØøÓz öuõSUPÄ® •i²®.

4'4   PõönõÎ ÷Põ¨¦PøÍ ÁiÁø©zuÀ
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Windows Movie Maker ö©ßö£õ¸øÍ RÊÒÍ URL •PÁ›°øÚ E£÷¯õQzx 

uµÂÓUP® ö\´x, PoÛ°÷» {ÖÄP.

http://www.windows-movid-maker.org

Windows Movie Maker Cß Áøµ¦¨ £¯|º Cøh•P®

1 2 3

E¸ 4.52

1.  •ØPõm]/ö\¯Ø£kzx® \õÍµ® (Preview/Player pane)
2.  ÷|µ¨£møh ÷©øh (Timeline Stage)
3.  öuõS¨¦ ö\´²® \õÍµ® (Editing function panel)

1'  •ØPõm]/ö\¯Ø£kzx® \õÍµ® (Preview/ Player pane) 
PõönõÎ ÷Põ¨¦PøÍ ÁiÁø©UP £¯ß£kzx® PõönõÎU Põm]PÒ 

©ØÖ® £i©   \mhPU  Põm]PøÍ  Põm]¨£kzuÄ®  E¸ÁõUP¨£mh  

£i©[PøÍ ÷\ª¨£uØS •ß¦ Põm]¨£kzuÄ® £¯ß£kzu¨£kQßÓx.

2'  ÷|µ¨£møh ÷©øh (Timeline stage)
ÁiÁø©¨£uØPõP  E£÷¯õQUP¨£kQßÓ  PõönõÎ  Põm]PÒ,  £i©  \mh 

P[PÒ ©ØÖ® J¼U ÷Põ¨¦PÒ ÷£õßÓÚ C¨£Sv°À Põm]¨£kzu¨£k® 

Põ» GÀø» Áøµ¯ÖUP¨£hõ©À C¸¨£xhß PõönõÎ Põm]PÒ ©ØÖ® 

£i© \mhP[PÒ ÷£õßÓÚ öuÎÁõP Põm]¨£kzu¨£k®.

3'  öuõS¨¦ ö\´²® \õÍµ® (Editing function panel)
E¸ÁõUP¨£mh PõönõÎU ÷Põ¨£õÚx öuõSzuÀ ö\¯Ø£õmiØPõP C¢u

\õÍµzv¾ÒÍ P¸ÂPÒ E£÷¯õQUP¨£kQßÓÚ. CU P¸ÂPÎß EuÂ 

²hß PõönõÎ  ÷Põ¨¦PøÍ C¯USuÀ, Pm¦» ÂøÍÄPøÍ Em¦SzuÀ 

^Visual effects& ©ØÖ® J¼ ÂøÍÄPøÍ •Põø© ö\´¯Ä® •i²®.
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Windows  Movie  Maker  CøÚ   E£÷¯õQzx   PõönõÎ   ÷Põ¨¦PøÍ 

E¸ÁõUSuÀ

£i  1'  Windows Movie Maker ö©ßö£õ¸øÍ vÓzuÀ

£i    2'  Home → Add Videos & Photos CøÚ £¯ß£kzv ÁiÁø©¨ 

¤ØPõP E£÷¯õQUP¨£kQßÓ £i©[PÒ ©ØÖ® PõönõÎ 

÷Põ¨¦PøÍ öu›Ä ö\´x, AÁØøÓz vÓzuÀ. C¢{ø»°À 

vøµ ¤ßÁ¸©õÖ Aø©²®.

E¸ 4.53

ÁiÁø©¨¤ØPõP ©õÖøPPÒ (Transitions) ÂøÍøÁ Em¦SzuÀ 

£i© \mhP[PÒ CµsiØQøh÷¯ öuõhºø£ HØ£kzuÄ® ©ØÖ® £i© 

\mhPz vøµ°À Põm]¨£k® Âuzøu PõmhÄ® ©õÖøP ^Transition& 
E£÷¯õQUP¨£kQßÓx.  

£i  1'   Aø\ÅmhzvøÚ (Animations) vÓ¢xUöPõÒP.

£i  2'  •uÀ£i© \mhPzvß «x ö\õkUSP.

£i  3'  Transitions  \mhzv¾ÒÍ JÆ÷Áõº ©õÖøP°ß ^Transition&    
«x® _miø¯U öPõsk ö\ÀP. C¢{ø»°À öu›Ä ö\´¯¨£mh 

£i©® vÓUP¨£k® Âu® Põm]¨£kzu¨£k®. ö£õ¸zu©õÚ 

©õÖøP°ß ^Transition&  «x ö\õkUQ AuøÚz öu›P.

£i  4' CÆÁõÖ ÷|µ¨£møh ÷©øh  ^Timeline stage& «xÒÍ ©ØøÓ¯ 
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£i©[PÐUPõP ö£õ¸zu©õÚ ©õÖøPPøÍ ̂ Transitions&    öu›P. 

©õÖøPPÒ ^Transitions& ¤µ÷¯õQUP¨£mh ¤ßÚº ÷|µ¨£møh 

÷©øh «x Põm]¨£kzu¨£k® £i© \mhP[PÒ ¤ßÁ¸©õÖ 

Aø©²®. 

E¸ 4.54

£i   5' •ØPõm]/ö\¯Ø£kzx® \õÍµzvøÚ £¯ß£kzv {¸©õnzøu 

ö\¯Ø£kzxP.   ÷uøÁ¯õÚ   öuõS¨¦   ö\¯Ø£õkPøÍ   ÷©Ø 

öPõÒP.

£i   6' £i©    \mhP®  Põm]¨£kzu¨£h   

÷Ási¯ Põ»zøu Animations → 
Duration Iz öu›Áuß ‰»® ©õØÔ 

Aø©UP. Apply to all  Gß£øuz  

öu›Áuß  ‰»® Kº £i© \mh 

PzvØPõP E£÷¯õQUP¨£mh 

öuõS¨¦a ö\¯Ø£õkPøÍ ©ØøÓ¯

 
£i© \mhP[PÐUS® E£÷¯õQUP •i²®.

£i   7'  £i© \mhPzøu Aø\ÅmkÁuØPõP,

i)   £i© \mhPzøuz öu›P.

ii)  Pan  and  Zoom Pmhzv¾ÒÍ JÆ÷Áõº Aø\Åmhzvß «x® 

_miø¯  öPõsk  ö\ÀP. ö£õ¸zu©õÚ Aø\Åmhzvß «x 

ö\õhUSP.

£i    8' {¸©õnzvØS uø»¨ö£õßøÓ CkÁuØPõP,

i)  •uÀ £i© \mhPzøuz öu›P. 

ii) Home → Title Iz öu›P'

iii) ö£õ¸zu©õÚ uø»¨ø£ umha]kP. 

iv) Format menu CøÚ vÓ¢x, uø»¨¤ØS ö£õ¸zu©õÚ 

ÁiÁø©¨¦ ©ØÖ® ÂøÍÄPøÍ ^Effects& CkP.  

E¸ 4.55
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£i  9' £i© \mhPzvØS öÁÆ÷ÁÓõP AÔ•Pzøu ÁÇ[P •i²®.   

  AuØPõP,

I) £i© \mhPzøuz öu›P.

II) Home → Caption Iz öu›¢x, ÷uøÁ¯õÚ AÔ•Pzøu umha]

kP. 

III) •ßÚº SÔ¨¤mhx ÷£õÀ ÁiÁø©¨¦PøÍ²® ÂøÍÄ 

PøÍ²® CkP. 

£i     10' {¸©õoUP¨£mh PõönõÎU ÷Põ¨¤ß Bµ®£® AÀ»x 

CÖv°À Auß u¯õ›¨£õÍº, |iPº, Ch® ©ØÖ® \[Ru® 

÷£õßÓÁØøÓ  ÁÇ[P öÁÆ÷ÁÓõP £i© \mhP[PøÍ EÒÎh 

•i²®. CuØPõP,

I)  Home → Credits Cß ‰»® ÷uøÁ¯õÚ AÔ•Pzøuz öu›P.

II)  ö£õ¸zu©õÚ uPÁÀPøÍ umha]kP.

|ßÔ

u¯õ›¨£õÍº

|i¨¦

Ch®

\[Ru®

E¸ 4.56

£i     11' {¸©õnzvØPõP J¼ ÷Põ¨ö£õßøÓ ÷\ºzuÀ. Cuß ‰»® 

{¸©õoUP¨£mh PõönõÎU ÷Põ¨ø£ ªPÄ® £¯ÝÒÍuõP 

©õØÓ •i²®.

I) •uÀ £i© \mhPzøuz öu›P.

II)  Home → Add music Iz öu›P.

£i     12' •ßÚº  {¸©õoUP¨£mk,  ÷\ªUP¨£mh   J¼U  ÷Põ¨ö£õß 

øÓz öu›Ä ö\´x, AuøÚ vÓUSP. CÖv°÷» ÷|µ¨£møh 

¯õÚx ^Timeline stage& ¤ßÁ¸©õÖ Põm]¨£k®. 
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E¸ 4.57

£i  13' E¸ÁõUP¨£mh  PõönõÎU  ÷Põ¨ø£ ö\¯Ø£kzxP. ÷uøÁU 

÷PØ£ öuõS¨¦a ö\¯Ø£õmøh ÷©ØöPõÒP. 

PõönõÎU ÷Põ¨ö£õßøÓ ÷\ªzuÀ ^Save& 

File → Save Project Iz öu›P.

÷Põ¨ø£ ÷\ªUP ÷uøÁ¯õÚ Chzøu öu›Ä ö\´x, ö£õ¸zu©õÚ ö£¯º 

JßøÓ Cmk, Save ö£õzuõøÚ ö\õkUSP.

  PÁÛUSP & Windows Movie Maker  ö©ßö£õ¸øÍ E£÷¯õQzx 

E¸ÁõUP¨£mh   ÷Põ¨£õÚx 'wimp ^Movie Maker Projects&  GÝ® ÷Põ¨¦ 

}m]UPø©¯ ÷\ªUP¨£kQÓx. C¢u ÷Põ¨¦ }m]UPø©¯ ÷\ªUP¨£kQßÓ 

÷Põ¨¦PøÍ öuõS¨¦ |hÁiUøPPÐUPõP E£÷¯õQUP •i²®. Azxhß 

C¢u PõönõÎ ÷Põ¨ø£ Cøn¯zuÍ[PÒ {¸©õnzvß÷£õx ¤µ÷¯õQUPU 

Ti¯ÁõÖ ÷\ªUPÄ®, \‰P Áø»zuÍ[PÎ÷» ^Facebook, YouTube, Flickr& 
vÓ¢x öPõÒÍU Ti¯ÁõÖ  ÷\ªUPÄ® •i²®.

Pm¦» ÂøÍÄPøÍU PõönõÎU ÷Põ¨£õP ÷\ªzuÀ

PõönõÎ ÷Põ¨ö£õßøÓ PoÛ, öuõø»UPõm], øP¯hUPz öuõø»÷£] 

AÀ»x  \‰P  Áø»zuÍ[PÎ÷»  vÓUPUTi¯ÁõÖ  PõönõÎU  ÷Põ¨£õP 

÷\ª¨£uØS ¤ßÁ¸® £i•øÓø¯¨ ¤ß£ØÖP.

£i 1'  File → Save Movie Iz öu›P, Cuß÷£õx ö£Ó¨£kQßÓ Menu  

  C¼¸¢x ÷\ªUP ö£õ¸zu©õÚ FhPzøu öu›P.
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£i    2'  ÷Põ¨ø£ ÷\ªUPz ÷uøÁ¯õÚ Chzøuz öu›¢x, AuØS   

  ö£õ¸zu©õÚ ö£¯øµ Cmk, Save ö£õzuõøÚ ö\õkUSP.

 E¸ 4.58

ªß Ag\¼ 

ØPõP

PoÛUPõP

Â÷\h vøµUPõP

øP¯hUPz 

öuõø»÷£] 

UPõP

 

\‰P Áø»zuÍ[ 

PÐUPõP

ö\Â¨¦» 

ÂøÍÂØPõP

÷\ª¨£uØPõÚ £À÷ÁÖ£mh FhP[PÒ

ö\¯Ø£õkPÒ

 ² £À¿hP Azv¯õ¯zvß ‰»® PØÖU öPõsh Âh¯[PøÍ 

Ai¨£øh¯õPU öPõsk C»[øP°ß Â÷\h Ch[PÎß 

£i©[PøÍ  E£÷¯õQzx Áøµ¦PÒ ]»ÁØøÓ E¸ÁõUSP.

 ² C¢u Áøµ¦PøÍ ¤ßÚo¯õP £¯ß£kzv Aø\ÅmhU Ti¯ 

GÊzxUPøÍU öPõsh C¸£›©õn JÎ°¯À Aø\Åmh® 

]»ÁØøÓ E¸ÁõUSP. 

 ² {¸©õoUP¨£mh Áøµ¦ ©ØÖ® JÎ°¯À Aø\ÅmhzvØS 

ö£õ¸zu©õÚÁõÖ J¼ ÷Põ¨¦PøÍ E¸ÁõUSP.

 ² ÷©÷» {¸©õoUP¨£mh Áøµ¦, JÎ°¯À Aø\Åmh® ©ØÖ® 

J¼ ÷Põ¨¦PøÍ E£÷¯õQzx C»[øP°ß Â÷\h Ch[PÒ 

\®£¢u©õÚ Kº PõönõÎ ÷Põ¨ø£ E¸ÁõUSP.
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 ² C»UP•øÓ Áøµ¤¯À ̂ Digital graphics&Gß£x PoÛø¯ E£÷¯õQzx 

Áøµ¦ ö©ßö£õ¸ÒPÎß EuÂ²hß E¸ÁõUP¨£kQßÓ, ¯õ÷uÝ® 

uPÁö»õßøÓ ÁÇ[S®  £i©©õS®.

 ² C»UP•øÓ Áøµ¤ß ¤µuõÚ A®\[PÒ  ]»  Á¸©õÖ : £h‰»® 

^Pixel&"  ¤›vÓß  ^Resolution&" £¸©ß ^Size& ©ØÖ®  Áºn® ^Colour&
 ² £h‰»®  Gß£x  öÁØÖU  PsPÍõÀ £õº¨£uØS PiÚ©õÚ ªPa ]Ô¯ 

¦ÒÎ¯õS®. C»UP •øÓ Áøµ£õÚx £À»õ°µUPnUPõÚ £h‰»[ 

PøÍU öPõsk E¸ÁõUP¨£kQßÓx.

 ² £h‰»©õÚx  ¤m  ^Bits& PøÍ öPõsi¸US®. J¸ uÛ Áºn 

£h‰»®  8 ¤m ^Bits& PøÍ²®, Áºn¨ ¤U\À 24 ¤m ^Bits& PøÍ²® 

öPõsi¸US®.

 ² C»UP•øÓ Áøµ¤ß ö£ÍvP £›©õnzøu ^Physical dimension&  AÍ 

Âk® A»S £h‰»®  Gß£xhß Auß ö£ÍvP £›©õn® ¤›vÓß 

GÚ AøÇUP¨£k®.

 ² AvP £h‰»[PøÍ²®, E¯º ¤›vÓøÚ²® ^High resolution& öPõsh 

C»UP•øÓ Áøµ£õÚx E¯º uµzøuU öPõshuõP Põn¨£k®.

 ² Áºn ©õv›¯[PÒ C¸ÁøP¨£k®. AøÁ,

 � RGB ©õv›¯® ^RGB Model& - ]Á¨¦, £aø\ ©ØÖ® }»® ^Red, 
Green and Blue&

 � CMYK ©õv›¯® ^CMYK Model& - CÍ}»®, Fuõ, ©g\Ò ©ØÖ® 

P¸¨¦  ^Cyan, Magenta,  Yellow and  Black&
 ² uÛ Áºn® -- ‰»Áºn[PÒ  ^Primary colours&

 ² C¸ Áºn[PÒ - Cµshõ® {ø»/xøn Áºn[PÒ ̂ Secondary colours&

 ² ‰ßÖ Áºn[PÒ -  Triplet colours

 ² ‰» Áºn[PÎß AÍÄ 256 ^0-255& Esk.

 ² zRGB TripletZ Áºn[PÒ ^000" 000" 000-225" 225" 225& GÝ® Ãa]À 

Aø©²®.

 ² zRGB TripletZ - RGB ^245" 102" 36& AÀ»x RGB ^F5"66"24& £vÚÖ© 

ö£Ö©v¯õP Põmh¨£k®.

 ² Áøµ¦ ö|¸UP® ^Graphic compression& C¸ÁøP¨£k®.

1' CÇ¨¦ ö|¸UP®/£õv¨£øh²® ö|¸UP® ^Lossy compression& 
2' CÇ¨¤À»õu ö|¸UP® /£õv¨¤À»õu ö|¸UP® ^Lossless   
    compression& 

 ² Áøµ¦ Cµsk ÁøP¨£k® ^Graphics types& 
1' £µÁÀ Áøµ¦ ^Raster graphic&
2' ö|Ô¯ Áøµ¦ ^Vector graphic&

ö£õÈ¨¦
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   C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

 ² Cøn¯zuÍö©õßÔß ÷uøÁ¨£õk ©ØÖ® EÒÍhUP®

 ² Cøn¯zuÍö©õßøÓ vmhªhÀ

 ² Cøn¯zuÍö©õßøÓ ÁiÁø©US® •øÓPÒ

 ² Cøn¯zuÍö©õßøÓ öÁÎ°kuÀ

 ² Cøn¯zuÍö©õßøÓ £µõ©›zuÀ

   Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

5'1 Cøn¯zuÍ[PøÍ ÁiÁø©¨£uØPõP uPÁÀPøÍ        

       ÷\P›zuÀ

Cøn¯zuÍö©õßøÓ E¸ÁõUS®÷£õx £» Âh¯[PøÍU P¸zvØ öPõÒÍ 

÷Ásk®. C¨÷£õx, }º Em£h E©x ©õnÁº SÊÄUS Cøn¯zuÍ 

ö©õßøÓ E¸ÁõUS©õÖ ö£õÖ¨¦ uµ¨£mkÒÍuõPU öPõÒP.

E®©õÀ Cøn¯zuÍ® E¸ÁõUP¨£kÁx,

 G¢u÷|õUPzxUPõP?

¯õ¸UPõP?

 GÆÁõÖ?

 £µõ©›¨£x GÆÁõÖ?

÷£õßÓ Âh¯[PÒ \®£¢u©õP Â›ÁõPÄ® BÇ©õPÄ® Bµõ¯¨£hÀ ÷Ásk®.

5'1'1 Þ¬íòˆî÷ªñ£¡P¡ (WebSite) «î¬õŠð£´

¯õ÷uÝö©õ¸ |£º AÀ»x {ÖÁÚzvß Â÷\h ÷uøÁ JßÖ AÀ»x £»ÁØøÓ  

{øÓ÷ÁØÖ® ÷|õUPzxUPõP÷Á Cøn¯zuÍ[PÒ E¸ÁõUP¨£kQßÓÚ. 

E»P»õÂ¯ Áø»°÷» £» ªÀ¼¯ß  PnUPõÚ Cøn¯zuÍ[PÒ Põn¨ 

£kQßÓÚ. AÁØÔß ÷uøÁ¨£õkPÒ £»ÁØøÓ AÁuõÛUP •i²®. AÁØÔÀ 

]» Á¸©õÖ:

   C¨ £õhzøuU PØÓ ¤ßÚº }[PÒ,

² Cøn¯zuÍö©õßÔß ÷uøÁ¨£õk ©ØÖ® EÒÍhUP®

² Cøn¯zuÍö©õßøÓ vmhªhÀ

² Cøn¯zuÍö©õßøÓ ÁiÁø©US® •øÓPÒ

² Cøn¯zuÍö©õßøÓ öÁÎ°kuÀ

² Cøn¯zuÍö©õßøÓ £µõ©›zuÀ

   Gß£Ú £ØÔ¯ ÂÍUPzøu¨ ö£ÖÃºPÒ.

5
£À¿hPz öuõÈÝm£zøu¨

£¯ß£kzv GÎ¯ Cøn¯zuÍ[PøÍ 

ÁiÁø©zuÀ
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i)  uPÁÀ öuõhº£õhÀ  (Communication)
Cøn¯¨ £¯|ºPÐUPÎß PÀÂ, _Põuõµ® ÷£õßÓ £À÷ÁÖ uPÁÀ öuõhº 

£õh¾UPõP E¸ÁõUP¨£mh Cøn¯zuÍ[PÒ Põn¨£kQßÓÚ.

    Euõµn®   ( www.nie.lk, www.edupub.gov.lk, www.webopedia.org

ii) ÁoP® (e - Commerce)
Cøn¯zv÷» ö£õ¸ÒPøÍ²® ÷\øÁPøÍ²® ÁÇ[S® Cøn¯zuÍ[PÒ 

Põn¨£kQßÓÚ.

    Euõµn®   ( www.farlin.lk, www.lego.lk, www.amazon.com

iii) ö£õÊx÷£õUS (Entertainment)
£õhÀ, vøµ¨£h®, |õhP® ÷£õßÓÁØøÓ PskPÎzuÀ AÀ»x uµÂÓUP® 

ö\´uÀ, Â÷Úõu ÂøÍ¯õmkUPÎÀ Dk£hÀ, ÁõöÚõ¼ ÷PmhÀ, 

öuõø»UPõm] £õºzuÀ ÷£õßÓ ÷|õUPzxUPõÚ ö£õÊx÷£õUS Cøn 

¯zuÍ[PÒ Põn¨£kQßÓÚ.

Euõµn®   ( www.islandcricket.lk, www.netflix.com, www.youtube.com

iv) ÂÍ®£µ® (Advertising)
{ÖÁÚ[PÎ÷» EØ£zv ö\´¯¨£kQßÓ ö£õ¸ÒPÒ ©ØÖ® ÷\øÁPøÍ 

©UPÐUS Põm]¨£kzx® Cøn¯zuÍ[PÒ Põn¨£kQßÓÚ. 

Euõµn®   ( 

www.onclickads.net, www.adcash.com, www.myadvertisingpays.com

v) ö\´vPøÍ ÁÇ[PÀ (News)
£À¿hPz öuõÈÝm£zxhß Ti¯ ö\´vPøÍ ÷ÁP©õP ©UPÐUS 

Põm]¨£kzx® Cøn¯zuÍ[PÒ Põn¨£kQßÓÚ.

Euõµn®  ( www.itnnews.lk, www.newsfirst.lk, www.bbc.co.uk

vi) \‰P öuõhº¦PøÍ Pmiö¯Ê¨¦® FhP[PÒ (Social Media)
PÀÂ©mh®, öuõÈÀ\õº, Â¸¨¦ ©ØÖ® ÷ÁÖ ÷|õUP[PÐUPõP ÷ÁÖ 

£mh \‰P SÊUPÎøh÷¯ öuõhºø£ E¸ÁõUPÀ ©ØÖ® AuøÚ öuõhºuÀ  

÷£õßÓ Á\vPøÍ ÁÇ[SÁuØPõP E¸ÁõUP¨£mh Cøn¯zuÍ[PÒ Põn¨ 

£kQßÓÚ.

Euõµn®
  
  ( www.facebook.com, www.linkedin.com, www.twitter.com

vii)÷uhÀö£õÔ  (Search Engine)
ö\õÀö»õßøÓ AÀ»x ÁõUQ¯ö©õßøÓ \õÂ¯õPU öPõsk, E»PÍõÂ¯ 

Áø»°÷» G©x ÷uøÁUS¨ ö£õ¸zu©õÚ Pm¦», ö\Â¨¦» uPÁÀPøÍ 

÷ukÁuØS›¯  Á\vø¯U  öPõsh Cøn¯zuÍ[PÒ  ÷uhÀ ö£õÔ ^Search 
Engine& GÚ AøÇUP¨£kQÓx.  
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Euõµn®    ( www.google.com, www.msn.com, www.bing.com

viii)  uÛ|£º ÷|õUP® (Personnel)
GÊzuõÍºPÒ, Aµ]¯ÀÁõvPÒ ÷£õßÓ ¤µ]zvö£ØÓ |£ºPÒ AÀ»x 

SÊUPÒ u©x uPÁÀPøÍ ©UPÐUS öÁÎ¨£kzxÁuØS CÆÁõÓõÚ 

Cøn¯zuÍ[PÒ EuÄQßÓÚ. 

Euõµn® ( 

www.president.gov.lk, www.arthurcclarke.net, www.nelsonmandela.org

¯õ÷uÝö©õ¸ Cøn¯zuÍzøu E£÷¯õQUS® |£ºPÒ A¢u Cøn¯zuÍzvß 

£¯|ºPÍõP (Web Users) P¸u¨£kÁº.  

Euõµn©õP www.google.com Cøn¯zuÍzøu E»PÍõÂ¯ Ÿv°÷» 

©UPÒ £¯ß£kzxÁuõÀ AÁºPÒ ¯õÁ¸® google Cøn¯zuÍzvß £¯|º 

PÍõÁº. C»[øP°ß £À÷ÁÖ ¤µ÷u\[PÎ¾ÒÍ ©õnÁºPÒ, B]›¯ºPÒ, 

ö£Ø÷ÓõºPÒ  ©ØÖ®  ÷ÁÖ  |£ºPÒ  £»   ÷uøÁPÐUPõP   PÀÂ  Aø©a]ß 

Cøn¯zuÍzøu E£÷¯õQ¨£uõÀ CÁºPÒ ¯õÁ¸® PÀÂ Aø©a]ß Cøn 

¯zuÍzvß £¯|ºPÍõÁº.

Cøn¯zuÍ[PÒ   £¯|ºPÐUPõP   E¸ÁõUP¨£kÁvÚõÀ  AÁºPÎß Â÷\h

C¯À¦PÒ ©ØÖ® AÁºPÐUQøh°»õÚ ÷ÁÖ£õkPÒ Aøh¯õÍ¨£kzu¨ 

£hÀ ÷Ásk®. AÆÁõÓõÚ C¯À¦PÒ ]» Á¸©õÖ:
1' ö©õÈ ©ØÖ® P»õa\õµ®

2' Á¯x ©mh®

3' PÀÂzuøPø© ©mh®

4. £õÀ

5' Â¸¨£[PÒ

¦v¯ Cøn¯zuÍö©õßøÓ E¸ÁõUS®÷£õx Auß £¯|ºPÒ \®£¢u©õÚ 

Â£µ[PøÍ Bµõ´¢x AÁºPÎß Â÷\h C¯À¦PÒ ©ØÖ® ÷ÁÖ£õkPøÍ 

Aøh¯õÍ¨£kzvU öPõÒÁ÷u £¯|º SÊ B´Âß ¤µuõÚ SÔU÷PõÍõS®. 

CuØPõP øP¯õÍ¨£k® ]» •øÓPÒ Á¸©õÖ

Euõµn®:
1' C»US £¯|ºPÒ \®£¢u©õÚ B´ÂÀ Dk£hÀ

2' CuØS \©ÚõÚ ÷ÁÖ Cøn¯zuÍ[PøÍ Bµõ´uÀ

C[S AÁuõÛUP¨£mh PõµoPøÍ P¸zvØ öPõsk C»US £¯|ºPÒ 

¯õÁ¸US® ö£õ¸¢x©õÖ ¦v¯  Cøn¯zuÍ©õÚx E¸ÁõUP¨£hÀ ÷Ásk®. 

CÆÁõÓõÚ \¢uº¨£[PÒ ]»ÁØøÓ AÁuõÛ¨÷£õ®.

5'1'2 ðòï˜ °¿ ÝŒ¾
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RÊÒÍ   E¸ 5.1  BÚx  C»[øP°ß   Ezv÷¯õP§ºÁ   Cøn¯zuÍzvÚx®    

©ØÖ® E¸ 5.2  BÚx öuõø»zöuõhº£õhÀ BønUSÊÂß Cøn¯z 

uÍzvÚx® •uÀ £UPzøu PõmkQÓx. C»[øP°ß £À÷ÁÖ ¤µ÷u\[PÎ¾® 

EÒÍ ©UPÎß |»ß P¸v •®ö©õÈPÎ¾® AÁuõÛUPU Ti¯ÁõÖ C¢u 

Cøn¯zuÍ[PÒ E¸ÁõUP¨£mkÒÍøuU Põn»õ®.

E¸ 5.2 CÀ EÒÍ Cøn¯zuÍ® £¯|›ß ÷uøÁø¯U P¸zvÀ öPõsk GÊz 

xUPÎß £¸©øÚ ©õØÔ AÁuõÛUPU Ti¯ÁõÖ Á\v ö\´¯¨£mkÒÍx. 

Azxhß £¯|›ß Â¸¨£zøuU P¸zvÀ öPõsk C¢u Cøn¯zuÍzv¼¸¢x 

C»SÁõP \‰P Áø»zuÍ[PÐUS ¤µ÷Á]UPÄ® Á\v ö\´¯¨£mkÒÍx.

][PÍ ö©õÈ°À 

Em¤µ÷Á]UP

B[Q» ö©õÈ°À 

Em¤µ÷Á]UP

uªÌö©õÈ°À 

Em¤µ÷Á]UP

E¸ 5.1 www.srilanka.lk   GÝ® Cøn¯zuÍzvß •uÀ £UP® Põm]¨£kzu¨£k® Âu®



C»Á\¨ £õh¡À 155

GÊzxUPÎß 

£¸©øÚ ©õØÔ 

Aø©UP

  ÷uhÀ ö£mi

PõönõÎ

   £i©®

£õh®

£v¨¦›ø© 

©ØÖ® £µõ©›¨¦ 

Bsk
Cøn¯¨ £UP[PÐUQøh÷¯ 

|Pºzx® vøµ

ö©õÈ°øÚ 

©õØÖÁuØS

¤µ]zv ö£ØÓ \‰P 

Áø»uÍ[PøÍ 

AøhÁuØS

E¸ 5.2  www.trc.gov.lk   GÝ® Cøn¯zuÍzvß 

•uÀ£UP® Põm]¨£k® Âu®

Cøn¯zuÍzv¾ÒÍ £¯|¸US ÁÇ[P¨£kQßÓ ö\Â¨¦», Pm¦» 

uPÁÀPÒ ©ØÖ® ÷\øÁPÒ AøÚzx® Auß EÒÍhUP©õPU P¸u¨£k®.  

Cøn¯zuÍ® ÁiÁø©¨£uØPõÚ ÷uøÁ/÷uøÁPÒ ©ØÖ® £¯|º SÊ 

B´Âß÷£õx ö£Ó¨£mh £¯|º ÷uøÁPÒ ÷£õßÓÚ P¸zvÀ öPõÒÍ¨£mk 

¦v¯ Cøn¯zuÍzvß EÒÍhUP® wº©õÛUP¨£kQÓx. CuÝÒ £¯|›ØS 

öuõhº£õhø» ÷©ØöPõÒÍz ÷uøÁ¯õÚ \P» uPÁÀPÐ® Azxhß Cøn 

¯zuÍzøu £›^»øÚ ö\´Áøu C»SÁõUSÁuØPõP ÁÇ[S¨£kQßÓ                   

÷\øÁPÐ® EÒÍhUP¨£hÀ ÷Ásk®.

÷ÁÖ£mh Cøn¯zuÍ[PøÍ £›^»øÚ ö\´²®÷£õx Auß EÒÍhU 

Pzv÷» ÷ÁÖ£mh uPÁÀPÒ ©ØÖ® ÷\øÁPÒ Põn¨£kQßÓÚ. AÁØÔÀ 

]» Á¸©õÖ:

 5'1'3 Þ¬íòˆî÷‹ å¡P¡ àœ÷ì‚è‹ (Web Content)
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 ² £õh® ^Text& ( uPÁÀPÎß _¸UP® 

 ² £i©® ( P©µõ ‰»® ö£Ó¨£mh ¦øP¨£h®, •ß B¯zu¨ £h® (Clip 
Arts)" Á¸i ‰»® ö£Ó¨£mh £h®

 ² J¼ ( £õhÀ, J¼U ÷Põ¨¦ ^Voice clip& 

 ² PõönõÎ ( PõönõÎU ÷Põ¨¦ ^Video clip&

 ² Aø\Åmh[PÒ ^Animations& ( Aø\ÅmhÀ ö©ßö£õ¸Îß EuÂ²hß 

£i©[PøÍ EÒÍhUQ E¸ÁõUP¨£mh Aø\Åmh[PÒ

 ² £v¨¦›ø© ^Copyright& ©ØÖ® £µõ©›¨¦ Â£µ®

 ² ÷ÁÖ uµÄPÒ, £i©®, ö\Â¨¦», Pm¦» ÷Põ¨¦PÒ, \‰P Áø»zuÍ[PÐhß 

öuõhº¦     

 ² ÂÍ®£µ®

 ² ÷uhÀ Á\v

 ² Cøn¯zuÍzv¼¸¢x £¯|¸US ÷uøÁ¯õÚ ö©ßö£õ¸ÒPÒ, GÊzx¸ 

ÁøPPÒ ÷£õßÓÁØøÓ uµÂÓUP® ö\´²® Á\v

CønzuÍö©õßÔÀ EÒÍhUP Â£µ[PøÍ AÁuõÛUP ÷©÷» E¸ 5.2
CÀ Põmh¨£mkÒÍ öuõø»öuõhº£õhÀ BønUSÊÂØS ö\õ¢u©õÚ 

Cøn¯zuÍzøu ^www.trc.gov.lk& £›^»øÚ ö\´P.

5'1'4 Þ¬íò àœ÷ì‚è ºè£¬ñˆ¶õ‹ (Web Content Management) 

Cøn¯zuÍö©õßÔØPõP öu›Ä ö\´¯¨£kQßÓ EÒÍhUP©õÚx ]Ó¢u 

•øÓ°À öuõSUP¨£kÁx EÒÍhUP •Põø©zxÁ©õPU P¸u¨£kQÓx. 

Cuß ¤µuõÚ ÷|õUP® £¯|›ØS ÂøÚzvÓß Ti¯ ÂuzvÀ Á\vPøÍ 

ÁÇ[SÁuõS®. ]Ó¢u •øÓ°À J¸[Pø©UP¨£mh Cøn¯zuÍ[PÎß 

C¯À¦PÒ ]» Á¸©õÖ :

 ² £õÁøÚø¯ C»SÁõUPÀ

 ² £¯|¸USz ÷uøÁ¯õÚ uPÁÀPøÍ ÂøµÁõPz ÷uiU öPõÒÍÀ

 ² £¯|øµU PÁ¸uÀ

 ² C»SÁõP CØøÓ¨£kzuÀ

 ² ¤ØPõ»zvÀ ¦v¯ £s¦PøÍ (features) ÷\º¨£uØS Á\vPÒ Põn¨£kuÀ

Cøn¯zuÍö©õßÔß EÒÍhUPzvØPõP öu›Ä ö\´¯¨£kQßÓ uPÁÀ 

PÎß GsoUøP SøÓöÁÛÀ, AuøÚ J¸[Pø©¨£x C»SÁõÚ  Põ›¯ 

©õS®. BÚõÀ ö\Â¨¦», Pm¦» uPÁÀPøÍ AvPÍÂÀ EÒÍhUQ¯ 

Cøn¯zuÍö©õßøÓ J¸[Pø©UP £À÷ÁÖ£mh ÁÈ•øÓPÒ ¤ß£ØÓ¨              

£kQßÓÚ. AuøÚ ¤ßÁ¸©õÖ GkzxUPõmh»õ®.
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1.  Áøµ£h® ‰»® ÁøP¨£kzuÀ

Cøn¯zuÍzvß EÒÍhUPzøu ö£õ¸zu©õÚ ÁøP¨£kzu¼ß Ai¨£ 

øh°À ÁøP¨£kzv Áøµ£h® ‰»® ^Site map& Põm]¨£kzxÁuõÀ 

Cøn¯zuÍzvØPõP E¸ÁõUP¨£kQßÓ Cøn¯¨£UP[PÒ ©ØÖ® 

AÁØÔØQøh÷¯ Põn¨£kQßÓ EÒÍPz öuõhº¦PÒ \®£¢u©õÚ 

öuÎÁõÚ AÔøÁ¨ ö£Ó •i²®. GkzxUPõmhõP ¤ßÁ¸® E¸ 5.3
CÀ Põmh¨£mkÒÍ  £õh\õø» Cøn¯zuÍ® JßÔß Áøµ¨£hzvÀ, 

Pmh[PÒ E¸ÁõUP¨£h ÷Ási¯ Cøn¯¨£UP[PÒ Põmh¨£mkÒ 

Íxhß ÷PõkPÒ ‰»® Cøn¯¨£UP[PÐUQøh÷¯ EÒÍP öuõhº¦ 

hø©ø¯ HØ£kzxÁuØPõP E¸ÁõUP¨£h÷Ási¯ «°øn¨¦ Põmh¨ 

£kQÓx.

E¸ 5.3  £õh\õø» Cøn¯zuÍö©õßÔß Pmhø©¨¦ Áøµ£h® (Site Map)

2.  Jmkö©õzu EÒÍhUPzvß öuõS¨ø£ •uØ£UPzvÀ Põm]¨       

     £kzuÀ

•uÀ £UP® (Home page) Cuß ‰»® Cøn¯zuÍzvß Jmkö©õzu 

EÒÍhUP©õÚx Põmh¨£kQÓx. C[S •uÀ £UPzvÀ Chzøu Pmk¨ 

£kzxÁuØPõP,

 ² «°ønPÒ (Hyperlinks) (E¸ 5.5)
 ² ¤µuõÚ ©ØÖ® E£ £mi¯ÀPÒ £¯ß£kzu¨£k® (E¸ 5.4)

•uÀ £UP®

|h¨¦z 

uPÁÀPÒ 
Áµ»õÖ ÂøÍ 

¯õmk

£øÇ¯ 

©õnÁº
£.A.\ø£

öuõhº¦ 

öPõÒÍÀ

GÀ÷»

C»UQ¯® Cì»õ® C¢x

Q›UöPmTøh¨£¢x

\[P®

•Põø©

zxÁ 

Pmhø©¨¦
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E£ £mi¯À

¤µuõÚ £mi¯À

E¸ 5.4 ¤µuõÚ ©ØÖ® E£ £mi¯À

3.  uPÁÀPøÍa _¸UP©õP ÁÇ[PÀ 

Cøn¯zuÍö©õßÔÀ AvP uPÁÀPÒ Põn¨£kªhzx ÷uøÁ¯õÚ 

uPÁ¼ß «x £¯|º DºUP£hõ©¼¸UP Áõ´¨¦sk. GÚ÷Á Kº £UPzvÝÒ  

EÒÍhUP¨£k® uPÁÀPÎß GsoUøP¯õÚx Pmk¨£kzu¨£mhuõP 

C¸zuÀ ÷Ásk®.

4.  C»UPªh¨£mh, SskUSÔ £mi¯ÀPÒ ©ØÖ® EÒuÒÍÀ 

Cøn¯zuÍzv÷» }sh £¢vPøÍU öPõsh uPÁÀPøÍ Áõ]¨£uõÀ 

£¯|¸US Aö\ÍP›¯® HØ£kQÓx. CÆÁõÓõÚ \¢uº¨£[PÎÀ C»UPU  

SÔ°hÀ ^Numbered List&" Ssk SÔ°hÀ  ^Bulleted List& AÀ»x  Em 

uÒÍÀ ^Indentation& ÷£õßÓÁØøÓ ¤µ÷¯õQzx SÔzu £¢vø¯ £» 

£SvPÍõP PõmkÁuõÀ, £¯|º PÁÚ® ö\¾zu Áõ´¨¦sk. 

5.  £¯Úº Áø»UPh¨¤hzøu C»SÁõP E»ÄÁuØPõÚ Á\vPøÍ     

    ÁÇ[SuÀ

ªP ÷ÁP©õPÄ® C»SÁõPÄ® Cøn¯zuÍzv¾ÒÍ uPÁÀ ¯õÁØøÓ²® 

AÁuõÛ¨£uØPõP £UP[PÐUQøh÷¯ |Pºzx® (Navigate& Á\v Põn¨ 

£hÀ  ÷Ásk®.  CuÚõÀ  £¯|¸US   u©US   ÷uøÁ¯õÚ   Pm¦», ö\Â¨ 

¦» uPÁÀPøÍ ©õzvµ® AÁuõÛUPÄ® ÷uøÁ¯ØÓÁØøÓ øPÂhÄ® 

Áõ´¨¦sk. ÷ÁÖ£mh Cøn¯zuÍ[PÎ÷» ÷ÁÖ£mh |PºzuÀ E£õ 

¯[PÒ E£÷¯õQUP¨£kQßÓÚ.
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      E¸ 5'5  www.laksala.gov.lk GÝ® 

Cøn¯zuÍzv¾ÒÍ «°øn°ß 

EuÂ²hß Cøn¯£UP[PÎøh÷¯ 

EÒÍ |PºzuÀ Á\v

Home

  Gem & jewellary GÚ¨ ö£¯›h¨£mh £UP® 
Gem & jewellary I 

ö\õhUS®÷£õx

Home I ö\õhUS®÷£õx

Home I ö\õhUS®÷£õx

 •uÀ £UP® 

  About us GÚ¨ ö£¯›h¨£mh £UP®

About Us I 

ö\õhUS® 

÷£õx



  C»Á\¨ £õh¡À160

6.  CØøÓ¨£kzuÀ

£v¨¦›ø© ©ØÖ® £µõ©›¨¦ Põ»® ÷£õßÓ uPÁÀPøÍ ]Ó¢u •øÓ°À 

JÆ÷Áõº £UPzv¾® Põm]¨£kzxÁuõÀ £¯|¸US uõ® £›^»øÚ ö\´²® 

uPÁÀPÎß |®£Pzußø© EÖv¨£kzu¨£k®.

5'1'5 Þ¬íòŠ ð‚èˆF¡ è†ì¬ñŠ¹‹ î÷‚«è£ôº‹ 
        (Structure and layout)

Cuß ‰»® Cøn¯¨ £UPzvß ¤ßÚo, AmhÁøn, \mhP®, Áºn®, 

GÊzxÁøP, GÊzx¨£¸©ß, GÊzx¸ ÁiÁ® ÷£õßÓÚ P¸zvÀ öPõÒÍ¨ 

£k®. Cøn¯zuÍzxUS £¯|º AÁuõÚzøu ö\¾zuÄ® Cøn¯¨ £UPz 

v¾ÒÍ ÷ÁÖ£mh uPÁÀPøÍ £¯|º öÁÆ÷ÁÓõP AÁuõÛUPÄ® Cøn¯¨ 

£UPzvß Pmhø©¨¦, uÍU÷Põ»® ÷£õßÓÚ P¸zvÀ öPõÒÍ¨£hÀ ÷Ásk®.

1.  Cøn¯zuÍzv¾ÒÍ JÆöÁõ¸ £UPzvÚx® uÛzußø©ø¯¨ 

    £µõ©›zuÀ

AøÚzx £UP[PÎÚx® Pmhø©¨¦, uÍU÷Põ»® ÷£õßÓÁØøÓ J÷µ 

ÂuzvÀ ÷£qÁuõÚx Cøn¯zuÍzvß uÛzxÁzøu ÷£n EuÄ®. 

SÔzu Cøn¯zuÍzvß ÷ÁÖ¨£mh £UP[PÎß ¤ßÚo, GÊzx¸ÁøP, 

GÊzx¸ £¸©ß, GÊzx¸ ÁiÁ® ÷£õßÓÚ A÷ÚP©õP \©ÚõS®.

2.  •UQ¯ uPÁÀPøÍ •øÚ¨¦ÖzuÀ

ªP ÷ÁP©õP ¯õ÷uÝ® uPÁö»õßøÓ ÷uk® ÷|õUPzxhß Cøn¯¨ 

£UP[PøÍ E»õÄ® ̂Web surfing& £¯|ºPÒ Cøn¯¨ £UPzv¾ÒÍ AøÚzx 

Âh¯[PøÍ²® Áõ]UP •øÚÁvÀø». C¢{ø»°À Azv¯õÁ]¯ 

Âh¯[PøÍ ÷ÁÖ£kzvUPõmkÁuõÀ £¯|›ß AÁuõÚzøu¨ ö£Ó 

•i²®. CuØPõP uPÁÀPÎÀ GÊzx¸ÁøP, GÊzx¸ £¸©ß, Áºn® 

÷£õßÓÁØøÓ ÷ÁÖ£kzvU Põmh»õ®.

3.  G¢uöÁõ¸ PoÛ°¼¸¢x® Cøn¯zøu AqSuÀ

£¯|ºPÒ  uÛ|£º  PoÛ,  

øP¯hUP öuõø»÷£] ÷£õßÓ 

÷ÁÖ£mh \õuÚ[PÎß EuÂ 

²hß Cøn¯zuÍ[PøÍ £õº 

øÁ°kQßÓÚº.  C¢u vøµ 

PÎß ¤›vÓß ÷ÁÖ£kÁuõÀ 

]» Cøn¯¨ £UP[PÒ JÆ 

÷Áõº   vøµ°¾®  ÷ÁÖ£mk  

Põm]¯ÎUS® Cx £¯|¸US 

Aö\ÍP›¯zøu HØ£kzx®. 
E¸ 5.6 ( ÷ÁÖ£mh £¸©Ýøh¯ vøµPÒ
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÷ÁÖ£mh  Cøn¯zuÍ {¸©õoPÒ CuØPõP ÷ÁÖ£mh •øÓPøÍ 

E£÷¯õQUQßÓÚº. vøµ°ß £¸©ÝU÷PØ£ Cøn¯¨ £UP[PÎß £¸©ß 

©õØÓ¨£mk Cøn¯zuÍ[PÒ {¸©õoUP¨£kÁøu Euõµn©õP P¸u 

•i²®. 

ö\¯Ø£õk

E©x B]›¯›ß EuÂ²hß R÷Ç uµ¨£mkÒÍ CønzuÍ[PøÍ 

£›^»øÚ ö\´x, AÁØÔß {¸©õnzvß Á¼ø© ©ØÖ® 

SøÓ£õkPÒ ÷£õßÓÁØøÓ Bµõ´P.

 www.srilanka.lk  www.schoolnet.lk
 www.doenets.lk  www.bbc.co.uk/education

Cøn¯zuÍö©õßÔØS EÒÎkÁuØPõP £õh®, £i©®, ö\Â¨¦», Pm¦» 

uµÄPÒ ©ØÖ® Aø\Åmh[PÒ ÷£õßÓ ¯õuõ°Ý÷©õº FhP ÁÍzøu öu›Ä 

ö\´²®÷£õx Ax öuõhº£õÚ ]» Âh¯[PøÍ P¸zvÀ öPõÒÍÀ÷Ásk®. 

AøÁ¯õÁÚ,

1.  AÍÄ

Cøn¯¨£UPö©õßÔÀ EÒÎh¨£mh FhP ÁÍ[PÎß öPõÒvÓß 

©ØÖ® Ax Cøn¯¨£UPzvÀ vÓUP¨£hz ÷uøÁ¨£k® Põ»® Gß£ÁØ 

ÔØQøh÷¯ ö|¸[Q¯  öuõhº¦sk. CÆÁÍ[PÎß öPõÒvÓß 

AvPö©ÛÀ Cøn¯ ÷\øÁ¯Pzv¼¸¢x  £¯|›ß PoÛUS AvP 

uµÄPÒ uµÂÓUP® ö\´¯¨£h ÷Ási²ÒÍ Cøn¯¨£UPzøuz vÓUP 

J¨¥mhÍÂÀ AvP Põ»® ÷uøÁ¨£k®. Cøn¯¨£UPzøu £›^»øÚ 

ö\´ÁuØS AvP ÷|µ® Põzv¸¨£uõÀ £¯|º AuøÚ  Âmkaö\À» 

Áõ´¨¦sk. GÚ÷Á Cøn¯¨£UPö©õßÔÝÒ EÒÎkÁuØS öu›Äö\´ 

¯¨£kQßÓ FhP ÁÍ©õÚx C¯ßÓÍÄ öPõÒvÓß SøÓ¢uuõP Põn¨ 

£kÁx ]Ó¢uuõS®. FhPzvß ÁøPUPø©¯ C¢÷|õUPzvØPõP  ÷ÁÖ£mh 

•øÓPÒ ¤ß£ØÓ¨£kQßÓÚ. 

² £i©ö©õßÔÀ ÷uøÁ¯ØÓ £Svø¯ }USÁuß ‰»® £h‰»zvß 

AÍÂøÚU SøÓ¨£uõÀ öPõÒvÓß SøÓUP¨£k®. ÁøµÂ¯À 

ö©ßö£õ¸ÒPÎÀ Crop/Trim ÷£õßÓ PmhøÍPøÍ E£÷¯õQzx C¢u 

|hÁiUøPø¯ C»SÁõP ö\´¯•i²®. Azxhß  Áøµ¤¯À ö|¸UP 

öuõÈÝm£zøu ^Graphic compression&  E£÷¯õQzx® £i©zvß 

öPõÒvÓøÚ SøÓUP •i²®.

² PõönõÎ ÷Põ¨ö£õßÔØPõP ö£õ¸zu©õÚ ö|¸UPz ̂ Compression& öuõÈÀ 

 5'1'6  áìè õ÷ƒè¬÷  (Media resources) ªîK¾ªêŒî™
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~m£zøu   E£÷¯õQzxa   \mhPzvß  £¸©øÚ  ^Frame size& SøÓzuÀ, 

\mhP ÷ÁPÃuzvøÚ ^Frame rate&  SøÓzuÀ ©ØÖ® vøµ°ß ¤›vÓøÚU 

SøÓzuÀ ÷£õßÓ ö\¯Ø£õkPÍõ¾®  öPõÒvÓß  SøÓUP¨£kQÓx.  Az 

xhß  ÷uøÁ¯ØÓ \mhP® ©ØÖ® ÷uøÁ¯ØÓ J¼z uµÄPøÍ ^Audio
tracks& }USÁuõ¾® ÷©¾® öPõÒvÓøÚ SøÓUP•i²®.

² ö£õ¸zu©õÚ ö\Â¨¦» öuõS¨¦ ö©ßö£õ¸ÎøÚ E£÷¯õQzx J¼U 

÷Põ¨ö£õßÔß ¤µuõÚ ‰ßÖ £s¦PÍõÚ ¤m ÷ÁPÃu® ^Bit rate&"
©õv› ÂQu® ^Sample rate&  ©ØÖ® ö\ÀÁÈ ^Channel& AÍÂøÚ SøÓ¨ 

£uõ¾® öPõÒvÓß SøÓUP¨£kQÓx. Azxhß CÇ¨¤À»õ ö|¸UPz 

öuõÈÝm£zvß ‰»•® SÔzu ÁiÁzvÀ G¢u Kº ©õØÓ•® {PÇõ©À 

÷uøÁ¯ØÓ J¼ uµÄPøÍ ©õzvµ® }USÁuõ¾® ÷Põ¨¤ß öPõÒvÓß 

SøÓUP¨£kQÓx.

2.  Põ¨¦›ø©US ©v¨£Îzx FhP ÁÍ[PÎß £¯ß£õk

÷ÁÖ |£ºPÍõÀ E¸ÁõUP¨£mh FhP ÁÍ[PøÍ E©x Cøn¯zuÍzvÀ 

EÒÎh ÷Áskö©ÛÀ E›ø©¯õÍº Â£µ[PøÍ AÔ¢x SÔzu E›ø©ø¯ 

ö£ÖÁx® Cøn¯zuÍ {¸©õnzvß Kº A[P©õS®. AÆÁõÔÀø»ö¯ÛÀ 

Ax  \mhzvØS  •µnõÚ  ö\¯»õPU  P¸u¨£kÁxhß,  \mh    Ÿv¯õÚ 

]UPÀPøÍ \¢vUP ÷|›k®.

BÚõÀ ö£õx¨£¯ß uzxÁzvØPø©¯ ö\´vPÒ, ÂÁµn[PÒ ÷£õßÓ 

FhP ÁÍ[PøÍ E£÷¯õQ¨£uØS CÆÁõÖ E›ø©ø¯ ö£ÖÁx AÁ]¯ 

©ßÖ.

ö\¯Ø£õk

E©x SÊÂß Cøn¯zuÍ E¸ÁõUPzvØPõP ÷©¾ÒÍ 5.1.1 
öuõhUP® 5.1.6 Áøµ¯õÚ BÖ E£uø»¨¦PÎÀ ÂÁ›UQßÓ vmh 

ö©õßøÓ Pmiö¯Ê¨¦P.

 

HTML GÚ  _¸UP©õP  AøÇUP¨£k®  Hyper Text Markup Language Gß£x 

E»P»õÂ¯ Áø»¨ £UP[PøÍ E¸ÁõUP¨ £¯ß£kzxQßÓ Ai¨£øh 

ö©õÈ¯õS®. Cøn¯ Áø»÷©÷»õi°ß ‰»® Põm]¨£kzu¨£kQßÓ  

HTML AÔUøP¯õÚx, Cøn¯¨£UP©õP P¸u¨£kQÓx. E[PÐUSz öu›¢u 

Visual basic" Pascal ÷£õßÓ PoÛ {PÌa]°øÚ GÊxQßÓ ö©õÈPÒ 

÷£õ»À»õx HTML BÚx Auß SÔ•øÓPÒ ‰»® Cøn¯¨ £UPö©õßÔß 

EÒÍhUP®, PoÛz vøµ°ß «x Põm]¨£kzu¨£k® Âu® ÷£õßÓÁØøÓ 

 5'1'7 Ü®Šð¬ì HTML ðò¡ð£´ 
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Cøn¯ Áø»¯÷©÷»õiUS öu›ÂUS®. CuÚõÀ HTML BÚx, PoÛ 

ö©õÈ AÀ». Cx Põm]¨£kzx®/Â£›US® ö©õÈ ^Markup/Descriptive 
Language& BP P¸u¨£k®.

uØ÷£õx HTML ö©õÈ°øÚ £¯ß£kzv GÎ¯ Cøn¯¨£UP[PÒ £»ÁØøÓ 

E¸ÁõUSÁuØPõP RÊÒÍ ö\¯Ø£õkPøÍ ö\´P.

ö\¯Ø£õk  1

£i 1( E¸ 5.7 CÀ Põmh¨£m  

kÒÍÁõÖ,

Start→ All Programme → 
Accessories → Notepad 
‰»® Notepad CøÚz vÓ¢ 

xUöPõÒP. Notepad Gß 

£x Âß÷hõì £oö\¯À 

•øÓø©²hß Cøn¢xÒÍ 

GÎ¯ ö\õÀ•øÓ ÁÈ¨£kz 

uÀ {PÌa]¯õS®.

£i 2( Notepad   C÷»   E¸  5.8 CÀ 

Põmh¨£mkÒÍÁõÖ umha_ 

ö\´P.

                                                           

E¸ 5.8 ( Notepad CÀ  GÊu¨£mh ]» HTML TØÖUPÒ

£i 3( E¸ 5.9 CÀ Põmh¨£mkÒÍÁõÖ Notepad Cß ÷Põ¨¦¨ ö£¯øµ 

myfirst.html  GÚÄ® ÷Põ¨¦ÁøPø¯ All Files GÚÄ® öu›Äö\´x 

ö£õ¸zu©õÚ EøÓ°ÝÒ ÷\ªUP ^Save&.

  E¸ 5.7 ( Notepad £UP©õÚx 

vÓUP¨£k® •øÓ
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E¸ 5.9  Notepad  CøÚ ÷\ªUS®÷£õx vÓUP¨£k® ö\õÀ»õhØ ö£mi

£i 4 ( myfirst.html ÷Põ¨ø£ vÓUP. E¸ 5.10 CÀ Põmh¨£mkÒÍÁõÖ 

E©x •uÀ Cøn¯¨£UP® Põm]¨£kzu¨£k®.

E¸ 5.10  vÓUP¨£mh HTML  ÷Põ¨¦

£i 6 ( ÷©¾ÒÍÁõÖ  umha]kÁuØS,  Notepad  ÷£õßÓ ö\õÀ•øÓ 

ÁÈ¨£kzuÀ ö©ßö£õ¸ÒPÐUS¨£v»õP HTML öuõS¨¦ 

^HTML editors& BP P¸u¨£k® ö©ßö£õ¸øÍ £¯ß£kzu 

•i²®. Euõµn©õP CÆÁõÓõÚ ]» ö©ßö£õ¸ÒPÒ ©ØÖ® 

AÁØøÓ uµÂÓUP® ö\´¯z÷uøÁ¯õÚ Cøn¯zuÍ •PÁ›PÒ 

÷£õßÓÚ R÷Ç Põmh¨£mkÒÍÚ.

  1. CoffeeCup (www.coffeecup.com/html-editor)

  2. Seamonkey Composer (www.seamonkey-project.org)

£i 5 ( ÷©÷» £i•øÓ 2 CÀ E[PÍõÀ Notepad  CÀ umha]h¨£mh 

"This is the title'' , "My first web page"  ÷£õßÓ Á\Ú[PÐUS 

£v»õP ÷ÁÖ Á\Ú[PøÍ  umha_  ö\´x  ÷ÁÖ  Cøn¯¨ 

£UP[PøÍ E¸ÁõUQ  AÁØøÓ £›^»øÚ ö\´P.
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  3. Eclipse (https://marketplace.eclipse.org/content/html-editor-wtp)

CÁØÔÀ ¯õ÷uÝö©õ¸ ö©ßö£õ¸øÍ E©x PoÛ°÷» {ÖÂUöPõÒP.

£i  7 ( E©x PoÛ°÷» {ÖÁ¨£mh Cøn¯zuÍ {¸©õn ö©ß 

ö£õ¸øÍ vÓUP. File → New HTML document GÚ Pmh 

øÍø¯ ÁÇ[Q¯¤ß CoffeeCup GÝ® HTML  editor BÚx 

vÓUP¨£mkÒÍøu E¸ 5.11 PõmkQÓx.

E¸ 5.11   CoffeeCup  HTML editor vÓUP¨£mk Põm]¨£k® Âu®

÷©÷» £i 2 CÀ E[PÍõÀ Notepad CÀ GÊu¨£mh £» Á›PÒ C[S 

ußÛaø\¯õP GÊu¨£mkÒÍuõÀ E©x ÷Áø» C»SÁõUP¨£kQÓx.

uØ÷£õx E©x Cøn¯¨£UPzxUS ÷uøÁ¯õÚ ÂÁµ[PøÍ ©õzvµ® ö£õ¸z 

u©õÚ Chzv÷» EÒÎkP. •uÀ Cøn¯¨£UPzvÀ E[PÍõÀ EÒÎh¨£mh 

"This is the title" ©ØÖ® "My first web page" ÷£õßÓ Á›PÒ EÒÎh¨£mkÒÍøu 

E¸ 5.12 PõmkQÓx.

File → Save As   PmhøÍ  ‰»®  coffeecup1.html  GÚ  SÔzu  EøÓ°ÝÒ    

÷\ªUSP.
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Preview  tool

“This is the Title”

“My First Web Page”

E¸ 5.12 (  CoffeeCup editor HTML C÷» Á›PÒ EÒÎh¨£mkÒÍ Âu®

£i  8( uØ÷£õx Preview tool CøÚ E£÷¯õQzx Cøn¯¨ £UPzøu 

AÁuõÛUP. ÷ÁÖ Á›PøÍ²® EÒÎmk ÷©¾® ]» Cøn¯¨ 

£UP[PøÍ E¸ÁõUQ AÁØøÓ £›^»øÚ ö\´P.

     

SÔ¨¦

Notepad ©ØÖ® ÷ÁÖ ö©ßö£õ¸øÍ E£÷¯õQzx C[S 

E¸ÁõUP¨£mh HTML ö©õÈ°ß Á›PÍõÚx HTML SÔ 

•øÓPøÍ EÒÍhUQ¯ HTML AÔUøP¯õS®.

E[PÍõÀ Aøh¨¤ÝÒ GÊu¨£mh <html>, <head>, 
<title> ÷£õßÓÚ HTML ö©õÈ°ß Ai¨£øh Aøh¯õÍ 

JmkUPÍõS® (HTML Tags). C¢u JmkUPÎß ‰»®  

Cøn¯¨£UPzv¾ÒÍ  EÒÍhUP® £¯|¸US GÆÁõÖ Põm 

]¨£kzu¨£h ÷Áskö©ß£uøÚ Cøn¯ Áø»÷©õi¯õÚx 

wº©õÛUS®. GÚ÷Á E[PÍõÀ öu›Äö\´¯¨£mh Pmhø©¨¦ 

©ØÖ® uÍU÷Põ»©õÚx HTML JmkUPÒ ‰»÷© Cøn¯¨ 

£UPzxUS EÒÎh¨£kQÓx. 

HTML AÔUøPö¯õßÔß Ai¨£øh Pmhø©¨¤¾ÒÍ Azv¯õÁ]¯ JmkUPÒ 

]» E¸ 5.13 CÀ Põmh¨£mkÒÍÚ. AvP©õÚ Aøh¯õÍ JmkUPÎÀ Bµ®£ 

5'1'8 HTML  ÜP‚¬èJ¡ Ü®Šð¬ì‚ è†ì¬ñŠ¹
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Jmk ^Opening tag& ©ØÖ® •iÄ Jmk ^Closing tag& Esk. BÚõÀ Bµ®£ 

Jmk ©õzvµ•ÒÍ Aøh¯õÍ JmkUPÒ £ØÔ ¤ßÚº P»¢xøµ¯õk÷Áõ®.

html Bµ®£ 

Jmk

head Bµ®£ 

Jmk 

head •iÄ 

Jmk

body Bµ®£ 

Jmk 

body •iÄ 

Jmk 

html •iÄ 

Jmk  

}
}

head £Sv

body £Sv

<html>

<head>

</head>

<body>

</body>

</html>

E¸ 5.13 ( HTML AÔUøP°ß Ai¨£øhU Pmhø©¨¦

HTML AÔUøP¯õÚx  head ©ØÖ®  body GÚ C¸ ¤µuõÚ £SvPøÍ 

öPõshx.   AÔUøP°ß  Bµ®£©õÚx   <html> Jmiß ‰»•® •iÁõÚx 

</html> Jmiß ‰»•® Põmh¨£mkÒÍøu E¸ 5.13 CÀ AÁuõÛUP •i²®.

Cøn¯¨£UPzvÝÒ EÒÍh[P÷Ási¯ \P» Âh¯[PÐ® body 
£Sv°À EÒÎh¨£hÀ ÷Ásk®. E©x •u»õÁx Cøn¯¨£UPzvÀ   "My 
first  web page"GÚU SÔ¨¤h¨£mhøu «Í AÁuõÛUP.

Head  £Sv°ÝÒ SÔ¨¦PÒ Ck® Â÷\h \¢uº¨£[PÒ Esk. Euõµ 

n©õP E©x •u»õÁx Cøn¯¨£UPzvÀ <title> Aøh¯õÍ Jmk ÷\õiP 

Îøh÷¯ "This is the title" GÚU SÔ¨¤h¨£mhøu «Í AÁuõÛUP. Cx E©x 

Cøn¯¨£UPzvß uø»¨¦ £møh°À Põm]¨£kzu¨£mi¸US®.

  5'1'9 HTML Þ¡ Þò™¹èœ

i) HTML   Aøh¯õÍ JmkUPÒ ‰»® Cøn¯¨£UP©õÚx Põm]¨£kz 

u¨£k® Âu©õÚx Cøn¯ Áø»÷©÷»õi°÷» Põmh¨£k®. HTML
AÔUøP°¾ÒÍ CÆÁõÓõÚ PmhøÍPÒ HTML SÔ•øÓ¯õP P¸u¨£k®.

ii) HTML Aøh¯õÍ Jmiß Bµ®£ ©ØÖ® •iÂÀ Aøh¨¦ Põn¨£hÀ 

÷Ásk®.

Euõµn® ( £¢vö¯õßÔß Bµ®£zøu Aøh¯õÍ¨£kzu <p> Aøh¯õÍ  

  Jmk £¯ß£kzu¨£k®.

iii) ö£õxÁõP  HTML  Aøh¯õÍ JmhõÚx ÷\õi¯õP÷Á Põmh¨£k®. 
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•iÄÖzx® JmkUPõP —$˜ ^back slash& SÔ²hß Jmiß ö£¯º Ch¨£hÀ 

÷Ásk®. 

    Euõµn® ( £¢vö¯õßøÓ Bµ®¤UP <p> Aøh¯õÍ Jmk®, •iÄÖzu            

  <$p>  Aøh¯õÍ Jmk® £¯ß£kzu¨£k®.           

iv) ö£õxÁõP C¢u Aøh¯õÍ JmkUPÒ ÷£öµÊzx, ]ØöÓÊzx GßÓ 

÷ÁÖ£õk ^Case sensitive& AØÖU Põn¨£k®. GÚ÷Á B[Q» ÷£öµÊz 

xUPÒ  ̂Capital& AÀ»x ]ØöÓÊzxUPÒ  ̂Simple& ÷£õßÓÁØøÓ E£÷¯õQ¨ 

£uõÀ GxÂu P¸zx ©õØÓ•® HØ£hõx. 

     Euõµn®( <TITLE>, <Title> AÀ»x <title> GÚ CkÁuõÀ G¢uÂu P¸zx  

  ©õØÓ•® HØ£hõx.

v) Aøh¯õÍ JmhõÚx ¤øÇ¯õÚ •øÓ°À ÁÇ[P¨£iß AuØPõP 

ÁÊaö\´v  ^Error message&  öu›¯Áµõx. ©õÓõP Áø»÷©÷»õi¯õÀ 

SÔzu PmhøÍ¯õÚx {øÓ÷ÁØÓ¨£hõ©À Põm]¨£kzu¨£k®.

6' HTML Aøh¯õÍ JmhõÚx EÖ¨¦ ^element&" £s¦ ^attribute& ©ØÖ® 

ö£Ö©v ^value&  ÷£õßÓ ‰ßÖ £SvPøÍU öPõshx.

Euõµn®      ( ""|õß    £õh\õø»  ©õnÁß''  GßÓ \õuõµn GÊzøu  ̂plain text&" 
PÇP®     GÝ® GÊzx¸Â¾®  }»{Ózv¾®   Põm]¨£kzu ÷uøÁ¯õÚ        HTML 
SÔ•øÓ Á¸©õÖ:

¯õ÷uÝ® HTML Aøh¯õÍ ]ßÚzxUS ö£õ¸zu©õÚ £s£õÚx Auß Bµ®£  

Aøh¯õÍ JmiÝÒ ©õzvµ® Ch¨£hÀ ÷Ásk®. Auß ö£Ö©v¯õÚx 

G¨÷£õx® ÷©Ø÷PõÒ SÔ°ÝÒ Põmh¨£k®.

E¸ 5.14 CÀ Põmh¨£mkÒÍÁõÖ ""C»[øP'' £ØÔ¯  AÔ•P Cøn¯¨ 

£UPö©õßøÓ ÁiÁø©¨÷£õ®. 

<font face = zzKalahamZZ  color = zzblueZZ >  |õß £õh\õø» ©õnÁß </font>

ö£Ö©vPÒ (Values)

EÖ¨¦ (Element) £s¦PÒ (Attributes)

5'1'10 Þ¬íòŠð‚èªñ£¡¬ø G¼ñ£Eˆî™    
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E¸ 5.14 (  ""C»[øP'' £ØÔ¯  AÔ•P  Cøn¯¨£UP® 

uø»¨ø£ E¸ÁõUPÀ

}º Â¸®¤¯ ̄ õ÷uÝ® HTML editor JßÔøÚ E£÷¯õQzx ¦v¯ £UPö©õßøÓ 

vÓ¢x E¸ 5.15 CÀ Põmh¨£mkÒÍÁõÖ HTML SÔ•øÓø¯ GÊxP. 

C¨£UPzøu E©x PoÛ°÷» ö£õ¸zu©õÚ Chzv÷» ö£õ¸zu©õÚ 

ö£¯¸hß ÷\ªUP. E©x Áø» ÷©õ÷»õiø¯ vÓ¢x Cøn¯¨£UPzøu 

AÁuõÛUP. E¸ 5.15 CÀ Põmh¨£mkÒÍ Á¸ÂøÍÄhß E¸ 5.14                         
C¾ÒÍ uø»¨¦ £õhzøu J¨¤kP.

uø»¨¦ 

£õh®

£i©®

£¢v

«°øÚ

AmhÁøn

Á›PÒ
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E¸ 5.15  uø»¨¦ £õhzøu ÁiÁø©UP ÷uøÁ¯õÚ  HTML SÔ•øÓ ©ØÖ® Á¸ÂøÍÄ

C[S }º E£÷¯õQzu ¦v¯ HTML JmkUPÒ £ØÔ ÷©¾® Bµõ´÷Áõ®. 

ö£õxÁõP AÔUøPö¯õßÔß uø»¨¦, E£uø»¨¦ ©ØÖ® ÷ÁÖ ]» 

GÊzxUPøÍ AÔUøPö¯õßÔ¾ÒÍ ÷ÁÖ GÊzxUPÎ¼¸¢x ÷ÁÖ£kzv 

PõmkÁuØPõP GÊzx¸Âß £¸©ß, ui¨¦ ÷£õßÓÁØøÓ AvP›zuÀ 

÷£õßÓ E£õ¯[PÒ øP¯õÍ¨£k®. Cøn¯¨£UPzv÷» C¢ua ö\¯Ø£õk 

|øhö£ÖÁx  Header GÚ¨£k® Aøh¯õÍ JmkUPÍõ»õS®. <h1> öuõhUP® 

<h6> Áøµ C»UPªh¨£¨£mh header ÁøPø¯U öPõsh BÖ JmkUPÒ 

EÒÍÚ. CÁØÔÀ <h1> ‰»® £¸©ß ©ØÖ® ui¨¦ AvP©õÚ GÊzx¸ 

ÁiÁø©UP¨£k®. <h1> öuõhUP® <h6> Áøµ ö\À¾®÷£õx GÊzx¸Âß 

£¸©ß, ui¨¦ £i¨£i¯õP SøÓÁøhQÓx.

E©x Cøn¯¨£UPzvÀ <h2>  Aøh¯õÍ JmkUS¨ £v»õP ÷ÁÖ header 
Aøh¯õÍ JmkUPøÍ Cmk, Cøn¯¨£UP® Põm]¨£k® Âuzøu £›^»øÚ 

ö\´P. E[PÍõÀ ö£õ¸zu©õÚuõPU P¸u¨£kQßÓ GÊzx¸Âß £¸©øÚU 

öPõsh uø»¨ø£ E¸ÁõUSP.

Font Jmk

}[PÒ CxÁøµ°À PØÖÒÍ HTML JmkPÎÀ, EÖ¨¦ ^Element&" £s¦ 

^Attribute& ©ØÖ® ö£Ö©v ^Value& GÚ ‰ßÖ £SvPÒ Põn¨£kQßÓÚ. 

<html>
     <head>
    <title> Sri Lanka </title>
     </head>
     <body>
           <h2><center><font face="Arial" color="blue"> 
    SRI LANKA        
    </font></center></h2>
                </body>
</html>

Á

¸

Â

øÍ

Ä

Sri Lanka

Header 
Jmk

Center 
Jmk

Font
Jmk

     Header Jmk
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GÊzx¸ ^Font& Aøh¯õÍ JmiÀ £¸©ß ^Size&" ÁiÁ® ^Face& ©ØÖ® Áºn® 

^Color& GÚ ‰ßÖ ¤µuõÚ £s¦PÒ Esk. GÊzx¸ £¸©ß ̂ Font size& £s¤ß 

‰»®  GÊzx¸Âß £¸©ß Põmh¨£k®. CuØPõP 1 öuõhUP® 7 Áøµ²ÒÍ 

ö£Ö©vPøÍ ÁÇ[P•i²®. C[S öPõhõ{ø» ö£Ö©õÚ® ^Default size&  = 
3 BS®. E[PÍõÀ GÊzx¸ £¸©ÝUS ^Font size& ö£Ö©v ÁÇ[P¨£hõu 

{ø»°À Áø»÷©õi°ÚõÀ ußÛaø\¯õP Põm]¨£kzu¨£k® £¸©ÚõS®.

Font face £s¤ß ‰»® GÊzx¸Âß ÁøP Põmh¨£k®. CuØPõP E©x 

PoÛ°À EÒÍ H÷uÝ® GÊzx¸  ÁøPø¯ Ch •i²®. ^Euõµn® 

zzArial", "Kalaham", "verdana"&. Font color £s¤ß ‰»® GÊzx¸Âß Áºn® 

Põmh¨£k®. C[S Áºnzvß ö£Ö©vø¯ ÁÇ[SÁuØS C¸ •øÓPÒ  

Esk. 

i)   •øÓ - 1: RÊÒÍ (E¸ 5.16) £vÚõÖ Áºn[PøÍ AÁØÔß ö£¯¸hß   

  ChÀ.

E¸ 5.16  £vÚõÖ Áºn[PÒ

Euõµn® ( <font   size=zz5" face=zzverdana"  color = zzgreen" >SRI  LANKA</  
          font>

  

ii)   •øÓ - 2 :        E¸ 5.17 CÀ Põmh¨£mkÒÍx ÷£õÀ ]Á¨¦, £aø\, }»® 

÷£õßÓ ‰» Áºn[PÎß RGB £vÚÖ© SÔ•øÓø¯ 

ChÀ. C[S # SÔ±mkhß Bµ®¤UQßÓ 0 öuõhUP®  
F Áøµ²ÒÍ BÖ C»UP[PÎÚõÀ SÔ•øÓ¯õÚx  E¸ 

ÁõUP¨£kQÓx.  CvÀ   Bµ®£    C»UP[PÒ    CµshõÀ 

]Á¨¦ Áºnzøu²® ©ØøÓ¯ C¸  C»UP[PÒ £aø\ 

Áºnzøu²® CÖv C»UP[PÒ Cµsk® }» Áºnz 

øu²® SÔUQßÓx.

   
Á¸ÂøÍÄ SRI LANKA
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E¸ 5.17  ]» RGB  ÁºnU P»øÁPÒ

Euõµn® ( <font   size = zz5''  face = zzverdana"   color = #0000FF'' >SRI  
LANKA</font>

Á¸ÂøÍÄ SRI LANKA

Center Jmk

Cøn¯¨£UPzvÀ uø»¨ø£ Qøh¯õP ©zv¯{ø»US |Pºzu E£÷¯õQU 

P¨£k® JmhõS®. CuøÚ £õh® (Text) JßÖUS ©õzvµ©ßÔ £i©®, £¢v 

÷£õßÓ Âh¯zxUPõPÄ® E£÷¯õQUP •i²®. ÷©÷» Center JmiøÚ¨÷£õÀ 

£õhzøu (Text  I) ÁiÁø©¨£uØS £¯ß£kzu¨£kQßÓ ÷ÁÖ GÎ¯ JmkUPÒ 

£» Esk. CÁØÔÀ ]»ÁØøÓ AmhÁøn 5.1 PõmkQÓx.

HTML SÔ±k GÊzx¸PøÍ ÁiÁø©US® ußø© Euõµn®

<b> ui¨¦ ^bold& SRI LANKA 

<i> \›ÁõUP® ^italic& SRI LANKA

<u> AiU÷Põk ^underline& SRI LANKA

<em> •UQ¯zxÁ® ^emphasis& SRI LANKA

<s> GÊzx¸ «x ÷PõihÀ  ^strike 
out&

SRI LANKA

<sup> ÷©À ¦ÒÎ°hÀ ^superscript& SRI LANKA

<sub> RÌ ¦ÒÎ°hÀ ^subscript&
SRI LANKA
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<marquee> Qøhzvø\°À Aø\øÁ PõmhÀ 

^horizontally moving text&
CuøÚ, Cøn¯¨ 

£UPzvÀ ÷\õvzuÀ 

÷Ásk®

AmhÁøn 5.1( £õh (Text) ÁiÁø©¨¦UPõP E£÷¯õQUP¨£kQßÓ ]» JmkUPÒ

Euõµn® (    <b> SRI  LANKA </b>

Á¸ÂøÍÄ SRI LANKA

ö£õ¸zu©õÚ Cøn¯zuÍ[PøÍ E»õÂ £õh ÁiÁø©¨¤ØPõP E£ 

÷¯õQUP¨£kQßÓ HTML JmkUPÒ \®£¢u©õP ÷©¾® Bµõ´P.

Euõµn® (  CuØPõP ¤ßÁ¸® Cøn¯zuÍ[PøÍ £¯ß£kzxP.

  http://www.w3schools.com/html
  http://www.tutorialspoint.com/html

ö\¯Ø£õk    

R÷Ç E¸ 5.18 CÀ Põmh¨£mkÒÍ SÔ•øÓ°÷» £õh\õø»°ß 

ö£¯¸US¨ £v»õP E©x £õh\õø»°ß ö£¯›øÚ ÷\ºzx E©x 

Â¸¨£zvØPø©¯ ÷ÁÖ ÁiÁø©¨¦PÐhß  Ti¯  Cøn¯¨  £UP 

ö©õßøÓ  ÁiÁø©UP.  C[S }º  GÊzx¸ ÁiÁ©õP ''Kalaham'' 
CøÚ E£÷¯õQzxÒÏº. CÆ AÔUøP°øÚ ÷\ªUS®÷£õx  E¸  

5.19 CÀ  Põmh¨£mkÒÍ Save As ö\õÀ»õhØ ö£mi°÷»  Encoding 
ÁøPø¯ Unicode GÚ ©õØÔ¯ø©UP. E©x Cøn¯¨ £UPzøu E¸ 

5.20 CÀ Põmh¨£mkÒÍ Á¸ÂøÍÄhß J¨¤kP.
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<html>
 <head><title> Text Formatting  </title></head>
<body>
<font face =''Kalaham'' color = ''Green'' ><h1> 1' E©x £õh\õø»°ß ö£¯º  </ h1></font>

<font face=''Kalaham'' color = ''lime'' ><h2> 2. E©x £õh\õø»°ß ö£¯º </h2></font>

<font face=''Kalaham''  color = ''olive'' ><h3> 3. E©x £õh\õø»°ß ö£¯º </h3></font>

<font face=''Kalaham'' color = ''Navy'' ><h4> 4. E©x £õh\õø»°ß ö£¯º </h4></font>

<font face=''Kalaham'' color = ''blue'' ><h5>   5. E©x £õh\õø»°ß ö£¯º </h5></ font>

<font face=''Kalaham'' color = ''Aqua'' ><h6> 6. E©x £õh\õø»°ß ö£¯º </ h6></font>

<font face=''Kalaham'' color = ''Teal'' ><h6> 7' E©x £õh\õø»°ß ö£¯º </h6></font>

</body>
</html>
 

E¸ 5.18 ( HTML AÔUøP 

E¸ 5.19 (  Save as ö\õÀ»õhØ ö£mi
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1. E©x £õh\õø»°ß ö£¯º

2. E©x £õh\õø»°ß ö£¯º

3. E©x £õh\õø»°ß ö£¯º

4. E©x £õh\õø»°ß ö£¯º

5. E©x £õh\õø»°ß ö£¯º

6. E©x £õh\õø»°ß ö£¯º

7. E©x £õh\õø»°ß ö£¯º

E¸ 5.20 :  E¸ 5.18 CØPõÚ SÔ•øÓ°ß Á¸ÂøÍÄ

ö\¯Ø£õk   

  1. HTML SÔ•øÓ \®£¢u©õÚ Cøn¯zuÍ[PÒ ©ØÖ® 

¦zuP[PøÍ  E»õÂ, ÷ÁÖ£mh £õh ö©¸TmhÀ JmkPøÍ 

(Text formatting tags) CÚ[Psk AmhÁøn 5.1 CÀ 

Põmh¨£mkÒÍx ÷£õÀ Kº AmhÁønø¯ E¸ÁõUSP.

  2. ÷©÷» E¸ 5.18 CÀ Põmh¨£mkÒÍ SÔ•øÓ°÷» 

uø»¨¦ JmkPÐUS (Header tags) £v»õP ÷ÁÖ£mh  £õh 

ö©¸TmhÀ JmkPøÍ (Text formatting tags) E£÷¯õQzx 

Cøn¯¨£UPö©õßøÓ E¸ÁõUSP.

  3. <marquee> JmiØS ö£õ¸zu©õÚ £s¦PÒ ]» Esk. 

AøÁ \®£¢u©õP ÷©»vP PØÓ¼À Dk£mk, ö£õ¸zu©õÚ 

Cøn¯¨ £UPzøu E¸ÁõUSP.

£i©ö©õßøÓ Cøn¯¨£UPzvÀ EÒÎmk ÁiÁø©zuÀ

E©x Cøn¯¨£UPzxUS EÒÎkÁuØPõP ö£õ¸zu©õÚ £i©ö©õßøÓz 

öu›P. Cøn¯¨£UPö©õßÖUS £i©ö©õßøÓ EÒÎk®÷£õx Auß ÷Põ¨¦ 

ÁøP .png, .gif,  .jpeg ÷£õßÓ öPõÒvÓß SøÓ¢u ÷Põ¨£õP Põn¨£hÀ 

÷Ásk®. Cøn¯¨£UPö©õßÔÀ EÒÎh¨£kQßÓ £i©[PøÍ J¸ ÷Põ¨¦ 

øÓ°ÝÒ ÷\ªzuÀ ]Ó¢uuõS®.
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Image Jmk

£i©ö©õßøÓ Cøn¯¨£UPzvÀ EÒÎh Image JmhõP P¸u¨£k®  <img>
Jmk £¯ß£kzu¨£k®. C[S Bµ®£, •iÄ JmkUPÒ GÚ C¸  JmkUPÒ 

E£÷¯õQUP¨£kÁvÀø» Gß£øu P¸zvÀ öPõÒP. öÁØÖ Jmk (Blank 
tag) AÀ»x (Empty tag) GÚ AøÇUP¨£kQßÓ CÆÁõÓõÚ ]» JmkUPÒ 

¤ßÚº Bµõ¯¨£k®. <img> Jmkhß öuõhº¦øh¯ £s¦PÒ HÓzuõÇ 12
Põn¨£kQßÓÚ. AÁØÔÀ ]» AmhÁøn 5.2 CÀ ÂÁ›UP¨£mkÒÍx.

£s¦ ö£Ö©v öuõhº£õÚ Â£µ® Euõµn®

‰»® 

(Source)
GÝ®  src

£i©zvß ö£¯øµ Auß ÷Põ¨¦                                                                   

}m]²hß ÁÇ[SuÀ ÷Ásk®. ÷Põ¨ 

£õÚx ÷ÁÖ EøÓ°À Põn¨£iß 

Auß £õøuø¯ •Êø©¯õP ÁÇ[P 

÷Ásk®.

src=“C:\Users\Pictures\
pet.png”

©õØÕk 

(Alternative) 
GÝ®  alt

÷©÷»   src   £s¤ÚõÀ  ÁÇ[P¨£k®

£i©©õÚx E›¯ ChzvÀ Põn¨ 

£hõu  {ø»°À ©mk® £i©zvØS 

£v»õP Põmh¨£k® £õh® (Text) 
C[S Ch¨£k®.

alt = ”map”

AP»®

(Width)
£i©® Põm]¨£kzu¨£k® AP»zøu 

£h‰» AÍÄ AÀ»x £UP AÍÂß               

\uÃu©õP PõmhÀ

width=”100” AÀ»x 

width=”50%”

E¯µ®

(Height)
£i©® Põm]¨£k® E¯µzøu £h‰» 

AÍÄ AÀ»x £UP AÍÂß \uÃu©õP 

PõmhÀ

height=”100”AÀ»x 

height =”50%”

ÂÎ®¦

(Border)
£i©zøu _ØÔ ÂÎ®¤h ÷Ásk 

ö©ÛÀ Auß ui¨ø£ £h‰» AÍÂÀ 

PõmkP. AÆÁõÔÀø»ö¯ÛÀ —0˜ 

GÝ® ö£Ö©vø¯ CkP. 

border =”3”    

÷|º£kzuÀ 

(Align)
Chx (Left), Á»x (Right), ÷©÷» 

(Top), R÷Ç (Bottom), ©zv°À (Mid-
dle) ÷£õßÓÁØÔÀ ö£õ¸zu©õÚ ÷|º 

Á›ø\¯õUPzøu CkP.

align=”middle”  

AmhÁøn 5.2 ( <img> Jmiß ]» £s¦PÒ
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Euõµn® (

<img src = " C:\Users\Pictures\srilanka'jpg"  
alt="Map" width="100"  height="200"  
border="3"  align="middle"> 

uø»¨¦ £õhzøu (Text) E¸ÁõUPÀ GßÓ £Sv°À E¸ÁõUP¨£mh 

""C»[øP'' \®£¢u©õÚ Cøn¯¨£UPzxUS £i©ö©õßøÓ EÒÎh E¸ 5.21
CÀ Põmh¨£mkÒÍÁõÖ SÔ•øÓø¯ £¯ß£kzxP. ¤ßÚº Cøn¯¨£U 

Pzøu Põm]¨£kzxP. Á¸ÂøÍøÁ E¸ 5.14 CÀ Põmh¨£mkÒÍ £i©z 

xhß J¨¤kP.

SÔ¨¦ : £i©® ÷\ªUP¨£mkÒÍ Ch® ÷ÁÖ£iß AuØ÷PØ£ ÷Põ¨¤ß   

  £õøuø¯ ©õØÖP.

E¸  5.21 ( £i©ö©õßøÓ EÒÎhz ÷uøÁ¯õÚ SÔ•øÓ

£¢vö¯õßøÓ EÒÎmk ÁiÁø©zuÀ

÷©÷» EÒÁõ[P¨£mh £i©zvß RÌ £¢vö¯õßøÓ  Cøn¯¨£UPzvÀ  

EÒÎhz  ÷uøÁ¯õÚ  SÔ•øÓø¯  E¸ 5.22 CÀ Põmh¨£mkÒÍÁõÖ  E©x 

Cøn¯¨£UPzxUS EÒÎkP. Cøn¯¨£UPzøu Põm]¨£kzv  AuøÚ  E¸ 

5.23  CÀ  Põmh¨£mkÒÍ  Á¸ÂøÍÄhÝ®  E¸  5.14 EhÝ® J¨¤kP. 

Á¸ÂøÍÄ

<html>

<head><title> Sri Lanka </title></head>

<body><h2><center><font face="arial" color="blue"> SRI LANKA 
  </font></center></h2>
  <center><img src=" C:\Users\Pictures\srilanka.jpg"
  ></center><center><font face="arial" size="2">
   A map of Sri lanka  </font></center>
</body>
</html>

Á

¸

Â

øÍ

Ä
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<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
 <center><font face="arial"  size="2"> A map of Sri lanka  </font></center>
<p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is  
 surrounded by the Indian Ocean. The geography of Sri Lanka includes 
 coastal plains in the north and hills and mountains in the interior. The 
 government system is a republic.  The chief of state and head of government  
 is the President. </p>
</body>
</html>

£¢v (Paragraph) Jmk
£¢v

E¸ 5.22 ( £¢vö¯õßøÓ EÒÎhz ÷uøÁ¯õÚ SÔ•øÓ

E¸ 5.23 ( E¸ 5. 22 C¾ÒÍ SÔ•øÓ°ß Á¸ÂøÍÄ 

C[S }º E£÷¯õQzu £¢v (Paragraph) Jmk GÚ P¸u¨£k® <p>  Jmk 

\®£¢u©õP ÷©¾® Bµõ´÷Áõ®.

£¢v  (Pragraph) Jmk

<p> Jmøh E£÷¯õQzx E¸ÁõUP¨£mh £¢v¯õÚx Chx ÷|º¨£kzuø» 

öPõshuõP Põn¨£k®. Cx Auß öPõhõ {ø»  ̂ Default& ÷uõØÓ©õS®.  <p>
Jmiß ÷|º¨£kzuÀ  ^Align& GßÓ £sø£ E£÷¯õQzx —left˜" —right˜" —center˜ 
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©ØÖ® —justify˜ ÷£õßÓ ö£Ö©vPøÍ Cmk |õßS ÷uõØÓ[PøÍ ö£Ó•i²®.

Euõµn® Jmk ÷|º¨£kzuÀ

< p align = ''left'' >
Chx

< p align = ''center'' >
©zv

< p align = ''right'' >
Á»x

< p align = ''justify'' > C¸ Kµ[PÐ® 

\©õ¢uµ©õP

AmhÁøn 5.3 £¢vø¯ ÷|º¨£kzuÀ

ÁõUQ¯[PÐUQøh÷¯¯õÚ CøhöÁÎ°ß AÍøÁ ©õØÔ¯ø©zuÀ

GÊzx E¸ö£õ¸Ò (Character entity) JmhõP P¸u¨£k® &nbsp; GßÓ 

SÔ•øÓø¯ E£÷¯õQ¨£uõÀ ÁõUQ¯[PÐUQøh÷¯ CøhöÁÎ°ß 

AÍÂøÚ AvP›UP •i²®. C¢u SÔ•øÓ¯õÚx  non breaking space GÚ 

AøÇUP¨£k®. uØ÷£õx ÷©¾ÒÍ EuõµnzvÀ Põmh¨£mkÒÍ £¢v°ß 

ÁõUQ¯[PÐUQøh÷¯¯õÚ CøhöÁÎø¯ ©õØÔ Á¸ÂøÍøÁ AÁuõÛUP.

<p> The government system is &nbsp;  a republic. The chief of state and head 
of government is &nbsp; &nbsp;&nbsp;the President. </p>

Á¸ÂøÍÄ

The government system is    a  republic. The chief of state and head of government 
is     the President. 

ö\¯Ø£õk   

  1. HTML SÔ•øÓ \®£¢u©õÚ Cøn¯zuÍ[PÒ ©ØÖ® 

¦zuP[PøÍ £›^»øÚ ö\´x GÊzx E¸ö£õ¸Ò (Character 
entity) GÚ P¸u¨£k® ÷ÁÖ ]» JmkUPøÍ Â£›USP.
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Á›PÒ ]»ÁØøÓ EÒÎhÀ

£¢vö¯õßøÓ EÒÎhÀ GßÓ £Sv°À EÒÎh¨£mh £¢vUS R÷Ç Á›PÒ 

]»ÁØøÓ EÒÎhz ÷uøÁ¯õÚ SÔ•øÓø¯ E¸ 5.24 CÀ Põmh¨£mkÒ 

ÍÁõÖ E©x Cøn¯¨£UPzxUS EÒÎkP.   

   Á› (Line) Jmk

E¸ 5.24 Á›PÒ ]»ÁØøÓ EÒÎhz ÷uøÁ¯õÚ SÔ•øÓ

  

E¸ 5. 25 ( E¸ 5. 24  C¾ÒÍ SÔ•øÓUPõÚ Á¸ÂøÍÄ

Á›PøÍ  ÷ÁÓõUP E£÷¯õQzu Line break GÚ¨£k® <br/>JmhõÚx }º •ßÚº 

£¯ß£kzv¯  <img>  JmiøÚ¨ ÷£õÀ öÁØÖ Jmk (blank tag /empty tag) 
ÁøPø¯a \õ¸®. Bµ®£, •iÄ GÚ C¸ JmkPÎßÔ <br/> Jmk Á›¯õÚx 

÷ÁÓõUP¨£h ÷Ási¯ Chzv÷» Ch¨£kÁøu AÁuõÛUP. 
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£mi¯À JßøÓ EÒÎhÀ   

JßÖhß JßÖ öuõhº¦øh¯ E¸¨£iPÒ Tmhzøu Á›ø\¯õP Põmkªhzx 

Ax £mi¯À BP P¸u¨£k®. ö£õxÁõP C¢u E¸¨£iPÒ JßÓß RÌ JßÓõP 

Põm]¨£kzu¨£k®. Cøn¯¨£UP E¸ÁõUPzvß÷£õx HTML ö©õÈ°À 

E£÷¯õQUP¨£kQßÓ ‰ßÖ ¤µuõÚ £mi¯ÀPÒ Esk.   

i) JÊ[Pø©UP¨£hõu £mi¯À (Unordered list)
JÊ[S•øÓ¯ØÖ Põn¨£kQßÓ £mi¯À CxÁõS®. JÊ[Pø©UP¨£hõu 

£mi¯ø»  Bµ®¤UP <ul> Jmiß EÖ¨¦hß Type GÝ® £sø£a ÷\º¨ 

£uõÀ Â÷\h SskUSÔPøÍ Ch•i²®. CuØS ÁÇ[P¨£kQßÓ ‰ßÖ 

ö£Ö©vPÐ® Á¸©õÖ.

1. Disc
2. Square
3. Circle 

£mi¯¼÷» E¸¨£iPøÍ öÁÆ÷ÁÓõP PõmkÁuØS <li>  JmhõÚx 

E£÷¯õQUP¨£k®.

E¸ 5'26  <li> Jmk ©ØÖ® Á¸ÂøÍÄ

ii) JÊ[Pø©UP¨£mh £mi¯À (Ordered list)
C»UP[PøÍ AÀ»x GÊzxUPøÍ E£÷¯õQzx Á›ø\ •øÓ°À E¸ÁõU 

P¨£mh E¸¨£iPÎß Tmh©õÚx JÊ[Pø©UP¨£mh £mi¯»õP P¸u¨ 

£k® (E¸ 5.27 I AÁuõÛUP). Cøn¯¨£UPvÀ CÆÁõÖ PõmkÁuØS 

<ol> Ehß <li> GÝ® C¸ JmkPÒ £¯ß£kzu¨£k®. <ol> Jmiß ‰»®  

JÊ[Pø©UP¨£mh £mi¯¼ß Bµ®£•® Auß EÖ¨¦ ‰»® Á›ø\ 

•øÓUPõP ö£õ¸zu©õÚ C»UP® AÀ»x GÊzxÁøP ÷£õßÓ Â£µ•® 

type GÝ® £s¤ÚõÀ Põmh¨£k®. AmhÁøn 5.4 BÚx  type £s¦US 

ÁÇ[P¨£k® ö£Ö©vPÎß ÂÍUPzøuU PõmkQÓx.
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ö£Ö©v P¸zx

1 C¢x Aµõ¤¯ C»UP®

A B[Q»¨ ÷£öµÊzx (Capital) 
a B[Q» ]ØöÓÊzx (Simple)
i B[Q» ]ØöÓÊzxøh¯ ÷µõ©ß 

C»UP® (Simple)
I B[Q»¨ ÷£öµÊzxøh¯ ÷µõ©ß 

C»UP® (Capital)

AmhÁøn 5.4 ( JÊ[Pø©UP¨£mh £mi¯À

Euõµn®(

I. ][PÍ®

II. uªÌ

III. •ì¼®

IV. ÷£ºPº

Á¸ÂøÍÄ

<ol type = ''I'' >
 
       <li> ][PÍ® </li>
 
       <li> uªÌ </li>
 
       <li> •ì¼® </li>
       <li>÷£ºPº</li>

</ol>

iii)  ÂÁµn¨ £mi¯À (Description/Definition list)
¯õuõ°Ý® E¸¨£iPÎß Tmhzøu Auß Â£µzxhß £mi¯À£kzu 

ÂÁµn¨£mi¯À (E¸ 5.28) E£÷¯õQUP¨£k®.

Jmk Â£µ®

<dl> ÂÁµn¨ £mi¯¼ß Bµ®£®

<dt> E¸¨£i

<dd> E¸¨£i°ß Â£µ®

AmhÁøn 5.5 ÂÁµn¨ £mi¯À

Euõµn® ( E¸ 5.28 CÀ Põmh¨£mkÒÍÁõÖ ÂÁµn¨ £mi¯ø» Cøn¯¨  

      £UPzxUS CkÁuØPõÚ HTML SÔ•øÓø¯ RÌÁ¸©õÖ GÊv   

      AuøÚ £›^»øÚ ö\´P. 

E¸ 5.27 JÊ[Pø©UP¨£mh £mi¯À
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E¸ 5'28 -  ÂÁµn¨ £mi¯À
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ö\¯Ø£õk 

1' ÷©÷» E¸UPÎÀ Põmh¨£mh £mi¯ÀPøÍ²øh¯ Cøn¯¨ 

£UPö©õßøÓ }º Â¸®¤¯ E¸¨£iPøÍ E£÷¯õQzx E¸ÁõUSP.

2' J¸ £mi¯À ÁøP°ÝÒ CßÝö©õ¸  £mi¯À ÁøP Ah[S©õÖ 

Cøn¯¨£UPö©õßøÓ E¸ÁõUSP. AÆÁõÓõÚ÷uõº SÔ 

•øÓ²® Auß Á¸ÂøÍÄ® E¸ 5. 29 CÀ Põmh¨£mkÒÍx. 

CuøÚ E£÷¯õQzx ÷ÁÖ£mh ÁiÁ[PøÍU öPõsh £mi 

¯ÀPøÍ E¸ÁõUSP.

E¸ 5'29 - £mi¯À ÁøP ]»ÁØøÓ EÒÍhUQ¯ SÔ•øÓ ©ØÖ® Á¸ÂøÍÄ

<ul type = ''disc''>
    <li>][PÍ®</li>
    <li>uªÌ

 <ol type = ''i''>
 <li> C»[øPz uªÌ </li>
 <li> C¢v¯z uªÌ </li>
 </ol> </li>
   <li> •ì¼® </li>
   <li> ÷£ºPº </li>
</ul>

Á

¸

Â

øÍ

Ä

«°øn E¸ÁõUSuÀ (Hyperlink)

E¸ 5.14 CÀ Põmh¨£mkÒÍÁõÖ ''President'' GßÓ £õhzxUS (Text) «°øn 

JßøÓ EÒÎk÷Áõ®. CuØPõP E¸ 5.30 C¾ÒÍÁõÖ SÔ•øÓ°øÚ E©x 

Cøn¯¨£UPzvÀ EÒÎkP.

E¸ 5.30 ( «°ønUPõÚ SÔ•øÓ

<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
 <center><font face="arial" size="2"> A map of Sri lanka  </font></center>
 <p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is surrounded  
  by the Indian Ocean. The geography of Sri Lanka includes coastal plains in the 
  north and hills and mountains in the interior.The government system is a republic. 
  The chief of state and head of government is the 
  <a href=”http://www.president.gov.lk“ >President.</a></p>
  People in Sri Lanka have four main categories in ethnically. They are <br/>
       Sinhala <br/>Tamil <br/> Muslim <br/> Burger <br/>
</body>
</html>

href £s¦anchor Jmk  «°øn¨¦ •PÁ›
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E¸ 5.31   «°øn¨¦UPõÚ SÔ•øÓ°ß Á¸ÂøÍÄ

Cøn¯¨£UPzøu AÁuõÛzx «°øn Ch¨£mh ''President'' GßÓ £õhzvß 

(Text) «x C¸•øÓ ö\õhUSÁuõÀ AÀ»x Right click → Open PmhøÍø¯ 

ÁÇ[SÁuõÀ SÔzu £õhzxhß (Text) öuõhº¦£kzu¨£k® ÷Põ¨£õÚx 

vÓUP¨£k®. 

Anchor Jmk

HTML SÔ•øÓ°À <a>  JmiøÚ E£÷¯õQzx ¯õ÷uÝ® £õh® (Text)
AÀ»x £i©zxUS «°øn JßÔøÚ ÁÇ[P •i²®. C¢u Jmkhß 

öuõhº¦øh¯ £s¦PÒ £» Esk. •UQ¯zxÁ©õÚ £s£õÚ  href Cß 

‰»® öuõhº¦øhø© E¸ÁõUP¨£k® Ch©õÚx Põmh¨£k®. Ax SÔzu 

Cøn¯¨£UP® ÷\ªUP¨£mh EøÓ°À Põn¨£kö©ÛÀ, ÷Põ¨¤ß ö£¯º, 

Auß ÷Põ¨¦ }m]²hß ÁÇ[P¨£hÀ ÷£õx©õÚuõS®.

Euõµn® ( <a href=“President.jpeg”>President </a>
  <a href=“President.html”>President </a>

BÚõÀ, ÷ÁÖ  Cøn¯¨£UPzxhß öuõhºø£ HØ£kzu ÷Áskö©ÛÀ, 

SÔzu £õøuø¯ (Path)  v¸zu©õP SÔ¨¤hÀ ÷Ásk®.

Euõµn® (  <a href=“http://www.president.gov.lk/president”>President </a>
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AmhÁønö¯õßøÓ EÒÎhÀ

Cøn¯¨£UPzxUS AmhÁønö¯õßøÓ ÁÇ[SÁuß ‰»® £õh®, £i©® 

÷£õßÓÁØøÓ {µÀ, {øµ¯õP JÊ[S¨£kzu¨£mh ÂuzvÀ Põmh •i²®.

E©x Cøn¯¨£UPzv÷»  ][PÍ®, uªÌ, •ì¼®, ÷£ºPº GßÓ |õßS 

ÁøPø¯ CkÁuØS <br/> Jmkhß GÊu¨£mh  HTML SÔ•øÓUS ¤ßÚº 

AmhÁønö¯õßøÓ EÒÎkÁuØPõP E¸ 5.32 CÀ Põmh¨£mkÒÍÁõÖ 

SÔ•øÓø¯ EÒÎkP.

E¸ 5.32 ( AmhÁønö¯õßøÓ EÒÎhz ÷uøÁ¯õÚ SÔ•øÓ

E©x Cøn¯¨£UPzøu Põm]¨£kzv ö£õ¸zu©õÚ £Svø¯ ©õzvµ® 

PõmkQßÓ E¸  5.33 C¾ÒÍ Á¸ÂøÍÄhÝ® E¸ 5.14 EhÝ® J¨¤kP.

ö\¯Ø£õk   

 1.  E©x Cøn¯¨£UPzv¾ÒÍ £i©zxUS ö£õ¸zu©õÚ 

Cøn¯zuÍzxhß «°ønö¯õßøÓ E¸ÁõUSP.

 2.  HTML SÔ•øÓ \õº¢u Cøn¯zuÍ[PÒ AÀ»x ¦zuP[PøÍ 

E»õÂ <a> Jmkhß öuõhº¦øh¯ £s¦PÒ ]»ÁØøÓ  

£mi¯À£kzxP.
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E¸ 5.33 ( E¸ 5.32  C¾ÒÍ SÔ•øÓUPõÚ Á¸ÂøÍÄ

Table Jmk

C¢u Jmiß ‰»® AmhÁønö¯õßÔÀ Bµ®£® Põmh¨£kÁxhß 

AmhÁønø¯ ÁiÁø©UP Auß EÖ¨¦hß ]» £s¦PÒ E£÷¯õQUP¨£k®. 

AmhÁøn 5.6 BÚx ]»£s¦PøÍ ÂÁ›UQÓx.

£s¦ Â£µ®

÷|º¨£kzuÀ 

(Align)
£UPzv¾ÒÍ ©ØøÓ¯ £õhzxhß  (Text) AmhÁøn¯õÚx ÷|º 

Á›ø\¯õUP¨£k® Âu® Põmh¨£kQÓx. Cuß ö£Ö©v¯õP  Left, 
Center, Right ÷£õßÓÚ £¯ß£kzu¨£k®.

AP»® (Width) AmhÁøn°ß  AP»zøu £h‰»® AÍÂÀ AÀ»x Cøn¯¨ 

£UPzvß AP»zvß \uÃu©õP Põmh¨£k®.

E¯µ® (Height) AmhÁøn°ß E¯µzøu £h‰» AÍÂÀ AÀ»x Cøn¯¨£UPzvß 

E¯µzvß \uÃu©õP Põmh¨£k®.

¤ßÚo Áºn® 

(Bgcolor)
AmhÁøn°ß ¤ßÚo {Ó® Põmh¨£k®. £õhzxUS £¯ß£kzv¯ 

Áºn¨ö£Ö©vPøÍ £¯ß£kzu •i²®.

ÂÎ®¦ (Border) AmhÁøn°ß P»[PøÍa _ØÔ ÂÎ®¦ ÷uøÁö¯ÛÀ, —1˜ GÚÄ® 

÷uøÁ¯ØÓöuÛÀ  —0˜ GÚÄ® ÁÇ[SP.

ÂÎ®¤ß Áºn®  

(Bordercolor)
ÂÎ®¤ß Áºn® Põmh¨£k®

¤ßÚo  (Back-
ground)

AmhÁøn°ß ¤ßÚoUS £i©ö©õßøÓ EÒÎhÀ. AuØS›¯ 

÷Põ¨¤ß ö£¯º AÀ»x £õøu ÁÇ[P¨£h ÷Ásk® (path) 

ÂÎ®¦ CøhöÁÎ 

(Cellpadding)
P»zvß ÂÎ®¦ ©ØÖ® Auß EÒÍhUPzxUQøh÷¯¯õÚ 

CøhöÁÎø¯ Põmk®. £h‰» Ai¨£øh°À ö£Ö©v ÁÇ[P¨£k®.

P» CøhöÁÎ 

(Cellspacing)
P»[PÐUQøh°÷¯ CøhöÁÎø¯ Põmk®. £h‰» Ai¨£øh°À 

ö£Ö©v ÁÇ[P¨£k®.

AmhÁøn 5.6 ( <Table> Jmiß ]» £s¦PÒ

E©x AmhÁønUS ÷©¾ÒÍ £s¦PøÍ Cmk AuøÚ ÁiÁø©USP.



  C»Á\¨ £õh¡À188

Euõµn® :<Table border="1"width="400" height="150"      
   cellpadding="5"cellspacing="5"bordercolor="green" bgcolor="yellow">

E¸ 5.34 ( Table  Jmiß Á¸ÂøÍÄ

Caption Jmk

AmhÁønUS uø»¨ö£õßøÓ AÀ»x ÂÁµö©õßøÓ Auß Bµ®£zvÀ 

EÒÎh £¯ß£kzu¨£k®. Cx £s¦PÒ  GuøÚ²® öPõsiµõÂiÝ® 

£õhzxUS E£÷¯õQUP¨£kQßÓ JmkPøÍ ¤µ÷¯õQzx C¢u uø»¨ø£ 

ÁiÁø©UP •i²®.

Euõµn® ( < Caption><b><u>Principle Forms of  Land use </u></b></Caption>

<tr> Jmk

<tr> GÚU Põmh¨£k® EÖ¨¤ß ‰»® AmhÁønUS ¦v¯ {øµö¯õßøÓ 

÷\ºUP •i²®.<table> CøÚ¨ ÷£õ» {øµ°ØS® ÷ÁÖ÷ÁÓõP  align, bgcolor, 
border, bordercolor ÷£õßÓ £s¦PøÍ ÷ÁÖ£kzv Ch•i²®.

Euõµn® (  <tr bordercolor=''green''  bgcolor=''yellow''  background= ''image.png''>

<td>  Jmk

{øµö¯õßÔÝÒ uµÄPøÍ EÒÎkÁuØPõP P»[PøÍ ^Cells& E¸ÁõUP £¯ß 

£kzu¨£k®. {øµ°øÚ¨÷£õÀ P»zvØS® ÷ÁÖ÷ÁÓõP £s¦PøÍ Ch 

•i²®.

Euõµn® ( <td  width=''4'' bordercolor = ''green'' bgcolor = ''yellow'' background 
''=image.png''>

]» \¢uº¨£[PÎÀ {µÀPÒ ]»ÁØøÓ AÀ»x {øµPÒ ]»ÁØøÓ Cønzx 

^Merge cells& P»ö©õßÖ E¸ÁõUP •i²®. CuØPõP ¤ßÁ¸® C¸ £s¦PÒ 

£¯ß£kzu¨£k®.  
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1. Colspan - {µÀPÒ ]»ÁØøÓ  Cønzx P»ö©õßÖ E¸ÁõUP¨£k®.   

        CønUP¨£k® {µÀPÎß GsoUøP Cuß ö£Ö©v¯õP   

        ÁÇ[P¨£k®.

Euõµn® (

E¸ 5.35 (  {µÀPÒ ]»ÁØøÓ Cønzx P»ö©õßøÓ E¸ÁõUSuÀ

2. Rowspan - {øµPÒ ]»ÁØøÓ Cønzx P»ö©õßÖ E¸ÁõUP¨£k®.  

  CønUP¨£k® {øµPÎß GsoUøP Cuß ö£Ö©v¯õP   

  ÁÇ[P¨£k®.

Euõµn® (

E¸ 5.36 {øµPÒ ]»ÁØøÓ Cønzx P»ö©õßøÓ E¸ÁõUSuÀ

<th>  Jmk

Table header GßÓøÇUP¨£k® C¢u JmhõÚx AmhÁøn°ß {µÀPÎß 

uø»¨ø£U Põmh £¯ß£kzu¨£k®. GÛÝ® AmhÁøn°ß G¢uöÁõ¸ 

P»zxUPõPÄ® <td> JmkUS¨ £v»õP £¯ß£kzu •i²®. Cuß ]Ó¨£®\® 

GßÚöÁÛÀ P»zvÝÒ EÒÎh¨£k® £õh® (Text) ui¨£õP Põm]¨£kzu¨ 

£kÁuõS®. Colspan, Rowspan EÒÍh[PÍõP <td> Jmiß £s¦PÒ ¯õÁØøÓ²® 

<th> JmiÀ £¯ß£kzu •i²®.
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ö\¯Ø£õk   

    R÷Ç Põmh¨£mkÒÍ AmhÁønUS \©ÚõÚ AmhÁøn 

ö¯õßøÓ  EÒÍhUQ¯ Cøn¯¨£UPö©õßøÓ E¸ÁõUSP. 

}º  CxÁøµ  PØÖÒÍ ÂÁµ[PøÍ Ai¨£øh¯õPU öPõsk

 AmhÁønUS £À÷ÁÖ ©õØÓ[PøÍ ÷©ØöPõÒÁuØPõP E£ 

÷¯õQUP¨£kQßÓ JmkUPÒ, Auß £s¦PÒ ÷£õßÓÁØøÓ 

|ßS öuÎÄ£kzvU öPõÒP.

  ö£õ¸zu©õÚ HTML editor Cß EuÂ²hß E©x SÊÁõÀ 

vmhªh¨£mhÁõÖ Kº Cøn¯zuÍzøu {¸©õoUP.

 5'2  Cøn¯zuÍ {¸©õn ö©ßö£õ¸Ò

GÎ¯ ö\õÀ•øÓ ÁÈ¨£kzuÀ AÀ»x HTML editor CøÚ E£÷¯õQzx 

HTML SÔ•øÓPøÍ GÊv Cøn¯zuÍ[PøÍ {¸©õoUS®÷£õx, HTML
ö©õÈ \®£¢u©õÚ BÇ©õÚ AÔÄ ÷uøÁ¨£kÁxhß SÔ•øÓUPõP AvP 

Põ»•® ÷uøÁ¨£k®. Cøn¯zuÍzøu CØøÓ¨£kzu ©ØÖ® ©õØÔ¯ø©UP 

«ÍÄ® u¯õ›UP¨£mh  HTML ÷PõøÁ°ß SÔ•øÓ°À ©õØÓ[PøÍ ö\´¯ 

÷Ásk®.

Cøn¯zuÍ ÁiÁø©¨¦ Á\vPøÍU öPõsh Cøn¯ ÁiÁø©¨¦ ö©ß 

ö£õ¸ÎøÚ £¯ß£kzv Cøn¯zuÍ[PøÍ E¸ÁõUSÁx® AuØS \©©õÚ 

ö\¯Ø£õhõS®. Áøµ¤¯À  £¯|º  Cøh•Pzvß EuÂ²hß Cøn¯zuÍ[ 

PøÍ {¸©õoUP, ©õØÔ¯ø©UP •ßÚº AuøÚ Põm]¨£kzu ©ØÖ® 

÷uøÁU÷PØ£ Cøn¯zuÍzøu CØøÓ¨£kzx® Á\vPÐ® Põn¨£kQßÓx. 

WYSIWYG ^What You See Is What You Get& GÚ¨£k® uzxÁzxUPø©¯ 

Áøµ¤¯À £¯|º Cøh•PzvÀ vmhªk®÷£õ÷u Cøn¯¨£UPzøu E¸ 

ÁõUP •i²®.



C»Á\¨ £õh¡À 191

£À÷ÁÖ ÁøP¯õÚ Cøn¯ ÁiÁø©¨¦ ö©ßö£õ¸ÒPÒ Põn¨£kQßÓÚ.

Euõµn®

1' Cøn¯ £øh¨£õUPU P¸ÂPÒ ^Web authoring tools&

2' EÒÍhUP •Põø©zxÁ •øÓø© ^Content  management  systems/CMS&

5'2'1  Þ¬íò ð¬ìð£‚è‚ è¼Mèœ (Web authoring tools)

CÆÁøP Cøn¯zuÍ ÁiÁø©¨¦ ö©ßö£õ¸Îß Â÷\h A®\® GßÚ 

öÁÛÀ, £¯|µõÀ ÁøµÂ¯À £¯|º Cøh•PzvÀ ÁiÁø©UP¨£kQßÓ 

Cøn¯¨£UPzvß HTML SÔ•øÓ¯õÚx ÷ÁÖ Cøh•PzvÀ _¯©õP 

Põm]¯Î¨£uõS®. £¯|¸US HTML AÔÄ Põn¨£iß ÁøµÂ¯À £¯|º 

Cøh•Pzxhß HTML AÔUøPPøÍ²® E£÷¯õQzx Cøn¯¨ £UP[PøÍ 

E¸ÁõUSÁx ÷©»vP AÝT»©õP P¸u¨£k®.

Kompozer, ckeditor, bluegriffon ÷£õßÓ vÓ¢u Buõµ‰» Cøn¯ £øh¨£õUP 

P¸ÂPÒ (Web Authoring Tools) £» Cøn¯zv¼¸¢x uµÂÓUP® 

ö\´¯•iÁxhß, Adobe dream Viewer, Microsoft front page, Visual studio
÷£õßÓ £n® ö\¾zv öPõÒÁÚÄ ö\´¯UTi¯ (£v¨¦›ø©²ÒÍ) ö©ß 

ö£õ¸ÒPÒ £»Ä® Põn¨£kQßÓÚ.

E¸ 5.37 ( vÓ¢u Buõµ ‰» Cøn¯ £øh¨£õUPU P¸ÂPÒ ]»ÁØÔß C»m\øÚPÒ

Cøn¯ £øh£õUPU P¸Â GÝ® ö©ßö£õ¸Îß EuÂ²hß Cøn¯zuÍ 

ö©õßøÓ E¸ÁõUSuÀ

Euõµn©õP ©Ûuz öuõSv \®£¢u©õÚ BÖ Cøn¯¨£UP[PøÍU öPõsh 

Cøn¯zuÍö©õßøÓ E¸ÁõUPz vmhªmkÒÍuõPU öPõÒP. Auß •uÀ 

£UPzvß Pmhø©¨¦, uÍU÷Põ»® ©ØÖ® EÒÍhUP® ÷£õßÓÚ E¸ 5.38 CÀ 

Põmh¨£mkÒÍx.
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E¸ 5.38 ( Cøn¯zuÍzxUPõP vmhªh¨£mh •uÀ £UP® 

¤µuõÚ uø»¨¦, ©Ûuz öuõSvø¯ Põmk® £i©®, _¸UP©õÚ   AÔ•P®, 

¤µuõÚ I¢x öuõSvø¯ Â£›US® ÷ÁÖ I¢x Cøn¯¨ £UP[PÐUPõÚ 

«°øn ©ØÖ® ÷©»vP uPÁÀPÐUPõP ÷ÁÖ Cøn¯zuÍzxhß öuõhº¦ 

÷£õßÓÚ •uÀ £UPzvÀ Põmh¨£mkÒÍÚ. 

E©US Â¸®¤¯ Cøn¯ £øh¨£õUPU P¸Â ‰»® C¢u Cøn¯zuÍzøu 

E¸ÁõUP  •i²®.  C[S Kompozer ö©ßö£õ¸øÍ E£÷¯õQzx Cøn¯z 

uÍzøu E¸ÁõUS® £i•øÓPÒ R÷Ç uµ¨£mkÒÍÚ.

£i   1' ö£õ¸zu©õÚ Cøn¯zuÍzøu E£÷¯õQzx ^Euõµn® ( www. 
kompozer.net/download-07.php& uµÂÓUP® ö\´¯¨£mh  kom-
pozer ö©ßö£õ¸Ò EøÓ°¾ÒÍ kompozer.exe ÷Põ¨ø£ ö\¯Ø 

£kzv¯ ¤ßÚº ö£Ó¨£k® ¤µuõÚ Cøh•P©õÚx E¸ 5.39
CÀ Põmh¨£mkÒÍx. Auß £SvPøÍ AÔ¢xöPõÒP.

©Ûu EhÀ öuõSv
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E¸  5.39 ( Kompozer ö©ßö£õ¸Îß ¤µuõÚ Cøh•P®

£i  2'   E©x  Âø\¨£»øPø¯   E£÷¯õQzx Cøn¯¨ £UPzøu E¸ 

ÁõUS®  ¤µ÷u\zvß ÷©À £Sv°À ""©Ûu EhÀ öuõSv'' GßÓ 

uø»¨ø£ umha]mk, GÊzx¸ ©ØÖ® £õhzøu ÁiÁø©US® 

P¸Â°ß  EuÂ²hß  GÊzx¸ ÁøP, GÊzx¸ £¸©ß,GÊzx¸ 

Áºn®, £õhzvß ¤ßÚo Áºn® ÷£õßÓÁØøÓ ö£õ¸zu 

©õÚÁõÖ  Cmk ÁiÁø©UP.

£i  3'  File C¾ÒÍ PmhøÍø¯ E£÷¯õQzx ö£õ¸zu©õÚ EøÓ°ÝÒ 

  ö£õ¸zu©õÚ    ö£¯øµ    ÁÇ[Q    ÷Põ¨ø£ ÷\ªUP.  Cøn¯

  Áø»÷©÷»õi°ß  EuÂ²hß  E©x  Cøn¯¨ £UPzøu AÁ  

  uõÛUP.

£i  4' ÷©¾ÒÍ Cøh•PzxU 

Pø©¯ £i©® ©ØÖ® 

£õhzøu   EÒÎh    •i² 

ö©ÛÝ® ö£õ¸zu©õÚ 

uÍU ÷Põ»zøu  ^Lay-
out& E£÷¯õQ¨£uõÀ Ca 

ö\¯Ø£õk  C»SÁõUP¨ 

£kQÓx. CuØPõP Amh 

Áønö¯õßøÓ EÒÎ 

k÷Áõ®. £mi¯Ø£møh රුපය 42 : වගුවක් ඇතුළත් කිරීමට අදාල සංවාද ෙකොටුව  E¸ 5.40 ( AmhÁønö¯õßøÓ 

EÒÎkÁuØPõÚ ö\õÀ»õhØ ö£mi
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(Menu bar) C¾ÒÍ  —Insert menu˜ AÀ»x —Table  tool˜   
CøÚ   E£÷¯õQzx  E¸ 5.40 CÀ  Põmh¨£mkÒÍ ö\õÀ 

»õhØö£miø¯¨  ö£ÖP.  {øµPÒ 6, {µÀPÒ 3 IU öPõsh 

AmhÁønø¯ EÒÎkP.

£i  5' }[PÒ ö\õÀ•øÓÁÈ¨£kzuÀ ö©ßö£õ¸Îß AmhÁøn 

ö¯õßÔÀ øP¯õÍ¨£mh {øµ, {µ¼ß }Í AP»zøu ©õØÓÀ,  

P»[PøÍ EÒÎhÀ, P»[PøÍ }UPÀ, P»[PøÍ JßÔønzuÀ 

^Merge cells& ÷£õßÓ ö\¯Ø£õkPøÍ ö\´¯•i²ö©ß£øu 

AÁuõÛUP.    

©Ûu EhÀ öuõSv

E¸ 5.41 (   AmhÁønö¯õßÔß P»[PøÍ ÁiÁø©zuÀ

£i  6'  AmhÁønö¯õßÔ¾ÒÍ P»zvÝÒ E¸ 5.39 CÀ Põmh¨ 

£mkÒÍ Á\vPøÍ ¤µ÷¯õQzx £õh®, £i©®, «°øn 

÷£õßÓÁØøÓ EÒÎmk ÁiÁø©UP. C[S Cøn¯¨ £UPzøu 

E¸ÁõUPz ÷uøÁ¯õÚ AøÚzx C»US¨ ö£õ¸ÒPÐ® J÷µ 

EøÓ°ÝÒ ÷\ªUP¨£kÁx ]Ó¢uuõS®.

£i  7' —New tool˜ Cß EuÂ²hß ¦v¯ £UP[PøÍ vÓUP. •uÀ 

£UPzv¾ÒÍ JÆ÷Áõº öuõSvUPõPÄ® ÷ÁÖ ÷ÁÓõÚ £UP[ 

PøÍ E¸ÁõUSP. AÁØÖUS ö£õ¸zu©õÚ ö£¯›mk, SÔzu 

EøÓ°ÝÒ ÷\ªUP.
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£i   8' JÆ÷Áõº öuõSvUPõÚ £UPzøu²® •uÀ £UPzv¾ÒÍ 

ö£õ¸zu©õÚ £õhzxhß «°ønø¯ HØ£kzv¯ ¤ßÚº E©x 

Cøn¯z uÍzøu Põm]¨£kzxP. ÷uøÁö¯ÛÀ ©õØÓ[PøÍ 

÷©ØöPõÒP.

  5'2'1'1  G¬ôˆî Þ¬íòˆî÷‹ (Static web sites) ñŸÁ‹ 
        Þòƒ°G¬ô Þ¬íòˆî÷‹ (Dynamic web sites) 

Cøn¯zuÍ EÒÍhUPzvß ußø©ø¯U öPõsk AuøÚ {ø»zu ©ØÖ® 

C¯[S{ø» Cøn¯zuÍ©õP C¸ ÁøP¨£kzu •i²®.

1'  {ø»zu Cøn¯zuÍ®

Cøn¯zuÍö©õßÔß EÒÍhUP©õÚx ©õØÓ©øh¯õx SÔzu Põ»zxUS 

÷£n¨£kö©ÛÀ Ax {ø»zu Cøn¯zuÍ©õP P¸u¨£k®. ö£õxÁõP HTML
ö©õÈ°øÚ Ai¨£øh¯õPU öPõsh Cøn¯zuÍ[PÒ CÆÁøPø¯a \õ¸®. 

Cuß Pmhø©¨¦ ©ØÖ® EÒÍhUP® HTML SÔ•øÓ ‰»® E¸ÁõUP¨£k®  

AuøÚ CØøÓ¨£kzx®÷£õx ©õzvµ® Auß EÒÍhUP® ©õØÓ¨£k®. 

Cøn¯¨ £UP[PøÍ JßÔønzx CÆÁõÓõÚ Cøn¯zuÍ[PøÍ C»SÁõP 

E¸ÁõUP •i²®. Cøn¯zuÍ £›^»øÚ°ß÷£õx £¯|ºPÒ, ÷\øÁ¯Pzx-

hß ^Web Server& ÷|µi¯õP öuõhº¦£kÁvÀø». Cøn¯zuÍ £øh¨£õÎ   

©mk®   Cøn¯zuÍ®  ÷\ªUP¨£mkÒÍ  ÷\øÁ¯Pzxhß öuõhºø£ 

HØ£kzv ÷uøÁ¯õÚ ©õØÓ[PøÍ ö\´¯ •i²®. CuØPõP AvP Põ»® 

÷uøÁ¨£iÝ®, CøÁ E¯º £õxPõ¨ø£U öPõsh Cøn¯zuÍ[PÍõS®. 

}[PÒ CxÁøµ GÎ¯ ö\õÀ •øÓÁÈ¨£kzuÀ ö©ßö£õ¸Ò, HTML ed-
itor, Cøn¯ £øh¨£õUPU P¸Â ÷£õßÓ ÷ÁÖ£mh ö©ßö£õ¸ÒPøÍ 

E£÷¯õQzx E¸ÁõUQ¯øÁ {ø»zu Cøn¯zuÍ[PÍõS®. 

2'  C¯[S{ø» Cøn¯zuÍ®

Cøn¯zuÍzvß EÒÍhUP® ©õØÓ©øh²ö©ÛÀ, Ax C¯[S{ø» 

Cøn¯zuÍ©õP P¸u¨£k®. Cx  PHP (Hypertext  Preprocessor), ASP.net   
(Active Server Page.net), JSP (Java Server Page) ÷£õßÓ PoÛ ö©õÈPÎß 

EuÂ²hß E¸ÁõUP¨£k£øÁ¯õS®.  C¯[S{ø» Cøn¯zuÍ EÒÍhU 

Pzv÷»÷¯ ÷\øÁ¯Pzvß ‰»® ö\¯Ø£k® uPÁÀPÒ Põn¨£k®. CøÁ 

A÷ÚP©õP uµÄzuÍzvß ‰»® AÀ»x ÷\øÁ¯Pzvß ‰»® C¯[SQßÓ 

uPÁ»õP Põn¨£h •i²®.
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Euõµn® 

1' Cøn¯zuÍö©õßÔÀ  uØ÷£õøu¯  ÷|µzøu (Current time) PõmkuÀ

2' £Ÿmø\ _möhsqUS Aø©ÁõP £Ÿm\õºzv°ß ö£Ö÷£ØøÓU PõmkuÀ

C¢u Cøn¯zuÍ E£÷¯õPzvÀ £¯|º ÷\øÁ¯Pzxhß ÷|µi¯õP 

öuõhº¦£kÁº. £¯|ºPÎ¼¸¢x ÷\øÁ¯PzxUS AÀ»x ©õÓõP uµÄ¨ 

£›©õØÓÀ |øhö£Ö®. GÚ÷Á {ø»zu Cøn¯zuÍzxhß J¨¤k®÷£õx 

CÆÁøP Cøn¯zuÍzvß £õxPõ¨¦US Aa_ÖzuÀ HØ£h Áõ´¨¦sk.

CøÁ Põ»zxhß ©õØÓ©øhQßÓ ÁoP®, \‰P® ©ØÖ® öuõhµÓõ 

£Ÿmø\ ÷£õßÓ Cøn¯zuÍ[PÐUS ªPÄ® EP¢uuõS®. BÚõÀ CÆÁøP 

Cøn¯zuÍ[PøÍ £õxPõ¨£õÚuõP  E¸ÁõUP xøÓ\õº {¦nºPÒ Azv 

¯õÁ]¯©õQßÓÚº.

÷\øÁ¯P® (server) £¯|º

(Client/browser)

{ø»zu (Static)

Áø» ÷\øÁ¯P®

(Web server)
uµÄzuÍ ÷\øÁ¯P® 

(Database server) 
£¯|º

(Client/browser)

C¯[S{ø» (Dynamic)

E¸ 5.42 {ø»zu ©ØÖ® C¯[S{ø» Cøn¯zuÍ[PÒ
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5'2'2  àœ÷ì‚è ºè£¬ñˆ¶õ º¬ø¬ñ 
  (Content Management System - CMS)

  

Cx C¯[S{ø» Cøn¯zuÍ[PøÍ E¸ÁõUPÄ® EÒÍhUP •Põø© 

©ØÖ® öÁÎ±k ö\´ÁuØPõPÄ® E£÷¯õQUP¨£kQßÓ ö©ßö£õ¸ÍõS®. 

Cøn¯zuÍ ÁiÁø©¨¤ØS uõÚõP÷Á EÒÍhUPzøu ©õØÔ¯ø©zx AuøÚ 

öÁÎ±k ö\´¯•i²®.

CMS E£÷¯õPzuõÀ ªP C»SÁõPÄ® ÷ÁP©õPÄ® Cøn¯zuÍ[PøÍ 

ÁiÁø©UPÄ® •Põø© ö\´¯Ä® •iÁxhß CuØS PoÛ ö©õÈ\õº 

AÔÄ AÁ]¯ªÀø». GÚ÷Á CMS BÚx uØPõ»zvÀ ªPÄ® ¤µ£»®Áõ´¢u 

Cøn¯zuÍ ÁiÁø©¨¦ ö©ßö£õ¸ÍõP P¸u¨£kQÓx.

ö©ßö£õ¸Î¾ÒÍ £i© Aa_ ^Templates& ©ØÖ® ÁÈPõmi ^wizard&   CøÚ 

©õzvµ® E£÷¯õQzx ÷ÁÖ£mh ö\Â¨¦», Pm¦» uµÄPøÍ Cøn¯z uÍz-

vÝÒ EÒÎkÁuõÀ ÁiÁø©¨£õÚx Áøµ¯øÓUSm£kzu¨£kQÓx. Azx-

hß ÁiÁø©UP¨£k® AøÚzx Cøn¯zuÍ[PÐ® J÷µ ©õv›¯õÚuõP 

Põn¨£kQÓx. HTML, PHP, Javascript, CSS, SQL ÷£õßÓ ö©õÈPÎÀ AÔÄ 

Põn¨£kö©ÛÀ, SÔzu SÔ•øÓ°÷» ©õØÓ[PøÍ ö\´x CUSøÓ£õmøh 

C¯ßÓÍÄ {Áºzv ö\´¯ •i²®.

Euõµn©õP vÓ¢u Buõµ‰» CMS ö©ßö£õ¸ÒPÒ ]»ÁØøÓ uµÂÓUP® 

ö\´¯ ÷uøÁ¯õÚ Cøn¯ •PÁ›PÒ R÷Ç Põmh¨£mkÒÍÚ:    

1. Joomla (www.joomla.org/download.html)
2. Wordpress (www.wordpress.org/download)
3. Drupal (www.drupal.org/download)

CMS ö©ßö£õ¸øÍ E£÷¯õQzx £À¿hPz uPÁÀPøÍ EÒÍhUQ¯ 

Cøn¯zuÍö©õßøÓ E¸ÁõUSuÀ

}[PÒ Â¸®¤¯ CMS ö©ßö£õ¸øÍ E£÷¯õQzx C¢u Cøn¯zuÍzøu 

E¸ÁõUP •i²®. Joomla  ö©ßö£õ¸øÍ E£÷¯õQzx Cøn¯zuÍzøu 

E¸ÁõUPz ÷uøÁ¯õÚ £i•øÓPÒ R÷Ç  uµ¨£mkÒÍÚ. 

£i  1' RÊÒÍ ‰ßÖ ö©ßö£õ¸ÒPøÍ²® E©x PoÛ°÷» {ÖÄP. 

Euõµn©õP CÁØøÓ uµÂÓUP® ö\´¯z ÷uøÁ¯õÚ Cøn¯ 

•PÁ›²® uµ¨£mkÒÍx. 

1. APACHE (www.apache.org)
2. PHP(www.php.net)
3. MySql (www.mysql.com)

BÚõÀ C¢u ‰ÁøP ö©ßö£õ¸ÒPøÍ²® EÒÍhUQ¯ uÛ¨ ö£õvø¯ 

{ÖÄÁx ªP¨ ö£õ¸zu©õS®. CÆÁøP ö©ßö£õ¸ÒPÒ Cµsk ¤ßÁ¸©õÖ:
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1. WAMP (www.wampserver.com)
2. XAMP (www.apachefriends.org/index.html)

£i  2' www.joomla.org GÝ® Cøn¯zuÍzv¼¸¢x JOOMLA ö©ß 

ö£õ¸øÍ uµÂÓUP® ö\´x E©x PoÛ°÷» {ÖÄP. CuØPõP 

£» •øÓPÒ Esk Gß£uõÀ ö£õ¸zu©õÚ Cøn¯zuÍz-

v¼¸¢x ÷uøÁ¯õÚ AÔÄøµPøÍ¨ ö£ÖP.

Euõµn® ( https://docs.joomla.org/J3.x:Installing_Joomla

£i  3' ¦v¯ Cøn¯zuÍzxUS ö£õ¸zu©õÚ £i© Aa]øÚ  ^Tem 
plates& öu›Ä ö\´uÀ, article EÒÎhÀ, component EÒÎhÀ 

÷£õßÓ ö\¯Ø£õkPøÍ ÷©ØöPõÒP. CuØPõP ÷uøÁ¯õÚ AÔ 

ÄøµPøÍ ö£õ¸zu©õÚ Cøn¯zuÍzv¼¸¢x ö£ÖP. 

£i  4'  E©x Cøn¯zuÍzøu Põm]¨£kzv, ÷uøÁ¯õÚ ©õØÓ[PøÍ 

  ÷©ØöPõÒP.

5'2'3  Þ¬íòˆî÷ ð¬ìŠð£Oèœ

SÔzu {ÖÁÚö©õßÖUS Cøn¯zuÍö©õßøÓ ÁiÁø©UPÄ® AuøÚ 

£µõ©›UPÄ® £» A[PzuÁºPøÍ  EÒÍhUQ¯ SÊöÁõßÖ ÷uøÁ¨£k 

QÓx. C[S JÆ÷Áõº A[PzuÁ¸® u©US ÁÇ[P¨£mh ö£õÖ¨¦PøÍ 

÷©ØöPõÒÁº. CvÀ Azv¯õÁ]¯ ö£õÖ¨¦PÒ ©ØÖ® ö\¯ÀPÒ ¤ßÁ¸©õÖ :

1' Cøn¯zuÍ £øh¨£õÎ (Author)
{ÖÁÚzvÚx® £¯|›Úx® ÷uøÁUPø©¯ Cøn¯zuÍzvß Cøh •Pzøu 

vmhªhÀ.

2. £v¨¤¨£Áº (Editor)
Cøn¯zuÍzvß  vmhªhÀ, EÒÍhUPzxUS Aø©ÁõP SÔ•øÓPøÍ 

GÊxuÀ, ÁÊUPøÍ £›÷\õvzuÀ ©ØÖ® ÁÊUPøÍ v¸zxuÀ ÷£õßÓ 

P¸©[PøÍ ÷©ØöPõÒ£ÁºPÒ. 

3. öÁÎ±mhõÍº (Publisher)
Cøn¯zuÍzøu öÁÎ°kÁuØPõÚ HØ£õkPøÍ ÷©ØöPõÒ£Áº.

ö\¯Ø£õk   

 1.  E©x SÊÁõÀ vmhªh¨£mh Cøn¯zuÍzøu Joomla 
ö©ßö£õ¸øÍ E£÷¯õQzx ÁiÁø©USP.
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4. Cøn¯zuÍ {¸ÁõQ (Administrator)
Cøn¯ ÷\øÁ¯P® ©ØÖ® uµÄzuÍzøu {ºÁQzuÀ/£µõ©›zuÀ

5. £¯|ºPÒ (Users)
Cøn¯zuÍ[PøÍ £¯ß£kzx£ÁºPÒ

 5'3 Cøn¯zuÍö©õßøÓ öÁÎ°hÀ

Cøn¯zuÍ E¸ÁõUP®, Áø» Â¸¢÷uõ®¤US ^Web host& Ch©õØÓ®, 

£µõ©›¨¦ ö\´uÀ ©ØÖ® Áø» öÁÎ±k ^Web post& ÷£õßÓ Põ›¯[PÒ 

AøÚzx® Cøn¯zuÍö©õßøÓ öÁÎ°h EuÂ ¦›²®. CuØPõP Cøn 

¯zuÍ öÁÎ±mhõÍº §µn¨£kzu ÷Ási¯ ]» ÷uøÁPÒ Á¸©õÖ:

1.  Cøn¯zuÍ ÁiÁø©¨¦ ö©ßö£õ¸Ò

2.  Áø» Â¸¢÷uõ®¤ ^Web host&

3.  BÒPÍ¨ ö£¯º

4. ÷Põ¨¦ Ch©õØÓ ö\®ø© |h¨¦ ÁÇUS (file Transfer protocol) 
5.  Cøn¯zxhÚõÚ öuõhº¦

{¸©õoUP¨£mh Cøn¯zuÍzøu Cøn¯zvß ‰»® GÁµõ¾® G¢u 

÷|µ•® G¢u Chzv¼¸¢x® £õºøÁ°hU Ti¯ÁõÖ ¯õ÷uÝ÷©õº ChzvÀ 

÷\ªUP¨£hÀ ÷Ásk®. Ca÷\øÁ ÁÇ[SQßÓ PoÛ¯õÚx Áø» 

Â¸¢÷uõ®¤¯õP P¸u¨£k®.

Cøn¯zuÍ©õÚx Kº ö£›¯ AÍÂ»õÚ {ÖÁÚzxUPõP {¸©õoUP¨£iß, 

ö£õxÁõP  Ax  {ÖÁÚzvÝøh¯  Â¸¢÷uõ®¤°À   ^Dedicated host&                         
÷\ªUP¨£k®.   ]Ô¯  AÍÂ»õÚ  {ÖÁÚö©ÛÀ,  ÷ÁÖ   {ÖÁÚ[PÐøh¯ 

Â¸¢÷uõ®¤ø¯ £Qº¢x  ^Shared hosts& AvÀ Kº Chzøu ö£ØÖUöPõÒÐ®.

£QºÄ Â¸¢÷uõ®¤°ÝÒ £» {ÖÁÚ[PÎß Cøn¯zuÍ[PÒ ÷\ªU 

P¨£kÁxhß, AuØPõP JxUP¨£k® ÷\ª¨¦ öPõÒvÓÝUS Aø©¯ Pmhn® 

AÓÂh¨£k®. C»[øP°÷» CÆÁõÖ ÷\øÁ ÁÇ[S® £» {ÖÁÚ[PÒ 

Esk. C»Á\©õP Cøn¯ ÷\øÁ¯P Á\vø¯ ÁÇ[S® {ÖÁÚ[PÐ® Esk. 

÷ÁÖ£mh Cøn¯zuÍ[PÎ¾® C¢u Á\v²sk. C[S E©x 

Cøn¯zuÍzv÷»  C¢{ÖÁÚ[PÎß ÂÍ®£µ[PÐ® Põm]¨£kzu¨£k®.

5'3'1 õ¬ô M¼‰«î£‹H (Web host)

ö\¯Ø£õk   

  C»Á\©õP Áø» Â¸¢÷uõ®¤ ÁÇ[S® C¸ {ÖÁÚ[PøÍ 

AÁØÔß Cøn¯ •PÁ›²hß GÊxP.



  C»Á\¨ £õh¡À200

E»Q¾ÒÍ G¢u |£øµ²® uÛzxÁ©õP Aøh¯õÍ¨£kzu Kº •øÓ²sk. 

A¢u¢u |õmi¾ÒÍ ©UPøÍ £vÄ ö\´²® {ÖÁÚzvß ‰»® AøÚzx 

|£ºPÐUS® Kº uÛzxÁ©õÚ C»UP® ÁÇ[P¨£k®.  CuøÚ ÷u]¯ Aøh¯õÍ 

Amøh C»UP® GÚ AøÇ¨£º.

CÆÁõÖ E»P»õÂ¯ Áø»°¾ÒÍ Cøn¯zuÍzøu uÛzxÁ©õP 

Aøh¯õÍ¨£kzu Kº •øÓ²sk. ICANN (Internet Corporation for As-
signed Names and Numbers) GßÓøÇUP¨£k® \ºÁ÷u\ {ÖÁÚ©õÚx, 

Cøn¯zuÍ[PÐUPõP uÛzxÁ©õÚ BÒPÍ¨ ö£¯øµ ÁÇ[PÀ ©ØÖ® 

£µõ©›zuÀ ÷£õßÓ ÷\øÁPøÍ ÁÇ[SQßÓx. 

Cøn¯zuÍö©õßøÓ {¸©õozu ¤ßÚº Ax ö£õ¸zu©õÚ BÒPÍ¨ 

ö£¯¸hß C¢u {ÖÁÚzvÀ £v¯¨£hÀ ÷Ásk®. CÆÁõÖ £» {ÖÁÚ[PÒ 

Esk. CøÁ ÷ÁÖ£mh Cøn¯zuÍ[PÎÝÒ ö\¯Ø£k®.

Euõµn® (

1. www.godaddy.com
2. www.bluehost.com
3. www.nie.lk

CÆÁõÓõÚ Kº {ÖÁÚzøu öu›Äö\´x Bµ®£U Pmhnzøu ö\¾zv 

£vÄö\´x öPõÒÍ÷Ásk®. ¤ßÚº Á¸hõ¢u Pmhnzøu ÁÇ[Q £vøÁ 

¦x¨¤zxU öPõÒÍ÷Ásk®. ö£õxÁõP Áø» Â¸¢÷uõ®¦  Á\v ÁÇ[SÚµõÀ 

C¢u |øh•øÓ Põn¨£kQßÓx. BÚõÀ ¤ØPõ»zvÀ E©x  Cøn¯zuÍzøu 

÷ÁÖ Áø» Â¸¢÷uõ®¤°À ÷\ªUP ÷Ási¯ {ø» HØ£iß SÔzu £vÄ 

öuõhº£õÚ ]UPÀPÒ HØ£h Áõ´¨¦sk. GÚ÷Á öÁÎ±mhõÍºPÒ FhP 

Cøn¯zuÍzøu £vÄö\´Áx ]Ó¢uuõS®.

Cøn¯zuÍö©õßÖUPõP BÒPÍ¨ ö£¯øµ öu›Äö\´²®÷£õx P¸zvÀ 

öPõÒÍ¨£h÷Ási¯ PõµoPÒ Á¸©õÖ :

1' BÒPÍ¨ ö£¯›ß ‰»® Cøn¯zuÍzvß E›ø© {ÖÁÚ® AÀ»x 

Cøn¯zuÍ {¸©õn ÷|õUP® ÷£õßÓ ÂÁµ[PÒ Põmh¨£hÀ                                   

]Ó¢uuõS®. C¢{ø»°À £¯|ºPÐUS ÷uhÀ ö£õÔ°ß (Search engine) 
EuÂ²hß SÔzu Cøn¯zuÍzøu ÷uiUöPõÒÁx C»SÁõUP¨£k®. 

Euõµn® ( www.nie.lk GÝ® Cøn¯ •PÁ›°ß BÒPÍ¨ ö£¯µõÚ nie 
‰»® Cøn¯zuÍ E›ø© {ÖÁÚ® Põmh¨£kQÓx.

2' Cøn¯zuÍzvß ußø©U÷PØ£   ˜.com— " —.edu˜ " —.org˜ "˜.lk˜ ÷£õßÓ 

E¯º©mh BÒPÍ¨ ö£¯ºPøÍ öu›Äö\´¯ •i²®.

Euõµn® ( www.wikipedia.org GÝ®  Cøn¯ •PÁ›°ß E¯º©mh 

5'3'2 Ýœè÷Š ªðò˜ (Domain name)
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BÒPÍ¨ ö£¯µõÚ —.org˜ ‰»® Cx ÁoP ÷|õUP©ØÓ Cøn¯zuÍ® 

GßÖ Aøh¯õÍ¨£kzu¨£k®. 

E¸ 5.43   Cøn¯zuÍzxUPõÚ BÒPÍ¨ ö£¯ºPøÍz öu›uÀ

3' BÒPÍ¨ ö£¯µõÚx _¸UP©õÚuõP Põn¨£iß £¯|¸US AuøÚ 

{øÚÂÀ øÁzv¸UPÄ® v¸zu©õP umha]hÄ® C»SÁõS®.

4' BÒPÍ¨ ö£¯›÷» C»UP®, Underscore ÷ÁÖ  SÔPÒ Põn¨£kÁx 

ö£õ¸zu©õÚuÀ». HöÚÛÀ Cøn¯ •PÁ›ø¯ TÖªhzx, Ax ö£Ö 

|µõÀ  v¸zu©õÚ ÂuzvÀ ÂÍ[QU öPõÒÍ •i¯õ©À ÷£õS®.

Euõµn® (

{ÖÁÚ AvPõµ¨ £i{ø»

(Organizational hierarchy)
¦Â°¯À AvPõµ¨ £i{ø»

(Geographic hierarchy)

(Root)

com edu uk fr pe sp jp cd gr ...milgov net ... ...

.net

.org

Network

Organization

ÁoP®

PÀÂ

Aµ\ vønUPÍ®

\ºÁ÷u\®

Áø»¯ø©¨¦ ÁÇ[Q

C»õ£ ÷|õUP©ØÓ {ÖÁÚ®

E¯º©mh 

BÒPÍ¨ 

ö£¯º

¤µ÷¯õP®P¸zx
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5'3'3  «è£Š¹ Þìñ£Ÿø ªê‹¬ñ ïìŠ¹ õö‚° (File Transfer 
            Protocol/FTP)

Cx E¸ÁõUP¨£mh Cøn¯zuÍzøu Cøn¯ Âv•øÓUPø©¯ öu›Ä 

ö\´¯¨£mh Áø» Â¸¢÷uõ®¤US  ©õØÖÁuØPõP E£÷¯õQUP¨£k® 

ö©ßö£õ¸ÍõS®. CuøÚ öPõÒÁÚÄ ö\´¯Ä® AÀ»x Cøn¯zv¼¸¢x 

C»Á\©õP uµÂÓUP® ö\´¯ •i²®.

Euõµn® ( 1. Filezilla (https://filezilla-project.org)
  2. SmartFTP (https://www.smartftp.com)

A÷ÚP Cøn¯zuÍ ÁiÁø©¨¦ ö©ßö£õ¸ÒPÎ÷» C¢u Á\v 

Põn¨£kÁuõÀ uÛ¯õÚ C¢u ö©ßö£õ¸øÍ {ÖÁ ÷uøÁ°Àø». Azxhß 

£QºÄ Áø» Â¸¢÷uõ®¦ ÷\øÁ ÁÇ[S® {ÖÁÚ[PÐ® C¢u ÷Põ¨¦ ©õØÖ 

Á\vø¯ ÁÇ[SQßÓÚ.

5'3'4 Þ¬íòˆ¶ìù£ù ªî£ì˜¹

Cøn¯zuÍö©õßøÓ öÁÎ°k® ö\¯Ø£õmkhß öuõhº¦øh¯ ÷Põ¨¦ 

©õØÓ®, CØøÓ¨£kzuÀ ©ØÖ® öÁÎ°k® uÍ[PøÍ CÚ[PõnÀ ÷£õßÓ 

‰ßÖ £i•øÓPÎ¾® Cøn¯zöuõhº¦ Azv¯õÁ]¯©õS®. Azxhß 

ÁõiUøP¯õÍøµ²® Áø» Â¸¢÷uõ®¤ø¯²® öuõhº¦£kzx® FhP©õPÄ® 

Cøn¯® öuõÈØ£k®.

Cøn¯zxhÚõÚ öuõhºø£ HØ£kzu ö£õ¸zu©õÚ Cøn¯ ÷\øÁ 

ÁÇ[SÚº (Internet Service Provider) JßøÓz öu›Ä ö\´uÀ ÷Ásk®. C[S 

SÔzu öuõhº¤ß ÷ÁP®, Pmhn®, £µõ©›¨¦ ÷\øÁ ÷£õßÓÚ P¸zvÀ 

öPõÒÍ¨£hÀ ÷Ásk®.

C»[øP°÷» Cøn¯ ÷\øÁ ÁÇ[S® {ÖÁÚ[PÒ ]» R÷Ç Põmh¨£m-

kÒÍÚ.

1. ÿ»[Põ öh¼öPõ®

2. »[Põ ö£À

3. ö©õ¤hÀ

4. h¯ö»õU GU]¯õhõ

5'3'5 Þ¬íòˆî÷ ðó£ñKŠ¹

Cøn¯zuÍö©õßÔß öÁØÔPµ©õÚ ö\¯Ø£õmiØS Ax ]Ó¢u •øÓ°À 

£µõ©›UP¨£kÁx Azv¯õÁ]¯õ©õS®. Cx £» £õP[PÍõP Â£›UP¨£h 

•i²®
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1' Cøn¯zuÍzvß ußø©UPø©¯ vÚ®, Áõµ® ©ØÖ® ©õu® ÷uõÖ® Auß 

EÒÍhUPzøu CØøÓ¨£kzuÀ AÁ]¯©õS®. Cuß÷£õx Cøn¯zuÍz-

v¾ÒÍ Âh¯[PÒ ©õzvµªßÔ, AÁØøÓ •ßøÁUS® Âu®, £i©®, 

Áºn®, ÁiÁ® ©ØÖ® ÷ÁÖ C»US¨ ö£õ¸ÒPÒ ÷£õßÓÁØÔ¾® 

©õØÓ[PøÍ ÷©ØöPõÒÍ ÷Ásk®. Cøn¯zuÍzvß •uÀ £UPzv÷» 

¦v¯ ö\´vPøÍ CkÁuØPõP uÛ¯õÚ Kº {µÀ Põn¨£iß, Põ»z 

xU÷PØ£ |øhö£Ö® ©õØÓ[PøÍ EhÝUShß C»SÁõP Põm]¨£kzu 

•i²®.

2' |a_ {µÀ ÷£õßÓ £õv¨¦ ö\¾zx® ö\´{µÀ, AÝ©v¯ØÓ ~øÇÄ ÷£õßÓ 

Âh¯[PÍõÀ Cøn¯zuÍzxUS £õv¨¦ HØ£h Áõ´¨¦sk. GÚ÷Á 

G¢÷|µ•® AÁuõÚzxhß C¸zuÀ, Põ»zxUS Põ»® Põ¨¦ GkzuÀ 

^Backing up&÷£õßÓ ö£õ¸zu©õÚ uØPõ¨¦ EzvPøÍ ÷©ØöPõÒÍÀ 

÷Ásk®.

3' Cøn¯zuÍ ÁiÁø©¨¦ ö©ßö£õ¸Îß |ÃÚ £v¨¦PÒ öÁÎ°h¨ 

£iß, AuØ÷PØ£ Cøn¯zuÍzøu CØøÓ¨£kzuÀ ÷Ásk®. Ax 

Cøn¯zuÍzvß £õxPõ¨¤ØS •UQ¯zxÁ® Áõ´¢uuõS®.

Cøn¯zuÍ {¸©õn ©ØÖ® ÁiÁø©¨¦ ö\¯Ø£õkPøÍ RÊÒÍÁõÖ Põm-

h¨£h •i²®.

E¸ 5.44 Cøn¯zuÍ {¸©õn ©ØÖ® ÁiÁø©¨¦ ö\¯Ø£õk

1&  uzxÁ®

(The concept)

3&  BÒPÍ¨ 

ö£¯º

(Domain name)

2&  ÁiÁø©¨¦ 

©ØÖ® {¸©õn®

(Design develop)

4&  Â¸¢ 

÷uõ®£À 

ö\¯Ø£õk

(Hosting)
5&  uµ÷ÁØÓ®

   (Upload)

6&  £›^»øÚ     

(Test)

7&  CØøÓ¨ 

£kzuÀ ©ØÖ® 

£µõ©›¨¦ 

(Update and 
manage)

Cøn¯zuÍ 

ÁiÁø©¨¦ ©ØÖ® 

{¸©õn Pmh[PÒ 

(Stages in web design 
and development) 

ö\¯Ø£õk   

   ö£õ¸zu©õÚ £i•øÓPøÍ¨ ¤ß£ØÔ E©x SÊÁõÀ 

{¸©õoUP¨£mh  Cøn¯zuÍzøu öÁÎ°kP.
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●  Cøn¯zuÍ  ÁiÁø©¨¤ß÷£õx, SÔzu ÷uøÁUS AÀ»x  £¯|º 

PÐUS ö£õ¸zu©õÚÁõÖ ÁiÁø©zuÀ ÷Ásk®.

● öÁØÔPµ©õÚ Cøn¯zuÍ E¸ÁõUPzvØS Auß EÒÍhUP® ]Ó¢u 

•øÓ°À J¸[Pø©UP¨£kÁx® ö£õ¸zu©õÚ Pmhø©¨¦ ©ØÖ® uÍU 

÷Põ»zxhß Cøn¯¨£UP®  {¸©õoUP¨£kÁx® Azv¯õÁ]¯©õS®.

●  Cøn¯ EÒÍhUPzvß C¯À¦PÐUPø©¯ {ø»zu ©ØÖ® C¯[S{ø» 

GÚ Cøn¯zuÍzøu C¸ÁøP¨£kzu •i²®.

● HTML Gß£x Cøn¯zuÍ ÁiÁø©¨¤ØS E£÷¯õQUP¨£kQßÓ 

Ai¨£øh ö©õÈ¯õS®. ]Ó¢u Cøn¯zuÍ £v¨¤¨£õÍ¸US C¢u 

ö©õÈ°ß AÔÄ AÁ]¯©õÚuõS®.

●  Áø» £v¨¦ ©ØÖ® EÒÍhUP •Põø© •øÓø© GÚ  Cøn¯ 

ÁiÁø©¨¦ ö©ßö£õ¸Ò C¸ÁøP¨£kzu¨£k®. CÁØøÓ E£ 

÷¯õQzx GÎ¯ Cøn¯zuÍ[PøÍ E¸ÁõUP  HTML ö©õÈ°ß AÔÄ 

AÁ]¯ªÀø».

●  EÒÍhUP •Põø© •øÓø© ö©ßö£õ¸øÍ E£÷¯õQzx C¯[S{ø» 

Cøn¯zuÍ[PøÍ E¸ÁõUP •i²®.

●  E¸ÁõUP¨£mh  Cøn¯zuÍzuÍ[PøÍ öÁÎ°kÁuØPõP ö£õ¸zu©õÚ 

Áø» Â¸¢÷uõ®¤, BÒPÍ¨ ö£¯º ©ØÖ® Ch©õØÖ® ö©ßö£õ¸Ò 

÷£õßÓÚ öu›Ä ö\´¯¨£hÀ ÷Ásk®.

●  Cøn¯zuÍö©õßÔß  öÁØÔPµ©õÚ ö\¯Ø£õmiØS Ax ]Ó¢u •øÓ°À 

£õµõ©›¨£uØPõÚ vmhªhÀ Põn¨£kÁx Azv¯õÁ]¯©õS®.

ö£õÈ¨¦
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vÚ•® K´ÂßÔ EøÇUS® \•uõ¯zvØS¨ ö£õÊx÷£õUS {PÌa]PÒ                      

Azv¯õÁ]¯©õøÁ¯õS®. £»º K´Âß÷£õx ©QÌa]¯øhÁuØPõPz  vøµ¨ 

£h[PøÍ¨ £õºUP Â¸®¦QßÓÚº. •ßÚº vøµ¨£h[PøÍz u¯õ›US® 

÷£õx HØ£mh SøÓ£õkPøÍz uÂºzx C¨÷£õx u¯õ›¨£õÍºPÒ E¯ºuµz 

vøµ¨£h[PøÍz u¯õ›UQßÓÚº. uØ÷£õx uPÁÀ ©ØÖ® öuõhº£õhÀ 

öuõÈÝm£Â¯¼À HØ£mh ¦µm]Pµ©õÚ  ©õØÓ[P÷Í CuØSU Põµn©õS®.

i)	 •¨£›©õn E¸Áz öuõÈÝm£®

			(3D - Three-Dimensional technology)
 £øÇ¯  vøµ¨£h[PÎÀ  Põn¨£mh  C¸  

 £›©õn E¸UPÐUS¨ £v»õP E¯º öuõÈ 

Ým£zøu¨ £¯ß£kzvz u¯õ›UP¨£k® 

vøµ¨£h[PÎÀ EÒÍ •¨£›©õn E¸z 

öuõÈÝm£® Põµn©õPz vøµ¨£h[PÒ 

E°÷µõmh® ö£ØÖÒÍÚ. |ÃÚ öuõÈÝm 

£zvØ÷PØ£z u¯õ›UP¨£mkÒÍ  ‰USU 

Psnõiø¯ Ao¢x Cµ]PºPÒ vøµ¨ 

£h[PøÍ  •¨£›©õnzvÀ Cµ]UP»õ®.

ii)	öíõ÷»õQµõ¤U Â®£[PøÍU Põm]¨ 

£kzx®  öuõÈÝm£®

						(Holographic image processing technology) 
		 Kº ChzvÀ £h©õUP Kº E¸Ázvß Â® 

£zøuz ÷uUQ øÁzx AuøÚ ÷ÁöÓõ¸ 

Põm]z uÍzvß «x PõmkÁuØS Cz 

öuõÈÝm£® £¯ß£kzu¨£kQßÓx. 

£¯[Pµ©õÚ  Põm]PøÍU  Põmk®÷£õx  

CzöuõÈÝm£® øP¯õÍ¨£kQßÓx.

\‰P•® uPÁÀ ©ØÖ®

 öuõhº£õhÀ öuõÈÝm£Â¯¾®

6'1  ö£õÊx÷£õUQØPõPz uPÁÀ ©ØÖ® öuõhº£õhÀ    

         öuõÈÝm£Â¯À

E¸ 6.2 öíõ÷»õQµõ¤U 

Â®£[PøÍz u¯õ›US® 

öuõÈÝm£Â¯À 

E¸ 6.1 •¨£›©õn E¸z 

öuõÈÝm£Â¯À

6
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iii)  ÷P¼a]zvµz vøµ¨£h®

]Ö¤ÒøÍPÎøh÷¯²® Á¯xÁ¢uÁº 

PÎøh÷¯²® ÷P¼a]zvµz vøµ¨ 

£h[PÒ ¤µ]zv ö£ØÔ¸¨£uØS AÁØ 

ÔÀ EÒÍ •¨£›©õn (3D three 
dimensional)  C¯À¦® AÁØÔÀ ÷©® 

£mh ö©ßö£õ¸Ò öuõÈÝm£® £¯ß 

£kzu¨£kQßÓø©²®  Põµn©õS®. 

iv)	C»UP•øÓa ö\Â¨¦»¨ £v¨¦PÒ 

uØ÷£õx Cø\¯ø©¨¤¾® £v¨¤¾® 

PoÛ, |ÃÚ ö©ßö£õ¸ÒPÒ BQ¯Ú 

£¯ß£kzu¨£kÁøuU Põn»õ®. £õm 

kPøÍ |õhõÂÀ £vÄö\´ÁuØS® 

£À÷ÁÖ£mh £õmkUPøÍU P»¨£uß 

‰»® ÷PÒÂ Cµ\øÚø¯U TmkÁuØ 

S® |õuU ÷Põ»[PøÍ Aø©¨£uØS® 

¦v¯ ö©ßö£õ¸ÒPÒ £¯ß£kzu¨ 

£kQßÓÚ. 

CÆÁõÖ £vÄö\´¯¨£k® £õmkPÒ 

GÎuõP CÖÁmkPÎÀ ÷uUQøÁU 

P¨£h»õ®. Azxhß Ãmk Aµ[Pz 

öuõSvø¯¨ (Home theatre system) 
(E¸ 6.5) £¯ß£kzv AÁØøÓU ÷Pmk                   

Cµ]UP •i²®.

v)	C»UP•øÓ ÂøÍ¯õmkPÒ 

(Digital games) 	
uØ÷£õx C»UP•øÓ ÂøÍ¯õmkPÒ 

¤µ]zvö£ØÖÒÍÚ. PoÛPÎÀ AÀ 

»x ö\À÷£]PÎÀ {ÖÁ¨£mkÒÍ 

C»UP•øÓ  ÂøÍ¯õmkPøÍ¨  £»º

ö£õÊx÷£õUQØPõP¨ £¯ß£kzxQß 

ÓÚº. •¨£›©õn (3D),  |õØ£›©õn  

(4D) öuõÈÝm£zøu¨ £¯ß£kzv  

Aø©UP¨£mh C»UP•øÓ ÂøÍ 

¯õmkPÒ uØ÷£õx ªPÄ® ¤µ]zv 

ö£ØÖÒÍÚ.
  E¸ 6.6 C»UP•øÓ ÂøÍ¯õmkPÒ

    E¸ 6.5 Ãmk Aµ[Pz öuõSv	

E¸ 6.3 ÷P¼a]zvµz vøµ¨£h®

 E¸ 6.4 C»UP•øÓa ö\Â¨¦»¨ £v¨¦PÒ
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vi)		£õÁøÚ ÂøÍ¯õmkPÒ  (Simulation games) 	
\õuõµn ÁõÌÂß ö\¯ÀPøÍU öPõsk C¯ØøPa `ÇÀ, AÀ»x 

PØ£øÚ ö\¯ØøP¯õP E¸ÁõUP¨£mk C¨£õÁøÚ ÂøÍ¯õmkPÒ 

ÂøÍ¯õh¨£kQßÓÚ.

CÆÂøÍ¯õmkPÒ £°Ø]¯ÎzuÀ, £S¨£õ´Ä ö\´uÀ, vmhªkuÀ BQ¯ 

ÁØÖUS¨ £¯ß£kzu¨£k® A÷u÷ÁøÍ CuØPõP Euõµn[PÍõP  ²zu¨ 

£°Ø]PÒ, ÁºzuP ÂøÍ¯õmkPÒ, ÁQ£õP® HØÖ |izuÀ (Role play)
BQ¯ÁØøÓU TÓ»õ®.

E¸ 6.7 £õÁøÚ ÂøÍ¯õmkPÒ

6'2  uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£zøu¨       

         £¯ß£kzx®÷£õx HØ£k® ¤µa]øÚPÒ

©ÛuÝøh¯ |õÍõ¢u ÁõÌøÁ GÎuõUSÁuØS¨ £» Azv¯õÁ]¯©õÚ A®      

\[PøÍ EØ£zvö\´xöPõsk ©ÛuÛß ö|¸[Q¯ |s£ÚõPz uPÁÀ 

©ØÖ® öuõhº£õhÀ öuõÈÝm£® Aø©QßÓ  ÷£õv¾® CzöuõÈÝm£zvß 

ÂøÍÁõP ©ÛuÝUS¨ £» ¤µa]øÚPÒ HØ£mkÒÍÚ. C¨¤µa]øÚPøÍ¨ 

¤ßÁ¸©õÖ ÁøP¨£kzvU Põmh»õ®.

E¸ 6.8 uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£zøu¨ £¯ß£kzx®÷£õx 

EshõS® ¤µa]øÚPÒ 

`Ç¾US

HØ£k® ¤µa]

øÚPÒ

w[S£¯US® 

ö©ßö£õ¸Ò	

    EhØ 

   ¤µa]øÚPÒ

\mh¨ 

¤µa]øÚPÒ

ÂÊª¯¨                 

¤µa]øÚPÒ

\‰P¨

¤µa]øÚPÒ

_Põuõµ¨

¤µa]øÚPÒ

uPÁÀ ©ØÖ® öuõhº

£õhÀ öuõÈÝm£Â¯¾®   

¤µa]øÚPÐ®
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C¨¤µa]øÚPøÍ²® AÁØÖUS›¯z wºÄPøÍ²® £ØÔ Â›ÁõP Bµõ´÷Áõ®.

6'2'1  ê†ìŠ Hó„C¬ùèœ

E¸ 6'9 AÝ©v°ßÔz uµÄPøÍU 

PÍÁõku¾® ¤µ÷Á]zu¾®

i)    ¤µzv÷¯Pz uµÄPøÍU PÍÁõkuÀ 

	 J¸Áøµ¨  ¤µzv÷¯P©õP  CÚ[Põs 

£uØS EÒÍ uPÁÀPøÍU (PII-Peroonally 

Indentifiable Information) PoÛ°¼¸¢x AÀ»x 

Ezv°¼¸¢x PÍÁõkuÀ.

 Euõµn® & ¤µzv÷¯P¨ ö£¯º, öuõø» 

÷£] Gs, JÎ¨£h® BQ¯ ¤µzv÷¯Pz 

uPÁÀPÒ Ch®ö£Ö® PoÛ {øÚÁPa 

]À¾PÒ, C»UP•øÓU P©µõUPÒ, ö\À 

÷£ØÔÀ BQ¯ÁØøÓU PÍÁõkuÀ AÀ»x 

AzuPÁÀPøÍ CµP]¯©õP¨ ö£ÖuÀ.

ii)	AÝ©v°ßÔU PoÛz öuõSvPÐUSÒ ¤µ÷Á]zuÀ

PoÛz öuõSv°À AÀ»x Áø»z uÍzvÀ ¤µ÷Á]¨£uØPõÚ £¯|º 

ö£¯øµ²® PhÄa ö\õÀø»²® PÍÁõi AÀ»x PshÔ¢x {ÖÁPzvß 

uµÄPøÍU PÍÁõkuÀ.

iii) ~snÔÄa ö\õzøuU PÍÁõhÀ

1.   ~snÔÄa ö\õzx Gß£x ¯õx?

J¸Áº AÀ»x J¸ {ÖÁP® ö\´u J¸ ¦v¯ £øh¨¦ £ØÔ¯ ÂÁµ[PÒ 

~snÔÄa ö\õzx GÚ¨£k®. AuõÁx CuØS •ßÚº £¯ß£õmiÀ 

C¸¢vµõu AÀ»x ©UPÒ AÔ¢vµõu J¸ ¦v¯ EØ£zvø¯ AÀ»x 

ö\¯ß•øÓø¯¨ £øhzu»õS®.  Ax J¸Á›ß AÀ»x {ÖÁPzvß 

E›ø©¯õS®. C¢~snÔÄa ö\õzøu ÷ÁÖ ö£¯›À •ßøÁzuÀ, 

E›ø©¯õÍ›ß AÝ©v°ßÔ ÷ÁÖ £øh¨¦PÐUPõP¨ £¯ß£kzuÀ, 

ÂØÓÀ BQ¯Ú ~snÔÄa ö\õzøuU PÍÁõhÀ GÚ¨£k®.

2.   ~snÔÄa ö\õzxPÎß \mh¨ £õxPõ¨¦UPõÚ BUPÄ›ø©   

  EzuµÄa^mk

BUPÄ›ø© EzuµÄa^mk Gß£x ¦v¯ £øh¨¤ØPõP Aµ\õ[PzvÚõÀ 

ÁÇ[P¨£k® ~snÔÄa ö\õzx E›ø©¯õS®. BUPÄ›ø© E›ø©ø¯¨ 

ö£ÖÁuØS E›¯ ÷u]¯ A¾Á»PzvØS¨ £øh¨£õÎ Âsn¨£zøua 

\©º¨¤zuÀ ÷Ásk®.
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iv) ÷©õ\iPÒ & Cøn¯zv¼¸¢x AÀ»x CÖÁmi¼¸¢x öÁÎ°mh 

|£›ß BÁn[PÒ (Á[Q GsPÒ, øPö¯õ¨£[PÒ), Pø»zxÁ¨ 

£øh¨¦PÒ BQ¯ÁØøÓ |PÀ ö\´uÀ, £À÷ÁÖ öPõkUPÀ Áõ[PÀPÎß 

‰»® |£ºPøÍ H©õØÖuÀ, AÁºPÐøh¯ PhÚmøh (Credit Card) ‰»® 

£nzøu ÷©õ\i ö\´uÀ.

6'2'2 M¿IòŠ Hó„C¬ùèœ

i) GÊzxz v¸mk	(Plagiarism)  
J¸ £øh¨£õÎ°ß  P¸zxPÒ, Pmk 

øµPÒ, ÷ÁÖ BUP[PÒ BQ¯ÁØøÓ 

|PÀ ö\´x AÁ¸øh¯  AÝ©v°ßÔ 

AuøÚz uÚx BUP©õP •ßøÁzuÀ 

GÊzxz v¸mk GÚ¨£k®. Cøn 

¯zøu¨ £¯ß£kzvz uµÄPøÍ²® uP-

ÁÀPøÍ²® öÁÎ°kuÀ Põµn©õP 

öÁÎ°h¨£mh PmkøµPøÍ |PÀ 

ö\´uÀ £µÁ»õP |øhö£ÖQßÓx. 

÷uøÁ¯õÚ \¢uº¨£[PÎÀ C¢u BUP[PøÍ HØÖUöPõÒÍ¨£mh ÁÈP 

ÎÀ ö£ØÖ¨ £¯ß£kzxÁuß ‰»® GÊzxz v¸møh (Plagiarism) {Özu 

•i²®.

J¸ SÔzu |£¸øh¯ E›ø©²ÒÍ Kº BUPzv¼¸¢x uPÁÀPøÍ¨ ö£Ö®÷£õx 

AuøÚ AÁ¸øh¯ ¤µzv÷¯Pz ußø©USz w[S HØ£hõuÁõÖ £¯ß£kzuÀ 

HØÖUöPõÒÍ¨£mh ÁÈPÎÀ ö£ØÖ¨ £¯ß£kzuÀ GÚ¨£k®. AuõÁx,

1.   GkzxU PõmhÀ 	(Citing)			-		GÊzuõÍ›ß AÀ»x GÊzuõÍºPÎß                                     

               uPÁÀPøÍU SÔ¨¤kuÀ

2.  ÷©Ø÷PõÒ PõmhÀ (Quoting)		-	|PÀ ö\´¯¨£mh £Svø¯z uø»RÌU   

      PõØ¦ÒÎPÎÀ ( "...........'') PõmhÀ	

3.   BuõµU SÔ¨¦ (Referencing)	-		uPÁÀPÒ ö£Ó¨£mh Áø»¨ £UPzøuU                                 

               Pmkøµ°ß  CÖv°À SÔ¨¤kuÀ

PoÛPøÍ¨ £¯ß£kzx®÷£õx AÁØøÓ¨ £õxPõ¨£õP¨ £¯ß£kzuõ 

ø©¯õÀ ö£ÍvP ©ØÖ® u¸UP¨ ¤µa]øÚPÒ GÊQßÓÚ. AuõÁx, \kv¯õÚ 

ªß xsi¨¦ Põµn©õPU PoÛ ÁÊUPÒ HØ£kuÀ, £øPÁºPÎÚõÀ 

E¸ 6.10 GÊzxz v¸mk

6'2'3   ªð÷FèŠ Hó„C¬ùèÀ‹ î¼‚èŠ Hó„C¬ùèÀ‹



  C»Á\¨ £õh¡À210

öuõÀø» HØ£kuÀ, Cøn¯zvß ‰»® Á¢x ÷\¸® w[S£¯US® ö©ß 

ö£õ¸Ò Põµn©õPU PoÛ Áø»¯ø©¨¦ ö\¯¼ÇzuÀ Gß£Ú ]»ÁõS®. 

AÝ©v°ßÔ¯ ¤µ÷Á\®, _ØÓõhØ PõµoPÒ BQ¯Ú PoÛPÎß £õv¨¤Ø-

SU Põµn©õQßÓÚ.

uPÁÀ, öuõhº£õhÀ öuõÈÝm£Â¯ø»¨ £¯ß£kzx®÷£õx HØ£k® 

ö£ÍvP, u¸UP¨ ¤µa]øÚPÎ¼¸¢x G[VÚ® £õxPõ¨ø£¨ ö£Ó»õ®?

ö£ÍvP¨ £õxPõ¨¦ (Physical Security)   
i)	 uøh¨£hõu ªß\õµ® ÁÇ[PÀ	(Uninterrupted Power Supply - UPS) 

Gvº£õµõ©À ªß uøh¨£k®÷£õx PoÛUS® BÁn[PÐUS® HØ£k® 

÷\uzøuz uÂº¨£uØPõPz uøh¨£hõu ªß\õµ® ÁÇ[P¼ÞhõPU  

PoÛUS ªßøÚ ÁÇ[PÀ EP¢ux. C[S uøh¨£hõu ªß\õµ® 

ÁÇ[QPÎÀ EÒÍ  ªß HØÔ¯ ªßP»zvß ‰»® ªß uøh°ß÷£õx 

öuõhºa]¯õÚ ªßÁ¾ PoÛUS ÁÇ[P¨£k® (E¸ 6.11).

E¸ 6.11 uøh¨£hõu ªß\õµ® ÁÇ[PÀ (UPS)

PoÛz öuõSv

UPS

¤µuõÚ 

ÁÇ[PÀ

ii)	Áß wa_Áº	(Hardware firewalls)
÷ÁÖ TÓõPÄ® öPõÒÁÚÄ ö\´¯¨£hzuUP Áß wa_Áº C¨÷£õx APßÓ 

£møh ÁÈ¨£kzv°À	 (broadband routers)	 Aø©UP¨£kQßÓx. Â÷\

h©õP Cøn¯zxhß öuõkUP¨£k® PoÛz öuõSvø¯²® PoÛ 

Áø»¯ø©¨ø£²® Aø©US®÷£õx Áß wa_Áº Azv¯õÁ]¯©õÚx. 

Cuß ‰»® Cøn¯zv¼¸¢x ö£Ö® Azxhß PoÛ Áø»¯ø©¨¤À 

£›©õØÓ¨£k® JÆöÁõ¸ uPÁ¾® ÁÈPõmh¨£kQßÓx. Cx AÝ©v 

°ßÔ¯ ¤µ÷Á\[PÎ¼¸¢x PoÛz öuõSvø¯¨ £õxPõUQßÓx (E¸ 

6.12).
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E¸ 6.12 Áß wa_Áº	(Hardware firewalls)

öÁÎa 

ö\À¾® uµÄ

EÒ Á¸®

uµÄ

w
a_

Á
º

Cøn¯®

PuÄ ‰»® Pmk¨£kzv¯ ¤µ÷Á\® 

G¨÷£õx® PoÛ B´Thzøuz uõÈmk¨ £õx-

PõzuÀ •UQ¯©õS®. öÁÎ|£ºPÎß ¤µ÷Á\zøu 

©mk¨£kzxÁuß ‰»® B´ThzvÀ EÒÍ PoÛz 

öuõSvPÐUS® HøÚ¯ xøn²Ö¨¦PÐUS® uP-

ÁÀPÐUS® HØ£k® ÷\uzøuz uÂºUP»õ® (E¸ 6.13).

iii) ‰i¯ _ØÖz öuõø»UPõm] (CCTV)
PoÛ B´Thzvß £õxPõ¨¦UPõP ‰i¯ _ØÖz 

öuõø»UPõm]ø¯¨ £¯ß£kzv A[S {PÌ£ÁØøÓ 

öÁÎ÷¯°¸¢x AÁuõÛUP»õ® AÀ»x J¸ |õÐUPõÚ 

ö\¯Ø£õkPøÍ JÎ²¸ (Video clips) xsh[PÍõP 

÷uUQ øÁzx¨ ¤ßÚº £õºøÁ°h»õ®.

iv) GÊa]¨ £õxPõ¨¤ 	(Surge  protector) 
PoÛ B´ThzvÀ EÒÍ PoÛPÒ  

Em£h  HøÚ¯ ªß xøn²Ö¨¦PÐUS 

ÁÇ[P¨£k® ªß Á¾Âß ÷ÁõÀØÓ 

ÍøÁU Pmk¨£kzu¨ £¯ß£kzu¨£k® 

CÆÄ£Pµnzvß ‰»® PoÛPÎÚx® 

HøÚ¯ E£Pµn[PÎÚx® £õxPõ¨¦ 

EÖv¨£kzu¨£kQßÓx. 

ÃkPÐUS AÀ»x A¾Á»P[PÐUS {¯© ÷ÁõÀØÓÍÄ¨ ö£Ö©õÚ® 240

÷ÁõÀØÖ BS®. CÆÁÍøÁ Âg_® ÷£õx ªß xøn²Ö¨¦PÒ ÷\u©øhuÀ 

E¸ 6.13 PuÄ ‰»® 

©mk¨£kzv¯ ¤µ÷Á\®

E¸ 6.14 ‰i¯ _ØÖz 

öuõø»UPõm]

        E¸ 6.15  GÊa]¨ £õxPõ¨¤
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CÆöÁÊa]¨ £õxPõ¨¤ ‰»® Pmk¨£kzu¨£k®  (E¸ 6.15).

      E¸ 6'16 _ØÓõhÀ PõµoPÒ

v)   _ØÓõhÀ PõµoPÒ

C¯ØøPa _ØÓõh¼À EÒÍ PõµoPÒ 

PoÛz öuõSv°ß {»ÄøPUS J¸ 

uøh¯õS®. PoÛ B´Thzøu AÀ»x 

ö\õ¢uU PoÛø¯z y], Dµ¼¨¦ 

BQ¯Ú CÀ»õ©À ÷£qÁuß ‰»® 

Auß {»ÄøPø¯¨ £õxPõUP»õ®  (E¸ 

6.16).

u¸UP¨ £õxPõ¨¦ (Logical Security)    

     E¸ 6'17 PhÄaö\õÀ (Password)

i)   PhÄaö\õÀ (Password) 	
PoÛ ö©ßö£õ¸ÒPÎÚx® ÷uUQøÁU 

P¨£mkÒÍ   BÁn[PÎÚx®   £õxPõ¨ 

¦UPõPU  PhÄaö\õÀ £¯ß£kzu¨£kQß 

Óx.  Cuß  ‰»®  PoÛ°À AÝ©v°ß 

Ô¨ ¤µ÷Á]zuø»²® £¯ß£kzuø»²® 

Pmk¨£kzu»õ®. PhÄaö\õÀø» öu›Ä 

ö\´²®÷£õx Ax GÊzx, C»UP[PÒ, 

SÔPÒ BQ¯ÁØÔß P»øÁ¯õP C¸¢uõÀ 

PhÄa ö\õÀ¼ß £»® AvP›US®

(E¸ 6.17).

	 E¸ 6'18 ö©ß wa_Áº 

ii)	ö©ß wa_Áº (Software firewalls)	
PoÛ Áø»¯ø©¨¤À EÒÍ PoÛPÎß  

‰»®  Cøn¯zvØS¨ ¤µ÷Á]US®÷£õx 

AÝ©v°ßÔ¨  ¤µ÷Á]¨£ÁºPÎhª¸¢x 

PoÛ   Áø»¯ø©¨ø£¨ £õxPõ¨£uØS 

ö©ß wa_Áº £¯ß£kzu¨£kQßÓx. 

PoÛ¨ £oö\¯À •øÓø©°À  Kº 

A[P©õQ¯ ö©ß wa_Áº G¨÷£õx® 

öuõÈØ£k® {ø»°À C¸zuÀ ÷Ásk®. 

Cuß ‰»® Cøn¯zvÞhõPU QøhU 

S® GÀ»õa ö\´v¨£›©õØÓ[PÐ® ÷\õvU 

P¨£k® A÷u÷ÁøÍ \¢÷uP©õÚ ö\´v¨ 

£›©õØÓ[PÒ ukUP¨£k®. A÷u÷ÁøÍ Áø»¯ø©¨¤À EÒÍ PoÛPÐ® 

÷\u¨£kzx® ö©ßö£õ¸ÒPÎ¼¸¢x £õxPõUP¨£kQßÓÚ.
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iii) Põ¨¦PÒ (Backups) 	 								
PoÛz öuõSv°À  \kv¯õP  HØ£k®         

ö\¯¼Ç¨¤ÚõÀ AvÀ ÷uUQ øÁUP¨ 

£mkÒÍ Azv¯õÁ]¯z uµÄPÐ® uPÁÀ 

PÐ® AÈ¢x ÂhUTi¯ A£õ¯® EÒÍx. 

AÁØøÓ¨ £õxPõ¨£uØS AÁØÔß Põ¨¦ 

PøÍz öuõhºa]¯õP E¸ÁõUQU öPõÒÍÀ 

÷Ásk®. CuØPõP Áß ÁmkPÒ, CÖ 

ÁmkPÒ, C»UP•øÓ¨ £ÀÁmkPÒ, £Îa 

^mk C¯UQ, {øÚÁPa ]À¾PÒ BQ¯Ú £¯ß£kzu¨£k®.  A÷u÷ÁøÍ   

AÆÅhPzøu   ÷ÁöÓõ¸   ChzvÀ £õxPõ¨£õP øÁzuÀ EP¢uuõS® (E¸ 

6.19).

6'2'4  bƒ°ðò‚°‹ ªñ¡ªð£¼œèœ

i)	 PoÛz öuõSvø¯¨ £¯ß£kzx®÷£õx £À 

÷ÁÖ Aa_ÖzuÀPÐ® uõUP[PÐ® HØ£kQßÓÚ. 

w[S£¯US® ö©ßö£õ¸Ò	 (Malicious software/
Malware)	AÀ»x w[S£¯US® SÔ•øÓPÒ	(Mali- 
cious codes)	 Põµn©õPU PoÛPÐUS® PoÛ   

Áø»¯ø©¨¦PÐUS®   HØ£k®   ÷\u® ªPÄ® 

AvP©õS®. AÁØÔÀ ]» R÷Ç uµ¨£mkÒÍÚ.

 ² PoÛ°ß vÓß SøÓuÀ (\›¯õPz öuõÈØ£hõø©, ÷uøÁ¯ØÓ ÂuzvÀ 

«sk® «sk® C¯[Pz öuõhUSuÀ (re - boot/re-start)          
 ² PoÛ ö©ßö£õ¸ÒPÒ AÈu¾® ¤øÇ¯õPz öuõÈØ£ku¾®

 ² ÷ÁÖ ö©ßö£õ¸ÒPøÍ {ÖÁ •i¯õø©

 ² PoÛ Áßö£õ¸ÒPÒ |¼ÁøhuÀ (ö|QÌÁmk C¯UQ |¼ÁøhuÀ, Áß 

ÁmkPÒ öuõÈØ£hõø©)

 ² PoÛ Áø»¯ø©¨¦ |¼ÁøhuÀ

 ² uµÄPøÍU PÍÁõku¾® AÈzu¾®

 ² ÷uøÁ¯ØÓ £v÷ÁkPÐ® ÷Põ¨¦PÐ® ÷\ºUP¨£kQßÓø©¯õÀ Áß 

Ámiß öPõÒvÓß SøÓuÀ.  

E¸ 6'20 w[S£¯US® 

ö©ßö£õ¸ÒPÒ

        E¸ 6'19  Põ¨¦PÒ (Backups)
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ii)	w[S £¯US® ]» ÁøP ö©ßö£õ¸ÒPøÍ²® AÁØÔß ]» w[SPøÍ²® 

RÌÁ¸® AmhÁøn ÂÍUSQßÓx.

w[S£¯US® 

ö©ßö£õ¸Ò

HØ£k® ÷\u®

    PoÛ |a_{µÀ

(Computer virus)
PoÛa ö\´{µ¼ß ‰»® PoÛ°À £µÄ® PoÛ  

|a_{µÀ Áø»¯ø©¨¤ß ‰»•® USB £Îa^mk 

C¯UQ, {øÚÁPa ]À¾PÒ ÷£õßÓ ¦Ó EÒÏmka 

\õuÚ[PÒ AÀ»x ªßÚg\À ‰»•® £µÄQßÓx. 

uµÄPÒ, ö©ßö£õ¸Ò, Áßö£õ¸Ò BQ¯ÁØÔØSz 

w[S£¯US® |a_{µÀ ÁøPPÒ JÆöÁõßÖ® {øÓ

÷ÁØÓzuUP ÷Põ¨¦PÐhß	 (Executable files)	öuõS 

vUSÒ÷Í ¦SQßÓÚ. AuõÁx  PoÛ |a_{µÀ 

G¨÷£õx® öuõSv°À öuõÈØ£mkU öPõsk C¸U 

QßÓx.

PoÛ ÷Á®PÒ

(Computer worms)
PoÛ   ÷Á®PÐ®	(Computer worms)	|a_{µÀ 

÷£õßÖ  öuõÈØ£kQßÓÚ. BÚõÀ ÷Á®PÒ uÛ 

¯õPz öuõÈØ£mk¨ £µÄ® BØÓø»U öPõsi 

¸US® A÷u÷ÁøÍ AuØPõP ªßÚg\À, ÷£õ¼ 

Áø»zuÍ®, \kv¯õPz ÷uõßÖ® ö\´va \mh[PÒ 

÷£õßÓ PoÛ Ai¨£øha \‰P¨ ö£õÔ°¯À	
(Social engineering)	EzvPÒ £¯ß£kzu¨£kQßÓÚ.

JØÓºö£õ¸Ò	
(Spyware)

÷Óõáß Svøµ	(Trojan Horse)
Q÷µUPºPÎÚõÀ ÷Óõ® Cµõa]¯zøu Ai£o¯ 

øÁ¨£uØS¨ £¯ß£kzu¨£mh ©µzvÚõÀ ö\´¯¨

£mh Svøµø¯ Euõµn©õPU öPõsk ö£¯›h¨ 

£mh ÷Óõáß Svøµ Gß£x CßöÚõ¸ w[S £¯US® 

ö©ßö£õ¸ÍõS®. w[PØÓx ÷£õßÖ ÷uõßÖQßÓ 

÷£õv¾®   w[S£¯US®   ö©ßö£õ¸ÍõQ¯ 

Cx £¯Úº AÔ¯õ©÷»÷¯ öuõSv²hß öuõhº¦ 

£kQßÓx. ÷uøÁ¯ØÓ ÂuzvÀ vÓUS® PoÛa 

\õÍµ[PøÍ²® ©õÖ® ÷©ø\z uÍ[PøÍ²®	
(Desktops)	 HØ£kzvU öPõsk® £v÷ÁkPøÍ 

AÈzxU öPõsk® £¯Úøµ Aö\ÍP›¯zvØS 

Em£kzx® ÷Óõáß Svøµ HøÚ¯ w[S£¯US® 

ö©ßö£õ¸ÒPÒ PoÛUSÒ÷Í ¦SÁuØS Á\v 

ö\´QßÓx. ªßÚg\ø»z vÓ¨£uß ‰»•® 

Cøn¯zvÞhõP¨ £vÂÓUP® ö\´¯¨£k® ÷Põ¨ 

¦PÐhÝ® PoÛ°ÝÒ÷Í ¦S® ÷Óõáß Svøµ 

PoÛ |a_{µÀ, ÷Á®PÒ BQ¯ÁØøÓ¨ ÷£õßÖ 

£µÄÁvÀø».
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AÚõÁ]¯  ÂÍ®£µ[PÒ (Adware) 
AÚõÁ]¯ ÂÍ®£µ[PøÍU PoÛz vøµ°À 

Põm]¨£kzuÀ Czw[S£¯US® ö©ßö£õ¸Îß 

C¯À£õS®. AÆÂÍ®£µ[PøÍ¨ £¯ß£kzv Áºz 

uPz uPÁÀPÒ ö£Ó¨£k®. AÚõÁ]¯ ÂÍ®£µ[PÒ 

PoÛ |a_{µÀ ÷£õßÖ w[S£¯UPõu ÷£õv¾® 

£¯|º EÍÂ¯À Ÿv°À öuõ¢uµÄUS Em£kQßÓõº.

         ö£õØì

(Bots)
÷Óõ÷£õ	 (Robot)	GßÝ® ö£¯›¼¸¢x ö£Ó¨£mh 

ö£õØì	 (Bots)	 HøÚ¯ Áø»¯ø©¨¦PÐhß 

öuõhº¦PøÍU öPõsi¸US® _¯©õPz öuõÈØ 

£mkz  w[S£¯US® ö©ßö£õ¸ÍõS®. \kva ö\´ 

vPÒ ©ØÖ® Cøn¯U P»¢xøµ¯õh¼ß ‰»® 

£›©õØÓ¨£k® ¤µzv÷¯Pz uPÁÀPøÍa ÷\P›¨ 

£uØS ö£õØì  £¯ß£kQßÓx.

öPõÒøÍUPõµº

(Hijacker/  Browser 
hijacker)

ÁºzuP, ÁoP, ÁºzuP¨ ¤µ\õµ¨ £oPÐUPõP 

Aø©UP¨£mh öPõÒøÍUPõµ›ÚõÀ £¯|º Cøn 

¯zxhß öuõhº¦£k®÷£õx AÁ¸US  AuØS ÁÈ

Âhõ©À ÷ÁÖ Áø»¨£UPzvØS Azöuõhº¦ ÁÈ¨

£kzx®. Cx AÚõÁ]¯ ÂÍ®£µ Aa_Özuø» Jzux.

¤æ[ 	(Phishing) ¤æ[	Gß£x  £¯|øµ  H©õØÔ AÁ¸øh¯ Á[QU

PnUS,  ªß PnUS  BQ¯ÁØøÓ¨  £ØÔ¯  uPÁÀ

PøÍ¨ ö£Öu»õS®. CuØPõP ªßÚg\À £¯ß 

£kzu¨£kQßÓx. CÆÁg\À J¸ ¤µ]zvö£ØÓ 

P®£Û ‰»® AÀ»x |s£Ûß ö£¯›À £¯Ú¸US 

AÝ¨£¨£k® A÷u÷ÁøÍ ÷ÁÖ Áø»zuÍzvØSa 

ö\ÀÁuØPõP Kº Cøn¨¦® AÝ¨£¨£k® AÆ 

Cøn¨ø£a ö\õhUSÁuß  ‰»® AÀ»x ÂÁµa 

]ØÔuøÇ  {µ¨¦Áuß ‰»® ö£Ó¨£k® uPÁÀPÒ 

£¯Ú›ß £nzøu²® •UQ¯ uPÁÀPøÍ²© v¸h¨ 

£¯ß£kzu¨£kQßÓÚ.

Â¸®£õ Ag\À 	
(Spam)

AÝ©v°ßÔU   QøhUS®   ªßÚg\À    Â¸®£õ

Ag\À  GÚ¨£k®.  Cx  ö£¸®£õ¾®  ö£õ¸ÒPÐU 

PõÚ ÁºzuP ÂÍ®£µ[PÍõP  AÀ»x CÚ[Põn¨ 

£hõu J¸Áº AÝ¨¤¯  J¸ ªßÚg\»õP C¸U 

P»õ®. CuÚõÀ Ag\Ø ö£mi AzuøP¯ ªßÚg\À 

PÍõÀ {µ¨£¨£h»õ®. Cuß ÂøÍÁõP¨ £¯Ú¸US 

Aö\ÍP›¯® HØ£h»õ®. AÆÁõ÷Ó uÛ¯õmPÎß 

ªßÚg\ÀPÎß •PÁ› \mhÂ÷µõu©õP ÷©õ\

iUPõP¨ £¯ß£kzu¨£h»õ®.
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iii)     w[S£¯US® ö©ßö£õ¸ÒPÎ¼¸¢x PoÛø¯²® PoÛ      

   Áø»¯ø©¨ø£²® G[VÚ® £õxPõUP»õ®?

²  PoÛUS J¸ |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸øÍ {ÖÄP. AuøÚz 

uUPÁõÖ  CØøÓ¨£kzxP.  Auß £õxPõ¨¦  Ezvø¯ G¨÷£õx®  (Guard/
Shield/Auto Scan/update) ö\¯Ø£k©õÖ Aø©USP.

²  öÁÎz ÷uUPP[PøÍ (USB {øÚÁP®) PoÛ²hß öuõkUS®÷£õx  

PÁÚ©õP C¸UP ÷Ásk®. AuøÚ |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸Îß  

‰»® ÷\õvUP.

²  G¨÷£õx® \mhŸv¯õÚ ö©ßö£õ¸øÍU PoÛ°À {ÖÄP.

² \õuõµn £¯ß£õmiØPõPU  PoÛ {ºÁQUS® PnUQØS¨ (Administrator 
account) £v»õPa   \õuõµn £¯|º  PnUøP¨ (User account) £¯ß£kzxP.

PoÛ Cøn¯zxhß öuõkUP¨£mi¸¨¤ß, 

²  £õxPõ¨£õÚ Áø»zuÍ[PøÍ¨ £¯ß£kzuÀ Â¸®£zuUPx URL £õxPõ¨ 

£õÚuõ  Gß£øua ÷\õv¨£uß ‰»® AÔ¯»õ®.

²  ö©ßö£õ¸øÍ AÀ»x ÷ÁÖ  GuøÚ²® £vÂÓUPg ö\´ÁuØS¨ £õx 

Põ¨£õÚ Áø»zuÍzøu ©õzvµ® öu›¢öukUP.

²  £vÂÓUPg ö\´ÁuØS •ß£õP A¢u BÁnzøu AÀ»x ö©ßö£õ¸øÍ 

|a_{µÀ £õxPõ¨¦ ö©ßö£õ¸Îß ‰»® ÷\õvUP.

²  ªßÚg\ÀPøÍz vÓUS®÷£õx PÁÚ©õP C¸UP. AÁØøÓ¨ £vÂÓUPg 

ö\´¯÷Áskö©Ûß AuØS •ßÚº £õxPõ¨¦ ö©ßö£õ¸ÎÚõÀ                           

÷\õvUP. \¢÷uPzvØQh©õÚ ªßÚg\ø»z vÓzuø» AÀ»x AÁØÔÀ 

EÒÍ Cøn¨ø£a ö\õhUSÁøuz uÂºUP.

² \¢÷uPzvØQh©õÚ AÔÂzuÀPøÍ AÀ»x ö\´vPøÍa ö\õhUSÁøuz 

uÂºUP.

²  J¸Á¸øh¯ A¢uµ[Pz uPÁÀPøÍ £õxPõ¨ø£a ÷\õvUPõ©À Áø»z 

uÍzvØS¨ £v÷ÁØÓ® ö\´¯ ÷Áshõ®.

²  wa_Áº (Firewall), |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸ÒPÒ (Virus guards), 
ªßÚg\À ÁiPmiPÒ (email filters) BQ¯ÁØøÓ¨ £¯ß£kzxÁuß ‰»® 

ChøµU SøÓUP»õ®.
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iv) w[S£¯US® ö©ßö£õ¸ÒPÎ¼¸¢x £õxPõ¨£uØPõPU PoÛPÎÀ 

{ÖÁzuUP ¤µ]zvö£ØÓ ]» |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸ÒPÒ R÷Ç 

EÒÍÚ :

♦ Avira Antivirus 
♦ Avast Antivirus 
♦  AVG Antivirus 
♦ K7 Antivirus 
♦ Digital Defender Antivirus 
♦ Norton Antivirus 
♦  Kaspersky Antivirus 
♦  Panda Cloud Antivirus [ B ]
♦  Microsoft Security Essentials 
♦  BitDefender Antivirus 
♦  McAfee Antivirus 

öÁÒÍ® Á¸•ß AønPmh ÷Ásk®!

   ÷©ØSÔzu |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸ÒPøÍ¨ ÷£õÀ ÷ÁÖ 

]» |a_{µÀ £õxPõ¨¦ ö©ßö£õ¸ÒPøÍ Cøn¯zv¼¸¢x 

÷ui¯Ô¢x £mi¯Ø£kzxP. AÁØøÓ EØ£zvö\´u {ÖÁP[ 

PøÍ²® EØ£zv ö\´u BskPøÍ²® £ØÔ¯ ÂÁµ[PøÍ 

AÔ¢x AmhÁøn¨£kzxP.

ö\¯Ø£õk

v)   Cøn¯z uPÁÀPøÍ¨ £›©õÖÁuØPõP C»[øP°À £õxPõ¨ø£ ÁÇ[S® 

{ÖÁP[PÒ

C¨÷£õx Cøn¯zvÞhõPz uµÄPøÍ²® uPÁÀPøÍ²® ö£Óõu |£º 

AÀ»x {ÖÁP® CÀø»ö¯ßÖ TÓ»õ®. E»P® •ÊÁx® \‰P Áø»z 

uÍ[PÒ Áø» öuõhº£õÚ wºÄPÐUS AÝ©v°ßÔ¨ ¦S¢x AÁØÖUS® 

AÁØÔß E›ø©¯õÍºPÐUS® ÷\u® ÂøÍÂzuÀ Ph¢u ]» BskPÍõP 

AvP›zxÒÍx. C»[øP°¾® AzuøP¯ \®£Á[PÒ AvP AÍÂÀ |øh 

ö£ÖÁuõP AÔÂUP¨£mkÒÍx. BP÷Á CÆÂøn¯¨ £oPÐUS¨ £õx 

Põ¨ø£ ÁÇ[S® {ÖÁP[PÐUPõÚ ÷uøÁ HØ£mkÒÍx. C¨£õxPõ¨¦ 

Cøn¯¨ £õxPõ¨¦ GÚ¨£k®.
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Cøn¯¨ £õxPõ¨£õÚx ªßÚg\À, Cøn¯z wºÄPÒ, Áø»zuÍ®, \‰P 

Áø»¯ø©¨¦PÒ BQ¯ÁØÖUS ©õzvµ® ©mk¨£kzu¨£mi¸¨£vÀø». 

Ax PoÛ Áø»¯ø©¨¦PÐUS® PoÛ¨ £oö\¯À •øÓø©PÐUS® 

E›¯x. Cøn¯¨ £õxPõ¨ø£ ÁÇ[S® ]» {ÖÁP[PÒ ¤ßÁ¸©õÖ:

 � C»[øPz uPÁÀ £õxPõ¨¦ {ÖÁP[PÒ (Institutions for Information Secu-
rity of Sri Lanka)
uPÁÀ	 öuõhº£õhÀ öuõÈÝm£Â¯À •PÁº {ø»¯® (Information 
and Communication Technology Agency) - ICTA ‰»® Aø©UP¨£mh 

÷©ØSÔzu Tmhø©¨¤ß ‰»® ¤µø\PÒ, Â¯õ£õµ {ÖÁÚ[PÒ ©ØÖ® 

Aµ\õ[P {ÖÁP[PÒ ÷£õßÓ  uµ¨¤Ú¸USa ÷\øÁPÒ ÁÇ[P¨£kQßÓÚ. 

 � ICTA	 {ÖÁP®, C»[øP {¯©[PÒ {ÖÁÚ®, C»[øPU PoÛ AÁ                                                                                           

\µU u¯õº{ø»U SÊ (Sri Lanka Computer Emergency Readiness Team 
- CERT) {ÖÁPzxhÝ® uPÁÀ £õxPõ¨¦ •Põø©zxÁ •øÓø©  

{ÖÁP[PÐhÝ® (Inf or mation Secur ity Mana ge ment  Sys tem - ISMS)                                                                                       
÷\º¢x \õßÔuÌ ÁÇ[S® |hÁiUøPø¯ Bµ®¤zxÒÍx. uÛ¯õmPÐ®  

{ÖÁP[PÐ® Aaö\´{µ¼ØPõP¨ £vÄ ö\´Áuß ‰»® uPÁÀ £õxPõ¨ø£ 

÷©ØöPõÒÍ»õ®.

¤ßÁ¸® Áø»zuÍ[PÎØS¨ ¤µ÷Á]UP. AÆÁø»z uÍzøuU 

öPõsk }º ö£ÓzuUP PoÛ öuõhº£õÚ  ÷\øÁPøÍ¨ £mi¯Ø 

£kzxP.

ö\¯Ø£õk

http://www.gov.lk/web/
   http://www.engage.icta.lk
    https://www.techcert.lk/si/

6'2'5 îèõ™ ñŸÁ‹ ªî£ì˜ð£ì™ ªî£NÂ†ðMòL¡ ðò¡ð£†´ì¡  
ªî£ì˜¹ð†ì  àì™  Ý«ó£‚Aò‹ ê£˜‰î Hó„C¬ùèœ

£ozvÓÛ¯¾® (Ergonomics)	EhÀ B÷µõUQ¯•®

Ergonomics  Gß£x  ergon, nomos GßÝ®  C¸ Q÷µUPa ö\õØPÎß   ÷\º©õÚ                            

©õS®.   ergon Gß£x £o¯õS®. nomos Gß£x \mh©õS®. Cuß GÎ¯ P¸zx 

¤ßÁ¸©õÖ. 
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£oø¯ EøÇ¨£õÍ¸US¨ ö£õ¸zu©õÚ ÂuzvÀ Aø©UP ÷Áskö©ß£x® 

EøÇ¨£õÍøµz öuõÈ¾UPõP AÝ\›zx¨ ÷£õS©õÖ {º¨£¢vUPUThõx 

Gß£x® AuØS ©õÓõP Aø©°ß EøÇ¨£õÍº £À÷ÁÖ ÷|õ´PÐUS 

BÍõuø»z uÂºUP •i¯õx Gß£x® BS®.

CßÖ öuõÈÝm£® ©ÛuÝUS Azv¯õÁ]©õÚ Kº A[P©õP C¸US® 

A÷u÷ÁøÍ öuõÈÝm£•® ©ÛuÝ® ¤›UP•i¯õu AÍÄUS JßöÓõ 

öhõßÖ ¤øn¢xÒÍÚ. vÚ•® öuõÈÝm£zvß £¯ß£õk AvP›US® 

A÷u÷ÁøÍ Auß ÂøÍÁõP A÷u AÍÂØS EhÀ B÷µõUQ¯¨  ¤µa]øÚ 

PÐ® AvP›zxÒÍÚ. PoÛø¯z öuõhºa]¯õP |õßS ©ozv¯õ»zvØS 

÷©Ø£mh Põ»zvØS¨ £¯ß£kzxQßÓø©¯õÀ HØ£kQßÓ CÆÄhÀ 

B÷µõUQ¯¨ ¤µa]øÚPøÍ C¨÷£õx Bµõ´÷Áõ®.

i)	 uø\ ÁßTmk¨ ¤µa]øÚPÒ

			(Musculoskeletal problems)	
PoÛø¯z öuõhºa]¯õP¨ £¯ß£kzxQßÓ 

ø©¯õÀ Eh¼ß £À÷ÁÖ Ch[PÎÀ uø\

PÎ¾® Gß¦PÎ¾® ÷|õÄ HØ£kÁuõP AÔ¯¨ 

£mkÒÍx. CuØS •UQ¯ Põµn® PoÛø¯¨ 

£¯ß£kzxøP°À \›¯õÚ öPõsoø»°À 

C¸UPõø©¯õS® (E¸ 6.21).

ii)                  «ÒÁ¸®     uøP¨¦U     Põ¯®  (RSI - Repetitive Stress 
 Injury)  
PnÛPÎÀ   öuõhºa]¯õP¨    £o¯õØÖÁuõÀ 

÷uõÎ¼¸¢x øP°ß ÂµÀPÒ ÁøµUS® 

EshõS® ÷|õÄ «ÒÁ¸® uøP¨¦U Põ¯® 

GÚ¨£k®. AÆÂh[PÎÀ ÃUP®, ÂøÓ¨¦, 

÷|õÄ BQ¯Ú EshõS®. _miUPõP EÒÍ[ 

øPø¯ A[S® C[S® öPõskö\À» 

PiÚ©õP C¸zuÀ Cuß AÔSÔ¯õS®. \›¯õÚ 

öPõsoø»ø¯¨ ¤ß£ØÓõø© CuØSU 

Põµn©õS®  (E¸ 6.22).

E¸ 6'21 uø\ ÁßTmk¨  

¤µa]øÚPÒ

E¸ 6'22 «ÒÁ¸® uøP¨¦U 

Põ¯® (RSI)
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iii)   ©oUPmka _µ[Pa \P\®	(CTS - Carpel Tunnel    
  Syndrome) 
øP°À EÒÍ ÂµÀPÎÀ HØ£k® ÂøÓ¨¦® ÷|õÄ® 

©oUPmka _µ[Pa \P\® GÚ¨£k®. ©oUPmøh 

Asi EshõS® AÊzu® Põµn©õP ÷|õÄ Es 

hõQßÓx. _miø¯²® \õÂ¨£»øPø¯²® \›¯õÚ 

ÂuzvÀ £¯ß£kzuõø©²® uõÚ¨£kzuõø©²® 

CuØSU Põµn©õS®  (E¸ 6.23).

iv)  PoÛ¨ £õºøÁa \P\® (CVS - Computer          
  Vision Syndrome)  
öuõhºa]¯õP 6 AÀ»x 7 ©ozv¯õ»zvØSU 

PoÛ°À £o¯õØÖÁuß ÂøÍÁõPU Ps 

oÀ EshõS® EÖzuÀ PoÛ¨ £õºøÁa 

\P\® GÚ¨£k®. Ps E»ºuÀ, ö\¢{Ó©õuÀ, 

Pspº Á¸uÀ, £õºøÁ SøÓuÀ, uø», 

PÊzx, |õ› BQ¯ÁØÔÀ ÷|õÄ HØ£kuÀ 

BQ¯Ú C¨£õºøÁ¨ ¤µa]øÚ°ß AÔSÔ 

PÍõS®  (E¸ 6.24).

v)   uø»Á¼ (Headache) 
PÊzvÀ uø\PÎß uøP¨¦, PsPÎß 

PøÍ¨¦ BQ¯ÁØÔß ÂøÍÁõP EshõS® 

uø»Á¼ PoÛø¯¨ £¯ß£kzx÷Áõ›h® 

ö£¸®£õ¾® C¸¨£øuU Põn»õ® (E¸ 6.25).

vi)   uøP¨¦ (Stress) 
÷©®£õmøh²® öuõÈÝm£Â¯¼ß 

uõUP® Põµn©õP HØ£mkÒÍ £o 

AvP›¨¤ÚõÀ ©Ú AÊzu® HØ£k 

QßÓx. {zvøµ öPõÒÍõø©, 

PøÍ¨¦, £]°ßø© BQ¯Ú ©Ú 

AÊzuzvß AÔSÔPÍõS® (E¸ 6.26).

E¸ 6'25 uø»Á¼

E¸ 6'23 ©oUPmka 

_µ[Pa \P\® (CTS)

E¸ 6'24 PoÛ¨ £õºøÁa 

\P\®	(CVS)

             E¸ 6'26 uøP¨¦
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EhÀ B÷µõUQ¯¨ ¤µa]øÚPøÍ G[VÚ® wºUP»õ®?

\›¯õÚ öPõsoø»	(Correct posture)	-	Cx £ozvÓÛ¯¼À (Ergonomics) 
SÔ¨¤h¨£k® •UQ¯ A®\©õS®. 

PoÛø¯¨ £¯ß£kzx®÷£õx \›¯õÚ öPõsoø»°À A©¸Áuß ‰»® 

£» ¤µa]øÚPøÍz uÂºUP»õ®.

                E¸ 6'27 \›¯õÚ öPõsoø»

1

3

5

4

2 }

1.  PoÛz vøµ J¸Á›ß Ps ©mhzvÀ C¸US©õÖ  PoÛU Pvøµø¯²® 

÷©ø\ø¯²® uõÚ¨£kzuÀ

2. PoÛz vøµUS® PsoØSªøh÷¯ EÒÍ yµ® HÓzuõÇ 45 cm - 70 cm BP 

C¸zuÀ.

3.  Pvøµ°ß •xS¨ £Sv°À |õ›ø¯ ÷|µõPÄ® ÷uõøÍ C÷»\õPÄ® 

øÁzv¸zuÀ.

4.  PõÀPøÍ {»zvØSa ö\[SzuõPÄ® EÒÍ[PõÀPøÍ {»zvß «x C÷»                

\õPÄ® øÁzv¸zuÀ.

5. _miø¯a \õÂ¨£»øPUS Asø©°À øÁzxU öPõÒÍÀ, C÷»\õPa                       

\õÂPøÍz umha]kuÀ, ©oUPmøh Kº ChzvÀ øÁzx AÊzuõ©À 

C¸zuÀ, \õÂ¨£»øPø¯ •Ç[øPUS ÷|÷µ AÀ»x R÷Ç uõÚ¨£kzuÀ      

BQ¯ \›¯õÚ öPõsoø»PøÍ¨ ¤ß£ØÖÁuß ‰»•®
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♦ Ps PøÍ¨£øh¯õuÁõÖ PoÛz vøµ°À JÎø¯a ^µõUPÀ Cøh 

°øh÷¯ vøµUS öÁÎ÷¯ £õºzu¾® Psøn ‰ku¾®

♦  £oø¯a ö\´²®÷£õx SÖQ¯ K´öÁkzu¾® SÖQ¯ yµzvØS E»õ 

Äu¾®

♦ ¤ÒøÍPÐUSU PoÛ ÂøÍ¯õmkPÐUPõP ÷|µzøuU Pmk¨£kzv 

JxUSu¾® AÁºPøÍ öÁÎ ÂøÍ¯õmkPÐUS ÁÈ¨£kzu¾®

♦ 7-8 ©ozv¯õ»zvØSU PoÛ²hß ö\¯Ø£k® Á¯xÁ¢uÁºPÒ ÃmiÀ 

PoÛø¯¨ £¯ß£kzxÁøuz uÂºzu¾® ©Úzøu C÷»\õP øÁzxU 

öPõÒÍ¾®

÷£õßÓ ö\¯ÀPÎÀ Dk£kÁuß ‰»•® PoÛ öuõhº£õÚ EhÀ B÷µõUQ¯¨ 

¤µa]øÚPøÍz wºUP»õ®

6'2'6     ÞôˆFóQòŸ èN¾èœ bƒ°ðò‚°‹ ÍôŠªð£¼œèÀ‹ 
        ÜõŸP¡ Íô‹ ²Ÿø£ì½‚° ãŸð´‹ bƒ°èÀ‹

PoÛ, öuõø»UPõm], ö\À÷£], Aa_¨ö£õÔ ÷£õßÓ ªßÛÚõÀ AÀ»x 

ªßP»zvÚõÀ öuõÈØ£kzu¨£k® £À÷ÁÖ C»zvµÛ¯À EØ£zv¨ 

ö£õ¸ÒPÎß £¯ß£k® Põ»® •iÁøh²®÷£õx AøÁ C»zvµÛ¯À 

PÈÄ¨ö£õ¸ÒPÍõPU P¸u¨£k®. (E¸ 6.28). 

\õÂ¨£»øP, _mi 

BQ¯ÚÄ® HøÚ¯ 

C»zvµÛ¯Ø                  

\õuÚ[PÐ®
J¼a                       

\õuÚ[PÒ

PoÛz vøµPÐ® 

uÛ¯õÒ PoÛPÐ®

Aa_¨ 

ö£õÔPÒ

C»zvµÛ¯Ø 

PÈÄ¨ 

ö£õ¸mPÒ

ö\À÷£]PÒ
CFL 

SªÌPÒ

öuõø»U

Põm]¨ 

ö£õÔPÒ

E¸ 6'28 - C»zvµÛ¯Ø PÈÄ¨ö£õ¸ÒPÒ



C»Á\¨ £õh¡À 223

£À÷ÁÖ w[S£¯US® ‰»¨ö£õ¸ÒPøÍU öPõsk EØ£zv ö\´¯¨£k® 

ö£õ¸ÒPÒ  £¯ß£k Põ»® •iÁøh¢ux® Ã\¨£kQßÓø©¯õÀ ©ÛuÝUS® 

_ØÓõh¾US® w[S HØ£kQßÓx.  _ØÓõhÀ ©õ\øh²®÷£õx ©Ûu÷Ú Auß 

£õuP[PÐUS BÍõQßÓõß.

S¨ø£²hß öÁÎ÷¯ØÓ¨£k® SªÌPÒ ©ÛuÛß B÷µõUQ¯zvÀ £õv¨ø£ 

HØ£kzx® £õuP©õÚ Cµ\zøuU öPõskÒÍÚ.

Cµ\zxhß öuõhº¦mh ÷|õ´PÐ® AÁØÔß uõUP•® ¤ßÁ¸©õÖ

 ² |µ®¦z öuõSv ö\¯¼ÇzuÀ

 ² ‰øÍ°ß P»[PÐUSa ÷\u® HØ£kuÀ

 ² ÷uõ¼À JÆÁõø©

 ² Cµ\zøu Em_Áõ]¨£uÚõÀ ø©¯ |µ®¦z öuõSv, ]Ö}µP®, DµÀ 

BQ¯ÁØÖUSz w[S HØ£kuÀ

 ² DNA, {Ó‰ºzu® BQ¯ÁØÖUSz w[S HØ£kuÀ

 ² AÆÁõ÷Ó £À÷ÁÖ C»zvµß PÈÄ¨ ö£õ¸ÒPÒ JÊ[PØÓ ÂuzvÀ 

Ã\¨£kQßÓø©¯õÀ EshõS® ÷|õ´PÎøh÷¯ EhÀ ÃUP®, G›Ä, ©Ú 

AÊzu® Cu¯÷|õ´, DNA ÷\u®, ¦ØÖ÷|õ´ BQ¯Ú CÁØÔÀ ]»ÁõS®. 

 ² AzuøP¯ w[S£¯US® ‰»P[PÒ B\ÛUS (Arsenic), ÷£›¯® (Barium), 

ö£›¼¯®  (Beryllium), Phª¯® (Cadmium), S÷µõª¯® (Chromium),  øhö¯õU 

]ßì  (Dioxins), D¯® (Lead), Cµ\® (Mercury), ö\»Û¯® ( Selenium) BS®.

DµÀ
÷uõÀ  

~øµ±µÀ

‰øÍ
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C»zvµÛ¯À PÈÄ¨ö£õ¸ÒPÎÚõÀ HØ£k® ¤µa]øÚPøÍ GÆÁõÖ 

SøÓUP»õ®?

1.  £¯ß£õmøhU SøÓzuÀ	 (Reduce)	 -	 uØ÷£õx £¯ß£kzu¨£k® 

C»zvµÛ¯À E£Pµn[PøÍ EP¢uÁõÖ ÷£qÁuß ‰»•® ÷uøÁ¯ØÓ 

ö£õ¸ÒPøÍU öPõÒÁÚÄ ö\´ÁøuU SøÓ¨£uß ‰»•®

2.  ©Ö£i²® £¯ß£kzuÀ	(Reuse)  -	£øÇ¯ BÚõÀ öuõÈØ£k® {ø»ø©°À 

EÒÍ C»zvµÛ¯À E£Pµn[PøÍ AÈUPõ©À |ßöPõøh¯õP ÁÇ[PÀ 

AÀ»x ÂØÓÀ.

3.  «Ò_ÇØ]	 (Recycle)	 -	 £Êx£õºUP •i¯õu E£Pµn[PøÍ «Ò_ÇØ] 

ö\´²® {ÖÁPzvØS ÁÇ[SuÀ.

1.  ©zv¯ AvPõµ \ø£°ß Áø»zuÍzvØS¨ ¤µ÷Á]zx C»zvµ 

Û¯Ø PÈÄ¨ö£õ¸ÒPøÍ •iÄö\´ÁuØS ÷©ØöPõÒÍ¨£mkÒÍ 

|hÁiUøPPøÍ CÚ[PõsP.

2. C»[øP°À C»zvµÛ¯À PÈÄ¨ ö£õ¸ÒPøÍU PÁÚ©õP 

•i¦ö\´ÁuØS EuÄ® www.ewaste.lk {ÖÁPzvß Áø»¨£UPzvÀ 

¤µ÷Á]UP. A¢{ÖÁPzvß ‰»® ÁÇ[P¨£k® ÷\øÁPøÍ²® 

AøÁ  ö£Ó¨£k®  Âuzøu²®  £ØÔ¯  uPÁÀPÒ Ch®ö£Ö® J¸ 

]ØÔuøÇz u¯õ›UP.

ö\¯Ø£õk

6'2'7 îèõ™ ñŸÁ‹ ªî£ì˜ð£ì™ ªî£NÂ†ðMò½‹    
 êÍèˆ¶ì¡  ªî£ì˜¹ð†ì Hó„C¬ùèÀ‹

i) C»UP•øÓ CøhöÁÎ (Digital divide)	-	
(E¸ 6.30) & uPÁÀ ©ØÖ® öuõhº£õhÀ 

öuõÈÝm£Â¯ø»¨ £¯ß£kzxÁuØS 

EÒÍ Á\v²® BØÓ¾®, |hzøu BØÓ¾® 

AøÁ öuõhº£õÚ  AÔÄ® ©ÛuøÚ¨ 

ö£õ¸ÍõuõµŸv°¾® \‰PŸv°¾® ¤›z 

xU PõmkQßÓÚ. Cx C»UP•øÓ Cøh 

öÁÎ GÚ¨£k®.

E¸	6.30	 C»UP•øÓ 

CøhöÁÎ	(Digital divide) 

Aß¦ÒÍ µÂ 

E[PÒ _P® G¨£i? 

''''''''''''''''''''''''''
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C»UP•øÓ CøhöÁÎUS HxÁõÚ PõµoPÒ (E¸ 6.31) ]»ÁØøÓ¨ 

¤ßÁ¸©õÖ Põmh»õ®.¤ßÁ¸©õÖ Põmh»õ®.

• PØÖÒÍø©

• öuõÈÝm£ BØÓ¾® AÔÄ®

• ö\ÀÁ®

• øPzöuõÈÀ©¯©õPÀ

• |Pµ ÁõÌÄ

• PØPõø©

• öuõÈÝm£ BØÓ¼ßø©²®    
AÔÂßø©²®

• ÁÖø©

• øPzöuõÈÀ ©¯©õPõø©

• Qµõ© ÁõÌÄ

E¸ 6'31 C»UP•øÓ CøhöÁÎUPõÚ Põµn[PÒ

♦  PØÖÒÍø©/PØPõø© & uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¼ß 

EÒÏkPøÍ²® AÁØÔß £¯ßPøÍ²® £ØÔ AÔ¢v¸¨£x® AÔ¯õ                  

v¸¨£x® ©ÛuºPÐUQøh÷¯ ÷ÁÖ£õkPøÍ HØ£kzxQßÓÚ.

♦ öuõÈÝm£ BØÓÀ, AÔÄ C¸zuÀ/ CÀ»õø© & uPÁÀ ©ØÖ® öuõhº£õhÀ 

öuõÈÝm£Â¯ø»¨ £¯ß£kzxÁuØPõÚ BØÓÀ EÒÍ AuøÚ¨ 

£ØÔ¯ AÔøÁ¨ ö£ØÓ ©ÛuºPÐUS® GÆÂuzv¾® AÔÄ CÀ»õu 

©ÛuºPÐUSªøh÷¯ öuõhº¦ HØ£kÁx A›uõS®.

♦  ö\ÀÁ®/ ÁÖø© & uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯ø»U PØ£ 

uØPõÚ ÷uøÁ C¸¢u ÷£õv¾® AuøÚ¨ £¯ß£kzxÁuØPõÚ ÷uøÁ 

C¸¢u÷£õv¾® AuØSz ÷uøÁ¯õÚ Qµ¯zøuz uõ[P•i¯õø© C»UP 

•øÓ CøhöÁÎUS ÷ÁöÓõ¸ Põµn©õS®.

♦  øPzöuõÈÀ©¯©õuÀ/ øPzöuõÈÀ©¯©õPõø© & J¸ |õk øPzöuõÈÀ 

©¯©õuÀ uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À EÒÏkPøÍ¨ 

£¯ß£kzxÁuØS J¸ Põµn©õS®. AÆÁõÖ CÀ»õu÷£õx |õmkUS 

|õk C»UP•øÓ CøhöÁÎ Põn¨£k®.

♦  |Pµ ÁõÌÄ/ Qµõ© ÁõÌÄ & |PµzvÀ ÁõÊ® ©Ûuß £oªUPÁß. uPÁÀ 

©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¼ß EÒÏkPøÍ AvP AÍÂÀ 

£¯ß£kzx£Áß. BÚõÀ ªPÄ® GÎ¯ _u¢vµ©õÚ _ØÓõh¼À 

ÁõÊ® Qµõ© ©Ûuß uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¼ß 

£¯ß£õkPøÍU  P¸zvÀ öPõÒÁvÀø». BP÷Á ©ÛuºPÐUQøh÷¯ 

C»UP•øÓ CøhöÁÎ HØ£kQßÓx.
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ii) C»UP•øÓ¨ £õ»® (Digital bridge) 
C»UP•øÓ CøhöÁÎø¯ }UQUöPõsk ©ÛuºPÐUQøh÷¯ HØ£kz 

u¨£k® öuõhº¦  C»UP•øÓ¨ £õ»® GÚ¨£k®. PoÛø¯ AÀ»x  

ö\À÷£]ø¯ ÁÇ[SÁuß ‰»® ©õzvµ® C»UP•øÓ¨ £õ»zøu 

HØ£kzu•i¯õx. ©Ûuß £À÷ÁÖ öuõÈÝm£a \õuÚ[PøÍ¨ ö£ØÖ 

AÁØøÓa \›¯õP¨ £¯ß£kzxÁuØS® AÁØøÓ¨ £ØÔ AÔ¢v¸¨£uØS® 

AÁØøÓ¨ ö£ÖÁuØS©õÚ FUPzøuU öPõsi¸zuÀ ÷Ásk®. AÆÁõÖ 

CÀ»õÂmhõÀ öuõÈÝm£Â¯À ö£Ö©õÚ® CÀ»õu ö£õ¸Ò Gß£vÀ 

\¢÷uPªÀø». 

C»UP•øÓ¨ £õ»zøu G[VÚ® HØ£kzu»õ®?

E¸ 6'2 C»UP•øÓ¨ £õ»®	(Digital bridge)

·     C»UP•øÓ AÔÄøhø© (Digital Literacy) £ØÔU PÁÚzøu DºzuÀ & 

uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À öuõhº£õP ©Ûuß ö£Ö® 

AÔÂÞhõP C»UP•øÓ CøhöÁÎø¯ }UP»õ®. Âuõuõ {ø»¯®, |Ú\» 

{ø»¯®, PoÛ ÁÍ {ø»¯® ÷£õßÓ C»Á\, ªPU SøÓ¢u PmhnzvØS 

C»UP•øÓ AÔÄøhø©ø¯ ÁÇ[S® {ø»¯[PøÍ öÁÆ÷ÁÖ ¤µ÷u\

[PÎÀ HØ£kzuÀ. AuØPõÚ  £[S£ØÖøPø¯  Â¸zv ö\´ÁuØS Ch®ö£¯º 

¤µ\õµ®, øPa]ØÔuÌPøÍ Â{÷¯õQzuÀ, _ÁöµõmiPøÍU Põm]¨£kzuÀ 

BQ¯ÁØøÓ¨ £¯ß£kzuÀ.

C»UP•øÓ   AÔÄøhø©ø¯  (Digital Literacy)  HØ£kzxÁuÞhõP  

©ÛuÝUSU QøhUPzuUP AÝT»[PÒ

• uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯ø»¨ £¯ß£kzxÁuß 

÷uøÁø¯ ÂÍ[QU öPõÒÍ¾® AuøÚ¨ £ØÔ¯ FUP® HØ£ku¾®.

• uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À ¤µ÷¯õPzvÚõÀ HØ£k® 

¤µa]øÚPøÍ  AvP AÍÂØSz wº¨£uØPõÚ BØÓÀ
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• ]møhPÐUPõPU öPõk¨£ÚÄ ö\´uÀ, PÀÂz uPÁÀPøÍ B´¢uÔ¢x 

÷\P›zuÀ, ©¸zxÁz uPÁÀPøÍ¨ ö£ÖuÀ, ¤ÒøÍPÐUSz ÷uøÁ¯õÚ 

PÀÂz uPÁÀPøÍ¨ ö£ÖÁuØS EuÄuÀ, öuõÈÀPÐUPõP Âsn¨¤zuÀ 

BQ¯ £oPÒ Cøn¯zøu¨ £¯ß£kzxÁuß ‰»® ªP GÎuõS® 

Gß£øu ÂÍ[QU öPõÒÍÀ.

♦  PoÛPøÍ ÁÇ[PÀ & C»UP•øÓ AÔÄøhø© C»UP•øÓ¨ £õ»zvØS 

Ai¨£øh¯õP C¸US®. \¾øP Âø»°À PoÛPøÍ ÁÇ[S® 

ö\¯ØÔmhzøu Bµ®¤¨£uÞhõP Auß £»zøu ÷©¾® AvP›UPa 

ö\´¯»õ®. Cx C»UP•øÓ AÔÄøhø©ø¯¨ ö£ÖÁuØPõP¨ £[S 

£ØÖ£ÁºPÐUS¨ ÷£õßÖ Sk®£zvß HøÚ¯ EÖ¨¤ÚºPÐUS® 

£¯ß£k®.

♦ HøÚ¯ {vz uøhPøÍ }USu¾® \© Áõ´¨¦PÐ® &  AøÚÁ¸US® C»Á 

\©õP AÀ»x ªPU SøÓ¢u Âø»US Cøn¯ Á\vPøÍ¨ ö£ÖÁuØPõÚ 

BØÓø» HØ£kzu¾® AuØS EÒÍ uøhPøÍ }UP¾®. Cuß ‰»® 

¤ÒøÍPÎß PÀÂ¨ £oPÐUSz ÷uøÁ¯õÚ uPÁÀPøÍa ÷\P›zuÀ, 

{PÌ{ø»z öuõø»U PÀÂUPõÚ BØÓø» HØ£kzuÀ, öuõÈÀPÐUPõP 

AvP Áõ´¨¦PÒ QøhzuÀ, \¢øu {ø»ø©U PØøP, \‰P Áø» 

¯ø©¨¤ÞhõPz uPÁÀPøÍ¨ £›©õÓÀ ÷£õßÓ £» ÷uøÁPøÍ {øÓ 

÷ÁØÓ»õ®.

♦  Cøh±mhõÍºPÎß £[S£ØÖøP & £À÷ÁÖ £[Søhø© Â¯õ£õµ[PÒ, 

\•uõ¯ Aø©¯[PÒ, Aµ\õ[P uÛ¯õº {ÖÁP[PÎß £[S£ØÖøP ÷£õßÖ 

EuÂPÐ® AÝ\µøn²® C»UP•øÓ¨ £õ»zøu öÁØÔPµ©õUSÁuØS 

ªPÄ® •UQ¯©õÚøÁ¯õS®.

C»[øP Aµ\õ[PzvÚõÀ C»UP•øÓ CøhöÁÎø¯ (Digi-
tal divide) }UQUöPõsk C»UP•øÓ¨ £õ»zøu (Digital bridge) 
HØ£kzxÁuØS ÷©ØöPõÒÍ¨£mkÒÍ |hÁiUøPPøÍ AÔ¢x 

AmhÁøn¨£kzxP.

ö\¯Ø£õk
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iii) 	vÓÚPØÓÀ (De-skilling)

E¸ 6'33 vÓÚPØÓÀ	(De-skilling)

 

vÓÚPØÓÀ  (E¸ 6.33)  BÚx uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¼ß 

÷ÁöÓõ¸ £UPÂøÍÁõS®. öuõÈ¼À Dk£k£ÁºPøÍ B°µUPnUQÀ 

öuõÈ¼¼¸¢x APØÔUöPõsk ¦v¯ ö£õÔzöuõSvPÒ AÁºPÐøh¯ 

Chzøu {µ¨¤²ÒÍÚ. ö£õÔzöuõSvPÎß •Põø©zxÁ•® |hzøu²® 

GÎuõP C¸¢u÷£õv¾® Caö\¯Ø£õk  £» vÓßªUPÁºPøÍ {ºUPvUS 

BÍõUQ²ÒÍx. |£ºPÎh•® {ÖÁP[PÎh•® EÒÍ ö\´•øÓ AÔøÁ¨ 

£¯ß£kzuõø©, PÀÂUS EÒÍ Áõ´¨¦ CÀ»õ©Ø ÷£õuÀ BQ¯Ú 

ußÛ¯UPzvß ]» ¤µvT»[PÍõS®. CuØSa ]» Euõµn[PÒ :

• øPzöuõÈÀPÎÀ ö£õÔzöuõSvPÒ ©Ûu EøÇ¨ø£²® BØÓ¾Ò 

ÍÁºPÎß Chzøu²® E›ø©¯õUQU öPõÒÍÀ.

• ªß¡ÀPÒ, ªß\g]øPPÒ BQ¯ÁØÔß ÂøÍÁõP ¡»P[PÒ ‰h¨ 

£ku¾® AÁØÖhß öuõhº¦£mh öuõÈÀPÒ CÀ»õ©Ø ÷£õu¾®.

• {PÌ{ø»U (Online) PØÓÀ, Cøn¯z uPÁÀPøÍ¨ ö£ÖÁuß Á\v BQ¯ 

ÁØÔß ÂøÍÁõP B]›¯ºPÎß ÷uøÁ SøÓuÀ. 

• Ãmi¼¸¢x EhÚ» {ø»ø©ø¯a ÷\õv¨£uØPõÚ BØÓÀ Põµn©õP 

B´Th¨ £oPÐ® AÁØÖhß öuõhº¦£mh  öuõÈÀPÐ® CÀ»õ©Ø 

÷£õuÀ.
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iv)  öuõÈÝm£Â¯¾hß öuõhº¦£mh ÷Áø»Áõ´¨¦PÒ

öuõÈÝm£Â¯À Põµn©õP¨ £À÷ÁÖ 

öuõÈÀ Áõ´¨¦PÒ (E¸ 6.34) CÀ»õ©Ø 

÷£õ²ÒÍÚ GÚ |õ® ÷©÷» PØ÷Óõ®. BÚõÀ 

C¨÷£õx öuõÈÝm£Â¯À ©ÛuÝUS 

Azv¯õÁ]¯©õÚ Kº A®\©õP ©õÔ²ÒÍx. 

CuØS •UQ¯ Põµn® uPÁÀ ©ØÖ® öuõhº 

£õhÀ öuõÈÝm£Â¯À £ØÔ¯ AÔÄ EÒÍ 

©Ûuß ö£ÓzuUP ÷Áø» Áõ´¨¦PÍõS®. 

uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À 

£ØÔ¯ AÔÄ® AuøÚU øP¯õÒÁuØPõÚ                                                   

]Ó¢u BØÓ¾® EÒÍÁºPÐUSz uPÁÀ 

©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À 

öuõhº£õÚ E¯º \®£Í•ÒÍ ÷Áø» Áõ´¨¦PøÍ¨ ¤ßÁ¸©õÖ Põmh»õ®. 

AuØS ÷©»vP©õPz uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¾hß  

öuõhº¦£mh ÷ÁÖ £» ÷Áø» Áõ´¨¦PÐ® EÒÍÚ.

 ² PoÛa ö\´{µ»º (Computer Programmer)

 ² PoÛ •øÓø©¨ £S¨£õ´ÁõÍº  (Computer/Information Systems Analyst)
 ² uµÄz öuõhº£õhÀ £S¨£õ´ÁõÍº (Data Communications Analyst) 
 ² uµÄzuÍa ö\´{µ»º/ £S¨£õ´ÁõÍº	(Database Programmer and Analyst)
 ² ÷©ø\/ ¤µ÷¯õP BuµÄa ]Ó¨£Ôbº	(Desktop/Application Support Specialist)
 ² ö\À÷£]¨ ¤µ÷¯õP E¸ÁõUS|º (Mobile Application Developer)
 ² Áø»¯ø©Ä ©ØÖ® •øÓø©¨ £õxPõ¨¦a ]Ó¨£Ôbº. 

     (Network and System Security Specialist)
 ² Áø»¯ø©¨¦ •Põø©¯õÍºPÒ ©ØÖ® {ºÁõQPÒ 

     (Network Managers and Administrators)
 ² ö©ßö£õ¸Ò G¢v› (Software Engineer)
 ² öuõÈÝm£ ÂØ£øÚa ]Ó¨£Ôbº (Technical Sales Specialists)
 ² öuõÈÝm£¨ £°ØÖÚº (Technical Trainer)
 ² öuõø»zöuõhº¦ •Põø©¯õÍºPÒ (Telecom Manager)
 ² öuõø»zöuõhº¦ Cøn¨¦ {ÖÄÚº (Telecommunications Line  Installer)
 ² Áø»zuÍ Â¸zv¯õÍº	(Website Developer)

E¸ 6'34 öuõÈÝm£Â¯¾hß 

öuõhº¦£mh ÷Áø» Áõ´¨¦PÒ
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CÁØÔøh÷¯ C»[øP°À ÷£õßÖ ÷ÁÖ |õkPÎ¾® ö©ßö£õ¸Ò ö£õÔ 

°¯»õÍºPÐUPõÚ (Software Engineer)  ÷PÒÂ ªPÄ® AvP©õS®. Cz 

öuõÈ¾USU QøhUS® \®£Í® ªPÄ® AvP©õøP¯õÀ CzöuõÈÀ G©x 

|õmiØS A¢{¯a ö\»õÁoø¯ Dmiz u¸® ¤µuõÚ öuõÈ»õP Aø©¢xÒÍx.  

BP÷Á PoÛ ö©ßö£õ¸Ò Aø©¨¦, uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈ 

Ým£Â¯À öuõhº£õP E¯º PÀÂø¯¨ ö£ÖÁuÞhõP |À» ÷Áø» 

Áõ´¨¦PøÍ¨ ö£Ó»õ®.

6'7'8  îèõ™ ñŸÁ‹ ªî£ì˜ð£ì™ ªî£NÂ†ðMò¬ô„ êÍèˆFŸ°  
 M«ó£îñ£èŠ ðò¡ð´ˆî™

i)		\‰P Áø»zuÍ[PÒ	(Social media)

E»QÀ ÁõÊ® ©UPÎøh÷¯ öuõhºø£ 

HØ£kzxÁuØS® ö£õx A¤¨¤µõ¯[PÒ 

EÒÍÁºPÎß P¸zxPøÍ¨ £›©õÖÁuØPõÚ 

Áõ´¨ø£ HØ£kzxÁuØS® |Àö»snzøu 

E¸ÁõUSÁuØS® uÛ¨£mh Gsn[PøÍ 

öÁÎ¨£kzxÁuØS® \õuÚ©õPa \‰P Áø»z 

uÍ[PÒ EÒÍÚ. Cuß ‰»® E[PÐUSU 

QøhUS® ÷\øÁPøÍ¨ ¤ßÁ¸©õÖ Põm 

h»õ®:

♦  J¸Áº  uÚx  EØ£zv¨ ö£õ¸ÒPøÍa \¢øu¨£kzxÁuØSa \‰P Áø»z  

uÍzøu¨ £¯ß£kzu»õ®.

♦  Cøn¯U SÔ¨¦PÒ Gß£uß SÖUP©õQ¯ ¦÷ÍõUì (Blogs) Gß£x 

¤µzv÷¯P |õmSÔ¨¦PøÍ AÀ»x \g]øPPøÍ ÁÈ¨£kzxÁuõS®. 

Aa\‰P Áø»zuÍ® J¸Á¸øh¯ vÚ\› AÝ£Á[PøÍ AÀ»x 

\‰PzvÀ |øhö£Ö® w[PõÚ |hÁiUøPPøÍ •ßøÁ¨£uØPõP 

E¸ÁõUP¨£mkÒÍx. ]»ÁØøÓ Áõ]¨£ÁºPÒ u[PÐøh¯  P¸zxU 

PøÍ²® öu›ÂUP»õ®.

♦  Cøn¯zøu¨ £¯ß£kzx£ÁºPÒ u©x Áø»zuÍzvØS AÀ»x 

EØ£zv Â¸zv Áø»¨£UPzvØS AÀ»x Áø»¨£vÄ¨  £UPzvØS 

ÁÈ¨£kzu¨£kuÀ \‰P Áø»¯ø©¨¤ß ‰»® |øhö£Ö® ÷ÁöÓõ¸  

÷\øÁ¯õS®.

E¸	6'35 
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♦  P»¢xøµ¯õhÀ PÍ® ©ßÓ® (Forum) GÚ¨£k®. Cx uÛ¯õmPÎß 

ö£õxU P¸zxPøÍ öÁÎ¨£kzxÁuØS Kº EP¢u Ch©õS®. Cx \‰P 

Áø»zuÍzvß ‰»® ÁÇ[P¨£k® ÷ÁöÓõ¸ ÷\øÁ¯õS®.

♦  E»P®  •ÊÁx®  ÁõÊ®  |£ºPøÍ  JßÖ÷\º¨£v¾® AÁºPÐøh¯ 

P¸zxPøÍ¨ £›©õÔU öPõÒÁuØS® |s£ºPÐhß P»¢xøµ¯õkÁuØS® 

E¸UPÒ, Ãi÷¯õ¨ £vÄPÒ, £õmkPÒ BQ¯ÁØøÓ¨ £›©õÔU öPõÒÁv¾® 

\‰P Áø»zuÍ[PÒ •UQ¯ Ch® ÁQUQßÓÚ.

ii)	 Cøn¯U SØÓ®	(Cyber crime)
\‰P Áø»zuÍzøuz uPõu ÂuzvÀ £¯ß£kzxQßÓø©¯õÀ Ax 

\‰PzvØSU ÷PhõP Aø©QßÓx. Cx Cøn¯U SØÓ® (Cyber crime) 
GÚ¨£k®. ¤ßÁ¸ÁÚ Cøn¯U SØÓ[PÍõPU P¸u¨£k®. 

♦  AÝ©v°ßÔ ¤Ó|£ºPÎß  JÎ¨£hzøu Cøn¯zvØS¨ £v÷ÁØÓg 

ö\´uÀ

♦ ö£sPÎß AÀ»x ²ÁvPÎß ö£õ¸zu©ØÓ JÎ¨£h[PøÍ AÀ»x 

JÎ²¸¨ £vÄPøÍ AÝ©v°ßÔ Cøn¯zvØS¨ £v÷ÁØÓg ö\´u¾® 

AÁØøÓ¨ £¯ß£kzv AÁºPøÍ Aa_Özu¾® AÀ»x Aa_Özv¨ 

£nzøu¨ ö£Ó•¯¾u¾®.

♦  uÛ¯õmPÎß |ß©v¨¦USz w[S HØ£k® ÂuzvÀ ö\´vPøÍ öÁÎ 

°kuÀ

♦ uÛ¯õmPøÍ¨ ¤øÇ¯õP ÁÈ¨£kzxÁuØS¨ ö£õ´z uPÁÀPøÍ²® 

JÎ¨£h[PøÍ²® Cøn¯zvÀ öÁÎ°ku¾® uÛ|£ºPÒ/SÊUPÎß 

ö£¯¸USU PÍ[P® HØ£kzu¾®.

♦  ö£õ´z   uPÁÀPøÍ¨   £¯ß£kzvz   uÛ¯õmPøÍ  H©õØÔz ÷uøÁ¯õÚ 

öuõhº¦PøÍ HØ£kzva \‰P  Áø»¯ø©¨¦PøÍ¨ £¯ß£kzxÁuß 

‰»® uÛ¯õÎß ÁõÌøÁa ^µÈzuÀ.

♦  uPõu •øÓPøÍ¨ £¯ß£kzvz uÛ¯õÎß PnUQØSÒ ¤µ÷Á]zxU 

uÛ¨£mh uPÁÀPøÍz v¸kuÀ.
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iii)	\‰P Áø»zuÍzøu¨ £¯ß£kzx®÷£õx ÷©ØöPõÒÍ ÷Ási¯   

     •ØPõ¨¦  |hÁiUøPPÒ BÁÚ :

♦ Cøn¯¨ £oPÐUPõPa \‰P Áø»zuÍzøuz öu›¢öukUS®÷£õx 

AÁuõÚ©õP C¸zuÀ ÷Ásk®.

♦  \‰P Áø»zuÍzvÞhõP |s£ºPøÍz öu›¢öukUS®÷£õx AÁuõÚ©õP 

C¸zuÀ ÷Ásk®.

♦ \‰P Áø»zuÍzvØS öÁÎ°k® uÛ¨£mh uPÁÀPøÍ¨ £ØÔ  AÁuõ 

Ú©õP C¸zuÀ ÷Ásk®.

♦  \¢÷uPzvØQh©õÚ ªßÚg\ø»z vÓ¨£øuz uÂºzuÀ.

♦  ªßÚg\¼À EÒÍ Cøh Cøn¨¦PøÍa ö\õkUSÁøuz uÂºzuÀ.

♦  ö£¯›À»õu ªßÚg\ø» |®£÷Áshõ®.

♦ ªßÚg\À •PÁ›¨ ¦zuPzøua ÷\õv¨£uØSa \‰P Áø»zuÍzvØS 

AÝ©vø¯ ÁÇ[P ÷Áshõ®.

♦ ¤µzv÷¯P ªßÚg\¼ÞhõPa \‰P Áø»zuÍzvØS¨ ¤µ÷Á]UP ÷Ás 

hõ®.  \‰P Áø»¯ø©¨¤ß •PÁ›ø¯ E»õÂ°À umha]mk¨ ¤µ÷Á               

]UP.

♦  \‰P Áø»zuÍzvß ‰»® ÁÇ[P¨£k® ÷©»vP ¤µ÷¯õP ö©ß                          

ö£õ¸ÒPøÍU  PoÛ°À {ÖÄÁøuz uÂºzuÀ.

♦  J¸ \‰P Áø»zuÍzøu¨ £¯ß£kzxÁuØS •ßÚº C¸ uhøÁ ]¢vzuÀ.

♦  \‰P Áø»zuÍzøu²® Auß £UPÂøÍÄPøÍ²® £ØÔ¨ ¤ÒøÍPÐUS® 

|s£ºPÐUS® AÔÄÖzxuÀ.
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♦ öuõÈÝm£Â¯À ö£õÊx÷£õUQØPõP¨ £À÷ÁÖ Âu©õP¨ £¯ß£kz 

u¨£kQßÓx.

♦ uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£zøu¨ £¯ß£kzx®÷£õx £» 

¤µa]øÚPÒ HØ£kQßÓÚ. AøÁ \mh¨ ¤µa]øÚPÒ, ÂÊª¯¨ ¤µa]

øÚPÒ, ö£ÍvP¨ ¤µa]øÚPÒ, w[S £¯US® ö©ßö£õ¸Ò,          

_ØÓõhØ ¤µa]øÚPÒ, EhÀ B÷µõUQ¯¨ ¤µa]øÚPÒ, \‰P¨ ¤µa]

øÚPÒ ÷£õßÓÚ BS®.

♦  BUPÄ›ø© EzuµÄa^mk ~snÔÄa ö\õzvß \mh¨ £õxPõ¨ø£ 

EÖv¨£kzxQÓx.

♦ ö£ÍvP¨ £õxPõ¨¦UPõPz uøh¨£hõu Á¾ ÁÇ[PÀ, Áß wa_Áº, ‰i¯   

_ØÖz öuõø»UPõm], PuÄ ‰»® Pmk¨£kzv¯ ¤µ÷Á\®, GÊa]¨ 

£õxPõ¨¤ BQ¯ÁØøÓ¨ £¯ß£kzu»õ®

♦  u¸UP¨ £õxPõ¨¦UPõPU PhÄaö\õÀø»¨ ¤µ÷̄ õQzuÀ, ö©ß                              

wa_Áøµz  öuõÈØ£kzuÀ, Põ¨¦PøÍ øÁzxUöPõÒÍÀ  BQ¯ÁØøÓ 

÷©Ø öPõÒÍ»õ®.

♦  w[S£¯US®  ö©ßö£õ¸ÒPÒ  AÀ»x  w[S£¯US® SÔ•øÓPÒ 

PoÛPøÍ²® PoÛ Áø»¯ø©¨ø£²® Á¾ÂÇUPa ö\´QßÓÚ.

♦  PoÛ |a_{µÀ, PoÛ ÷Á®PÒ, JØÓºPÒ, ö£õØì, öPõÒøÍ¯ºPÒ, 

¤æ[, Â¸®£õu Ag\À BQ¯Ú w[S£¯US® ö©ßö£õ¸ÒPÍõS®.

♦  w[S£¯US® ö©ßö£õ¸ÒPÎ¼¸¢x £õxPõ¨£uØS |a_{µÀ Põ¨¦ 

ö©ßö£õ¸ÒPÒ £¯ß£kzu¨£kQßÓÚ.

♦ \›¯õÚ öPõsoø»PøÍ¨ ¤ß£ØÖÁuß ‰»® EhÀ B÷µõUQ¯¨ 

¤µa]øÚPøÍ CÈÁÍÁõUP»õ®.

♦ C»zvµÛ¯Ø PÈÄ¨ö£õ¸ÒPøÍ EP¢uÁõÖ APØÓõø©¯õÀ  _ØÓõ    

h¾USa ÷\u® HØ£kQßÓx.

♦ C»UP•øÓ CøhöÁÎ Gß£x uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈ                  

Ým£Â¯À Põµn©õP EshõS® \‰P¨ ¤µa]øÚ¯õS®.

♦  C»UP•øÓ¨ £õ»zvß ‰»® A¨¤µa]øÚPøÍz wºUP»õ®.

♦ vÓÚPØÓÀ Gß£x uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯¼ß 

÷ÁöÓõ¸ £UPÂøÍÁõS®.

♦ uPÁÀ ©ØÖ® öuõhº£õhÀ öuõÈÝm£Â¯À AÔÄ EÒÍ ©ÛuÝUS¨ 

£» öuõÈÀ Áõ´¨¦PÒ EÒÍÚ.

♦  \›¯õP¨ £¯ß£kzu¨£kÁuÚõÀ \‰P Áø»zuÍ® ‰»® |øhö£Ö® 

\‰P Â÷µõua ö\¯ÀPøÍ CÈÁÍÁõUP»õ®.

ö£õÈ¨¦
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